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Preface 

 

This manual presents a guide to the effective use of VentSim DESIGN™ ventilation software for mine ventilation 
simulation and design.  It does not profess to be a ventilation engineering guide and as such should not be used as a 
substitute for existing ventilation texts on underground ventilation and environmental engineering.   

The manual may contain simplifications and does not attempt to explain many of the complex concepts and methods 
used in mine environmental engineering.  It is highly recommended that users of VentSim DESIGN™ have at least a 
basic understanding of ventilation and simulation theory in order to correctly input and interpret the program functions and 
results.    

The solutions and methods presented in VentSim are based on the published work of many talented individuals and 
research organisation over many decades.  Many excellent texts and papers exist for mine ventilation, not the least which 
is the late Malcolm J McPherson’s ‘Subsurface Ventilation and Environmental Engineering’, from which VentSim 
DESIGN™ draws much of the methodology for thermodynamic and other simulation. 

Finally, special thanks to Dr Rick Brake for his continued assistance in the development of VentSim™. 
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1 What’s New ? 

1.1. VentSim DESIGN™ – Version 5.2 

VentSim DESIGN™ 5.2 is a major upgrade with many new features and improvements. 
   

 

1.2. VentSim DESIGN 5.2 - Improvements 

New simulation features • Dynamic Simulation will now include activity tracks 

• Vehicle presets 

• Filter presets 

• Piston effect 

• Gag wizard, and adjustments to moisture calculations 

Modeling Escape Routes • Color Distance to Surface / Refuge Bay 

Modeling Equipment Paths • Improvements to Activity Track Editor 

User Interface • New simpler configuration of 3D graphics visibility options 

• Data Manager minor update to managing colors 

• New easier way to assign icon to pre-sets 

• Draw guides showing angle and length when drawing airways 

• Legend  

• New Edit Properties (using property grid) 

• Model Explorer 

• New ability to draw custom airway profiles  

• Licensing can now read your license settings directly from the 
pdf file  

• File Inherit can now select which 3d Graphics to inherit 

• Spreadsheet tool has new sorting and filtering tools 

• Zoom to specific Graphics Layer 

• Minor change to Fan Database 

• Apply changes to Specific Stages  

• Add Scale Manager as a separate View 

• Irregular shape selection 

VentLog • New Tablet Mode 

• Anemometer, smoke tube data entry 

VentSim™ CONNECT • New Connect UI 
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2 VentSim DESIGN™ – An Introduction 

VentSim DESIGN™ is the successor to VentSim Classic which was first developed and released in 1993, 
and was widely lauded for its simple interface and graphical Windows based 3D wireframe approach to 
displaying ventilation models.  

The relatively recent introduction of affordable 3D graphics hardware into everyday PC’s encouraged a 
new approach with VentSim ventilation software. 

It became clear soon after the introduction of VentSim 
Classic that very sophisticated and complex models were 
being developed with the program, however the application 
and analysing of these models was restricted by the shear 
amount of data being manipulated.  In addition, in models of 

many thousands of airway branches, serious mistakes could 
often be made in the entry of data without being noticed.  
Viewing and editing of large datasets was becoming 
increasingly problematic, and use of these models by others 
not familiar with the mine was becoming more difficult. 

A key factor in the development of VentSim DESIGN™ was 

the observation that many sophisticated ventilation models 

were being developed in VentSim Classic by bright 
engineers, but then simply gathered dust once these 
engineers moved on, and new engineers abandoned trying 
to decipher them. 

Another key factor to the development of the next generation of VentSim was the increasing demand to 
simulate and design underground environmental conditions, to ensure suitable conditions for mine 

workers and equipment.   

As a result, VentSim DESIGN™ Standard and Advanced were developed to address these requirements.  
Primarily, it has been designed as a ventilation tool, which can operated independently of other mine 
planning packages, but maintains a level a compatibility which ensures data from mine planning 
packages and other ventilation software can be passed to the program. 

VentSim DESIGN™ provides a full toolbox of tightly integrated utilities to analyse ventilation flows, heat, 
contaminants and financial aspects of mine ventilation.  Building on the success and experience of fifteen 

years of VentSim implementation at over 800 sites, VentSim DESIGN™ goes a generation further in its 
approach to ventilation simulation and analysis, and sets a new standard in ventilation software design 
and implementation. 

  

Chapter 

2 



 

 

2.1. About VentSim™™ 

Ventilation has been a primary concern in underground mines for hundreds of years, but until the 
introduction of computerized model analysis in the last 40 years, the planning and modelling of 
ventilation was largely a black art, relying on experience, guesswork and extensive calculations. 

Even when computer ventilation software allowed simulations of large models of underground airways, 
the process of entering and interpreting results still remained a job for experts in the field.  VentSim 
DESIGN™ aims to make ventilation simulation and design accessible to any mine engineer or ventilation 
officer, even those without substantial ventilation experience. 

VentSim DESIGN™ Standard provides the user with the tools to; 

• Simulate and provide a record of flows and pressures in an existing mine. 

• Perform 'what if' simulations for planned new development. 

• Help in short term and long term planning of ventilation requirements. 

• Assist in selection of types of circuit fans for mine ventilation. 

• Assist in financial analysis of ventilation options. 

• Simulate paths and concentrations of smoke, dust, or gas  for planning or emergency situations 

VentSim DESIGN™ Advanced provides additional tools to; 

• Undertake full thermodynamic analysis of heat, humidity and refrigeration in underground mines. 

• Take into account air compressibility for deeper mines. 

• Provide tools for analysing multiple different airways size options, both financially and for 
establishing ventilation capacity. 

• Show dynamic time based analysis of contaminant, gas, diesel fume or heat spreading through a 
mine from different activities. 

• Provide a tool to check for recirculation in mines. 

• Simulate Diesel Particulate Matter (DPM) concentrations through a mine. 

VentSim DESIGN™ Premium provides additional tools to; 

• Dynamically and simultaneously simulate multiple ventilation parameters (contaminant, gas, diesel 
fume, heat and airflow), including the simulation of fire heat and fumes. Models can be programmed 

to self-modify during simulation. This tool is called VentFIRE. 

• Connect and load external data (from mine sensors for example) to display realtime data within a 
VentSim model.  This tool is called LiveView. 

• Ventlog : A separate software program to record and store measured ventilation data from 
underground areas.  VentSim DESIGN™ can link to this data and show it within a 3D model.  This 
tool is called Ventlog. 

VentSim DESIGN™ has been written to make the process of ventilation model analysis as easy to use as 

possible.  Both versions utilise sophisticated 3D graphics, driven by a fully graphical mouse driven 
interface.  VentSim DESIGN™ is compatible with Microsoft Windows XP, VISTA, WINDOWS 7 and 
WINDOWS 8.  The software can also be run on Apple Mac Computers with suitable graphics hardware, 
running Microsoft Windows under dual boot or emulation. 



 

 

VentSim DESIGN™ automatically installs as a 32 bit or 64 bit version.  The 64 bit version has the ability 

to utilise additional computer memory, and therefore much larger models can be used.  Recommend 
maximum model sizes are 30,000 airways for the 32 bit version, and up to 100,000 airways for 64 bit 
versions. Increased amounts of DXF reference data can also to set to be displayed in the 64 bit version. 

2.2. Computer Hardware Requirements 

VentSim relies heavily on 3D graphics hardware to present detailed smooth graphics.  While most 
computers these days have this functionality built in, older computer may not and may struggle to produce 
acceptable performance. 

Even modern computers, particularly laptops may have substandard graphics hardware for displaying 3D 
graphics and performance may not be as good as expected.  The following guide is recommended for 
computers 

Minimum Configuration  

• (AMD or Intel) processor 1 Ghz + 

• Windows XP, Vista or Windows 7 / 8 / 10 

• Memory 2G or RAM, Hard Drive Space 100 Mb 

• Direct X9 compatible graphics (minimum Intel integrated graphics) 

• Two button mouse 

Recommended Configuration 

• i9 Intel processor (or equivalent  AMD)  

• Windows 10 64 bit 

• Memory 32G of Ram. Hard Drive Space 2TB, Resolution 1920 x 1080 

• High-end professional laptop / desktop graphics card based on the consumer GeForce RTX 2070 
(TU106 chip) of with 2,304 shaders and 8 GB GDDR6 VRAM or comparable card 

• Two button mouse with centre scroll / click wheel 

• Note : VentSim DESIGN™ is not supported on Apple Mac computers, however it can run on newer 
Macbooks under Windows dual boot or Parallels™ virtualisation software. 



 

 

3 VENTSIM CLASSIC™ TO VISUAL GUIDE 

                       

VentSim Classic™ was released in 1994 and enjoyed many years as a simple but popular ventilation 
software program to simulate airflows and pressures in mine.  Despite limitations such as incompressible 
flows and lack of heat simulation, many hundreds of mines adopted VentSim Classic for use.  VentSim 

Classic™ was improved to version 3.9, however all development on this program was stopped in 2007, 
after which time VentSim DESIGN™ was developed. 

VentSim DESIGN™ was completely rewritten from the ground up.  It is a substantially different program 

than VentSim Classic 3.9 and takes a new approach to ventilation display and simulation.  This section 
will give you a brief overview of the major changes if you are familiar with VentSim Classic 3.9, and may 
also assist if you are familiar with other ventilation software packages.  In most cases, VentSim Classic™ 
models can be imported directly into VentSim™™. 

Every graphical aspect of the program has a necessary function to help make ventilation models easier 
to understand and reduce the opportunity for error.  The 3D graphics accurately represent the true size, 
shape and location of underground airways.  The colouring represents many different types of data (for 
example temperature or pressure).  The animated arrows show both the speed and direction of airflow.  
By removing or reducing the need to comb through excessive amount of textual data, ventilation models 
can be analysed and validated much faster than traditional means. 

3.1. Display 

Three dimensional (3D) perspectives are rarely used in CAD or Mine Planning 
packages, except occasionally for final presentation purposes.  The perspective 

view tends to distort distances and true directions and is therefore largely 
unsuitable for detailed engineering drawing.  An orthogonal non-perspective view however is not required 
for ventilation modelling, which relies more on effective data presentation. for ventilation modelling, which 
relies more on effective data presentation. 

A 3D perspective view is the way we look at the world and when used to view computer models, it is 
natural and easily understood, particularly to someone unfamiliar with your model.   

Airway solids shown with true dimensions and shapes allow quick appraisal to check whether dimensions 

are as intended.  The author has found numerous examples of VentSim Classic 3.9 models loaded in 
VentSim DESIGN™ that immediately show inadvertent incorrectly sized or shaped airways which may 
prevent the model from simulating or balancing as expected.   
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VentSim DESIGN™ 
default uses a 3D 
perspective view. 

The VentSim DESIGN™ 
Approach: 

To create a user friendly, 
graphically rich program 
and interface, which 
shows the maximum 
amount of relevant data, 
in the most efficient and 
understandable way. 



 

 

A perspective view also permits closer visualisation of specific parts of a model, while other parts are 

hidden or obscured by distance.  In cluttered large models this can help clarify intended data 
significantly. 

3.2. Animation 

They say a picture is worth a thousand words. Animation may therefore be worth a thousand pictures.  
VentSim DESIGN™ animation again demonstrates a key feature of the software’s presentation of 
complex data.  By animating flow arrows, fans and heating/cooling sources, VentSim DESIGN™ can 
show a huge amount of data in a way that the human brain can quickly visualise and interpret.  

Animated flows show the direction and relative speed of all airflows in a mine over potentially thousands 
of airways.  Animated fans show whether they are turned on or off, while dynamic colouring draws the 
user’s attention to specific data ranges.  Using only animation and colouring of data, VentSim DESIGN™ 
users can process and analyse complex models, without having to interpret a single line of textual data.  
In addition, it makes presentation of data very effective to the layperson (who often control budgets and 
have to make decisions regarding investing in costly ventilation infrastructure)  

3.3. Elevation Database (Levels) 

There no longer needs to be a defined surface level elevation.  Any airway can be connected to the 
surface at any place in the mine, by clicking on Connect to Surface in the airway Edit Box VentSim 

DESIGN™ will calculate which end is connected to the surface, based on the free end available.. 

A level database, although still useful, is no longer mandatory for viewing different elevations of a model.  
While an overarching single elevation level covering all elevation ranges is still recommended, any 
elevation range can be viewed at any time by Right Clicking the screen, choosing Select Level select level 
function can be used to quickly limit an elevation range, or multiple ranges, by drawing a box around the 
intended airways., or multiple ranges, by drawing a box around the intended airways. 

3.4. Airways 

Airways no longer need to be connected to another and can be left open ended, as would be the case in 
blind development headings.  Because this may still cause unintentional problems (such as airways not 
joined as the user intends), VentSim DESIGN™ will alert the user to these during simulation.  

These warnings can be turned OFF in the settings menu, or disabled individually by clicking “Closed End” 
in the edit box.  No airflow will travel through closed ended airways, unless connected to surface. 

No Entry / No Exit errors are largely abolished with VentSim™™.  Providing the airways are connected to 
a part of a model where a pressure can be derived, VentSim DESIGN™ will automatically reverse and 
adjust airways into a node. 

3.5. Data 

The single biggest change to VentSim DESIGN™ is the visual management of data types.  Around ninety 
(90) different data types exist in the Advanced version, all of which may be displayed as text on the 
screen, in a spreadsheet or as a colour range.   

Colour and Data Manager 
This creates a rich, but potentially confusing interface.  To simplify things, VentSim DESIGN™ uses both 

a Display Manager Control form to assist in rapid analysing and changing of on screen data and colour.  

This control can be utilised via the view menu, or from the toolbar. 

It is important to note that colours can be displayed independently of the text data which is shown on 
screen (for example pressures can be showed at a colour range, while text data could show air flows.  
Colour ranges can be adjusted in the Display Manager with the slider bars, or by manually entering new 
ranges. 

3.6. Coordinates 

VentSim has switched to a more conventional Eastern / Northing / Elevation coordinate approach.  The 
relative directions on screen of these coordinates can be changed in the Settings menu. 



 

 

VentSim DESIGN™ allows decimal point coordinates to be used allowing more accurate placement of 

airways.  While this will have little effect on ventilation flows, it removes the ‘saw tooth’ effect often seen 
in the VentSim Classic 3.9 integer coordinate display 

3.7. Editing and Information 

Edit Box 
The Edit Box now acts as a powerful editing and information tool for airways in a model.  The Edit Box 
may be left open permanently, and will update with information from the airway clicked on during 
viewing, editing and adding modes.  It will also automatically update after simulation, with the latest 
airway results. 

Information Tab 
To view airway information for example, leave the Edit Box selected on the Information Tab, and airways 
throughout a model can be quickly analysed by clicking on the airway.  Likewise, the Fan Tab could be 

left open, and operating fan curves can be analysed quickly at different point in the model in the same 
way. 

Modifying Data 
To modify data in an airway, simply click on the cell you wish to modify and change the data.  The airway 
will automatically update when Edit Mode is changed, during editing multiple airways will be changed for 
all the selected airways.    

3.8. Referenced Graphics 

VentSim DESIGN™ permits the use of referencing external 3D graphics into the program, such as 
wireframes, surface terrains, orebodies, actual development and mine infrastructure.   

While referenced graphics do not interact directly with ventilation circuits, they provide a useful visual 
and construction aid to developing and presenting models.  Mine ventilation model airways and sizes can 
be directly compared to actual or design development, surface terrains can be used to ensure shafts are 

set to the correct elevation, while orebodies and stope wireframes can be used to ensure ventilation 
circuits are not developed in the wrong area, and have adequate ventilation designs to control airflow. 

3.9. Experiment! 

Finally, by all means experiment with the program.  Load up and view some of the included demos. Most 
features have a Tool Tip attached to them, which will provide further information. Ensure you save your 
model files frequently and create backups where necessary. 

 
Craig Stewart 
Author VentSim™ 
© 2018 VentSim™ Software 



 

 

4 THE VIEW WINDOW 

VentSim DESIGN™ operates in a full three dimensional (3D) graphical environment.  The main VentSim 
DESIGN™ window contains all the functions you will require to create, edit, view and simulate airway 
models.  Note that some of these functions may differ between Premium, Advanced, Standard versions. 

  

Figure 4-1 VentSim DESIGN™ Main Window 

1 Main Menu.  Consists of options required to load, save, view and manipulate the model, as well as 
options to change settings and simulate ventilation models. 
 

2 Action Toolbar.  Consists of many of the construction tools required to build ventilation models.  In 
addition it contains a number of buttons for different types of ventilation simulations, as well as options 
to save or load new model, change stages and alter animation speeds for arrows.  This toolbar can be 

hidden, but not moved to other locations. 

 
3 Data Toolbar.   Allows the text or colours of airways to be changed.  Displays or hides the colour legend 

control. This toolbar can be hidden or moved to the upper or lower part of the screen. 
 
 

4 View Toolbar.  Contains options to show or hide various graphics items such as arrows, text, nodes 

and reference (DXF) graphics.  This toolbar can be hidden or moved to the left or right of the screen. 
 

5 Display Manager.  Contains controls to alter the colour or transparency of airways on the screen.  In 
addition it can also change the display to show different layers, levels (elevations) or air types on 
display. 
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6 Data Position Control: Selects the position along an airway from which data will be displayed as text 

on screen or as colours.  The condition of air will change along an airway (particularly long or deep 
airway segments), therefore this option is available to select which position along an airway segment 
display data is sourced from.  The first and last button displays the conditions of air entering and 
exiting an airway segment.  The middle button displays an average of airway data through the 

segment.  The middle left and right button displays the airflow conditions entering and exiting any icon 
(for example a fan) within the airway.  If an icon is not present, then the middle conditions of an 
airway segment are displayed. 
 

7 Mouse cursor position coordinates in the 3D screen. 
 

8 Simulation status.  Green = successful simulation, Yellow = successful simulation with warnings, Red 

= unsuccessful simulation. 
 
 

9 Main 3D view display window.  Up to seven (7) separate windows can be opened in VentSim.  The first 
four (4) windows can be docked within the main windows structure, while the remaining are ‘undocked’ 
or free floating. 

 
The success on how to utilise some of the unique aspects of a 3D perspective view comes from an 
understanding of how it works.  VentSim DESIGN™ has a number of guides to assist in viewing and 
construction in 3D. 

4.1. Point of Focus 

The view in the main 3D VentSim window is essentially a view seen from a ‘camera’ floating in space, 
aimed at a point of focus.  Your eye is the camera.  The point of focus is always in the centre of the 
screen, at a pre-determined distance away from the camera. 

Moving the point of focus. 
You can move closer or further away from the point of focus with the Mouse Scroll  button, and rotate 
around this point of focus with the Mouse Right  button.  To move the screen to a different location, the 
point of focus needs to be moved.   

There are several ways to move the point of focus; 

• Draw a window with the mouse around the area you wish to focus on.  The focus will move to the 
centre of the window, at the closest distance of an object or airway in the window. 

• Drag (pan) the screen with the Centre mouse button.  The point of focus will move along the current 
horizontal plane with the mouse cursor  An alternative to the centre mouse button is to hold both 
LEFT and RIGHT mouse  button, or hold down the keyboard SPACEBAR. 

• Click on an airway while in the view mode, or when in any other mode with the Mouse Middle button 

(or a Right/Left combination for those without a 3 button mouse).  This will automatically put the 
focus onto the clicked airway at the same viewing distance as was previously set.  If the object being 
clicked is a long way away, this has the effect of quickly flying through space towards that object in 
order to maintain the same view distance as the previous point of focus. 

• The Elevation of the point of focus can also be changed by selecting the ShiftMouse Scroll￼￼ (if  (if 

the grid is turned on) will show the horizontal plane of the point of focus. 

4.2. Multiple Windows 

VentSim 3.0 and above can display multiple graphics windows (up to 8), each with its own independent 

view of the ventilation model.  Every window is fully 3D and is customisable in terms of data display 
including colours, levels, layers, text and graphical items shown. 



 

 

•  

Docked Windows 
By default, VentSim will tile the first four (4) windows within the main VentSim window.  The direction of 

tiling can be changed in the Window Menu bar in VentSim.  These windows are called ‘Docked’ windows 
because they are constrained and sized by the main VentSim window.  Additional windows created after 
the first four will be ‘undocked’ and can be independently sized and located around the computer screen(s). 

Undocked Windows 
A docked window can be ‘undocked’ simply by dragging the window outside of the main VentSim window.   
An undocked window can be ‘re-docked’ by dragging the windows back inside of the main VentSim window 
(providing there are less than four windows present)  To disable the automatic docking behaviour, deselect 
the Auto-Arrange function from the Window Menu Bar. 

The Active Window 
Shared VentSim functions (such as the Camera button or keyboard button inputs) are always directed to 

the currently active window.  The Active Windows is the most previous window clicked or interacted with 

the mouse. 

Drawing between windows. 
It is possible to construct an airway between windows.  While in the DRAW mode, simply start drawing in 
one window (click at least one leg of the airway in the initial screen), then drag the mouse to the new 
window and location. 

  



 

 

 

4.3. User Control Summary 

 

  



 

 

4.4. The Edit Plane 

The Edit Plane is a horizontal plane at a set elevation.  By default, any new airways are initially 
constructed on the edit plane.  The edit plane can be viewed by ensuring the grid function is turned on.  
The plane will be crossed with grid coordinate lines.  If Shift is selected the edit plane will be made semi-
transparent which will indicate where it intersects existing airways. 

 

Figure 4-2  The Edit Plane, shown with the SHIFT key pressed 

To move an edit plane, select a new point of focus by centering on an airway, or use the Shift-Mouse-
Scrollcombination to move the edit plane elevation.  The coordinates in the status bar at the Bottom Left 
corner will always show the elevation of the edit plane.edit plane. 

Hint :  The Edit Plane will also temporarily move automatically to the level of an airway being drawn from another airway.  
Additionally, the edit plane and point of focus can be moved manually by the Set Edit Plane function in the View menu. 

 

Figure 4-3  True Vertical Line showing top and bottom airways lining up 

 



 

 

 

Figure 4-4 True Vertical Guide Line helps guide a shaft vertically into the airway below 

4.5. Drawing in the Third Dimension 

Drawing in three dimensions can be a challenge as the view is being displayed on a two dimensional 
screen monitor.  VentSim DESIGN™ alleviates this problem by only drawing on the horizontal plane 
except when the shift key is pressed, or the screen is orientated to a vertical cross section orientation. 

The True Vertical Guide 
3D perspective views do not necessarily show a vertical object as pointing straight up.  As objects move 

further left and right of the point of focus, they ‘lean’ over away from the centre of the view.  To assist 
the user as to which direction is truly up while creating or editing airways, a true vertical line is displayed 
while drawing, moving or copying.  If the object being drawn aligns with the true vertical line, then it is 
vertical.  The true vertical line can also assist in locating airways directly under or over other airways at 
different elevations by observing where the line ‘intersects’ airways above and below the current point 
being edited. 

Drawing Airways 
To simplify construction of airways, initially all drawing, moving and copying of airways defaults to the 
horizontal Edit Plane, regardless of the orientation of the view screen. To assist the user further, airways 

being drawn or moved will automatically ‘click’ and join to airways under the mouse cursor, even if at 
different elevations or distances away.  

Hint:  To quickly change the view from horizontal plan view to vertical section view, press the F2 button 

If airways are drawn in isolation (not connected to other airways), they will use the default airway 
settings specified in the Settings form.  If airways are drawn connected from another airway, they will 
inherit the settings from the airway from which they are drawn.  Airways can be drawn from another 
airway end (node) or from any other point along an airway.  VentSim DESIGN™ will create a new node 

(or junction) if none already exists. 

Hint:  VentSim DESIGN™ can detect whether an airway being constructed crosses the paths of other airways.  For example, if a long 
airway is drawn from one point to another, over which it crosses the paths of existing airways, VentSim DESIGN™ will join this airway 
into the crossed airways with new nodes.  This will only happen in the drawing mode.  If airways are imported (from a DXF for 
example), crossed airway junctions will not automatically be detected). 

To draw in the third dimension (up or down in elevation) where there is not an airway above or below to 
click to, first draw the airway to the desired horizontal (plan) location, then press the Shift key.  The Edit 
Plane will turn semi-transparent, and further movements of the mouse will occur in a Vertical plane 
parallel to the computer screen. The Edit Plane will follow the vertical movement, assisting in showing 
where the cursor is in relation to other airway elevations.  In addition, the numbers in the lower left 
status bar will show the elevation and coordinates of the point. 



 

 

 

Figure 4-5  Picture showing inclined airway being drawn down 
 to the elevation of the level below 

Manual Coordinate Entry 
Airways can be manually added, moved or copied by selecting a manual coordinate entry system.  To 

activate this system while in draw mode, click on an airway end or somewhere in empty space.  To 
activate this system every time an airway is drawn (to allow manual adjustment or entry of airway ends) 
select the pull down arrow on the ADD button and choose the ‘Coordinates’ sub-options from the button.   

To activate the system, when moving or copying, simply click an existing airway end while in the Move 
or Copy mode.  A coordinate window will show and the coordinates (or offsets) of the airway can be 
entered. 

The coordinate entry allow airways ends to be adjusted manually, or by using a vector polar coordinate 

or a physical offset of the easting’s, northings and elevation.  End coordinate values are adjusted in real 
time as offsets or polar coordinates are adjusted.  To apply the change, simply click OK when completed. 

 

Figure 4-6 Coordinate entry system 

Moving Airways 



 

 

Depending on where the airway is clicked with the mouse in Move mode, either end, or the entire airway 

may be moved.  If the ends (nodes) of the airway are connected to other airways, they will be stretched 
to accommodate.   An airway can be ‘broken’ away from a node by selecting it a small distance back from 
the node, and ‘dragging’ it away with the mouse. Multiple airways can be copied or moved by Selecting 
the airways (with the Select button, or by drawing a Fence around the airways while in Move or Copy 

mode), and then dragging the selected airways or clicking one with the mouse coordinates. 

 

Examples of Moving Airways 

 

 

• Upper left : Airways are selected and then moved simultaneously 

• Upper right : Airway junction is moved with all attached airways 

• Lower left : Airway is ‘broken away from node and pulled away with mouse 

• Lower right : Airway junction is moved vertically by pressing shift while using mouse.  

 
 

ORIGINAL 



 

 

 

Moving / Copying Icons 
Icon placement is not normally critical, however for fans or heat sources it can have some effect due to 
changes in air density and pressure along an airway.  The simulation will calculate the parameters and 
effects of an icon as the specific point it is located in the airway.  To move an icon within an airway, simply 

choose the Move mode, and select and drag the icon along the airway with the LEFT mouse button.  To 
move or copy an icon to another airway, simply drag the icon to the new location.  Note that an icon can 
only be copied or moved to an airway with no existing equivalent icon. 

Hint: Icon location can cause significant changes to fan performance on very long airways with elevation changes.  For example, a 
fan place at the top of a 1000m deep shaft will perform very differently to a fan place at the bottom of the shaft due to different 
density and pressure variations at each location.  VentSim DESIGN™ Advanced will calculate the variations and simulate the fan at 
the location at which the icon is placed.  Ensure the icon is correctly located along the airway, or use a very short airway segment 
(for example a short extension at the top of a shaft) to locate the icon where it is required to be simulated. 

Copying Airways 
Airways can be copied, much in the same way as the Move function.  An airway can be ‘grabbed’ with 
the mouse and ‘dropped’ in a new location, or the airway can be clicked and manually copied with new 

coordinates.  In addition, a group of airways can be selected with the Select button, or by drawing a 
fence around the airways, and then clicking or dragging one of the selected airways. 

 

Figure 4-7  Example of copying a selected group of airways 

  



 

 

5 THE MENU BAR 

The main menu bar accesses a host of functions including simulation options and settings, and viewing 
options and settings.  Many of the main menu bar function are duplicated in the toolbar buttons. 

 

5.1. File Menu 

• Open - Loads a pre-saved model.   

You can also open VentSim DESIGN™ files by dragging file icons from your Windows folders onto the 
VentSim DESIGN™ screen. 

VentSim can open a number of different formats, including VentSim™, VentSim Classic, and provides 
limited functionality to load VNET-PC files. 

VentSim Classic files are slightly different in structure.  While good compatibility should be retained when 
loading these files, it is always important to check and validate the model to ensure no significant changes 
have occurred during the transition from VentSim Classic to VentSim™. 

 

VentSim can directly import VnetPC VDB files and construct a workable 

Ventilation model from the file, however full compatibility is not guaranteed.  
VentSim attempts to import all airway data, fan curves and environment data, 
however because of some fundamental differences in files formats and data 
used, there may be difference in simulation.   

To maintain maximum compatibility, the resistance of all airways is fixed to the 
same value as the VnetPC file, however if the file has correct airway dimensions, 

the user is encouraged to remove this fixed value and utilise the AUTO 
resistance in VentSim to calculate airway resistance from size and friction factor.  
To do this, select the airway or airways, then choose the EDIT button, and 
change the CUSTOM resistance to AUTO.  Ensure the airway size and friction 
factors are correctly set for each airway. 

Warning.  Full VnetPC compatibility is not guaranteed and every file should be thoroughly checked for accuracy and consistency after 
import.  VnetPC files are missing much of the information VentSim normally used to simulate models, and assumptions are sometimes 
made which may not be correct.   

 

When loading VentSim Classic or VnetPC models, a simple validation check can 
be done by comparing the model Summary before and after a simulation.  For 
example, immediately after loading the model, select RUN > SUMMARY from 
the main menu, record the airflows and other data, then SIMULATE the model 
and compare the new SUMMARY results.  If the results are very similar it is 

likely that there are no significant compatibility issues. 

Chapter 
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VnetPC Files 

Validating Imported Models 



 

 

• Merge - Joins two models together instead of erasing the currently loaded model. 

Similar to the Open command, this may be useful for joining separate modeled areas of the same mine.  
Caution should be taken however, as duplicate branches are not immediately checked when the models 
are merged (duplicate branches will be subsequently be deleted if an attempt is made to simulate the 
model). 

• Save - Saves changes made to the ventilation model.   

If the VentSim title bar shows that the model is untitled, the user will be prompted to select a name 
before the file can be saved.  

• Save As - Saves the model, but gives the option of saving under a different name.  

VentSim can be saved in one of two formats.  The default format in the VSM file which is the standard 
file format.  This format is highly compressed and cannot be read by other programs. 

VentSim DESIGN™ files can also be saved as a Text format.  This format follows the standard TAB 

separated values format and can be loaded by programs such as Microsoft EXCEL, WORD or ACCESS.  
The internal contents of the file can be viewed, modified and resaved as a Text  file.  The Text  file can be 
reloaded into VentSim DESIGN™ providing the basic structure and the HEADER and FOOTER tabs remain 
the same.  

• Master Link 

Enables a common settings file (Master File) to be linked and shared with multiple VentSim DESIGN™ 

files.  Master Files replace the Template function used in Version 1 of VentSim™. 

Master Files store a user definable selection of shared settings (for example resistance and friction factor 
preset values or fans).  When a VentSim file is linked to a Master File, and the file is saved, the settings 
are also saved to the Master File and will be available to all other VentSim DESIGN™ files which have a 
link to the Master File.  The settings in linked VentSim DESIGN™ files are updated from the Master File 
when loaded.  If the Master File is not available, then a warning will show and the most previously saved 

settings will the used. 

Warning : Using linked Master Files can be dangerous if settings made in one file adversely affect another linked file.  For example if a 
fan is removed or replaced with another fan, and the file saved, then all other linked VentSim DESIGN™ files which used to use this 
fan may no longer work correctly.  If a linked Master File is used, it is normally better to add new settings, not remove or delete existing 
settings which may be used by other files. 



 

 

Create New : Creates a new Master file template, which can then be 

linked to other VentSim DESIGN™ files.  When creating the file, it is 
automatically linked to the current file.  Other VentSim DESIGN™ 
files can be linked to this same Master File by opening the files and 
using the Link option below.   

Hint : When creating a new file, there is an option to specify what common settings you 
would like to make in the master file.  For example if only the fan database, and the 
common resistance, friction and shock factors are to be used, then click on the Fan 
Database, and Preset options in the dialog box. 

 
Save the Master File in an accessible file location. A descriptor can be 

saved with the file to explain information about what components 
have been saved.   

Link : Opens a dialog form to search and link to a Master File.  If the 
current VentSim file has an existing linked Master file, the new Link 

will replace the data in the VentSim file.  An alternative method to 
link a file is to simply drag and drop a Master File into the current 
VentSim DESIGN™ window. 

Unlink : Breaks a link to the Master file (but does not change the 
Master File).  Any changes to file settings made after the link is 
removed will no longer update the Master File.   

Update : Refreshes the current VentSim file with the data in the Master File.  This may be necessary if 
another file has modified the data in the Master File after the VentSim file has been opened.  It is 
normally not recommended to have multiple files open accessing the same Master File as only the most 

recently saved VentSim File will have updated the master settings.  If another file has updated the 
Master File while the current file is open, then a WARNING will display indicating a possible conflict. 

CAUTION – When selecting ‘REPLACE’ many components such as fan databases, levels and most presets may not correctly map to the 
existing model’s fans, levels and presets, particularly if (for example) fans within the database are in a different order.  These may need 
to be manually corrected by checking and re-editing fan airways to ensure the correct fans have been placed. 

• Defaults - The start up settings for VentSim™. 

The defaults file is stored in the user’s personal Windows directory.  The file is loaded when VentSim 
DESIGN™ starts and specifies the settings, behaviour and fans when the program is first loaded.  Each 

user who logs on to the computer will have a different default file which is initially created when the 
program is installed. 

VentSim DESIGN™ files have a copy of defaults stored within the file which may have been modified 
after the model file was started.  This will override the standard start up defaults when the file is loaded. 

Reload Startup - Reloads the original defaults file that is first loaded when VentSim is initiated.   

This may be required if the default settings that are automatically loaded with a VentSim simulation file 

are incorrect or out of date, or you wish to overwrite the current file settings.   

CAUTION – This will reset all file parameters such as fan databases and graphics options.  If you wish to only update selected 
components, use the inherit function to load selected components from an existing file. 

Save Defaults - Saves the settings currently loaded in memory to the defaults file.  These will be loaded 

automatically next time the program is run. 

Restore Defaults - Restores the defaults file to the original file created when the VentSim DESIGN™ 
program was installed.  

Figure 5-1  Master File Options 



 

 

Inherit -  Adopts selected attributes from another model. 

VentSim DESIGN™ files contain many different 
components such as fan databases, file and simulation 
settings, level and layer database and many other 
options.  Instead of setting up new parameters for a 

model, these components can be loaded from an 
existing file without deleting the airway data in the 
current file.  

Hint : Fans from other VentSim DESIGN™ files can be used in your 
existing files by inheriting and ‘combining’ the fan databases.  The 
simulation file fans inherited will only be added if no existing fans exist 
with the same name.  The ‘merge’ option will ensure all the current 
model fans will be preserved, and new fans made available for 
selection.  The fan list can be edited from the fan database, or from the 
Presets spreadsheet. 

Once a suitable file is selected, an option panel is 
displayed to allow the user to select various components they wish to inherit from the saved file.  Once 
loaded, these components will become part of the existing file.  An option is provided to merged with 
existing presets (for example, the friction factors may be added to a list of currently used friction 
factors), or they can simply completely replace existing presets. 

• Icons and Backgrounds 

Offers tools to assist with applying custom pictures to fans, 

resistance or heat preset items in VentSim.  In fact, icon 
pictures can be applied to any airway, even if no existing icons 
exist.  In addition, the background can be replaced with a 
custom picture or logo that statically remains on screens at all 
times (for company logos, consultant logos etc). 

Custom icons allow individual fans, heat sources or resistances 

to have pictures of (for example) real installations placed over 
the default icons in the model. 

To place a new icon picture in a model, simply ‘drag and drop’ a 
picture file from any Windows folder, onto the icon or airway in your VentSim DESIGN™ model to be 
changed.  The default icon will automatically change to the new picture.  If a picture is dragged onto an 
icon, or similar icons of the same preset type will also be changed.  If a picture is dragged onto a blank 
airway, then a note description will be made that applies the picture to all airways with the same note 

description. 

To place a picture or logo in the background, simply drag and drop a picture into the VentSim 
background.  An options to shade the picture with the existing background blend, or place the picture in 
the original format can be selected. 

Other tools that may be of use in managing custom icons and backgrounds include: 

Export: VentSim stores compressed copies of any icon pictures in the model onto a hard drive location 
that can be accessed from a Windows folder. 

View: Shows the Windows folder with currently stored VentSim Icon Pictures. 

Refresh: Updates the VentSim display with any changed icons in the model.  This should normally not be 
required. 

Clear Icons: Removes any icon pictures from the VentSim file.  The pictures are still available in the 
Windows folder if they are required again. 



 

 

Clear Background: Clears the background pictures to the standard shading setup. 

• File Tools 

A series of tools to assist with securing, comparing or linking pictures to VentSim files.  The tools are 
described below. 

• Compare  : Compares the current loaded file with a saved file.  Any obvious changes to airways such 

as moving, deletion, new attributes, presets or sizes will be highlight on screen and in the error list 
box. 

HINT :  This function may be useful where there may be multiple similar versions of the same file, and it is unknown what changes 
may have been made between versions. 

• Security  : Sets the file security with a password to prevent unauthorised changes or access.  In 

addition, a password protected file cannot be merged with another.  To activate security for a file, 
simply select this option, enter a password and click what security option you wish to apply. 

Figure 5-2  File Security Options 

When a security enabled file is loaded a dialog form will request a password.  If the password is not 
entered or is incorrect, only the restricted security access option will be available. 

 

CAUTION – Passwords are case sensitive.  Ensure you can recall the password.  A lost password means the file will not be able to be 
opened or changed in the future. 

• Save Picture 

Saves the current screen to a file location as an image file.  

This file can be later loaded into documents or presentations from other software packages. 

• Import 

Imports external data into VentSim DESIGN™ to build model model. 

•  

• View Only – Allows the model to be loaded and viewed, but 
not changed in any way or re-saved. 

• Read Only – Allows the model to be loaded and modified, 
but not resaved or copied to a new model. 

• Lock File – Prevents the file from being opened or viewed. 

•  



 

 

VentSim can import data from TXT (text) files, DXF (drawing exchange format Autocad) files, DWG 

(Autocad native format), STR (Surpac string files), DM (Datamine Files – String or Wireframe Solid) and 
VDP (VnetPCTM files). 

 

Imports model data from TXT format  This format is widely available through 

most spreadsheets and can be read into word processors.  The standard format 
for a TXT file can be saved from VentSim DESIGN™ under the save as 
command.  Most components (such as fan database and colour settings) can be 
excluded from a TXT file, leaving only the main file component if desired.   file, 
leaving only the main file component if desired.   

A VentSim text file must have at least the first row header line, which defines the text file as VentSim 
compatible and a Completion line ‘END’ (the last line in a VentSim DESIGN™ saved TXT file). 

Load any VentSim file saved as a TXT file to view the structure in a compatible editor (for example 

Microsoft Excel™) 

 

Figure 5-3  An example of a VentSim DESIGN™ Text File Loaded into Microsoft Excel 

Imports DXF , Autocad DWG, Microstation DGN , Datamine and Surpac  
formatted data (supported by many CAD and Mine Planning packages).   

Importing graphics items can serve two functions.  Importing line string graphics can allow VentSim 
DESIGN™ to directly create new airways, using the line strings as centre lines for the development.  The 
centrelines can be converted to airways during the import function, or later on by selectively clicking or 
fencing the centrelines with the Add > Convert  function.  Further utilities under the tools menu allows 
users to quickly turn the new airways into viable models. 

Formats DXF, DWG and DGN also allow text to be imported and displayed in VentSim. 

HINT : Converting all imported centrelines to airways can be a problem if some model airways already exist and may be duplicated 
by this function.  Instead, loading centrelines as a reference graphic without converting to airways can allow the user to check where 
extensions or changes to a mine model may be, particular if some of the centrelines may overlap existing airways.  The reference 
lines will extend from existing ventilation airways showing where extensions to the mine ventilation model may be required.  The 
referenced centreline can then be selectively clicked or fenced to convert to airways using the Add >Convert function. 

A second option allows importing DWG, DGN or DXF files as ‘references’, which places the graphics 
within the model, but does not affect or interact with the model airways.  Examples may include mine 
surface terrain, orebodies, actual development solids etc. This option allows the reference graphics to be 
used as a guide to building new airways, or simply enhances the display with more information about the 
mine environment.  Any solids or wireframes that are present in the DXF will automatically be imported 

Text Files 

Import (DXF / DWG / DM 
/ STR / DGN) 



 

 

as a ‘reference’ graphic, as VentSim DESIGN™ cannot build new airways from graphical solids (only 

centrelines) 

 

Figure 5-4 Import Option form showing DXF import options. 

Import reference files can be merged with an existing model (for example a mine addition), and new 
airways built with DXF centre lines can be set with default attributes (airway sizes etc) before importing.  
Attributes can easily be changed later within the program. 

HINT : File imports support drag’n’drop.  Simple grab the file from a windows folder or directory and drop it on the VentSim 
DESIGN™ screen.  More than one file can be imported at a time by using the SHIFT or CTRL key to select and load the files. 

 

VentSim DESIGN™ will search a DXF file for both line strings and solids, as well as layers within the DXF 
file.  The import options indicate what action to take if these items are found. 

Layers 

The right hand column lists available layers in the DXF file which may be imported.  Only select the layers 
required to be imported into VentSim. 

Centrelines 

Centrelines (lines or polylines) can be either converted to ventilation airways, which will carry airflow within 
a ventilation model, or simply as a reference graphical line string, which will not affect a mine ventilation 

model, but which can be used to help guide and place manually constructed airways. 

Disabling this function will tell the program to ignore any line strings found. 

Adds the new imported data to the current model  

Imports text strings included in DXF, DWG and DGN files. 

Tells the program NOT to build airways out of centrelines, but simply import 
as a graphical reference.  A centreline can be converted later to an airway 
using the Add > Convert function. 

Import Options 

Import Centrelines 

Merge Data 

Import Text Strings 

Import as reference only 



 

 

Surfaces or 3D solids cannot be directly converted into airways (unless a 

‘convert all’ option is attempted), however 3D data can provide a useful 
reference to manually developing VentSim Airways.  In addition, it can 

provide an important visual aid to viewing ventilation models within an actual 
mine environment. 

Disabling this function tells the program to ignore and not load any solid 
graphical data found in the reference file. 

Disabling this function ignores importing of hatched graphics which can 
consume excessive amounts of computer memory.  It is recommend to turn 
this function off where possible to conserve memory and improve display 

speed. 

Adds the imported data to any existing referenced solid graphical information 

already within the model 

Adds the imported data as a wireframe line solids, instead of a polygon solid.  

Most imported files do not have an internal specification of whether the units 
are Imperial or Metric.  VentSim will assume the coordinates are the same as 
currently used in the VentSim file, however if the coordinates system are 

mismatched, then the imported data will be displaced to incorrect coordinates 

(for example a metric DXF imported into an imperial VentSim model).  This 
setting allows you to override the default VentSim setting to ensure coordinates 
will match up. 

Allows a DXF file to be imported with an offset from the original file 
coordinates.  This may be useful to match existing coordinates used in 
VentSim, or when a 2D file single elevation file needs to be moved to a new 

elevation in VentSim. 

Flattens the entire DXF file on to a single elevation or level.  Occasionally, flat 

2D CAD files may have different elevations set in the file.  When these files 
are used in a 2D CAD package, the elevations difference may not be noticed, 

however when loaded into VentSim, the elevation differences may become 
troublesome in a 3D working environment.  If the OFFSET Z option is entered, 
then the imported elevation will be at this number when this option is set.  

Allows the DXF import data to be scaled to a different size.  This is 

sometimes usefull if the original DXF data has been scanned or converted 
from a PDF file at an arbitrary scale and no longer matches the true scale. 

Rotates the DXF data around a zero based origin by a specified number of 
degrees. 

Allows the user to select the colour of the reference data to import. 

Colours the imported graphics to the original colour (if selected), or the user 

selected colour (if not selected) 

Imports the reference graphics into VentSim with each layer as a different 
reference name, instead of a single reference name encompassing all layers.  
The reference names can then be individually managed in the Reference 

Manager function under the File menu. 

Imported splines (smooth curves) can have hundreds of data points to make 
smooth curved lines.  This can consume excessive memory in VentSim.  

Select this function to reduce the imported data requirements, and 
approximate the curves with a series of straight lines. 

Surfaces (referenced) 

Import Solids 

Import Hatching 

Merge References 
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Default Colour 

Use DXF Colours 

Split Layer Names 

Filter Splines 



 

 

Simplifies curved solid shapes.  Curved shapes can consume a lot of 

graphical memory and reduce display speeds.  Higher numbers simplify 
graphics further. A higher number will simplify display and reduced memory 

requirements. 

Simplifies triangles imports and join them together where possible.  Excess 

triangles consume a lot of graphical memory and reduce display speeds.  A 
higher number will simplify display and reduced memory requirements. 

• Import STR (Surpac Strings) 

Similar to DXF functionality, VentSim will attempt to import line strings and offer to directly convert to 
airways, or import them as a reference for later use. 

• Import DM (Datamine Strings and Wireframe Solids) 

Similar to DXF functionality, VentSim will attempt to import line strings and wireframe solids from 

Datamine compatible files. 

• Export DXF/DWG 

  

 

Provides a utility to export VentSim centrelines, text and solid 
graphics to a DXF, DWG or DGN file for importing into other CAD 
software.  The colours and text exported will be set to the current 

screen colours and text.  Different items can be selected for 
exporting.  They will be placed on different DXF layers so they can 
be turned on or off independently in the CAD program. 

 

Note that any airway ventilation attributes will be lost during the export process, and DXF files cannot be 
re-imported back in to VentSim as ventilation models.  A variety of formats are available to save.  Older 
formats are normally recommended to improve compatibility and reduce file size. 

  

Curve Segments 

Triangle Tessellation 

Figure 5-5  Export to DXF Options 



 

 

• Manage References 

Provides a utility to separately manage any imported graphics reference.  Each 
imported object can be separately coloured, made transparent or hidden from 
the main view through the form options.  

Select one or more graphics objects from the list with the mouse (hold the 

shift key down to select multiple items).  A check box activated against the 
name indicates it is currently being shown.  A clear check box indicates it is 
currently hidden.  

RIGHT CLICK the mouse to view additional options; 

Changes the colour of the items.  The second 
colour shows the transparency effect on the 
colour.  Clicking the multi-coloured box will 

colour the reference graphics object with a full 

spectrum of colours based on elevation. 

Changes the transparency of the item. 

Hides the object from the screen view 

Shows the object in the screen view 

Joins together two or more selected files from 

the reference graphic list. 

Removes the reference object from the file 

Search all reference graphics for duplicate 
graphics and removes any duplicates to 
reduce memory requirements.  This 

function does not remove duplicates on different reference layers.  

Clears textures (pictures) that may have be dropped over a reference 

graphics surface. 

Shows the current internal VentSim memory reserved for storing reference 
graphics.  If this approaches 100%, consider removing some reference 
graphics objects, or alternatively if the computer has sufficient memory 

increase the Reference Graphics memory from the Settings >Settings menu.  

• Title Note 

Allows the user to specify a unique file comment which appears in the top title bar.   

This comment can help identify the date, name and purpose of the model. 

• File Memo 

Allows users to write an extensive descriptor regarding the function or description of the current model.  

This is saved with the file for future reference. 

• Page Setup / Print / Print Preview 

Prints a graphic picture of the model in the View Window to an installed printer.  

Only printers with Windows supported graphics capabilities will be capable of printing the model.  As 
VentSim DESIGN™ uses a perspective view, no particular scale is applied to the image.  The image is 
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Delete 

Duplicates 

Clear Textures 

Memory 

Figure 5-6 Reference Graphics Manager 



 

 

sized to the maximum size of the page and orientation.  To reduce colour output, the VentSim screen 

colours can be changed under the Settings > Settings > Graphics > Colours menu.  For detailed 
engineering accuracy output, it is recommended to export the model to a DXF file for loading into a 
suitable CAD program for later output to a printer. 

• Previous File Listing 

Quickly loads files recently loaded or saved. 

• Load Demonstration 

Loads a generic model of a typical mine.   

This is for demonstration purposes only, and contains a number of simple mine examples to view.  Note 
that while these items can be modified, they cannot be resaved in the same folder. 

• License Manager 

Opens the License Manager form.   

The license manager is a multi-type license activation and release tools.  VentSim licenses are created with specific 
options when purchase and may include 

1. Single or Multi User mode 

2. Single computer or transferrable between computer options 

3. Automatic release, manual release and limited borrow time options 

4. Internet activate or USB activated options 

5. Local Network License Server or Internet License Server options. 

More information about the License Server is available in the License Manager Chapter. 

• Exit 

This command closes VentSim. VentSim will prompt if your model file, fan database or defaults have not 
been saved since last modified.Edit Menu 

• Undo 

Reverses the previous action 

Undo is a fully functional undo facility that will undo a number of previous changes made to a model (up 
to the buffer size of the undo function).  Note that while it will not directly undo a simulation, by pressing 
UNDO until your previously model is in place and then re-simulating, this will produce the same results. 

• Redo 

Redo will reverse the result of the undo function. 

• Copy and Paste Airways 

Copy airways from one VentSim DESIGN™ program to another. 

Copy and Paste Airways creates an exact replica of selected existing airways in a model and pastes them 
into the same location into the existing or new model.  The function is primarily designed to copy and 
paste airways between VentSim files or between different Stages in a mine ventilation design; for 
example to update airways from a model that has been modified. 



 

 

To use this function to copy and paste between models, ideally have two copies of VentSim DESIGN™ 

open with different model files.   Select the Copy Airways menu item, and click on, or fence the airways 
you wish to copy. 

To paste the airways, move to the new model (or load it up) and select the Paste Airways TRUE  menu 
item.  The copied airways will be pasted into the new model at the same coordinates as the original 

airways. 

To paste duplicate airways between STAGES, use the same technique, but simply copy the airways in 
one stage, switch to the desired stage name or number, then Paste Airways TRUE.  A copy of the 
airways will be set in the new stage. 

If airways become duplicated in the process, VentSim DESIGN™ will delete one of the duplicate copies. 

To paste airways in a different location, use the Paste Airways LOCAL menu option.  This will paste the 
airways around the current local screen location set in the view window, effectively copying the airways 

from the original location to a new location. 

Clone and Apply Attributes 
Clones selected attributes from one airway and applies the attributes to another. 

Attributes are physical airway parameters such as size, resistances, friction factors and shock losses, as 
well as identifying other settings such as layers.  You can decide which attributes to apply to an existing 
airway by selecting the Clone Options function from the menu or Select Manager Form from the toolbar. 

To clone attributes, select the Clone Attribute menu item, and click on an existing airway.  The airway 
properties will be copied to memory and the program will automatically enter the Apply Attribute mode. 

To apply attributes, make sure you are in the Apply Attribute mode if it has not already been selected 
and either click on an existing airway, OR fence a selection of airways to apply the attributes to that 
group.  Cloned Attributes can be applied at anytime (even after other editing has been done) and will 
apply the most recently cloned values. 

 

Example : An existing airway has been set to 
copy size, friction factor and resistance 
attributes.  To copy these attributes on to other 
airways, 

• Select then clone options 

• Ensure the Apply Attributes options is 
chosen 

• Select Edit >  Copy Attributes 

• Click the airway you wish to copy the 
attributes from. 

• Select Edit > Paste Attributes 

• Click or Fence the airways you wish to 

copy the attributes to. 

 

Figure 5-7  Clone Attributes 



 

 

New Airways 
Control which attributes are applied to new airways.   

New airways drawn from existing airways will inherit the settings from the 
airways they are attached to (such as size, shape, friction factors etc).  
Airways which do not originate from another airway will use the default 

setting values. 

To force the program to use the Default Values (from the Settings Menu), 
choose Default.  All new airways drawn (regardless of whether they connect 
from existing airways) will use the default settings. 

Forces the program to use the Cloned Settings from a previously cloned 
airway.  For example if a shaft is to be drawn from a horizontal airway, 

cloning a similar shaft and then drawing the new airway with this function 
set, will result in a new shaft with the same size, parameters and layer settings 
as the cloned shaft. 

Find Text & Select  
 

Automatically locates specific airways and moves the screen to selected parts of a model.   

 

Figure 5-8  Find Airway Data 

Selecting one of the options will find and highlight the airway searched for. The option may be repeated 

for further branches by pressing the Next,.   

HINT – Pressing <F3> will rapidly allow you to search through a model, by repeatedly jumping to the next item.  

Select All 
Highlights or select all airways matching the previous find criteria.  To find All instances of an airway (for 
example to find all airways with the name ‘shaft’ in the airway name, or to find all fans, click on an initial 
find type and then click on Select All.  All items with these parameters will Highlight and Flash. 

5.2. View Menu 

Fit All 
Fits all the display data into the view window.  

Use Inherited 

Use Defaults 

Use Cloned 



 

 

CAUTION : If display data is from two regions a long way apart (for example data may have been imported into VentSim DESIGN™ 
from a different coordinate system).  The Fit All may not be able to accommodate the range of data attempted to be shown, or the 
camera may be too far away to view the data effectively.  Ensure all data is in the same coordinate region before it is loaded or merged. 

Show All 
Resets all hidden levels, layers and airway data and displays the entire model.  Occasionally a model may 
have hidden or semi-transparent airways set from a previous action.  Show all will quickly bring the entire 
model back to full view.  Show All will force VentSim DESIGN™ to show all elevations of airway data in 
your model, even if they are outside of the ranges specified in the Level Database.   

Reset Display 
Resets the graphics display adaptor and re-establishes the graphics on the screen.  Some types of 

hardware graphics display adaptors may occasionally corrupt or fail to show the screen graphics, 
particularly if the computer has been brought out of hibernation, sleep or screen saver.  This option in 
most cases should recover the graphics. 

Quick View 
Quick Views can quickly be saved and recalled sequentially outside of the normal Saved View system.  
Quick views are not added to the Save View menu selection. The views can be quickly recalled at any 
time using the arrow keys.  The function primarily assists with navigation of large models, where 
different areas can be quickly returned to for viewing simulation results. 

Creates a temporary view position for a model.  The view is added 

sequentially to previous stored Quick Views.  The sequence of stored quick 
view can be recalled or returned to using the LEFT and RIGHT arrow keys. 

Clears and removed the currently recalled quick view.  The view is removed 
from the sequence of other stored Quick Views, and can no longer be 
recalled. 

Clears all Quick Views from memory.  

Recall the previous Quick View from the sequence of saved Quick Views. 

Recalls the next Quick View in the sequence of saved Quick Views.  
 

Flight Path 
Stores a flight path activated during the FLIGHT mode.  Flight paths can be played back after completion, 
or they can be stored for later playback from the SAVED VIEW menu. 

Copy to clipboard 
 

Copies the screen to the Windows clipboard for direct pasting into an external documents (such as a Power Point 
presentation).  Static Views are primarily for referencing areas before and after simulation.   

Copy to clipboard (all) 
 

Similar to above, but copies any overlying windows (such as legends and graphs).  

Copy to clipboard HI-RES 
Similar to above, but copies an ultra-high resolution picture to the clipboard.  This picture has more detail 
than the screen graphics, but may fail to work on slower or older computers.  Hi-Res pictures will show 
more clearly in large format printing or reports, but are of less use in screen or projector presentations 
where the screen cannot show the higher resolutions. 

Snapshot 
Creates a picture copy of the current window in a new form window.  Static Views are primarily for 

referencing areas before and after simulation.  It may be useful in showing a sequence of changing 
ventilation simulation results by storing previous results for comparison with new results. 

Save Quick View 

Clear Current 

Clear ALL 

Previous Quick View 

Next Quick View 



 

 

The form window defaults to 25% of the size of the normal view window, but can be resized or maximised 

at any time to show full detail.  The static view forms can be renamed for reference or saved to a picture 
JPG file for future use in other software.  

Static views are simply picture copies of the original model graphics and remain the same regardless what 
happens to a model after the static view is created.  They cannot be edited, moved or rotated.   The 

number of static views created is only limited by the memory capacity of the computer. 

HINT : Both the EDIT box and the FAN DATABASE form can also be reproduced as a STATIC view.  This is useful to provide a quick 
comparison between airways or model results before and after simulation changes.  To use this function, simply RIGHT click the EDIT 
box or FAN form, and select Static View 

Set Edit Centre 
Sets the edit grid and point of focus to a specified coordinate or elevation. 

New airways will be drawn on the specified elevation  

Show All Elevations 
Shows all elevation ranges for the model. 

Turns on all level elevations views, and includes airways and references outside of the defined elevation 
ranges.  

Show All Layers 
Shows all layers (primary and secondary) in the model. 

Turns on all layers so all airways graphics will be visible. 

Hide Zero Flow 
Hides airways with no flow.  This function is useful for hiding disused or unventilated parts of a mine so 
they do not clutter the display.  Airways with no flow (or airflow below the level set as zero flow value in 
the Settings menu) will be shown as transparent or hidden, depending on the transparency settings 
described above, and the transparency amount set in the Display Manager. 

Hide Excluded 
Hides airways which have been set as EXCLUDED from the model.  This function is useful for hiding parts 
of a mine which are not required to be simulated, or are not set to be part of the current simulation 
model.  The exclude options for airways are available from the EDIT box. 

Hint: Old sealed off development, or future development yet to be mined can be excluded from the model to speed up simulation 
and display of models.  Excluded airway can be hidden to simplify the display, but can be shown and converted back to normal 
airways at any time if required. 

5.3. Saved View Menu 

Save View 
Saves the current view and stores the save name in menu for future recall.  Save view will save all 
attributes in a view including RL levels, layers and display options.  Saved views can be pulled back into 

any current window by selecting the saved name from the pull down view list. 

Delete View 
Deletes the saved view stored in the CURRENT pull down menu list (and hence removes this name from 
the list). 

Saved Views 
 

Four view orientations are set as defaults -  

PLAN EW SECTION NS SECTION ISO 



 

 

 

These standard views will display the model at various orientations (although the model can still be 
orientated to the same orientations by using the RIGHT mouse button.  These views cannot be deleted 
or changed 

Caution: The Perspective view will distort some aspect of the views.  For example, the plan view will show the airways at the EDIT grid 
level to plan, but airways above and below this elevation will appear larger and smaller respectively. 

Any further saved views will be placed below these items.  Saved views save the position, orientation, 
colour scheme, data types and attributes of the screen at the time at which they were saved. 

Hint: Saved views are not only useful for recalling the location and orientation of a model.  Because they recall selected levels, layers, 
data types and colours, they can be a quick way to establish a template to edit and view different data aspects of your model.  For 
example, you may have an AIRFLOW view, custom set to highlight a certain range of airflows in different colours, while a ‘HEAT’ 
view may be saved to highlight a range of temperatures. 

5.4. Run Menu 

The RUN menu allows menu access to the main simulation functions of VentSim™. Note that these can also be 
accessed from the main toolbar buttons. 

Standard Functions 

• Airflows 

• Steady State Contaminants 

VentSim DESIGN™ Advanced Functions 

• Thermodynamic 

• Diesel Particulates 

• Dynamic Contaminants, Gas, Heat and DPM 

• Recirculation 

• Financial 

VentSim DESIGN™ Premium / VentFIRE™ Functions 

• VentFIRE™ Fire Simulation 

• Multi type dynamic simulations 

 

Airflows [ALL] 
Undertakes a steady state airflow simulation of the model.  The Standard version will only perform an 
incompressible flow simulation, whereas the Advanced and Premium versions will optionally perform 
compressible flow mass balanced simulation if selected in the settings. 

Thermo-dynamics [ADVANCED] 
Undertakes a steady state thermodynamic simulation, which derives initial airflow (and mass flows) from 
an airflow simulation.  Thermodynamic simulation is complex and endeavours to simulate numerous 

parameters encountered in a mining environment. The simulation process follows well documented 

methods described in books such as Subsurface Ventilation and Environmental Engineering by Malcolm J. McPherson. 
Heat parameters that VentSim DESIGN™ Advanced considers includes 

• Heat and moisture derived from rock strata and ground water. 

• Thermal properties of different rock types. 

• Heat from point sources (such as electric motors), linear sources (such as conveyors), diesel 

engines and oxidisation of ores. 

• Heat from auto-compression of air. 



 

 

• Refrigeration and spot cooling of air. 

• Changing densities throughout the mine, due to depth and temperature effects, as well as pressure 
from ventilation flows. 

• Natural ventilation changes from changing densities. 

• Moisture from sources such as dust suppression sprays. 

• Condensation from over saturated air 

To accurately model a mine, all of these factors must be considered.  If data for a parameter is not 
entered, VentSim DESIGN™ will assume a default value specified in the Settings and in most cases will 
simulate a result anyway.  The accuracy of this result will largely depend on the accuracy of the entered 
data, and the default values used.  More information regarding thermodynamic simulation can be found 
later in the manual. 

Diesel particulates [ADVANCED] 
Simulates the spread of diesel particulates throughout a mine model, derived from diesel heat sources 
placed throughout the model.  The simulation process assumes a steady state emission of diesel 

particulate sources and a uniform mixing process throughout the model and its junctions.  Note that this 
may not always be the case in a real mine, where incomplete mixing and dynamic changing of exhaust 
emissions through the day can change concentrations of diesel particulates at different times, however it 
provides a useful baseline to examine the effects of changing ventilation circuits and flow in a mine. 

For more information see Diesel Particulate Simulation 

Dynamic Simulations [ADVANCED] 
Simulates the time based spread of contaminants, gases, heat and DPM contaminants.  Time based 
dynamic simulation show the results of a simulation on the screen at increasing time increments that can 
be paused and resumed.  Only one of these dynamic simulation parameters can be simulated at a time 

(although the PREMIUM VentFIRE™ module can simulate multiple parameters simultaneously)   To 
record a history of time base simulation results, ‘monitors’ can be placed at defined locations to record 
changes to ventilation flow. 

For more information see Dynamic Simulation 

VentFIRE™ [PREMIUM] 
VentFIRE™ as the name suggests allows for complex simulation of fire heat and contaminants.  In 
addition, it allows for simultaneous dynamic simulation of multiple ventilation parameters such as airflow, 
gases, contaminants, DPM’s and heat.  VentFIRE™ allows models to be automatically modified during 

simulation to enable scenarios such as altering fans, opening or closing doors, or moving machines to be 
modelled dynamically over time. 

For more information see the VentFIRE™ Simulation section. 

Recirculation [ADVANCED] 



 

 

Examines a model for paths which may recirculate airflow in a mine and reports the % or recirculated air 

in each airway.   

The definition of recirculation is the passage of airflow or a 
portion of airflow through the same point in a mine more than 
once.  VentSim DESIGN™ uses a custom algorithm to track the 
paths and recirculated portion of every airflow throughout a 
mine, and report where airflow may recirculate.  To prevent 

trivial reporting of recirculating air (such as minor leakage of air 
through a high resistance stopping) a default tolerance of 
1m3/s recirculation is used.  These limits can be changed in the 
Settings form.  Recirculating airflows are shown as a portion or 
% of air which has recirculated through the same airway.  

Note that this is not necessarily the total amount of recirculated air travel 
through a location, only the portion of air travelling through the current location 
and returning to the same location.  Air in some cases may have recirculated 
upstream in a different part of the mine, and will not be reported as recirculated 
in downstream headings that do no recirculate.  To view the downstream effect 
of recirculated air, click on the ‘Recirculated Stream’ data or colour option, 
instead of the Recirculation % option. 

Financial Simulation [ADVANCED] 
 

Provides a number of methods for optimising airway sizes, including defining set airway sizes and costs 
for consideration or by defined mining costs as variable and fixed factors so that an unlimited number of 
different sizes can be considered. 

See the financial optimisation section for further information. 

 

Contaminant Simulations 
 

Simulates the downstream spread or the upstream source of contaminants in the air.  These routines are 
generally used to identify the path and spread concentration of fumes, gases, dust and smoke from a 
contaminant source, or to predict where the airflow for a particular location comes from.  The routines 
are not generally recommended for large fires, due to the dynamic and changing nature of fires, and the 
dynamic heat effects on natural ventilation pressures.   

To clear any contaminants or gases from a ventilation model, select the Clear Contaminants option from 

this menu, or the toolbar menu. 

See the Contaminant Simulation section or the Gas Simulation section for further information. 

Summary 
 

Displays a summary of the current model collectively, or grouped under different TABS.  The data may be 

copied to the clipboard, for pasting into another package such as Microsoft Word, or an email. 

Note that if Staging is used, then only the currently viewed stage is summarised. 
An example output is listed below from the Advanced version with explanations. 

MODEL AIRWAYS            2772 Total number of discrete airways in a model 

Total length               66196.0 m  Total summed length of all airways 

Total airflow  intake             1025.5 m3/s  Total airflow entering the mine from the surface 

Figure 5-9  Example showing a ventilation fan recirculating 
air 



 

 

Total airflow 
exhaust 

1040.2 m3/s Total airflow exhausting from the mine to the surface.  Because of air 
density changes due to heat an elevation, this may not match the 
intake value on models with compressible flow. 

Mine resistance            0.00164 Ns2/m8  Cumulative resistance of moving the total airflow through the mine.  
This includes the resistance of ventilation ducts and recirculated air, 
so caution should be taken in adopting this value for primary airflows. 

Total mass flow 1260 kg/s Total mass of air flowing through the mine.  Note that this is ‘dry’ 
mass flow which excludes moisture content. 

POWER SUMMARY   

AIR (loss) Power           1772.2 kW   Total theoretical power required to move air through all airways 

INPUT Power                3609.2 kW Total installed electrical power required to move airflow 

Consisting of ..             

    9 fans  @                 3607.6 kW  

    0 fixed press @           0.0 kW  

    2 fixed flows @           1.6 kW  

Model Efficiency         49.1 % Ratio of theoretical friction loss to versus installed input electrical 
power.  Model efficiency may decrease when fans are operated 
inefficiently, or when excessive surface velocity pressure losses occur. 

MODEL FAN 
SUMMARY 

  

Fan Installations          7 Total fan installation in model 

Fan Numbers                9 Total number of fans in model 

Fan Sites Switched 
Off     

0 Fans turned off 

Fan Sites Stalled          0 Fans operating at their maximum pressure 

Fan Sites Low 
Pressure 

1 Fans operating at a pressure beneath the lowest fan curve pressure, 
but still above zero 

Fan Sites Negated          0   Fans running with no or negative pressure added 

Fans running 
reversed      

0  Fans running in reverse (user selected) 

Total fan power            3607.6 kW Total of all fan electrical power.  The is calculated from fan shaft 
efficiencies, and motor efficiencies. The fan power is calculate from 
the fan power curve.  If the curve is unavailable, it is estimated from 
the fan total efficiency curve.  If this is unavailable, the default fan 
efficiency is used. 

HEAT & MOISTURE 
INPUT SUMMARY 

  

Diesel Sources                 0.0 kW    from 0 
sources 

Sources of diesel heat and contaminants 

Sensible Heat 
Sources       

0.0 kW       from 0 
sources 

Sources of sensible (dry) heat 



 

 

Linear (S) Heat 
Sources     

0.0 kW        from 0 
sources 

Sources of heat distributed along multiple airways 

Latent Heat 
Sources         

0.0 kW        from 0 
sources 

Sources of latent (vapour) heat 

Oxidisation Heat 
Sources    

0.0 kW        from 0 
sources 

Sources of oxidising heat 

Electrical Heat 
Sources     

3609.2 kW         Sources of electrical heat 

Total Input Heat          3609.2 kW Total heat input from man-made influences 

Total Strata Heat         2885.1 kW Total heat input from heat dissipated from rock 

Broken Rock Heat 1450 kW Total heat from broken rock, which is calculated when an advance 
rate is entered for airways or stopes. 

TOTAL HEAT 
SUMMARY      

6494.3 kW Summation of all heat 

Total Refrigeration         0.0 kWR     from 0 
sources 

Refrigeration installations 

HEAT BALANCE 
TOTAL      

6494.3 kW Summation of heat minus refrigeration 

Moisture Point 
Sources   

0 Number of point moisture sources (such as conveyor dust 
suppression spray) 

Moisture Linear 
Sources  

0  Number of liner moisture sources (man-made, such as decline dust 
sprays) 

Moisture Input as 

Latent 

0 ml/sec Summary of moisture added from latent heat sources (such as diesel 

engines and latent point sources) 

Moisture Airway 
Surfaces 

4404 ml/sec Summary of moisture evaporated from rock strata 

Model condensation     0 ml/sec Summary of moisture condensed as water (normally in upcast 
exhaust shafts)  It can also indicate formation of fog in a mine. 

MOISTURE 
EXHAUSTED    

4403 ml/sec Total moisture exhausted from mine. 

HEAT AUDIT   

Input heat below 
surface 

6454.5 kW Check to make sure heat exhausted from mine, is accounted for from 
summation of underground heat sources. 

Elevation 
adjustment 

29.5 kW Adjustment due to inlet / exhaust elevation differences (auto 
compression) 

Differential inlet to 
outlet 

6469.9 kW Different between inlet from surface heat, and exhaust to surface 
heat 

Potential heat 
imbalance  

14.1 kW  (0.2 %) Error between the underground inputs and the surface recordings 

Potential temp 
imbalance  

0.01 C degrees Potential error in temperature as a result. 

Figure 5-10  Example of Summary Output with Description 



 

 

Heat Audit errors occur due to simulation approximations made in calculating heat and airflow in a mine.  

Airflow simulation approximates flow in each airway to an acceptable error, while heat simulation 
approximates temperature to an acceptable margin.  These errors and margins are adjustable in the 
settings.  The summation of these approximations can cause minor variances between heat entered or 
removed from each airway, and the heat difference between the air entering and exiting the mine.  The 

heat audit function is designed to highlight these potential differences and show the potential effect on 
simulation accuracy. 

 

It depends on the model and tolerance for temperature margins, however up to 
5% is generally acceptable, and will only give a slight imbalance in 
temperatures.  Errors beyond 5% are likely due to large allowable error settings 
in the main settings, or excessive airways in the model with little or no flow, 

which have a relatively high degree of approximation error.  In most cases, the 
error can be reduced by EXCLUDING unused parts of the model with little 
airflow, reducing the mass flow limit in the heat simulation settings or reducing 

the temperature and allowable airflow errors in the airflow and heat simulation 
settings.  

A selection of graphs derived from model parameters. 

The energy losses show the loss of input electrical energy into various ventilation losses such as wall 
friction, shock loss and exit losses.  Exit losses represent power lost due to the velocity of ejection of 
exhaust air into the atmosphere.  Note that some of this energy can be recovered and converted to 
useful fan static pressure by increasing diffuser size and reducing exit velocities. 

Heat Gain / Losses show the addition and 
removal of heat into the mine atmosphere. Note 
that while autocompression is a significant heat 

addition to deeper mine, the heat is removed 
when air travels back to the surface.  Also note 
exhaust fan heat on surface fans has been 

deliberately excluded from this summary as the 
heat does not directly affect underground 
atmosphere. 

Moisture Gain  shows the addition of moisture to 

the underground atmosphere.  Note that in 
most cases, moisture is due to either 
evaporation from rock strata or from diesel 
engine latent heat. 

Resistance and power curves show a graph of 
how much pressure and power will be required 

for a global increase or decrease in mine airflow.  Mine resistance is calculated based on the established 
airflow pathways set by resistances and fans.  If airflow distribution or resistance is changed with 
alternatively placed fans or resistances, then model resistance will also change.   

To utilise the graph, any airflow change must be assume to universally and equally change across the 
entire model.  Increasing the airflow only through one part of the mine (with resistance or fans) and not 
another will change the total mine resistance, and therefore pressure and power changes will no longer 
follow the curve.  The mine resistance graph shows two (2) curves – the lower red curve without 

auxiliary ventilation duct included, and the green curves including auxiliary ventilation duct. 
 
 

How much Heat Audit Error is too much? 

Graphs 

Figure 5-11 Mine Summary Graphs 



 

 

   



 

 

5.5. Connect Menu 

A selection of tools to connect to external data sources.  Some tools may not be available unless 
purchased as an added extra. 

LiveVIEW™ 
LiveVIEW™ is a VentSim Design™ module designed to connect to external data sources such as SQL 
databases, Excel or Access data files, or text files.  It is commonly used to connect to data coming from 
live underground sensors.  The data can be mapped and displayed within a 3D VentSim Design™ model, 
and can even be used to simulate new results based on the connected data. 

Further information is available from the LiveVIEW™ section of this manual. 

Ventlog™ 
Ventlog™  is a software program designed to record and collate underground surveyed ventilation data.  
The Ventlog™ database can be interfaced with VentSim Design™ to provide the ability to show actual 

Ventlog™ data results, overlayed with VentSim Design™ simulation results.  This provides a useful tool 

to compare actual and simulated values when trying to validate a model.   

Further information is available from the Ventlog™ Integration section of this manual. 

VentSim CONNECT™ 
VentSim CONNECT™ is a new version of VentSim for connnecting directly with devices on a site. VentSim 
CONNECT™ is aimed at connecting and monitoring Fans, Sensors, Regulators and any other devices at 
site.  

Further information is available in the “VENTSIM CONNECT™” chapter of this manual. 

5.6. Tools Menu 

A selection of tools and settings to check, modify and fine tune the model 

Fans 
Displays a windows form that allows editing, adding and deleting of all fans in the model fan database.  
Up to one thousand (1000) fans and the associated fan curves may be entered into the fan database.  A 
display for each fan curve and data will be presented when a fan is selected from the display list.   

For further information on entering and using fans, see the Fan Section in this manual. 

Levels 
A list of elevation ranges on which airway data can be individually viewed. 

This form allows editing or creating of a list of levels (elevations) between which airway data is located.  
The level list can contain up to 1000 levels on which your model will be created.   

Elevation data can be edited in any order, as well as added at a later date - VentSim will sort the data 

from highest to lowest when next displayed. 

To select which levels are displayed, use the Data Display manager to select what levels to display.  

Alternatively, levels can also be independently set by using the mouse context pop-up menu (right 
mouse button on the screen) to Select Levels.   

To view ALL levels at any time, simply use the Right Click pop-up menu to select All Levels.  Levels can 
be sorted by clicking the column header for the desired item. 

  



 

 

Stages 
Opens the stage form, where stage names can be entered or modified.  In addition, detailed descriptions 
for each stage can be entered, and simulation events for air and heat can be enabled when the user 
switches between stages in the models. 

For further information on staging, see the Stage Section in this manual. 

 

Spreadsheet 
Displays a READ-ONLY list of currently viewed or selected airways in a spreadsheet form.   

The spreadsheet of airway data is displayed can be copied and pasted to other applications such as 
Microsoft Excel or Word. 

Up to 100 different types of data can be displayed on the spreadsheet.  To display different data types,  

use the SELECT > DATA OPTIONS menu to select which data you wish to display. 

Data can also be removed from the spreadsheet, by selecting EDIT > REMOVE or using the right mouse 
button.   

Data columns can be reordered by selecting the column title and dragging to a new location.  In addition 
columns can be resized and resorted by using the appropriate menu commands. 

Hint : While the spreadsheet function is not designed for editing data, extensive data characteristics for each airway can be 
displayed, and copied to external programs such as Microsoft Excel ™.  VentSim DESIGN™ provides an Index number and a Unique 
number reference for each airway.  The Index number is referenced internally and during simulations by VentSim™, but may 
changed for each airway as airways are added or removed.  The Unique number will not change, and should be used as a 
permanent reference number to each airway if other identifiers such as names are not used. 



 

 

 
 
Figure 5-12  Spreadsheet view of model with selected data 

Filter 
Filtering tools consist of a selection of airway utilities to help filter and correct complex, disconnected or 
overlapping raw model data.  The tools can be run simultaneously as a group, or individually. 

The All Tools tab in the form, allows simultaneous filtering using the various selected tools.  Alternatively, 
each tool can be selected and run individually from the other tabs. 

 

Figure 5-13 Filtering Tools Combined 

Simplify allows the user to reduce the number of airways in a model to a more efficient number without 
affecting the overall model analysis.  

It is particularly useful where a model has been imported via a DXF file and contains a large number of 
very detailed but unnecessary small connected airways. 

Simplify will search a model for sequences of airways that may be reduced to single straight airways.  In 

doing so, much of the overhead and effort required to set parameters to every airway can be reduced.  
Note that the simplify function will only combine airways that have a single entry and exit.  Airways at 
junctions and split branches will remain untouched. 



 

 

 

Figure 5-14  The simplify dialog box 

The Max Angle option specifies the maximum angle between two airways 
being considered for merging.  For example, if the original model contains a 
number of airways that form a curve and Max Angle is set to 20 degrees 

Simplify will keep on merging airways until the airways being considered have 
directions changed by 20 degrees or more. 

The Max Length option restricts simplification to airways less than the 
specified length.  For example if set to 30m, only airways with lengths of less 
than 30m will be considered for merging and simplifying. 

In general, the higher the values of the Max Angle and Max Length settings, the 

more aggressively VentSim DESIGN™ will simplify and combine airways. 

Ensure the new length of a combined airway is fixed to remain exactly the 
same as the original combined lengths even if the original airways formed a 
curve.  If not set, the new lengths will be recalculated as the true length of 

the new straight line.  In most cases the difference is minor, and it is 
recommended to leave this option unchecked. 

Ensures that airways with a preset resistance (such as a bulk headed airway) 

are not simplified and merged with other airways. 

Check to see if airways that are considered for merging and simplifying are 
only joined if they are exactly the same size. 

Similar to dimensions, only airways with similar wall (friction factor) types 

are joined. 

Only simplify selected airways and ignore all others. 

HINT : Short irregular airway segments are best simplified with high joined angle settings (+45 degrees) or smaller joined length 
settings (<20m).  Long smooth airway segments are best simplified with low joined angle settings (<20 degrees) and high joined 
length settings (>50m).  Note that airways can be individually selected for simplification. 

Binding 
Binding connects disconnected airways ends or intersections.  Many imported DXF files do not have 
correctly connected centre lines or ends.  This function will search for unconnected ends or crossed 
airways and join them together if they are close enough.  Airways must always be correctly joined to 
allow air to flow 

Maximum Joined Angle 

Maximum Joined 
Length 

Use combined lengths:  

Ensure no resistance 
presets filtered: 

Ensure airways 
dimensions are the 
same:  

Ensure wall types are 
the same:  

Selected airways only:  



 

 

Warning : These functions are intended for preliminary clean-up of new models, not for existing balanced models.  It can permanently 
change the characteristics of your model and may delete some preset items or values.  Ensure only the required airways are first 
SELECTED before binding or simplification. 

 

Figure 5-15 Binding Tools 

Bind loose airway ends 

Defines the distance to join airway ends in a model which are close together but do not join.  Imported 
DXF file commonly have lines which don’t exactly join due to editing or drawing methods used in the 
original file.  Airways which do not exactly join in VentSim DESIGN™ will not flow air, and will result in a 
No Exit / Entry warning. 

The search radius can be entered in the preset box.  For example a search radius of 4 will join any loose 
end (airway end without another connection) to any airways within 4m of the end. 

Bind adjacent nodes 

Defines the distance to join adjacent connected nodes in a model which are close together but do not 

join.  This function is a little like simplify, in that small airways between the joined nodes will be 
removed. 

Warning : Selecting this option with too greater distance can seriously distort the model.  Use with caution or not at all. 

Bind airway ends to Junction 

Defines the distance to join airway ends to other airway mid sections.  It effectively splits and joins into 
the new airway.  Imported DXF files commonly have lines which cross the path of airway ends, but do 
not have a joining node.  This function will create a joining node along the line. 

Bind Crossed Airways at Intersection 

Defines the distance for joining airways that intersect or come close to intersecting, but do not have a 
joining node.  It effectively splits and joins both airways into new airways.  Imported DXF file commonly 
have lines which cross the path of another airway, but do not have a joining node.   

Duplicates 
Searches for airways which have duplicates in the same or similar position.  Duplicate airways can cause 
problems with air simulation due to poorly defined or hidden flow paths that the user cannot see. 



 

 

 

Figure 5-16 Duplicate Finding Tools 

Adjacent Angle is the maximum angle difference between adjacent airways that may be considered as a 
duplicate.  Airways next to each other with greater angles between them will not be considered as a 
duplicate.  The smaller the angle in degrees, the more ‘parallel’ and airway must be to be considered a 
duplicate. 

Adjacent Distance is the maximum distance two adjacent airways can be apart over which they will no 
longer be considered as duplicates.   

Exact selects only an exact matching airway as a duplicate 

Reversed selects airway the same, but facing opposite directions. 

Similar selects airways similar but not identical.  The adjacent angle and distance will be used as a 
criterion for selection. 

Action defines what action will be taken when the duplicate airways are found. 

Divide 
Divides longer airways into shorter sections.  This is normally not required, however may provide 

improved simulation and tracking of dynamic simulation data.  Note that dividing a model into excessive 
shorter sections may slow simulation and display. 

 

 

  



 

 

Convert To 3D 
Moves the model airways on to a 3D surface or contour plan, effectively converting the model from a 2D 
plan to a 3D model.  Note that if only parts of a model need to be converted, they should first be selected 
with the Select tool 

 

Figure 5-17  Filter Airways 

Use Reference 3D Lines :Uses lines (such as contours) loaded in from a DXF as a reference to convert the 
model to 3D. 

Use Reference 3D Solids : Uses solids (such a terrain polygons) loaded in as a referenced DXF object, to 
convert the airways to 3D, 

HINT : To convert a multi seam or level model to 3D using this function, individually group select the airways required, and ensure 
only the relevant 3D DXF object for that level is turned on before conversion.  

Models beneath steeply sloping or mountainous terrain may not be able to 
correctly apply virgin rock temperatures from a single elevation datum (this 
is the normal way VentSim calculates VRT temperatures of airways 

underground).  This function sets and fixes the VRT temperatures based on the 

proximity of a 3D contour or surface plan above the airways. 

Joins airways with small gaps between the joining ends.  This may be 
required if the airway is imported or pasted from another model, or created 
from an autocad centre lines conversion.  Note that the FILTER tool can 

perform a similar function with the BINDING option. 

Finds the pathway between one or two selected airways.  If one airway is 

selected, a pathway from one end to the other is calculated and selected.  If 
two airways are selected, a pathway between the two selected airways is 

calculate and selected.  A variety of different path methods are offered, 
including shortest distance, least airways, lowest resistance.  See the ‘Shortest 
Path’ section for more details. 

Note that selected airways can be shown in more details with the SPREADSHEET option once the pathway 
is calculated. 

Utilities 
The utilities sub menu provides many functions to assist with manipulation of airway data, particular raw 

data which may have been input from a DXF import or similar. 

Swaps the Easting and Northing (X and Y) coordinates of all airways in the 
model.  This may be useful where the coordinate system in VentSim 
DESIGN™ does not match the directions used on the Mine Plan Grid.  Where 

the direction of the coordinates needs to be reversed, use the Settings > 
COORDINATES settings to change direction of the axis coordinates.  

A utility which rotates all (if none are selected) or just the selected airways 

by a number of degree around the point of focus.  The point of focus is 

Calculate VRT 

Fuse 

Find Path 

Swap Axis 

Rotate Coordinates 



 

 

always at the centre of the screen.  It can be set by middle clicking the mouse 

button on a point, or by entering the centre coordinates in the View > Set Edit 
Centre option. 

Allows all airway coordinates to be mirrored around the centre location of the 
screen.  Note that the centre location must be accurately set before this 

function is used.  

Changes the sign of airway coordinates from positive to negative or visa-
versa.  Not that this is similar to mirroring coordinates around a zero centre. 

A utility which scales all airway or reference coordinates by an input factor.  
This effectively reduces or increases the size of the model without changing 
the airway size.  An airway length will not be changed if it has been fixed. 

Warning this function should only be used to scale schematic ventilation model with predefined fixed airway lengths.  Scale a model 
without fixed length will change the airway length and resistance, making it invalid for true scale model simulation. 

A utility which scales all airway dimensions by an input factor.  This 
effectively reduces or increases the size of the airways in the model.   

Warning this function will rarely find a practical use. One possible use is to incorporate an ‘over break’ factor into mine design airway 
dimensions, as mined airways are often slightly largely than design. Scaling model airway sizes will change the airway resistances, 
making it invalid for true scale model simulation. 

Airways 
Modify a selection of airway specific parameters 

Fixes or un-fixes airway lengths, so that models may be manipulated without 
changing the calculated airway lengths. 

This will fix and protect all airways in the model from changes in length when 
moving airways.  This may be useful if airways are required to be moved for 

clarity, but lengths must remain the same. 

This will un-fix and recalculate all true airway lengths in a model.   

This function will recalculate airways lengths and hence change any previously fixed lengths.  If there are any doubts, use the EDIT 
function to individually fix/unfix lengths of only the airways that need to be changed. 

Auto Name 
Automatically places a code number on every airway without a current airway name.  A letter may be 

specified to head the number if desired (e.g. B157).  

Sequences the order of airway numbers in a VentSim DESIGN™ model. 

Index numbers 

VentSim™.  The numbers may change as airways are deleted or added.  VentSim DESIGN™ uses Index 
numbers to refer to airways during simulation and when identifying problems.  All index numbers are 
sequential and the highest index number will be the sum of all airways.  Resequencing index numbers 
renumbers all airways from higher elevation to lowest elevation, easting to northing. problems.  All index 
numbers are sequential and the highest index number will be the sum of all airways.  Resequencing 
index numbers renumbers all airways from higher elevation to lowest elevation, easting to northing. 

Unique numbersmodel is developed. Resequencing the unique numbers renumbers all airways from 
number 1, sequentially top to bottom to the last airway.to the last airway. 

Mirror Axis  

Reverse Coordinates 

Scale Coordinates 

Scale Airway Size 

Lengths 

Fix All Lengths 

Unfix All Lengths 

Resequence 
Index/Unique Numbers 



 

 

HINT  Resequencing numbers is not a requirement in VentSim™, but may simplify tracking airways, as the resequence function 
tends to group airways in similar locations with similar numbers.  This is particular handy in the SPREADSHEET function which initially 
lists airways in sequential index order. 

Troubleshoot 
This option allows detailed checking of models, and will identify areas of your model that may cause 
problems during the simulation process.  A model with too many redundant bulkheads (bulkheads in the 
same airway path as other bulkheads), or fans that are in the same airway path as other fans, may 
result in a model that will not converge.  

Finds and alerts the user to fans that are directly competing against other 
fans. 

Finds and if desired remove bulkheads that are not necessary (usually 
because another bulkhead in the same airway has already stopped the 
airflow). 

Reset Model 
Removes all airflow and temperatures from a model.  The simulation processes is restarted with fresh 
data.  VentSim DESIGN™ utilises flows, densities and temperatures from previous simulation to help it to 
recalculate new simulations faster and more accurately.  If data has been corrupted during a bad 

simulation (which may have produced errors, excessive airflows, heat or densities), this may hinder 
subsequent simulations from finding an acceptable solution, or may simply produce further errors. 

Resetting the model will remove all calculation flows, pressures, densities and heat.  It will NOT remove 
any values fixed by the user, such as fixed flows, pressures or heat sources. 

5.7. Settings 

Presets 
A list of preset factors and characteristic used for placing in airways. 

Presets include 

• Resistances 
• Friction Factors 
• Shock Factors and Equivalent Length 
• Heat, Refrigeration and Moisture Sources 
• Layers 

• Air Types 
• Combustible materials 
• Fans (limited to header information only) 
• Airway Types 
• Airway Profiles 
• And more 

Values entered into the preset spreadsheet will be made available for applying to airways in the EDIT 

box.  Updating existing values in the preset spreadsheet will automatically change all airways with that 
preset on the next simulation.  Sorting the order of preset values in the preset sheet, will maintain the 

same sort order in the EDIT box. 

See the PRESETS section for further information. 

Warning : Be careful when removing existing settings from the preset spreadsheet.  Settings removed which already belong to an 
existing airway, will force the airway to ‘set’ the values permanently. 

Units 
Sets the metric and imperial conversion units and factors used for VentSim™, as well as the number of 
decimal points to show on the display. 

Restrictive Fans:  

Unnecessary 
Bulkheads:  



 

 

The conversion table displays the metric and corresponding imperial units for each type of data used in 

VentSim™.  The table is saved with every model, and can be individually modified for each model file.  
The conversion settings can be inherited by other models or saved in a template file.   

Additional unit settings can be added to each type of data.  The imperial unit names and factors may be 
freely changed to suit the region or preference of the mine.  The imperial column in the table may even 

contain metric units if required, by setting the imperial unit name to a metric text value and a conversion 
factor to convert between metric types (eg ‘1000’ could be used to convert metres to millimetres). 

 

Figure 5-18  Unit Table 

 

Figure 5-19  Conversion Table 

Clicking on the unit name in the unit table which show the conversion table, where units can be changed 
or additional units added.  Note that the default metric value cannot be changed. 



 

 

The name can be set to any text description, but is normally recommended to display either metric or 

imperial. 

Sets the number of decimal units to display on the screen and in text 
displays.  

Example  A decimal value of three (3) for example will display a value of 123.123 on the graphics display, or in the spreadsheet view. 

Caution  While the metric unit text name can be changed, the underlying metric value cannot be changed.  For this reason, the units 
must remain the same as preset in VentSim.  For example, the Velocity cannot be changed to km/hr as this would represent a different 
value scales, and the underlying VentSim equations are hard corded to use m/s.   

A text name describing the imperial units. 

The factor used to convert from metric to imperial.  VentSim DESIGN™ 
performs all internal calculation using metric formula and methods, 

converting displayed data back to imperial (if set in SETTINGS).  The factor 

is used to convert to and from metric to imperial, and will result in errors if not 
properly set. 

This factor is only used in converting degrees Celsius to degrees Fahrenheit, 
and added to the metric value before multiplied in imperial. 

 Natural Ventilation 
Apply natural ventilation pressures to the simulation model, based on the air density in every airway.  
Natural ventilation is applied based on the differential of density between air at an equivalent elevation 
outside of the mine and the air within the airway.  Therefore, for accurate analysis it is essential that 

heat first be correctly modelled, and correct outside temperatures added.  Unless heat is modelled 
accurately, it is recommended that Natural Ventilation be turned off, and fixed pressure applied to 
surface connected airways instead. 

Caution : Natural Ventilation may result in fluctuating airflow and temperatures between simulations.  This is because the natural 
ventilation effects may cause airflows to change, which in turn changes heat build-up in airways, which again can change the natural 
ventilation pressure.  This endless cycle of change cannot always be resolved, and can lead to variable (normally only small changes) 
simulation results. 

Compressible Flows 
Applies compressible flow effects to airflow based on elevation and fan pressures.  As a result, airflow 
volume will change depending on depth and temperature, although mass flow will remain the same 
(ignoring any moisture content changes to the air).  Compressible flow effects become significant over a 
few hundred metres in depth, and it is recommended for Advanced Version users to turn it on for more 
accurate simulate results. 

Simulation Accuracy 
Automatically optimises simulation settings to preset recommended values to achieve faster simulation 
speeds, or slower but more accurate simulation.  The function automatically adjusts the airflow 

simulation allowable error, the heat simulation temperature margin, the minimum mass flow heat 
balance setting, and also a number of other simulation factors such as convergence iterations. 

All of these settings can also be individually adjusted in the Settings section below.  Where individual 
settings vary from the preset recommendations, the simulation accuracy menu will show the setting as 
‘CUSTOM’. 

In most cases, the simulation accuracy will have little effect on the final simulation results, however if 

maximum accuracy is critical (and the range of assumptions entered into VentSim is accurate), then the 
high/slow simulation accuracy setting is recommended. 

Settings 
An extensive list of settings used by VentSim DESIGN™ that control the behaviour, simulation parameters 
and visual appearance of the program. 

Decimal Points  

Imperial Unit  

Multiplier 

Addition 



 

 

Settings are divided into a number of categories, including. 

Main Category  Description 

Costing 

 

Parameters for ventilation and mining costs required for 
accurate optimisation of airways and sizes 

Basic program settings to establish default airway sizes, factors 
and file settings. 

Settings that control the display of VentSim graphics and text on 

the screen. 

A wide range of factors and settings controlling the performance 
of different simulation methods in VentSim. 

Technical settings controlling the memory requirements in 

VentSim, language and the type of units used (eg Metric or 
Imperial) 

General Airway defaults, file settings and behaviour and license proxy 
information. 

Graphics Options to modify displayed graphics, including icons, text, sizes 
and more. 

Simulation Settings to control simulation parameters and behaviours 

System Settings Settings to control computer reserved memory, language and 
type of units for simulation data. 

For further information on settings, go to the settings sections 

5.8. Windows Menu 

Fit All 
Fits all display data on the screen. 

New Window 
Adds a new window form to the display.  The new window is based initially on the view position and 

contents of the most recently used open window.  

Zoom Out 
Increase the distance away from the window point of focus.  This may be of use if the mouse used does 
not have a scroll wheel.  

Tile 
Enables windows to automatically arrange to fill the master window form.  Note that only docked 

(windows within the master window) will be affected.  

Tiles all open windows in a vertical direction with equal spacing 

Tiles all open windows in a horizontal direction with equaly spacing 

Tiles all open windows in square or tiles to fill the master window display. 

Auto Arrange 
Enables windows to automatically dock and arrange the window position within the master window.  
Windows that are dragged into the master window will be automatically arranged when this function is 

activated. 

Vertical 

Horizontal 

Tiled 



 

 

6  THE VIEW TOOLBAR 

The VIEW toolbar adjusts the display of items shown on the screen.            

Fit All 
Fits available graphics centrally on the screen.  If graphics are spread over a huge area, then 

VentSim may elect to only show the airways in the most prominent area. 

Solid / Wireframe 
Switches the model between wireframe and solid display mode.  The wireframe mode is 
sometimes useful for fine editing of models, particular when airways are large or very close 
together. 

Grid 
Displays or hides the main grid.   Note that in a section (vertical) view, the grid 
automatically changes to show elevations. 

  

Nodes 
Displays or hides nodes (junctions) of airways.  This option can also show or hide individual types of 

icons by clicking the sub option drop down arrow to the right of the button 

Arrows 
Display or hides arrows showing airflows.  

References 
 Displays or hides reference graphics (for example DXF graphics or data imported into VentSim. 

Visibility 
Provides options for limiting the amount of data displayed in a model.  For complex models, displaying 
data for every single airway segment this can lead to a cluttered display, and is often unnecessary, 

particularly if the data shown is largely the same (for example airflows).  For other items however (such 
a heat flows) this large amount of text data can still be useful. 

       

Figure 6-1 Visibility Options 
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Hint : For data which may vary from one end of an airway to another (such as temperature), VentSim DESIGN™ will 
always show the ENTRY data on the airway unless otherwise specified. 

Only displays text, nodes and/or arrows on airways which specifically have 
‘Show Data’ option set in the EDIT box. For example a loop in a decline 
consisting of 10 airway segments, will normally show data for every 

segment.  To only show one text data for all the segments, ensure only one 
airway is set to ‘Show Data”. To force an airway segment to show data, use the 
EDIT box and click ‘Always Show Data’. 

Display or hides icons. 

 
All Text    Controls how much text information is displayed on the screen. 

Transparency 
By default, all data which is non-active (for example levels or layers which are 

turned off, data which is outside of the Display Manager, or zero flows if set) are 
shown as a transparency, with the transparency amount set in the Display 
Manager.  

To specifically hide some items (for example layers which are not visible), but still show transparencies 
for other items (for example Zero Flows or Coloured Data), data types can be individually set to show 
transparency or be hidden.  

Data : coloured data which is outside of the selection range in the Display Manager, and is selected to be 
hidden can be made transparent, or removed from the display.  

Levels : level elevations outside of the selected ranges can be made transparent or hidden 

Layers (primary and secondary) layers that are not selected can be made transparent or hidden. 

Zero Flows : Airways carrying no flow can be made transparent or hidden.  

 

 

Limit All Items 

Icons 



 

 

7 THE ACTION TOOLBAR 

The toolbar allows quick access to commonly used VentSim DESIGN™ functions.   

The toolbar will be slightly different between VentSim Viewer, Standard and Advanced versions. 

  

7.1. File Input and Output Functions 

 

New File  
 Creates a new file.  The current file will be cleared. 

Open File  
Open the file dialog to load a new file 

Save File  
Saves the existing file.  If no name has yet been set, a Save File dialog will be displayed. 

 

7.2. Utility Functions 

  

Undo  

Reverses the last action performed in VentSim™ 

Redo  

Cancels the previous Undo, restoring any changes made. 

Create New Window  

Adds a new window to the display for multi windows viewing of the model.  Up to seven (7) 
windows may be opened.  

Snapshot  

Takes a static image of the screen in a form which may be saved, copied or remain on the screen 
for further comparison with other windows.  Snapshot are static only and do not change. Right click on 

the snapshot window for more options. 
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Video Camera 
 Activates a screen video capture function to record current activity on the computer screen as a video.  
When activated, the video camera will flash active.  When turned off, the video will be automatically 
created and played back.  The video file can be viewed in the stored computer folder which can be 
opened from the sub settings of this control button.  A wide variety of video formats, sizes and 
compression rates can be selected from the sub settings.  A time lapse video mode is also available to 
allow recording of long simulations, and subsequent high speed playback. 

 

Find 
 
Searches for specific items within a ventilation model.  Pressing the ‘searchlight’ icon directly, repeats the 
previous find action.  Pressing the submenu arrow next to the icon, activates the find submenu as shown 
below. 

Find the name of an airway name or node.  Entering any part of the name will find airways containing 

the name part.  

Some examples include ; 

Find an airway with the specified index or unique number 

Find airways with operating fans, fans that are turned off, or fans that are 

performing outside of their rated fan curves. 

Find airways with fixed flows or pressures. 

Find airways with artificially heat, cooling, diesel or moisture sources. 

Find airways with contaminant sources set. 

Find model errors defined during the previous simulation. 

Show All  
 

Automatically turns on all hidden airways to ensure all airways in the model can be seen. 

Lock 
The lock function controls how the VentSim cursor attaches to other airways or graphics objects.  When 
editing, this is often desirable to ensure airways attach correctly to other airways or reference graphics 
while drawing or editing, however it may become problematic particularly in graphically crowded 

environments.  

 

Individual graphical locks can be turned off using the function below.  Note that ALL LOCKS CAN BE 
TURNED OFF temporarily by pressing the CTRL key while editing (moving or drawing) airways. 

Number 

Fans 

Fixed 

Heat sources 

Contaminants 

Errors 



 

 

Hint : You may wish to carefully move airway ends or joins, however the move keeps 
connecting the ends to other nearby (or far away) airways in the same view direction.  To 
disable this behaviour and allow fine control over moves, simply hold the CTRL key down 
while moving to prevent the airways locking on to other objects. 

Locks on to the closest airway when 
adding, moving or copying new airways.  
Deselecting this option will allow airways 

and nodes to be finely moved without locking 
on to a nearby node or airway, or to travel 
through each other without connecting.  

Hint : The lock target can be deselected when arranging airways which are closer together.  The lock function when selected will 
normally lock on to the closest available airway, ensuring a positive join between the airway.   

Warning.  If the lock target function is turned off, airways may not join into each other precisely (even if they appear close or overlap), 
resulting in no exit or entry errors.   The ‘lock target’ function should always be selected when you intend to join into other airways or 
nodes.  You can check whether airways truly join into each other by turn on the NODE display. 

Allows transparent (non-active) airways to be locked on to, selected or 
edited.  Transparent airways are normally treated as invisible by the 

program and by default cannot be selected or changed.  Enabling this 
function will allow the airways to be selected or edited the same as any other 
airway. 

Forces new airways, or moved or copied airways to be drawn exactly 
vertically when the vertical movement function is chosen (with the SHIFT 
key or the RIGHT MOUSE button) while drawing.  When this function is not 

selected, airways can be moved both vertically and parallel to the plane of the 

viewing screen while being drawn. 

Hint: Airway drawn or moved with the Lock Vertical function activated can still be angled.  Simply release the SHIFT key or 

RIGHT mouse button while drawing and moving when you are at the desired elevation and the airway end can continue to be 

moved horizontally at the new elevation. 

Locks the mouse cursor onto a referenced graphic surface or wireframe.  
VentSim DESIGN™ will preferentially search for airways when moving the 
mouse cursor to new locations.  If no airway is found, if this option is 

enabled the program will search for a reference graphic (imported graphics) to 
lock on to.   

Hint: This function is very useful for tracing or moving airways on to imported referenced graphic locations.  By using the 
referenced graphics as a guide, airways can be accurately placed within a model.  To force the program to use the referenced 
graphics only, and not lock on to other airways, turn the Lock Target options OFF. 

Checks whether new airways intercept existing airways, and inserts a node if 
they do.  The function works by searching surrounding airways for 

intersections or crossing paths that are close. Turn this function OFF if you 
require an airway to cross another without joining (for example an overcast 

airway) or airways are required to be drawn very close together without being 
joined. 

Hint: When drawing Vent Duct within or close to an airway, ensure this function is turned OFF.  The Vent Duct airway may 
inadvertently join into the adjacent airway, creating shortcuts or duplicate airways.  

Perspective View 
Sets the viewing system to orthogonal or perspective.  Orthogonal removes the effect of perspective, 
making objects in the distance appear the same size as close objects.  This mode may be of assistance 
when viewing sections or plan views, where the perspective appearance would otherwise distort the true 
scale of objects at different distances.  The mode has the disadvantage of a more cluttered and complex 
display.  

Lock Target 

Lock Transparency 

Lock Vertical 

Lock On References 

Check Intercept 



 

 

Perspective view is more suited to general editing and viewing, where objects in the distance are obscured 

by perspective scale, creating a less cluttered display. 

 

Figure 7-1  Orthogonal Display 

 

Figure 7-2  Perspective Display 

Hint : When performing true PLAN or SECTION views, ensure that ORTHOGONAL mode is chosen to prevent perspective errors in 
these views.  In plan or section view, airways at a different plan or section depth will be shown at a different scale in perspective 
view.  You can quickly change between views by pressing the ‘P’ key on the keyboard. 

Flow Animation 
The animation ‘play’ button animates the airflow arrows in the model.  The airflow animation is 
performed at true scale speeds, with airflow arrows travelling at the simulated air velocities in the model.  

Providing the model is designed true to scale, the progress of airflow can be tracked at the same speed 
as expected airflow in the underground mine when set to X1 speed. 



 

 

 

The animate toolbar button has a number of sub menu items 

X1 Animate flows in true real time.  Arrows travel at the same scale speed as 
calculated air velocity. 

X5 Arrows travel at five (5) times the scale speed of calculated air velocity. 

X10 Arrows travel at ten (10) times the scale speed of calculated air velocity. 

STOP Stops flow animation.  Flow animation in large model can consume 

significant processing power and slow model response and rotation.  It is 
recommended flow animation be turned off when not needed on larger models. 

Hint:  Clicking the main flow animation icon will cycle the airflow speeds through all available ranges. 

Figure 7-3  Animation Speed Control 

Path Find and Measure Tool 
  

This is a powerful tool to select and analyse paths through a ventilation circuit.  Path options include 

• Direct – ignore the airway and measure the distance between 2 or more 
points. 

• Minimum Resistance – selects the path of least resistance between two 

points. 

• Minimum Distance – select the shortest path (vertical and horizontal) 
between two points. 

• Minimum Horizontal Distance – selects the shortest path between two 

points, but does not consider vertical shafts and airways. 

• Free Split – selects the path of minimum pressure loss between two points.  This feature is 
commonly used to analysis whether any high resistance obstructions are located in a primary 

ventilation paths through a circuit (which would be an inefficient arrangement). 

• To select a path, choose the path method option, and then click or drag between two or more points 
in the ventilation model.  The path tool will attempt to SELECT all airways between the two or more 
selected points. 

• Once the airways are selected, a distance window will show the selected distances.  The selected 
airways can also be used the same as normal selected airways for other purposes (eg EDITing). 

•  

Figure 7-4  Measure Distance Information Form 

• The Graph Tool can then be clicked to draw a graph of ventilation conditions along the pathway.  
Different ventilation options can be chosen to graph and exported to the clipboard if required. 



 

 

 

Figure 7-5  Path Graphing Tool 

Stage 
Sets the stage number or name of the model.  Only airways on the currently selected stage will be 
shown.  The name of the stage and many other options can be changed by RIGHT CLICKING the drop 
down list box.  The GREEN lock button lock any changes to the model to the current stage only. 

  

For more information on staging, see the Staging Section. 

7.3. Editing Functions 

 

View 
Places the program in view mode 

Draw a window to zoom into part of a model.  The front most airway in the 
view window will define the point of focus for the zoomed in area.  To zoom 
into area behind other airways, ensure the zoom window does not contain 

any portion of the front airways.  

Centre the view on the airway.  Centres the view on an airway so the screen 

can be rotated around the point clicked. 

Edit the airway.  Left clicking the mouse on top of an airway will show the 
Edit Box for that airway. 

Press and hold to pan the screen horizontal around the current Edit 
PlaneClick to centre the Edit Plane and rotation point about a specific airway 
or point on the Edit Plane. 

IN ALL MODES, right mouse click will rotate the model graphics about the 

point of focus.  Hold and move the mouse vertically to tilt the model.  Hold 
and move the mouse horizontally to spin the model. 

Left Mouse Drag 

Left Mouse Single Click 

Left Mouse Double Click 

Middle Mouse Drag 

Right Mouse Click 



 

 

Add 
 
Places the program into draw (add) mode to allow creation of new airways or measure between airways.  
The function has several sub-functions available by clicking the small arrow at the right. 

In normal (free draw) mode, airways that are constructed from other airways will adopt the attributes of 

the joined airway (such as size and wall friction factors types).   

Airways that are NOT constructed starting from other airways will adopt the default set in the Settings 
menu. 

Edit the airway.  Left clicking the mouse on top of an airway will show the 
Edit Box for that airway. 

Constructs a new airway from where the mouse is initially pressed, to the 

point where the mouse button is released. 

Left Mouse Click 

Left Mouse Drag 

To manually control the coordinates of the airway being constructed, 
select the sub-menu functions of the add button as shown below. 

Draw Single 

Allows the mouse to draw both ends of a single airway. Airways 
can be drawn vertically by hold the SHIFT key down. 

Draw Continuous 

Allows the mouse to continuously draw joined airways until either 
the ESCAPE button is pressed, or the airway joins into another 
airway.  Airways can be drawn vertically by hold the SHIFT key 
down. 

Draw Gradient 

Allows the mouse to continuously draw joined airways at a 

predefined gradient until either the ESCAPE button is pressed, or 
the airway joins into another airway.  The defined gradient is 
request when activating the function and can be entered as a 
percentage (eg 10%), degrees (eg 12.5) or a ratio of horizontal to 
vertical distance (eg 1:10).  

Draw Coordinates 

Shows the coordinate entry box after the airway is drawn to allow 
manual entry of airway end coordinates.  

Construct Duct  

a tool for quickly building ventilation ducting which follows existing 

airways.  Select the airways you wish to construct ducting along 
with the SELECT button. 

 

Figure 7-6 Manual airway drawing 
options 



 

 

 
Figure 7-7 The Vent Duct Builder Dialog Box 
See the Auxiliary Fan and Ducts section for further information. 

 

A tool for quickly building spiral ramps.  After selecting the tool, draw the initial 
direction of the ramp, and the ramp builder toolbox will show, allowing 
gradients, ramp bends, straights and heights to be established.  A ramp can be 
previewed to try different factors before clicking BUILD to commit the ramp 
design to the model. 

 
Figure 7-8: Ramp Build Function 

A tool for building pathways to allow rollback of smoke and fumes during fire 

simulation.  This function is highly specialised and should not be used unless 
required specifically for this function.  

Clears rollback pathways and restores the original airway shapes and 
configurations.  

Warning – modification made to the airways connecting to the rollback airways may result in disconnected ends when the rollback is 
cleared. 

Allows the selective direct conversion of DXF reference lines to airways.  If 
imported DXF centrelines are shown as a reference layer on screen (instead 
of automatically being converted to airways on import), then this function 

can be used to select or fence the reference lines that are to be converted to 

airways.   

Construct Ramp   

Construct Rollback   

Clear Rollback   

Convert Centreline 



 

 

Note that each reference line can only be selected once, as the program will not duplicate multiple selected lines. 

If centre lines are not available, this is an experimental feature which 
agglomerates groups of reference graphics to try and establish an airway 
path which could be constructed.  Examples may include survey string data 

showing wall, floors and backs, or 3D solids of actual mine development or 
shafts.  Note that the results from this function are very approximate and will 

likely require significant manipulation with the MOVE and DELETE tool function 
after being done, to create a workable model. 

Allows the mouse to measure distances between two points.  Click on the 
start point of where the measurement will start, and drag the mouse to the 
end point.  The measurement will display in the bottom left Status Bar area 

of the screen. 

Edit 

Place the program into Edit mode 

Edit the airway.  Left clicking the mouse on top of an airway will show the 
Edit Box for that airway. 

Selects the airways within the fence box being drawn.  Selected airways can 
then be edited by clicking on any of the selected airways. 

Hint : Selecting Multiple airways permits attributes for a large number of airways to be changed simultaneously.  This can greatly 
speed up creating a model. 

Select 
 

Selects a group of airways.  Selected airways are considered 
as a group by a number of other VentSim DESIGN™ functions 

including Edit, Delete, Move, Copy and Filter.  These options 

will apply changes to all selected airways simultaneously. 

Selects or de-selects the airway 
under the current mouse cursor. 

Fences a number of airways for 
multiple selection. 

De-selects all currently selected airways  

Deselects fenced airways 

Individually selects or deselects airways, ignoring the group setting or other 
group selection options. 

Multi Select Options 
 

Permits groups of airway to be automatically selected, based on either an initial airway selection, or 
subsequent selections with the mouse.  The selection mode will remain set, until it is reverted back to 
the single airway select option, or the <escape> key is pressed twice. 

For example, to select all airways of the same size, either select a single initial airway with the select 
button, and then select the mult-select option “Same Size”. OR select the “Same Size” option first, and 
then click on an airway.  All airways of the same size as the initial selection will be selected.  Once 

selected, the airways can be edited, deleted, move etc. 

Delete 
Deletes an airway or airways from a model 

Convert Any 

Measure 

Left Mouse Click 

Left Mouse Drag 

Left Mouse Click 

Left Mouse Drag 

<Escape> 

<SHIFT> 

<CTRL> 

Figure 7-9 Multi Selection Options 



 

 

Delete the airway.  Left clicking the mouse on top of an airway will delete the 

airway beneath the mouse cursor.  If multiple airways have been selected, it 
will delete all selected airways. 

Selects the airways within the fence box being drawn.  Selected airways can 
then be deleted by clicking on any of the selected airways. 

Deletion Options 
 

 

Presents a number of deletion options.   

Delete airways outside fence will delete all airways not 
inside the fenced area.  This can be useful to remove 
errant airways which may be located a long way away 
from the main model. 

Delete references removes DXF graphics within the fence 
area.  Delete references outside fence remove DXF 

graphics not within the fenced area. 

Figure 7-10  Deletion options 

Block 
 

Blocks or unblocks an airway with the highest resistance available (as defined in 
the Settings menu).  This will restrict nearly all airflow through the airway. 

Warning: Ensure that fans or fixed flows are not present in blocked airways, or in airways leading to or from 
blocked airways.  This will create a simulation error, as airflow will be unable to travel through the blocked 
airway without unreasonable pressure or heat build-up. 

Move 
 

Moves the selected airway, airways, airway ends or icons to a new location by 
clicking and dragging the LEFT MOUSE BUTTON.  Unless the SHIFT key is held, the move will always be 
done at the same horizontal elevation.  A ‘true vertical’ line is displayed showing where the move point is 
in relation to other airways. 

• To move an airway end (and all other attached airway ends), click on of close to the end node of 
an airway 

• To move an airway end away from other airways, click slightly back from the airway end node.  

The airway should ‘break’ away from other connected airways. 

• To move an entire airway (both ends), first select the airway with the select button, or fence the 
airway to be moved, and then drag the selected airway(s) to the new location. 

• Multiple airways can be moved by first selecting the airways and the dragging any one of the 
selected airways to the new location. 

• To move an icon (such as a fan, heat source or resistance) along an airway, simply grab the icon 
with the left mouse button and drag the icon along the airway to the new location.  Icons can also 

be dragged to other airways. 

Opens the coordinate entry dialog box to allow the move to be specified as a 
coordinate or offset from the current position. 

Drags the airway or node to a new location in the vertical plane, adjacent to 
the viewing screen.  The Edit Plane is moved with the dragged airway to 
indicate where the elevation is in relation to other airways. 

 

Left Mouse Click 

Left Mouse Drag 

Left Mouse Click 

Left Mouse Drag + Shift 

Figure 7-11 An airway 
stopping 



 

 

Move References / Textures 
 

The Move button has sub options that can move entire reference layer 
graphics to new locations, or move the texture picture located within the 
reference.  

Reference MOVE allows the graphic layer to be ‘dragged’ to a new 
location, or can more accurately be CLICKed once and the exact 

coordinates or offset entered instead. 

Reference ROTATE and SCALING allows numeric entry of the rotation angle or scaling factor. Note that 
rotation and scaling are performed around the centred position of the screen in the horizontal plane only.  
To centre the screen first on a location, simply click the middle mouse button once at that spot.  The 
screen will move and centre on that location, 

Texture MOVE allows any picture applied as a texture to a reference graphics, to be moved and positions 

around the texture. 

Texture SCALE / ROTATE allows the picture to be rotated and scaled to the correct location.  It is 
recommended to first move a known point on the picture/texture to the correct location on the reference 
graphics.  Then centre the screen on that location using the middle mouse button.  Finally, use the 
texture scale / rotate to drag another known point to the correct location.  The texture will automatically 
rotate and scale during this process. 

Copy 
 
Copies the selected airway, airways or icons to a different location.  The original airways or icons remain 
in place. 

Opens the coordinate entry dialog box to allow the copy to be specified as a 
coordinate or offset from the current position. 

Drags the copied airways or icons to a new location.  If the ICON is being 
copied, it will show on airways under the mouse cursor.  When moving 

airways, a ‘true vertical’ line is displayed showing where the move point is in 
relation to other airways. 

To copy an icon (such as a fan, heat source or resistance) along an airway, 
simply grab the icon with the left mouse button and drag the icon to another 
airway. 

Drags the copied airways to a new location in the vertical plane, adjacent to 

the viewing screen.  The Edit Plane is moved with the dragged airway(s) to 
indicate where the elevation is in relation to other airways.  

 
Insert Node 
 
Inserts a node or junction within an existing airway.  The airway is split into two airways as a result.  
This node can then be moved or joined into by other airways. 

Hint : Drawing an airway into the middle of another airway will automatically create a new node or junction into the joined airway. 

  

Left Mouse Click 

Left Mouse Drag 

Left Mouse Drag + Shift 



 

 

Reverse 
Reverses the direction of the selected airway.  The direction of the airway, and the airflow within the 
airway is reversed.  Fan, fixed flows and pressures are also reversed. 

Message Boxes 
Message boxes allow text and messages to be place in the display, independent of airways.  The 
message boxes can be coloured and sized individually, and can be locked at a specific screen location, or 
positioned in 3D coordinates so that it moves and rotates with the rest of the model. 

 

To create a text message box, select the toolbar button 
and click on the location on the screen where the box 

will be located.  The message box dialog box will show 
allows colour, sizes and position to be adjusted.  
Message boxes can also be assigned to belong to one 
or more stages.  

 

Contaminant 
 
Places a contaminant type within an airway.  A number of different contaminant types can be chosen.. 

 

Figure 7-12  Contaminant placing options 

Contaminant 
Places a standard contaminant value (defined in the Settings > Contaminants) in an airway.  Standard 

contaminants are considered unit less, however different units can be specified in the settings.  All 
downstream simulation values will be related to the initial concentration of a contaminant in the airway’s 
airflow.  Downstream contaminants are diluted proportionally to this value.  See the contaminant section 
for further detail. 

Report Smoke 

Used in the contaminant source tracking routines, this will place a smoke report within an airway.  After 
a contaminant tracking simulation, all airways below this point will be considered as contaminated.  All 
airways upstream from this point will be considered as a potential source of the contamination. 

Report Fresh 

Again, used in the contaminant source tracking routines, this will place a fresh air report within an 
airway.  After a contaminant tracking finding simulation, all airways above this point will be considered 
as fresh air. 

Left Mouse Click 



 

 

Places or removes one of the above types of contaminants. 

Monitor 
Records ventilation conditions at this airway location during dynamic simulation. 

See the Dynamic Simulation section for more detail.  

Filter 
Applies a filter to selected airways to simplify or bind together airways.  See the TOOLS > FILTER section 
for more detail, or more control is required on how the filtering is applied.  

7.4. Simulation Functions 

The simulation functions control the major simulation capabilities of VentSim™.  The buttons assume 
that a valid model has been created and all required data has been entered in preparation for simulation. 

 

Airflow Simulation 
Performs an airflow simulation on the model data. 

Ventsim DESIGN™ has two options for running Airflow Simulations: the Matrix solver and the Sequential 
solver. Each solver can be run by choosing it from the dropdown list of the Airflow simulation button. 
Ventsim will remember the selection and use the chosen solver in subsequent Airflow, Heat, 
Contaminant and Dynamic simulations.  

The Sequential solver uses the Hardy-Cross method to calculate the mine 
network airflows. This solver is the same solver used in previous versions of 

Ventsim.  

The Matrix solver is a new solver option in Ventsim DESIGN™. In contrast to 
the Sequential solver, it uses a matrix equation to solve the equations for 

airflow simultaneously. 

In the majority of mine networks - particularly large models - the new Matrix solver should solve 
noticably faster than the Sequential solver.  

The two solvers will solve for the same network and design inputs, but since they use different numerical 

methods, some small differences in results between the two solvers are to be expected, particularly 
where compressible flows are enabled. 

Heat Simulation [ADVANCED]  
 

Performs a thermodynamic simulation on the model data 

For more information, see Thermodynamic Simulation 

Contaminant Simulation 
Performs a steady state contaminant simulation on the model data.  Contaminant sources or flag must 
be present in the model to work.  Three different types of contaminant simulations are available from the 
sub menu pull down (arrow to the right of the icon).  See the Contaminant Menu bar for more 
information. 

Sequential solver 

Matrix solver 



 

 

Contaminant 

Spreads contaminant sources through the 
model as a never ending continuous stream 
(steady state).  The display and colour legend 
automatically switch to a contaminated 
concentration display, showing the simulated 

spread and contamination of the contaminants.  
See Contaminant Spread from the menu bar 
section for further information. 

 
 
Figure 7-13  Contaminant Options 

Hint : A number of additional contaminant data types are available including the ‘spread time’ of data.  

 

Performs a diesel particulate matter spread simulation based on diesel heat 
sources in a mine model.  The result is displayed as a concentration per unit 
volume of airflow.  The diesel heat sources are defined under the 

thermodynamic Heat Tab from the Edit Box form.  Diesel heat sources are 
converted to a diesel particulate emission rate per unit of engine power, based 
on either a default setting, a preset heat source setting, or entered directly in 
the Edit Box or Preset form.  Diesel emissions are spread throughout the model 
using a steady state, complete mixing algorithm that assumes perfect mixing 
and no settling or deposition of particles.  Diesel sources are assumed 
cumulative, and downstream sources or recirculation may increase 

concentration higher that the initial source.  

The simulated air concentrations are given in the same emission type as 
specified in the exhaust emissions.  For example if Total Carbon (TC) matter 
emission rate is given for a diesel engine (which includes elemental and organic 

carbon), then the air concentration rates will also be based on Total Carbon.  
Most air quality standards will quote either an Elemental Carbon exposure limit 
or a Total Carbon exposure limit.   

To convert to an Elemental or Total Carbon concentration, a factor will need to 
be applied either to the original emission rate, or to the simulated air 
concentrations. 

See DPM emissions for further information. 

 

Performs a steady state gas simulation based on gas settings edited into an airway.  See the gas 

simulation section for further information.  

 

Performs a reverse contaminant simulation, where the sources of airflow 
through the contaminant point are tracked back to the surface.  The 

contaminant markers are used to define the point(s) at which the simulation 
searches upstream for paths.  The display and colour legend automatically 
switch to a source concentration display, which shows the relative amounts (%) 
of airflow along different airway paths which eventually flow through the 
contaminant marker. See Contaminant Source from the menu bar section for 
further information. 

 
 

Diesel DPM [Advanced] 

 

Gas 

Reverse Contaminant 

Find Source 



 

 

Performs a contaminant search simulation which tracks the likely paths of fresh 

and contaminated air.  See Location Tool from the menu bar section for further 
information. Recirculation Simulation [ADVANCED] 

  



 

 

Recirculation [ADVANCED] 
 

Performs a recirculation search simulation which attempts to find any paths and portions of airflow that 

recirculate in the model.  Any recirculation paths are highlighted after simulation and the portion of each 
airflow recirculating through each airway will be shown on the screen as colour and text.  For further 
information, see Recirculation Simulation under the Menu Bar Chapter. 

Financial Simulation [ADVANCED] 
Performs a financial and airflow simulation for multiple airway sizes, to assist in determining the 
optimum airway size for mine ventilation flows.   For further information, see Financial Simulation under 
the Menu Bar Chapter. 

 

 



 

 

8 THE DATA TOOLBAR 

 

The DATA TOOLBAR control the colours and text displayed on the screen. 

Data Category 
Limits the data types shown in the adjacent pull down menu, to the category type specified. 

 

Airflow 
Show data types such as air flow volume, velocity, mass flow and 
density 

Pressure 
Shows pressure related data such as relative to surface, 
barometric and friction loss. 

Attributes 
Shows airway resistances, friction factors and shock loss 
numbers 

Energy 
Shows power and cost calculations for airflow, fan and fix inputs 

Heat 
Shows heat related data, such a temperatures, internal heat 
content, humidity. 

Identifiers 
Show airway specific indentifying traits, such as index or unique 
numbers and primary and secondary layers numbers 

Contaminants 
Shows airway contaminant factors, source values, simulated 
values, spread times and diesel particulate levels. 

Rock 
Show airway rock conditions, such as wetness fractions, specific 
heat and other rock parameters. 

Measured 
Not currently used. 

Figure 8-1  Select a data category, followed by a data type 
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Displays screen data related to the Data Category specified in the left hand pull down menu.  Each data 

category will have a unique selection of data types that are made available when the category is 
changed. 

Warning: some data types (such a pressures) may not be correctly set until after a successfully simulation.  While VentSim DESIGN™ 
saves previous simulated values in a file, these values may not be valid if further changes and modifications have been made to the 
model.  Another simulation may be  

Dynamic Text Size 
Dynamically rescale the text on the screen so that it can be easily adjusted for clarity or presentation.  The  

button will toggle between zoom scaled text (which grows larger or smaller the closer to the object 
graphics) or constant size text (which remains the same size regardless of zoom level)  

Favourites 
Shows the Favourites Manager.  Favourites are names for groups of data that can be simultaneously displayed on 
the screen.  For example, airflow volume, velocity and massflow could be displayed on each airway from a favourite.  If 
favourites are used for colours, only the first favourites item in the list will be used. 

To create favourites, press the  button, and add, remove or edit the favourites in the left hand column.  The favourite 
name, and the type of data under each selected favourite can be defined in the right handle panel.  The “Text” and 
“Colour” options define whether the favourite will appear in the text and / or colour selection boxes. 

 

Favourites can be displayed on the screen by selecting the favourite options from the drop down list. 

    

Because the display can become cluttered with too much data, favourites can also be displayed only on 
individual airways with a text box panel.  To show a selected favourite on an individual airway, EDIT the 
airway, switch to the INFORMATION panel, and select the desired favourite from the list.  

  



 

 

Scaling 
Dynamically resizes text, data and graphics on the screen.  

Each sliding control quickly rescales different items on the screen. For example the data 
text can be made larger or smaller to improve display clarity.  Use the mouse to move the 
slider up and down.  For finer control of sizing, click the slider once then use the mouse 
scroll wheel to move the slider up and down. 

Display Manager  
Shows the Display Manager dialog box, which floats on top of the VentSim DESIGN™ 
windows, and can be kept open at all times if desired. 

The Display Manager control provides options as to what graphics details and colours to 
display.  The display manager contain five (5) tabs which change the colour display 
between data types, and air, layer and elevation types. 

The Display manager can be displayed or hidden by clicking this icon  

The Manager controls many of VentSim DESIGN™ advanced display functions.  At the core of the 
manager is the ability to display any type of ventilation data as a colour range, including the ability to 
hide or make transparent data outside of a set range. 

Ranged Data.  The data which creates the colour legend is automatically ‘ranged’ to fit the model data 
values.  It may occasionally require resetting if new or changed values are present in a model (after a 
simulation for example), or the values do not divide the colours as you would like.  The data can be re-

ranged by either manual typing in new values, or allowing VentSim to automatically choose new values 
by selecting the median or linear range RESET Range buttons.  

  

Data range of airway data, 
equally divided by airway 

numbers.  To manually change, 
simply enter a new value in the 
box. 

Upper and lower range 
limiters 

Transparency level slider, 
for data outside of data 
range values 

Hide or make transparent 

data outside of range.  At full 
extent, no data will be made 
transparent even if outside of 
range 

Recalculated colour range 
derived from the top data 
range and the range limit 

sliders 

Unit type of displayed 

data type. 

Adjustable colours for each 

range.  To change a colour, click 
the colour square and select a 
new colour from palette. 

Click the reset colour scale 

buttons to re-colour airways 
automatically from available 
data 



 

 

OPTIONS (Right Click Mouse Button) 

 

Reverses the colour range direction 

Restores the colours to the default VentSim DESIGN™ palette. 

Restores the range to the full spectrum of available airway data values. 

Hint: The Display Manager will initially default to automatically range and set colours for the displayed data.  If the range values are 
manually adjusted, or the colours are changed, the Display Manager will no longer automatically range and adjust colours for the 
data displayed.  To restore or recalculate the range and colours, simply click the ‘Auto Range’ or ‘Restore Colours’ buttons. 

Hint:  VentSim DESIGN™ will store a custom colour and data value range for each type of data type.  This setting is saved with the 
VentSim DESIGN™ file 

Levels 
Selects which levels (elevation ranges) are displayed on screen.  To 
select or de-select all levels, choose the check box adjacent to the 

Level Name. 

To change a level name, right mouse click on the existing level name 
and type in the new name. 

Air Types 

Selects and colours the air types to be shown on screen.  Air types are designed to allow the user to colour 
airways according to air quality or purposed (for example fresh or exhaust air).  Air Types behave in much 
the same way as primary or secondary layers. 

To change an air type name, right mouse click on the existing air type name and type in the new name. 

Note that Version 4 or greater has a facility to alter the Atkinson flow coefficient for the pressure loss 
equation for each type of air.  This coefficient defaults to ‘2’ for P=RQ2, and is normally sufficient for the 
vast majority of mine models where flow is assumed to be turbulent.  However for special cases where 
extremely low velocity airflows causes the Reynolds number to decrease to the laminar flow range, the 
air type can be defined with another coefficient (for example 1) to force the simulation to model airways 

assigned with this air type with the alternative coefficient. 

Note that VentSim currently makes no attempt to automatically define the coefficient based on the 
airflow behaviour.  It us up to the user to define an air flow type with a different coefficient, and assign 
airways in the low flow regions with the air type.  Examples of regions that may need to be considered 
for lower flow coefficients, include extensive room and pillar mines with open circuits and low flows, and 
sealed area like coal mine gobs where slow gas movements may need to be modelled.   

To determine whether laminar flow ranges need to be considered for these zones, calculate the Reynolds 

number and the laminar or turbulent range for the flow velocities. 

  

Selects which primary or secondary layers are displayed on screen.  Layers are 
a way to show selected airways (such as a decline system or a shaft system) on 

screen while hiding other airways.  Primary and Secondary layers can be set to 
individual airways in the Edit Box 

To change a Layer name, right mouse click on the name and type in the new 
name.  Names can also be changed directly from the airway Edit Box, or in the 
Preset Box available from the Settings menu. 

Reverse Spectrum 

Restore Colours 

Auto Range 

Primary / Secondary 
Layers 



 

 

 

Selects which imported graphics files 
(references) are displayed on the screen.  
References can be modified by right clicking the 
context menu.  The transparency level of the 

reference can be change by first clicking on the 
reference item, then adjusting the transparency 
slider at the top of the display manager. 

 

 

Figure 8-2  Reference Manager Context Menu options 

 

Allows the user to adjust the scale of text and graphics on the screen.  Move the 
sliders right and left to achieve the desired size.  Sliders are available for text 
size, icon size, graphics size, text item number, data and message box size. 

 

Figure 8-3  Text and Graphic Scale Options 

 

Reference Manager 

Scaling Option 



 

 

9 THE EDIT BOX 

The edit box is a powerful tool required to manipulate and display 
airway attributes.   In summary, the Edit Box can perform the following 
functions 

• Set airway attributes for airflows and pressure simulation. 

• Set airway attributes for heat simulation. 

• Set contaminant, radon and gas attributes for airways 

• Allow custom comments and information (such as survey results) 
to be set for each airway 

• Select and display working fan duty curves 

• Display airway information derived from simulation 

• Enter a PQ (Pressure Quantity Survey) to automatically calculate 
and apply resistance.  

 

 

The Edit Box can be activated by clicking on an airway while in the 
View, Edit or Add modes selected from the main toolbar.  The Edit Box 

is divided into a number of TABS to allow quick access to each function. 

 

Figure 9-1 Edit Box Tabs 

9.1. Edit Box  

SNAPSHOT 
Creates a picture of the current airway information.  This picture can be saved (by right clicking the 
form) or used to compare results with an updated simulation. 

9.2. Edit Box – Select Menu 

Select Airways 
Allows the selection of multiple airways based on a selection criteria.  Multiple selected airways can be 

edited simultaneously from the Edit Box. The number of airways selected will be displayed in the form 
Caption Box (at the top of the form). 

 

Selects all airways directly joined to the initial airway (for example a decline 
loop).  The selection will stop when the airways reach a junction. 

Chapter 
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Select Joined Airways 



 

 

Selects all airways with the same primary layer 

 

Selects all airways with the same secondary layer 

 

Selects all airways of the same size 

Selects all airways with the same resistance type (eg bulkhead).  This may 
be useful for group changing and testing different regulator types on model 
performance. 

Selects all airways with the same friction type (eg ‘rough blasted’ walls).  

  

Selects all airways with the same shock type. 

Selects all airways with the same fan.  Note that while fan types cannot be 

changed in multiple headings, however fans can be turned on or off over 
multiple headings. 

Selects all airways with the same air type (for example ‘exhaust’) 

 

Selects all airways with the same heat type (eg trucks).  This may be useful 
for example to rapidly change all similar heat sources in a model to a 

different heat source (for example change all Truck Models from ABC500’s  
to ABC750’s) 

Selects all airways with one end that are not connected to others, and which 
are not flagged as connected to surface or marked as ‘allow closed end’.  
This function is useful for quickly editing new model creations (from a DXF 

file for example) which may have lots of dead ends and development stubs (eg 
truck bays) that need to be flagged or deleted to prevent no entry / exit errors 

in the simulation.  Note that this function should only be used when all valid 
connections have been accounted for. 

Similar to the loose end selection, but only selected airways with no 
connection on both sides. 

Select airways with the same sourcing contaminant type.  This selection was 
included to allow rapid definition of different air types in a mine by using the 
contaminant finding function.  For example is a ‘smoke’ sourcing pin was 

placed, all airways downstream will be turned ‘red’ for contaminated air.  If a 
‘fresh air’ sourcing pin is placed, all airways upstream will be turned ‘blue’ for 

fresh air.  Once all entries and exhaust pathways to the mine are marked, 
similar airways can be selected and the air type for those airways could be 
changed to ‘Fresh’ or ‘Exhaust or ‘Intermediate’ etc. 

 

  

Select Same Primary 
Layer 

Select Same Secondary 
Layer 

Select Same Size 

Select Same Resistance 
Type 

Select Same Friction 
Factor Type 

Select Same Shock 
Type 

Select Same Fan 

Select Same Air Type 

Select Same Heat Type 

Select Loose Ends 

Select Both Loose Ends 

Select Same 
Contaminant Type 



 

 

9.3. Edit Box – TOOLS Menu 

Tools – Set Fix Flow Resistance / Orifice 
Where a fixed flow has been used to retard or resist normal airflow, the resulting resistance can be used 

instead of the fixed flow.  Select this option to convert the fixed flow into a custom resistance or an orifice 
size that will give a similar flow based on current model pressures.  If multiple airways are selected, then 
all selected fixed flows will be converted to resistances or orifices.  The fixed flow is removed once this 
action is done. 

Pressure Survey Tools 
Pressure surveys of airways or shafts allow more accurate resistances to be calculated and used in 
VentSim.  These options provide tools to convert differential or barometric pressure survey information 
into resistances or friction factors.  Select the airways along which the pressure survey was performed 
and select the menu option.  A dialog form will show which allows the survey information to be entered 

and the resistance or friction factor to be calculated.  Select the desired resistance method (fixed 
resistance, linear resistance or friction factor) and select OK to update the model airways.   

Note that if Friction Factor is chosen, then an accurate survey of the airway dimensions is required if the factor is to be used 
elsewhere. 

Apply Gradient Slope 
Applies a gradient or slope to the selected airways.  The gradient will start from the end selected first in 
the EDIT box.  This tool assist in creating ramps between levels, particularly if survey data has been 

entered in 2D and requires to be converted into 3D.  

Distribute Rock Age 
Distributes rock opening ages evenly along a series of connected airway segments.  The rock age 
distribution will start at the end selected first in the EDIT box.  Ensure that the airways selected do not 
have split airways into other areas otherwise the function will fail to distribute the ages properly. 

Convert Fixed Resistance to Friction Factors 
Convert any custom resistance in the edited airways to friction factors, and resets the resistance to AUTO. 

Convert Linear Resistance to Friction Factors 
Converts any custom linear resistance in the edited airways to friction factors and reset the resistance to 
AUTO. 

9.4. Airway Tab 

Changes made to the airways in the Edit Box are highlighted in BLUE.  The changes are applied to the 
airway when; 

• Apply is pressed.  

If another airway is selected, the changes will be applied, and the next airway data will be displayed. 

Multiple airways can be selected and simultaneously edited from the Edit Box.  Note that not all Edit 

Functions are available for multiple editing and some function may be hidden.  To utilise multiple airway 
editing, simply Select the required airways before the Edit Box is opened.  Only attributes that are 
changed (and therefore highlighted in BLUE) are applied to the selected airway(s) 

The Airway Tab Page defines most of the airway attributes associated with airflow and pressure 
simulation, as well as basic airway information such as names and airway coordinates. 



 

 

 

Figure 9-2  Airway Edit Box Form 

 



 

 

Airway Names, Coordinates and Stages 
 

 

Sets the airway and node names, data box display and airway stages. To set new names or coordinates, 
simply type the information into the relevant text boxes.  Names are optional and are not required for 
the simulation. 

The data box display shows a selection of simulation data in a special text box that floats above the 

airway.  Data boxes are an alternative to highlight special data on a selected number of airways.  The 

data types display in the data box can be defined by pressing the  to create a ‘favourites’ group of 
data. 

Airway Size 
Sets the physical size and shape characteristics of the airway 

 

Figure 9-3  Set airway physical characteristics  

Allows a preset type of airway to be specified, which will automatically set 
the airway profile, dimensions and friction factors.  Pressing the TYPE ‘T’ 
button will open the PRESET form where airway preset types can be entered 

or modified.  If an airway type is modified, all airways set to that type will be 
automatically modified during subsequent simulations. 

Sets the profile of the airway.  If the shape chosen is ‘irregular’, the Width 
box will be changed to Perimeter, the Height box will be hidden and the Area 
box will become editable.   

Square, Round 

Arched – an airway with arched upper corners.  

Shanty – an airway with one side higher than the other. 

Irregular – an undefined shape characterised by area and perimeter 

• If the shape chosen is ‘round; the Width input box will be changed to Diameter. 

• If the shape chosen is ‘irregular’ the Width input will be changed to Perimeter and the 
Area box will allow data entry. 

• Further profiles can be created in the Presets form. 

Airway Size & Shape 

Shape 



 

 

 

 

Recommends an airway size based on the current simulated or fixed flow.  Note that this is a 
recommendation based exclusively on the current flow, airway attributes and cost data entered into the 
Settings.  If these values have not been established yet, do not use this feature to estimate the most 
efficient airway size.  Also note that if the airway size is accepted, this may actually change simulation 

results, and other adjustments elsewhere in the model to fans or regulators may be required to return the 
airway to original flow rates. 

Warning – do not use this feature unless the required airflow rate has currently been simulated or fixed in the airway, and the default 
COST settings have been set in the Settings > Settings > Costing. 

 

The number of parallel airways defined by the single airway.  This allows 
multiple airways in parallel to be represented and simulated by a single 
displayed airway. 

The width of the airway 

The height of the airway.  For vertical airways, the width and height are 
interchangeable.  For ‘Arched’ or ‘Shanty’ airways, the height is assumed to 
be at the centre of an airway. 

The calculated area of the airway, derived from the width, height and shape.  
If the shape chosen is ‘irregular’ then the ‘Area’ box can be edited, otherwise 
it will remain as Read Only and display the calculated size based on the 

width, height and shape. 

Assumes a continuous area obstruction along the airway (for example a 
duct, services or compartment) and removes this value from the available 
area of the airway.  Note that this should not generally be used for short 

fixed objects (such as a vehicle); in this case the orifice function may provide a 
better simulation result. 

Assumes a continuous % obstruction of backfill along the length of the 
airway and removes this value from the available area of the airway.  In 
addition, it removes the area of covered airway that transmits heat into the 

airway, to represent the insulating effects in heat transfer calculations for 

backfilled stopes. 

The calculated length of the airway.  The calculated length is automatically 
derived from the airway coordinates.  To change the length, click on the 
Check Box, and type in the new length.  This may be required if the model is 

drawn as schematic if an airway is moved to allow easier viewing, but the true 
original airway length still needs to simulated in the model. 

The calculated flow in the airway.  This number can be modified to provide a 

resistance based on the frictional pressure loss entered below.  The 
calculated resistance will be entered in the resistance box as a custom 

resistance.  The airway WILL NOT be fixed to this flow rate and will 
automatically recalculate next after the next simulation.  Use the Edit Box > FAN 
Tab > Fix Flow function if this is required. 
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The calculated pressure drop in the airway.  This number can be modified and will be used to calculate a 

resistance for the airway if an equivalent flow is entered in the above box. 

The calculated velocity of air in the airway.  This is the average velocity of air 
across the airway area, and is ‘Read Only’ and cannot be changed. 

Airway Options 
 

Controls various attributes relating to the airway behaviour and identification within a model 

 

Connects the airway to the surface, allowing it to freely exhaust and intake 
air from the surface atmosphere.  The airway end which is not connected to 
any other airway is assumed to be the end connected to the surface.  If both 

airway ends are connected, this item is ignored by the simulation.  The exit to 
the surface is assumed to be at the elevation of the airway end.  Barometric 

pressures at this point will be adjusted for any difference in height between the 
airway elevation and the defined surface elevation in the settings. 

Allows VentSim DESIGN™ to assume the airway is a ‘dead end’ without 
connecting to other airways or to the surface.  Examples of this may include 
a dead end￼.  The simulation process will assume this path is blocked, and 

allow no airflow along the airway.  will report a ‘no entry’ or ‘no exit’ error. a ‘no 

entry’ or ‘no exit’ error.  

Groups any selected airways into a single selectable group that can be 
selected with a single Select click.  Individual airways can still be individually 
edited by clicking on them directly with the EDIT button instead of using 

SELECT first, or by holding the <CTRL> key down while selecting. Grouped 
airways are a convenient way to collect airway systems together (for example 

shafts or decline sections), so they are easier to select and edit simultaneously.  
It has no effect on simulation.  

Excludes the airway from the simulation process.  Any errors or problems 
with the airways are ignored during simulation and no flow is allowed 
through the excluded airways.  Any non-excluded airway which joins with an 

excluded airway will be assumed to be blocked.  This function is handy for 

Velocity 

Surface 

Close End   

Group 

Exclude 

Figure 9-4  Further Airway Options 



 

 

excluding sections of a model design which have yet to be mined, or perhaps 

removing old sealed of filled sections of a mine which no longer carry 
ventilation.  Excluding airways will speed up simulation for the remaining 
airways. 

Prevents VentSim DESIGN™ from changing the airway’s airflow direction 

during simulation.  An error is displayed after simulation if an attempt to 
reverse is made.  This function is useful to ensure critical airflow locations 

underground are not arbitrarily changed without first warning the user. 

Always shows text data for this airway when the LIMIT view option is set. 

Specifies the gradient of the airway as a percentage.  For example a gradient 
of 10% results in an airway increasing 1m in height for every 10m in 
horizontal length.  If a group of selected airways needs to be change 

simultaneously, use the TOOL > APPLY GRADIENT option in the EDIT form 
menu.  Note that the first selected airway clicked with the EDIT button will be 

the airway from which the gradient is applied.  

Specifies an evasé or diffuser for the airway outlet.  This function will only be 
simulated on a surface connected airway, and will only have an influence on 
an exhaust airway.  An evasé or diffuser reduces exit velocity pressure losses 

to the mine, lowering overall total system pressure requirements to produce the 
same airflow.  Where fans are present, an improvement in the performance of 
the fan will be noted with increasing evasé sizes.  Note that the simulated evasé 
effect is theoretical only, and will ultimately depend on the efficiency and 
placement of the design to produce the simulated effects in a real mine.  As with 
all ventilation structures, there will be some efficiency and shock loss factors 
that will reduce performance from the theoretical calculation.  These should be 

considered when observing the effects of simulated evasé.   

VentSim simulation assumes diffusers are 100% efficient, however typically 
diffusers may only be 70-75% efficient.  Therefore it is recommended simulating 

a diffuser at less than design area of the actual diffuser size to account for this 
inefficiency. 

Note that only the Total Pressure simulation method calculates lost velocity pressures.  This additional lost velocity pressure is added 
to the Fan Total Pressure requirements for the mine.  If Static or Mixed pressure simulation is used (which will happen if fans with 
only Static Pressure curves are used), then any calculated primary fixed or fan pressures will exclude velocity pressure and therefore 
be more representative of Fan Static pressures only. 

Places a sudden restriction in the airway, with an open hole equivalent to the 
specified area.  The resulting shock loss and resistance of the orifice will be 
added to the resistance of the airway.  Orifice settings are normally used to 

simulate the effect of regulators, holes in wall, partly open doors or other 

sudden restrictions which may occur in underground headings.   

It can also be used to simulate the effect of large equipment blocking an airway 
by entering the ‘remaining’ area around the equipment as the ‘orifice’ size. 

Sets the type of air the airway is carrying, for example fresh, exhaust, mixed 
etc.  The air type can be shown as a separate colour on screen by selecting 
air type under the favourites menu on the Display Manager.  
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Figure 9-5  Example of use of fresh / exhaust airway type colouring 

Hint : Most mines have designated fresh and exhaust airways, and may also have airways which may be designated as potentially 
either, depending on production activities.  VentSim Classic 3.9 defaulted to a blue / red / green colour scheme for these three types 
of airways.  VentSim DESIGN™ uses these three air types, but also has up to potentially 25 other types (and colours) which can be 
specified under the Edit Box.  Other air types could be set by the user as ‘emergency access’, flooded’, ‘vent duct’ etc. 

Sets the primary layer type of the airway.  Once set, primary layers can be 
independently displayed using the Display Manager.  The name of the 
primary layer can be changed by clicking the Primary Layer button, and 

entering a new name or colour in the Preset spreadsheet. 

Sets the secondary layer type of the airway.  Once set, secondary layers can 
be independently displayed using the Display Manager. The name of the 
secondary layer can be changed by clicking the Secondary Layer button, and 

entering a new name or colour in the Preset spreadsheet. 

Airway Attributes 
 

Sets resistance, friction factors and shock loss factors for an airway. 

The sort order of the attribute items in the list boxes can be specified in the Preset Spreadsheet 

 

Figure 9-6  Resistance, Friction and Shock Factors 

Sets the resistance for an airway.  Resistance can be set to automatic, preset 

or fixed. 

‘Auto’matic allows VentSim DESIGN™ to calculate the resistance automatically from the airways size, 
length and wall friction factors.  
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‘Preset values’, can be selected from the resistance list.  Preset values are added to the underlying 

automatic resistance value.  To create a new Preset Resistance or change an existing one, select the 
Button to enter the Preset Spreadsheet and enter or change any existing resistance values from the 
Preset Spreadsheet.  When the Preset Spreadsheet is closed, the new preset resistances will be available 

in the pull down menu for all airways.  

‘Custom’ values are fixed resistances that override the automatic resistance calculation, and therefore 
ignore any pre-existing airway shape, size or friction factor.  Values can be typed directly into the 
resistance value text box. 

Resistances are normally set to apply equal resistance to airflow in either 
direction, however resistances can be specified to apply a different resistance 
when airflow is reversed.  To enable this function, create a Preset Resistance 

and enter both a primary and a secondary ‘reversing’ resistance in the preset 
spreadsheet.  This will force the simulation to consider an alternative resistance 
if the airflow is reversed from the direction that the resistance was originally 
placed.  If a reversing resistance is not required, simply leave the reversing 

resistance value at ‘0’ 

To swap the direction of a one-way resistance, use the “REVERSE” button on the 
ICON toolbar.  One-way resistance that currently are applying the secondary 

reversing resistance will be shown in a RED colour on the screen.  Example of 
use for this function include resistances such as hanging flaps or swinging doors 
which may either seal better, or alternatively swing open if airflow is reversed. 

Preset Resistances are assumed to be entered at standardized density 
(normally a sea-level air density), therefore can change according to the air 
density at which they are applied.  VentSim DESIGN™ will internally 

automatically adjust resistances during simulation according to the local air 
density.  This behaviour can be overridden from the global settings, or with the 
resistance Check Box on the edit form. 

If this box is not checked, the resistance entered is assumed to be derived from 

a reference air density as specified in the PRESETS for each type of resistance 
(which is normally 1.2kg/m3 unless set otherwise).  In most cases, resistances 
are likely to have been derived from preset values and standard air densities, 

and this option should remain unchecked. 

If the box is checked, VentSim DESIGN™ will assume an adjustment has 
already been included and will not attempt to adjust the resistance from density 
changes further.  Examples of this may be if the resistance has been measured 
at a specific site underground at a density similar to that simulated by the 
program. 

 

Sets the friction factor for the airway.  Friction factors describe the 
unevenness of wall profiles, which produces airflow turbulence and hence 
pressure loss.  The value can either be entered directly in the Friction F text 

box, or can be selected from the pull down menu.  As with resistance, new 

preset values can be entered by clicking the Friction button, and entering new 
preset values in the Preset Spreadsheet.  The new Preset Friction Factors will be 

available for all airways. 

Similar to the resistance density adjustment, friction factors are also 
normally standardised to sea-level air density, and will be adjusted for 
different air densities.  VentSim DESIGN™ will internally adjust friction 

factors during simulation according to the local air density.  If this box is not 
checked, the friction factor entered is assumed to be derived from a reference 
air density as specified in the PRESETS for each type of friction factor (which is 

normally 1.2kg/m3 unless set otherwise).  In most cases, friction factors are 
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likely to have been derived from preset values at standard air densities, and this 

option should remain unchecked. 

If the box is checked, VentSim DESIGN™ will assume an adjustment has 
already been included and will not attempt to adjust the friction factor further.  
Examples of this may be if the friction has been measured along a specific 

airway underground at a density similar to that simulated by the program. 

Sets a shock loss factor for the airway.  Shock losses can be set as an 
equivalent length, or as a shock loss factor (X).  The method used is defined 
in the Settings.   

Only one method can be used for all airways.  Ensure shock values are 
consistent with the method chosen in the settings throughout the model.  

Shock values can be manually entered in the text box, set to a Preset Value or 

set to an Automatic value from the pull down menu at the right.  To change or 

establish new preset values, press the Shock button, and enter or change the 
values in the Preset Spreadsheet. 

Preset values can be added or changed by clicking the Shock button next to the 
value box. 

If AUTO is chosen, VentSim DESIGN™ will attempt to recalculate a new value 

during simulation, by observing airflow direction, airway geometries and airway 
size changes.  VentSim will only calculate the Automatic Shock Value once, to 
prevent oscillations in simulation results.  If the model geometry or air direction 
changes it is recommended to RESET the shock value to zero (0) and let the 
AUTO shock loss recalculate the value during the next simulation. 

AUTO HIGH assume a rapid or sharp edge change of airway direction.  AUTO 
MID arbitrarily assume a smooth corner and is rated at 50% of AUTO HIGH.  

AUTO LOW assume an even smooth corner and is rated at 25% of AUTO HIGH. 

Note that this is a rough estimation only and may change slightly with every simulation due to changing airflow and directions.  The 
AUTO HIGH option assumes sharp corners on all direction changes and size changes, and is therefore considered to be a ‘worst’ case 
value. 

DO NOT use AUTO shock losses everywhere through a model.  AUTO shock loss should only be used on known areas of high airflow 
and sharp direction change or size change, Using SHOCK loss throughout a model will over predict total model pressure requirements 
by up to 20% because for AUTO HIGH every corner and bend will be considered as a ‘worst case’ geometry.  This is not the case for 
most mines as corners and bends are often smoothed or rounded.  Auto MID or LOW may be a more conservative approach if the 
auto option is to be used extensively. 

In critical areas which are subject to high airflows and large shock losses, a 
more thorough examination of airways should be performed, and the shock 
factor settings manually calculated and used.  Guides in setting Shock Value are 

available in most quality ventilation texts. 

PQ Surveys 
PQ (Pressure Quantity Surveys) allow the direct entry of a measured flow and pressure to automatically 
calculate the resistance of single or multiple connected airways.   

The PQ entry mode can be established by selecting the PQ Survey item in the Preset Resistance drop list.  
Once selected, the PQ entry boxes will be shown. 

PQ measured resistance is recognised as the most accurate way to create accurate ventilation models as 
it bypasses many of the variables (such as size, shock losses and friction factors) that would otherwise 
be required to calculate resistance.  If a PQ method is used, other airway definitions such as size and 

friction factors are ignored in the resistance calculation. 

Shock Loss Factors 



 

 

 

PQ surveys can be entered as a fixed survey or linear length method.  A fixed survey is intended to be 
applied on specific single airways in VentSim (for example a shaft section between levels).  The 
resistance calculated from the PQ entry variables is applied directly to the airway.  Ensure the linear 
length option is not selected in this case. Only a single airway should be edited when applying this 
method. 

The linear method allows the length of the PQ survey to be also entered across a series of connected 
airways.  This allows the resistance per 100m or 100ft to be calculated and applied to underlying airways 
of any lengths.  This method is intended for use where the PQ survey may have been performed 

covering multiple VentSim airway segments (for example around the bends in a ramp), or when a 
sample portion of PQ survey is intended to be applied to additional lengths of VentSim similar airways.  
To apply this method, one or more airways can be selected and edited simultaneously. 

Hint : To select and edit an existing linear PQ survey in VentSim, use the SELECTION > SAME PQ survey option on the toolbar to 
ensure all airways that were used in the original linear PQ survey are first selected before EDITing.   

Regulators 
 

A regulator creates a shock loss in an airway, leading to a loss in pressure and reducing the flow rate. 
The regulator can be adjusted to give the desired airflow. In contrast to the Orifice option – which has a 
predetermined shock loss curve - the Regulator option in Ventsim allows the user to define a specific 
shock or resistance curve. 

To add a regulator to an airway, select the Regulator option under the Resistance Type List. The type of 
regulator and the opening of 

the regulator can now be set.  

To examine or edit the shock 
curve for an existing regulator, 
open the Reguator edit form by 

clicking on the Button. A 
new regulator type can also be 

added. 

9.5. Fans 

Displays a form allowing fan and fixed airflows and pressures to be applied to an airway.  If a fan is 
present, a fan curve graph and duty will be displayed after simulation showing fan performance in a 
simulated model airway. The operating duty point and system resistance curve will be shown on the fan 
curve graph.  If no fan is present in the airway being edited, a blank window will be displayed. 



 

 

 

Fan Settings 

Sets fans, fixed flows or fixed pressures within the airway.  
This setting allows the user to include a pressure or flow to 
move air around a model.  Without at least one airway 
within a model containing a fan or a fix flow, pressure or 
power, there will be no airflow within a model (unless 
natural ventilation pressures are present). 

ON 

Turns on the fan or fix during simulation enabling the item 
to influence airflow within the model 

OFF 

Turns off the influence of the fan or fix during simulation.  

The airway and model will behave as if the fan or fix is not 
present.  

 

Figure 9-7  Edit Box Fan Information 

 

Auto Close 

Closes the airway when a fan or fix is turned off. 

Many actual fan installations have a mechanical 
device which shuts off airflow when a fan is 
turned off or loses power.  The self-closing option 
allows the simulation to reflect this.  If this option 
is unchecked, airflow will be allowed to flow freely 
back through the airway, as if the fan is not 

present.  Activating this option will close the 

airway; preventing airflow when the fan is 
switched off. 

 

 

Forces the simulation to produce an airflow equivalent to the value entered 
in the box.  A fixed flow cannot be set when a fan is present, and a fan will 

be removed if the fixed flow is checked.  To remove the influence of the fixed 
flow, simply uncheck the fix check box.  When a fixed flow is simulated, the 
program will calculate a required pressure and power to produce the fixed flow.  

Fix Flow 



 

 

Where the fixed flow is less than what would normally be simulated, the fixed 

flow acts as a ‘resistance’ or negative pressure influence, and restrict flow. In 
both cases, the results of fixing a flow will be displayed in the INFO box. 

Select one of the Recommend fan options if a fixed flow is present and has been 
simulated.  The program will examine the pressure and flow required to achieve 

the flow, and then search the fans in the program database for a suitable 
match.  The program will consider up to 4 parallel fans as being a viable match, 
and display them in descending match order.  To swap the fixed flow for a 
recommended fan, select the desired fan from the list. 

Restrict is similar to a fixed flow in that a certain air flow rate is targeted 
during simulation.  The main difference however is the ‘restrict’ is designed 
to resist flow and provide an equivalent resistance.  If the restrict value is 

greater than what would normally be required to restrict airflow (ie it boosts the 
airflow) a warning will be displayed during the model simulation. 

Forces the airway to produce a constant positive pressure equivalent to the 
entered value in the box.  A fixed pressure cannot be set when a fan is 
present, and a fan will be removed if the fixed pressure is checked.  To 

remove the influence of a fixed pressure, simply uncheck the fix check box.  

When a fixed pressure is simulated, the program will calculate the required 
airflow and power to produce the fixed pressure.  The results of fixing a 
pressure will be displayed in the INFO box. 

Applies a pressure and flow equivalent to a perfect fan with the specified 
fixed power, at the assumed default fan efficiency (normally 80%) 

Selects a fan for the airway. The upper pull down menu allows a fan to be 
selected from the fan database.  Fans are sorted in the order established in 

the Preset form.  Adjacent to the fan name, is the number of fans to be 
included in the model, and below this is the configuration of the fans (parallel or 
series).  Fans installed in series will increase available fan installation pressure 

according to the number of fans available, while fans installed in parallel will 
increase available airflow. 

Selecting EDIT will jump straight to the fan curve database edit screen. 

Displays the fan curve pressure type used for the simulation. TOTAL is a Fan 

Total Pressure (FTP) curve while STATIC is a Fan Static Pressure (FSP) curve.  
This is selected automatically if one or the other curve is unavailable. 

VentSim will preferentially use an TOTAL PRESSURE fan curve if available, 
except for auxiliary fans connected to ventilation duct, which will use STATIC 
curves.   

If a combination of FAN STATIC and FAN TOTAL curves are used in a model, 

then (with the exception of auxiliary fans) a mixed pressure simulation solution 
method is used, which ignores exhaust velocity pressure from a mine.  It is 
recommended that FTP (TOTAL PRESSURE) fan curves be used throughout an 

entire model if possible, however if this is not possible then the entire model 
should use FSP (STATIC PRESSURE) fan curves instead.  Both types should not 
be mixed throughout a model as a mixed pressure solution may overestimate 
the performance of any fan using an FTP curve, as the surface velocity pressure 

loss is ignored. 

Reverse the fan blade direction during simulation. This item is useful for 
emergency simulation where fans are available in the model to reverse 
airflow at specific locations. The fan curve is adjusted by the reverse factors 

set in the fan database, to reflect the poorer performance of fans with blades 
run in reverse.  The reverse function is only available for fans, not fixed flows or 
pressures.   
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Warning : This is not the same as reversing a fan installation direction where the maximum fan performance would be applied in the 
opposite direction – the reverse toolbar button should be used for this purpose instead.  

Adjusts the fan blade rotation speed from the default setting defined by the 
fan curve in the Fan Database.  Note that this is a theoretical pressure and 
flow adjustment which may not exactly meet true fan performance at 

different speeds. 

Hint: While the simulated speed adjustment to a standard fan curve should be reasonably accurate, if an exact fan pressure and flow 
curve is required for fan performance at different revolutions, it is suggested a separate manufacturer guaranteed fan curve be 
entered for the adjusted variation. 

Fan Duty Point 
The fan duty point defines the pressure and airflow that a fan operates at, and is shown by blue lines on 

the fan curve.  Note that either an individual fan duty can be selected, or if multiple fans are present at 
the installation in parallel or series configuration, the entire combined installation duty can be displayed.   
Due to local air density adjustments, the fan curve may have been adjusted to the one defined in the 

Fan Database. 

The efficiency returned reflects the efficiency curve entered with the fan.  The efficiency curve is the shaft 
efficiency of the fan.  It does not include electric motor or drive inefficiencies, which are considered 
separately in the Settings menu under Motor Efficiency. 

Enters the fan database screen to view or adjust fan data.  Note that any fan 
changes will not be reflected in the EDIT box until after a simulation.  Also note 
that modifying the fan database will change ALL fans of the same name in other 
locations in the model.  To create a custom change only for the fan at one 
location, you will need to create a duplicate of the fan in the database, and only 
modify the duplicate. 

Hint : Fan operating density is an important specification for designing fan types and installations.  Higher air densities will increase 
the available operating pressure curve (and power draw) for the fan, while lower air densities will have the reverse effect.  This can 
be an important consideration when selecting or designing a fan for a particular area in a mine.  Note that for VentSim DESIGN™ 
Standard, air densities are assumed fixed at all locations in a mine. 

Fans Stalled, Low Pressure or Negated 
If fans are forced by other model conditions to run beyond the limits of the fan curve, a warning showing 
stalled, low pressure or negated will be shown during model simulation.  

Stalled fans occur when the fan pressure build-up is greater than the capacity of the fan curve to 

accommodate.  VentSim DESIGN™ reduces the airflow quantity to a point where the fan pressure is no 
more than the maximum pressure specified in the fan curve. 

Low Pressure fans occur when a fan pressure falls below the lowest pressure point of the fan curve, but 
is still operating above a zero pressure.  This may occur when a fan is run with too little resistance or the 
fan is a high pressure type, being used in a low pressure application.  The fan pressure curve in this case 
may not extend down to the point the fan is operating at.  This is undesirable as the program must make 

assumptions as to what duty point the fan is actually running at.  In addition the fan is unlikely to be 
running efficiently at this duty point.  To prevent this warning, simply extend the fan curve to a lower 

pressure point. 

Negative Pressure (Negated) fans occur when the fan offers no useful pressure to the system, and may 
even retard airflow that would otherwise flow more freely without the fan.  This may be a result of other 
model factors or fans forcing or drawing air through the fan.   

When VentSim DESIGN™ encounters a low pressure or negated fan situation, it applies a resistance for 

airflow through the fan above the highest curve quantity.  This mimics real life performance of fans and 
effectively restricts airflow moving through a fan above its limit.   The induced resistance results in an 
additional pressure drop and in negated situations, the fan may apply a nominal negative or ‘resisting’ 
pressure, effectively acting as a ‘brake’ or orifice for the airflow. 

%RPM 



 

 

Any of these situations are not desirable, as fans are not designed to run beyond their fan curves.  

Without a fan curve VentSim DESIGN™ is forced to approximate fan performance and power 
consumption.  While stalled, low pressure and negated warnings can be ignored, every effort should be 
made to reduce or eliminate these occurrences within a model. 

Fan Pressure Curve 
The fan pressure curve associated with the fan (or fans if combined is selected) in the airway.  Note that 
the fan curve may have been adjusted by the simulation from the curve entered in the fan database to 

reflect the change in air density at the fan location.  The fan operating duty point is shown at the 
intersection of the horizontal and vertical lines. 

Fan Efficiency Curve 
The efficiency curve and the airflow volume intersection point define the efficiency the fan is operating at.  
The efficiency value is used to calculate the estimated fan shaft power.  If fan shaft power is entered in 
the database directly, a fan power curve will be shown and the program will derive shaft power from this 
curve instead. 

Fan Power Curve 
If a power curve has been entered for the fan, the power curve and the airflow volume intersection point 
will define the shaft or absorbed fan blade power the fan(s) are operating at.  VentSim will preferentially 
use this curve to calculate power if present.  If the power curve has not been entered for the fan, the 

efficiency curve will be used to calculate power.  If this is not present, the default efficiency in the 
settings menu will be used. 

Fan Data 
Fan Data is shown describing the operation and perform of the fan.  Most items are self-explanatory.  
Shaft power is power drawn by the fan impeller, and excludes inefficiencies in electrical motors or 
gearboxes.  Peak capacity it the fraction of the operating point away from the peak fan pressure.  Peak 
capacity approaching 100% for either resistance or flow indicates the fan may be prone to stalling. 

 

9.6. Heat Tab  (Advanced Version) 

The heat Tab Page controls most of the airway attributes associated with 
heat and moisture simulation. 

   

[ADVANCED] 



 

 

 

Heat and Cooling 
Sets the heating, cooling and moisture inputs for the 
airway. 

 The Heat Assistant 
helps calculate or estimate 
heat and moisture values to 
place within airways.  The 
heat assistant calculator is 
described further in the next 
Chapter. 

The toggle allows heat 

and cooling preset sources 

to be turned on or off, 
while leaving the preset in the 
airway.  If the box is 
unchecked, the preset will 
have no effect on the model 
thermodynamics.  Presets 

which are turned off will show 
in the model as a grey colour.  
Note that custom heat values 
which are not presets cannot 
be turned on or off, and must 
be removed if no 

thermodynamic effect is 
desired. 

Point Sources 
Point Sources of heat and moisture are applied to one 
specific location within an airway.  The thermodynamic 
change occurs immediately at that point. 

Adds (+ve) or removes (-ve) sensible heat from the airflow.  The number will 
be coloured RED (+ve) or BLUE (-ve) according to the heating or cooling 
effect of the value. Sensible heat is added or removed without changing 

moisture content.  If sensible heat is removed, and the air temperature dips 
below the dew point, moisture will condense and will be removed from the air 
by the simulation. 

Adds (+ve) or removes (-ve) latent heat from the airflow.  Latent heat is 
sometimes describe as a ‘moisture’ heat and does not directly change the air 
temperature, but rather increases (+ve) or reduces (-ve) water vapour in 

the air.  Sigma Heat and Enthalpy increases with latent heat addition. 

Removes sensible heat from the airflow. If heat is removed, and the air 
temperature dips below the dew point, moisture will condense and be 
removed from the air by the simulation.  Refrigeration is essentially the 

same as placing a negative Sensible Heat, and is included as a separate item to 
clarify its intended function within the model analysis.  

Adds (or removes) moisture in an airflow.  Moisture addition has a neutral 

effect on airway heat content, and is therefore added without changing the 
Sigma Heat content of the airway.  The effect of adding moisture is therefore 

an ‘evaporative’ effect which reduces dry bulb temperature and sensible heat, 
and increases latent heat.  Removing moisture will produce the opposite effect.  
Example of adding moisture to the air may include an evaporative cooling 

Heat Assistant 
Calculator 

 On or Off  

Heat Sensible 

Heat Latent 

Refrigeration 

Moisture 

Figure 9-8  The Edit Box Heat Tab (Advanced Version Only) 



 

 

chamber or a dust suppression scrubber.  Directly removing moisture from air 

(without cooling) although technically possible, is not a common mine process, 
and this option in VentSim DESIGN™ would only normally be used to ‘condition’ 
air to a certain temperatures and humidity for simulation purposes. 

Adds a combination of sensible and latent heat to the air to simulate a diesel 

heat source.  The result is generally a warmer moister air flow after 
application.  The ratio of sensible and latent heat added is controlled by the 

diesel to water ratio set in the heat settings menu. 

Linear Sources 
Linear sources of heat and moisture are thermodynamic changes applied evenly over the length of an 
airway or airways. 

The amount of heat per linear length generated by oxidising material in 
airway walls.  While oxidisation is not a significant factor in most mines, 
exceptionally reactive sulphide or carbonaceous materials may have a 

significant effect where airflows are low or airway drives travel an exceptional 
length through high oxidisation rock. 

Adds heat per unit length of the airway.  The value is intended to define heat 
sources which emit heat over a long length (such as conveyor belts).  

Setting a single equivalent point sensible heat to each airway will produce 
the same heat result. 

Adds (or removes) moisture per unit length of airway.  Similar to the 
moisture point addition, this less commonly used function may be of value is 
simulating a long length of airway water addition, such as decline dust 

suppression sprays. 

Hint : How much moisture as being added to your airways from sprays? To practically assess the amount, take a wet and dry bulb 
temperature above and below the sprays, and use the VentSim DESIGN™ Heat and Moisture Calculator to estimate the change in 
moisture content. 

 

Adds a combination of sensible and latent heat to the air over the length of 
the airway.  A linear diesel source is sometimes used in preference to a 
number of individual diesel point sources to represent a fleet of diesel 

equipment travelling along a selected route of airways.  To establish this type of 
collective heat addition, the average diesel motor output of the equipment fleet 

needs to be summed, and divided by the length of airway the fleet would travel.  
The resulting heat per length value can then be applied at a linear source to all 
the airways the equipment fleet would follow.  This method is considered to 
provide a slightly more accurate way to apply a moving heat source, but has the 
disadvantage of being harder to visualise as independent machines.  

Fuel Burn 
Fuel sources can be burnt directly into airways.  Fuels are defined in the combustible preset menu.  
Typically fuel burn is applied to airways with heaters for cold climates (propane or diesel for example in 

winter).  Alternatively, fuel burn can be applied as a linear application over a number of airways to define 

diesel machine activity over a particular route.  

Fixed Data 
Provides methods for forcing ventilation conditions along an airway to be a required value. 

Diesel Engine 

Oxidisation 

Sensible / Latent Heat 

Moisture Linear 

Diesel Engine 



 

 

 

 

Allows wet and / or dry bulb temperature of the outlet air from the airway to be 

fixed to a value.  This forces the heat simulation to adjust the air temperature 
from any previous simulated heat temperature upstream, to the fixed values.  
The corresponding heat and moisture values required for the transition will be 
calculated and reported after simulation.  This function may have several useful 
functions: 

• To adjust air temperature to a known value at a certain location, without having to modify 
simulated results above this location 

• To predict the heat or cooling required to condition the airflow to the fixed temperatures. The 
INFO tab will provide this information after simulation. 

The pull down menu for Fixed \ Threshold allows the user to specify a 
temperature threshold instead of a fixed temperature. Setting the fixed 
temperature as a Lower Limit or an Upper Limit means that rather than fixing 
the temperature, VentSim Heat Simulation will not allow the temperature to go 
past the limit set. For example, to model a heating unit configured to maintain 

the temperature in an airway above 3 degrees Celsius, the user would set a 
temperature of 3 degrees and then select the Lower Limit option. The 
temperature in this airway will not go below 3 degrees Celsius, but – depending 
on the rest of the model – the temperature can be any value above 3 degrees. 
This feature can be helpful when used with the Annual Thermal Flywheel Tool 

(Chapter 20.5), to model the variying usage of heating and cooling at different 

times throughout the year. 

Hint : Fixing the air temperature requires an adjustment to both sensible and latent heat content of the air.  Entering the wet and 
dry fixed values as the same temperature forces the simulation to assume a pure ‘refrigerative’ condition which is converted to 
sensible heat and condensation, instead of the normal sensible and latent heat calculation.  This is useful for determining 
refrigerative loads required for producing particular airway conditions.  Note that there still may be some residual latent heat 
reported for the airway due to strata heat and moisture transfer. 

 
An optional value used for Diesel Particulate Matter simulation which defines the 
total amount of diesel particulates emitted by an engine over a period of time 

for each unit of engine power.  This can be derived from manufacturer’s 
specifications or by practical testing of exhaust emissions.   

Note that EPA measured values are likely to include all particulate matter 

including elemental carbon, organic carbon and other trace matter.  
Atmospheric DPM exposure limits are normally limited to elemental or total 
(elemental + organic) carbon levels, therefore either emission rates or final 
simulated results will need to be scaled accordingly. 

 

The rate of advance or progression of the airway per month.  The area size of 
the airway dictates the number of tonnes entered into the simulation, and this 
figure is included in the Simulation Summary.   Heat from broken rock entering 
the mine atmosphere is highly dependent on the geometry of the muck pile, the 

Fix Temp WB, DB 

Diesel Emission 

Advance Rate 



 

 

length of time the rock is exposed to air and the airflow and moisture over the 

muck pile.   

To simplify the process, heat from broken rock is added to the atmosphere at a 
rate defined in the settings as a percentage of heat contained in the broken rock 
that is between the mine atmosphere temperature wet bulb, and the virgin rock 

temperature.  The exposed rock surface of the advancing airway is 
automatically assumed to be freshly mined for simulation purposes. 

Rock Conditions 
Sets specific rock conditions for the airway.  Airways will normally source these values from the default 
values in the Settings menu, however they can be individually overridden for each airway.  Using these 
functions, it is possible to set parts of the mine with different rock parameters types or wetness fractions. 

 

Figure 9-9  Rock Condition entry for airways 

Rock Type 

Specifies a rock type that has been pre-defined in the Preset menu (click on Rock Type) to enter the 
menu.  Selecting a preset value overwrites any manually defined rock parameters. 

Thermal Conductivity 

The thermal conductivity of rock surrounding the airway. 

Thermal Diffusivity 

The thermal diffusivity of rock surrounding the airway.  This value is optional and can be derived by entering 
the rock density instead. 

Specific Heat 

The specific heat value of rock surrounding the airway. 

Rock Density 

The density of rock surrounding the airway.  This value is optional and can be derived by entering the thermal 
diffusivity instead. 

 

 



 

 

Wetness Fraction 

The fraction of the airway surface which is wet.  A value of 0.01 would describe a nearly dry surface, 
while 1.0 would describe a fully wet surface.  The Wetness Fraction button can be clicked to enter the 
preset spreadsheet and create names for defined wetness fraction values. 

Age or Year Entry 

The age in years since the start of the airway was mined (in decimal years, for example 4.5), or the 
calendar year of mining (in decimal format, for example 2006.5 would represent end of June in the year 
2006) 

Age or Year Exit 

The age in years since the end of the airway was mined  

Airway ages can be a mixture of calendar years and age in years.  VentSim DESIGN™ determines which age type has been entered 
by the number of digits in the date field.  Four (4) digits indicate a calendar year age.  Where calendar year ages are entered, airway 
ages are calculated from the Current Calendar Year age set in the Settings Menu. 

VRTemp Entry / Exit 

Manually sets the Virgin Rock Temperature at the start and end of an airway.  This function is unlikely to 
be used often.  It forces the heat simulation to use preset rock temperature values, instead of calculating 
the rock temperature from the geothermal gradient.  This function may be of assistance if the rock does 
not conform to the geothermal gradient parameters (for example mining through backfill) or the rock 
temperature is being modified by other factors such as local geothermal sources or reactions. 

Note that the values normally reported in these cells are calculated from the simulation and will change 
with depth and time.  To FIX the values to permanent temperatures, simply overwrite the pre-existing 

calculated values.  

Exposed Surface 

Read-only field showing the simulate rock surface temperature after cooling for the specified rock 
exposure age. 

 Contaminant 
 
The contaminant tab display options and settings required for contaminant simulation in a model. 

 

Figure 9-10  Edit Box Contaminant Input 



 

 

Places an initial average contamination value into the airway.  The value can 

either be unit less or represent a volume concentration value of a particular 
type.  It is proportional to the airflow in which it is entered, and could be 

considered as a percentage, part per million (ppm) unit or any other unit which is representative of a 
value per unit volume of air.  Clicking on the check box adjacent the value box, will automatically set or 

remove a value specified in the Setting defaults. 

This value is ignored if ‘Explosive Simulation’ is selected as in this case the initial concentration is 
automatically calculated from the explosive yield rate (established in the settings) and the airflow. 

Contaminant Options (Dynamic) 
 
Specifies dynamic contaminant simulation options which can be modified for the airway. 

Specifies a constant concentration release of contaminant into the airstream 
for a specified number of seconds.  

Specifies a reducing concentration release of contaminant into the airstream 
for a specified number of seconds.  The concentration initially starts at the 

specified amount, and decreases at a linear rate over the specified number 
of seconds. 

Specifies a logarithmically decreasing concentration release of contaminant 
into the airstream for a specified number of seconds.  This means the 
concentration of contaminant will start at the initial concentration and rapidly 

decrease over the initial time frame, with a longer lower concentration period 
after that.  

The type of explosive to use for dynamic contaminant simulation.  The 
default option is to simulate Contaminant Only. Users can select an explosive 
type from the Explosives Preset, meaning concentrations of different 

explosion emmission products can be simulated. 

The amount of explosive to place for dynamic contaminant simulation.  The 
higher the amount placed, the more contaminant that must be dispersed 
into the model during simulation. 

The logarithmic factor rate at which contaminant will be dispersed. This does 
not impact the mass volume of contaminant entering the model, but rather 
the rate at which it escapes into the model airflow.  Higher values will simulate 

more rapid dispersion of contaminant from the initial contaminant source.  It does not affect dispersal rates 

once the contaminant has entered the main model airstreams. 

Sourcing Location Tools 
Provides options for setting contaminant reports and simulating possible location sources of 
contaminants underground. 

Places a smoke report in the airway. 

Places a fresh report in the airway. 
See Location Tool menu item for further information. 

9.7. Information 

The information tab provides a list of detailed information of settings and simulated values for an airway.  
The list may be copied to the Windows clipboard for pasting in another application such as Word or Excel.  
This can provide a valuable tool for comparing changes in specific airways before and after simulation. 

In addition, a thermodynamic summary is provided showing conditions at the start and end of the 

airway. 

Contaminant 
Concentration 

Fixed Release 

Linear Decay 

Logarithmic Decay 

Explosive  

Explosive Amount 

Dispersion Rate 

Report Smoke 

Report Fresh 



 

 

 

Figure 9-11 Airway Information Tab 

While most data values are self-explanatory, some notes below provide further explanation. 

Fan and Fixed Information 
An airway with a fan, fixed flow or fixed pressure will display the specific pressures, power and cost of 
the fan or fix for the airway installation.  Unlike the Fan Tab, the pressures and volumes displayed will be 
for the entire combined fan installation (if more than one fan present), not for individual fans. 

Fan Present 

Fan pressures are derived directly from the pressure volume curve of the 
fan.  If the Fan Total Pressure (FTP) method is used, the duty point will be 
simulated from the FTP fan curve, and static pressure will be derived from 

the fan diameter or airway size.  For the Static Pressure (FSP) method, the duty 
point is simulated from the FSP fan curve and the total pressure derived for the 
fan or airway size.   

Special consideration is required for surface exhaust fans.  For an exhaust 
surface fan, by definition, the Mine Total Pressure (loss of total pressure across 
all mine resistances) at the collar (inlet) to the fan is equal to the required Fan 
Static Pressure (FSP).  The Fan Total Pressure includes the velocity pressure loss 

Fan Pressure 



 

 

of the fan to atmosphere.  The value provided by the simulation (FTP) considers 

evasé and discharge area size, but is theoretical, and does not include shock or 
frictional losses between the fan collar and the fan discharge outlet.  As a result, 
for an actual fan installation, additional FTP beyond the simulated result may be 
required to achieve the simulated results.  As every fan and installation is 

different, it is best to discuss this with your fan manufactures in pressure critical 
installations. 

The fan power is calculated on Fan Total Pressure (FTP) and represents the 
power the fan motor is applying to the fan blades to generate the pressure 
and flow through the fan. The fan shaft (absorbed) power is calculate from 

the fan power curve. If a power curve has not been set for the fan, the fan total 
efficiency curve is used in conjunction with fan total pressure and volume flow, 

to calculate shaft power.  If this is unavailable, the default fan efficiency is used. 

Fan Electrical power is the estimated electrical power drawn by the fan motor.  
It is calculated from the Fan shaft power factored up by the motor efficiency 

factor set in the Settings menu. 

The annual cost figure is derived from the power cost set in the Setting 
Menus for a fan operating at this duty point continuously for a full year. 

Fix flows or pressures are often entered where a specific fan is not available or 
needs to be calculated.  The fixed flow information in particular is useful for 
identifying duty points for fan pressure at a specific volume.  This point can then 
be used to specify and source a suitable fan with a curve that can matches the 
pressure and flow. 

A fixed flow will show a Collar Total pressure for a surface exhaust fan or a 
Fan Total pressure for an equivalent underground fan in the airway. This is 

similar to a duty point for a fan.   

For a surface exhaust Fan, the Fan Static Pressure is arguably the critical 

pressure value, as the velocity portion of the Fan Total Pressure is lost to 
atmosphere.  A fixed flow will give a Total Collar pressure value for a fan.  This 
is equivalent to the Fan Static Pressure if the fan is a similar size to the airway 
shaft, however this correlation will change for differing fan diameters. 

For an intake or underground fan, the fixed flow with provide a equivalent Fan 

Total Pressure value. 

The power value will utilise the default efficiency set in the Settings Menu 
and describe a minimum motor size (shaft power) for the required fixed flow, 
and estimated power (electrical) consumption for the fixed flow. 

The annual cost figure is derived from the power cost per kilowatt hour set in 
the Setting Menus for a fixed flow or pressure operating at the duty point 

continuously for a full year. 

Pressure Information 
Describes various pressure conditions at either end of the airway. 

 

The pressure at either end of the airway in relative to the equivalent surface 
pressure at the same elevation.  Negative values indicate the relative 
pressure is lower than the surface pressure, while positive values indicate 

the opposite.  Relative pressure in different parts of the mine can help show 
which direction air would flow if they joined.  Air will always flow from higher 

relative pressures to lower relative pressures if a path is available. 

Fan Power 

Fan Cost 

Fix Duty Point 

Pressure Collar TP 

Required Power 

Annual Fix Cost 

Relative Pressures 



 

 

Note : As the relative pressure describes airway pressure at an equivalent elevation, if effectively ignores elevation and barometric 
effects of depths. 

Describes the calculated barometric pressure at the start and end of an 
airway.  Barometric pressure increases with elevation depth, and is in 
addition to any pressure influences on the model by fans or other pressure 

sources.  Barometric pressures and the resulting densities are an important 
factors in fan performance and heat simulation. 

Describes the frictional pressure losses along an airway, plus pressure 

additions due to fans or other pressure sources.  A negative value indicates 
frictional pressure drops are larger that pressure additions to an airway.  A 

positive value indicates pressure additions from fans or fixes have more than 
overcome frictional losses and contribute to system pressure increases 
elsewhere in the model. 

Heat Data 
Heat data shows various air conditions derived from heat simulation. 

Wet bulb and dry bulb temperatures at the start and end of the airway 

The Sigma Heat content of the air at the start and end of the airway.  This 

value describes the heat content of air per unit weight, and is therefore 
independent of air or mass flow rates. 

The amount of sensible and latent heat added to the airflow per unit length.  
The heat may be sourced from rock strata, auto compression or a heat or 
refrigeration input value.  

The total amount of sensible and latent heat added for the full airway length. 

The amount of heat added by the user in the form of sensible, latent or 

diesel heat input. 

The amount of sigma heat present in airflow, multiplied by the mass flow of 
the air through the airway.  The difference in these values should be 
equivalent to the total heat addition to the airway. 

The moisture content of the air relative to the total saturation potential of the 
air at the current temperature and pressure conditions. 

The volume flow of moisture condensation from airflow due to environmental 

conditions changes which result in air temperatures or pressures falling 
below the saturation point of air.  This normally results from a refrigeration 

source chilling air below the dew point temperature, or a reduction in barometric 
pressure (from air travelling up a shaft for example) reducing air moisture 
carrying capacity. 

Simulated Data 
Displays the results of heat simulation at the entry and exit of the airway.  The data displayed is ‘Read 
Only’ and is for information purposes only.  Most of the values displayed are self-explanatory.  More 

detailed airway information is available under the Information Tab. 

The calculated elevation of the start (left) and end (right) nodes of the 
airway. 

The calculated wet bulb temperature at either end of the airway. 

The calculated dry bulb temperature at either end of the airway. 

Barometric Pressures 

Pressure Loss 

Temperatures 

Sigma Heat 

Heat Addition / l 

Heat additions total 

Manual addition 

Contained energy 

Relative Humidity 

Condensate 

Elevation 

Wet Bulb 

Dry Bulb 



 

 

The calculated relative humidity and the moisture content of the air. 

The calculated virgin rock temperature at either end of the airway.  This 
value is calculated from the geothermal gradient, the elevation of the airway 
and surface rock temperature settings. 

The total sensible (dry) heat addition to the airway, from rock strata and any 

user sensible heat inputs into the airway 

The total latent (wet) heat addition to the airway, from rock strata and any 
user latent heat inputs into the airway. 

9.8. Sensors 

The sensor option in the edit box allows live imported data from the optional LIVEVIEW™ module to be 
placed and displayed on an airway. 

The dropdown lists permit the specific sensor to be attached to an airway, and also offer an option to 
modify the simulated conditions in the airway during LiveVIEW™ simulation.  See the LiveVIEW™ section 
for further information. 

 

Figure 9-12  Attaching sensors to airways 

9.9. Notes 

The Notes Tab allows detailed information to be recorded for any airway.   

 

Notes may include specific model setup information, or 
may consist of ventilation survey results of airflow, 
temperatures or gas levels for actual underground 
ventilation conditions.  Such information could be used 
to help validate simulated models, or could provide a 
useful ventilation recording tool to demonstrate 

ventilation conditions underground over a period of time, 
or provide a Statutory record of ventilation information. 

 

Figure 9-13  Recording sheet for entering general airway information  
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10  THE POPUP CONTEXT MENU 

The popup menu, activated at any time by a Right Mouse Click, provides a useful collection of commonly 
used function.  While most of the functions are also available from the toolbar or top menu, the popup 
feature can save considerable time as the mouse cursor is not required to return to the top of the page 
when a new function is selected. 

 

Fit All 
Scale view window, so all model graphics fit on the screen. 

Zoom Out 
Increases the distance away from the point of focus by a factor of 
two. 

Flight 
Enters a flight mode, which allows the user to freely ‘fly’ around the 
model in three dimensions.  To control the flight system, simply 
move the mouse similar to an aircraft flight stick, using the scroll 
wheel to move forwards and backwards. 

Mouse Controls 

Pitch down 

Pitch up 

Yaw (turn) left or right 

Control Speed Forward and Reverse 

Exit flight mode 

 

Select Level 
Selects one or more levels or elevations for separate display on 
screen.  This can isolate a specific elevation range of airways for 
display, which can clarify display on screen in complex models.  The 
function works independently of the levels specified in the level 

(elevation) database.  Any elevation or range of elevations can be 
selected at any time. 

The elevation range is selected by LEFT mouse clicking one or more airways on the screen, and RIGHT 
mouse clicking to commit and activate the selection.  As airways are clicked, the elevation range selected 
will turn YELLOW.  To select a larger area or range of elevations, draw a fence (by holding the left mouse 
button and dragging the box) around the airways within the desired elevation. 
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All airways outside the elevation range will be hidden or made transparent.  The level of transparency 

can be adjusted from the Colour Palette Manager.  

HINT: Airways outside of the normal range of the LEVEL (elevation) database will be displayed as invisible or transparent.  The LEVEL 
database should have a least one level which encompasses all elevations of airway data in your model. 

 

Figure 10-1  Model example before level selection 

 

Figure 10-2  Model example after level selection 

Hint : VentSim DESIGN™ initially defaults to displaying a 10 metre window range around the selected levels.  Airways outside of this 
range will not be displayed, or will be made transparent.  The range can be changed from the Settings menu. 

Show All 
Display all elevation ranges.  This function will reset any levels selected from the previous function. 

View 
Enter the view mode.  See toolbar view for more information. 

Select 
Enter the selection mode.  Airways selected can be deleted, edited, moved or copied.  See toolbar 

selection for more information. 

Add 



 

 

Enter the airway construction mode.  Airways can be drawn by dragging the mouse or edited by clicking 

the mouse.  See toolbar add for more information. 

Edit 
Enter the airway edit mode.  Airways clicked or fenced can be edited in the Edit box.  See toolbar edit for 
more information. 

Block 
Enter the airway block mode.  Airways clicked can be blocked or unblocked to prevent or allow airflow.  
See toolbar block for more information. 

Delete 
Enter the airway delete mode.  Airway clicked, or fence selected and clicked are deleted from the model.  
See toolbar delete for more information. 

Move 
Enter the airway move mode.  Airways clicked can be moved via coordinates.  Airways dragged can be 

moved with the mouse.  See toolbar move for more information. 

Reverse 
Enter the reverse airway mode.  Airways clicked are reversed along with any fixed flows, pressures or 

fans.  See toolbar reverse for further information. 

Action, Data and View Toolbar 
The toolbars at the sides of the screen can be turned off or on as required.  Use this function to select 
the visibility of each toolbar. 

Reset Display 
Reconnects the Windows operating system to the graphics hardware device.  The software link may 
occasionally become disconnected or corrupted, resulting in a blank display.  Reconnect the DirectX 
interface will reset the graphics software to hardware link and re-establish the display. 

 

•  

 



 

 

11 PRESETS 

11.1. Pre-set Values 

  
Figure 11-1  Preset Table Options 

Preset values provide a quick and convenient way to specify airway characteristics and parameters that 
may be commonly used in the ventilation model.  Examples are resistances (such as doors or seals), 
common wall friction factors, shocks losses, heat sources. 

The preset table also provides access to model primary and secondary layer names and colours, as well 
as air types, tunnel profiles, fans, wetness fractions and numerous other items used in VentSim 
simulation. 

Preset Values 
Any preset value which is changed will be applied to ALL airways using that preset value.  For example if 
a model has 10 airways using a resistance preset called ‘Rubber Flaps’ and the resistance for ‘Rubber 

Flaps’ is changed in the preset box, then ALL 10 airways using rubber flaps will have the new resistance 
applied when simulation is next performed. 

Most items can be deleted by selecting the entire row (or a selection of rows) and pressing DELETE, or 
by selecting and deleting individual values.  If a preset is currently in use, a warning may appear stating 
the fact, and the result it will have on the model.  Ideally, presets should not be removed if they are 
currently in use. 
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Sort Order 
The sort order of the preset values displayed in the spreadsheet, and displayed in forms in other parts of 
the program can be specified.  All columns in the preset form can be sorted by Ascending or Descending 
by clicking the column header once or twice.  For example, resistances can be sorted by name (by 
clicking the ‘Resistance Name’ column header, or by value (by clicking the value header).   

In addition, row items can be manually sorted, by selecting the row and pressing the UP or DOWN arrow 
on the keyboard.  The sort order will be retained next time the form is accessed and will be saved with 

the file. 

11.2. Accessing Presets 

Preset items are accessed from the main TOOL menu, however most preset items can also be directly 

accessed from the EDIT form by pressing the appropriate preset button  

  

Resistance 
Up to 100 different resistance presets can be entered.  Resistance presets can be applied to airways from 
the EDIT form.  Any resistance entered in the preset will be applied to an airway during simulation.  

 It is important to note that underlying airway resistances due to wall friction WILL ALSO be applied in 
addition to the preset resistance.  For example if a preset resistance of ‘10’ for a ‘DOOR’ is applied, and 
the airway has an underlying resistance of 0.015, then a total resistance of 10.015 will be applied during 
simulation. 

Preset activation buttons 

Preset activation buttons 

Airway Type 



 

 

The reversing resistance is an optional field which applies a different resistance should an airflow be 

reversed during simulation, and the ‘restrict airflow direction’ flag is chosen for the airway.  Reversing 
resistances may be useful in situation where resistance increase (such as automatic doors closing, or 
flaps sealing) or where resistances decrease (such as doors swinging open automatically) when airflow 
direction changes.  Such setups may occasionally be used to prevent recirculation or assist with 

emergency response design when fan direction may be reversed.  If the value is left at zero (0), then a 
default reversing resistance (specified in the SETTINGS) will be applied if an airway is reversed AND the 
‘restrict airflow direction’ flag is selected. 

Friction 
Up to 250 different friction factor presets can be entered or used.  The friction values in the EDIT box can 
be applied as presets (entered in the preset form), as individual ‘CUSTOM’ values or as AUTO values 
which defaults to a value specified in the SETTINGS. 

Shock 
Shock equivalent lengths or shock factors can be entered in the shock preset area.  The application of 
these factors will depend on which shock loss method is specified in the SETTINGS.  The values for each 

shock item during simulation will be applied according to the method chosen.  Only the value of the 

shock loss method currently used needs to be entered.  

Heat 
Up to 250 different heat, moisture and refrigeration sources can be entered.  Each ‘Heat’ source can be a 
combination of different heat parameters (such as moisture and sensible heat combined).  Airways with 
a specified heat source will have these values applied during simulation.  The screen also shows the 
number of heat sources currently in use.  

Vehicles 
Vehicle Presets are used solely in the Activity Tracks feature, in conjunction with the Heat Presets. They 
allow the specification of the velocity and aerodynamic characteristics of vehicles (trucks, loaders) or any 
moving object (falling rock, hoist cage). These parameters are used to calculate piston effects and to 
track the movement of heat sources along Activity Tracks. 

Layer Prim, Layer Sec, Air Type 
The form shows current names for these items, and in the case of layers, whether they are being used or 

not.  The names can be changed at any time, and new layer names and air type names can be added.  
Colour can be changed by clicking on the colour box.  There are currently 250 layers and 25 airway types 
reserved for use. 

Fans 
Present a summary of current fans, and the basic characteristics of those fans (eg diameter, air density 
for the curve etc).  While the fan curve data cannot be directly edited from this screen (you will need to 
go to the fan database function), the fan names can be changed as well as the other fan parameters.  
Fans can also be fully deleted from the model.  A read only column states the number of fans in use in 
the model. 

Airways 
Airways presets allow a specific size and type of airway to be set with pre-defined dimensions, friction 

factors and profiles.  Airways can then be quickly selected in the EDIT box to the preset airway type 
containing the preselected values. 

Profiles 
Profiles allow custom profile shapes to be entered into VentSim.  The first five (5) profile shapes – 
square, round, shanty, arched and irregular are preset and cannot be changed, however the profile 
string is shown to help users define new profile strings. 



 

 

Profile strings are dimensionless 

coordinates centred around an 
origin point of (0,0).  Airway 
profiles are intended to extend 
from (-1, -1) to (1, 1) which 

represents the full extent of the 
profile.  The actual airway size of 
the profile is set in the EDIT box 
which then scales the profile to 
whatever size is specified.  The 
profile shape is updated in the 
lower right corner, once the 

profile string is entered and re-
selected. 

To enter or add a profile, click on 
the Profile String cell on the 

profile grid.  A data enter form 
will show allowing points to be 

entered or modified. 

For example a square would have an X, Y profile -1,-1 ; -1, 1 ; 1 ,1 ; -1, 1, which represents the X,Y 
extents of all four corners around a centre point of 0,0.  If this profile is chosen in the EDIT box when 
setting an airway, entering a width and height dimension of 5.0m would scale the profile accordingly.  
Note that there is no need to provide an area or perimeter.  VentSim automatically calculates the 
perimeter and area, based on the profile shape given.  

Wetness Fraction 
Defines the wetness fraction options for underground airway wall wetness.  Wetness fractions can be 
applied to airways in the HEAT section of the EDIT box.  In general, wetness fractions closer to zero 

represent dryer airways and fractions closer to one (1) represent wet airways. 

Sensors 
Lists the current sensors imported from the LiveVIEW™ option. 

Combustion 
A selection of combustible products used in VentFIRE™ simulations.  Combustible products are defined 
by the amount of heat released MJ/kg, the oxygen consumption (kg Oxygen per kg fuel burned) and the 
yields rates of various combustible products (kg combustion product per kg product burned). 

Note that the yield of carbon monoxide is specified as a minimum and maximum.  This provides some flexibility in the emission rates 
for oxygen rich and fuel rich fires.  If the calculated equivalence ratio (ratio of fuel available per oxygen available) exceeds above (1) 
then the maximum CO value will be used in simulation.  It the ratio falls below 0.5 then a value close to the minimum will be used.  
For ratios between these values, a value between minimum and maximum will be calculated, increasing towards the maximum 
value as the ratio approaches one (1). The equivalence ratio is not fixed and is constantly recalculated during simulation. 

 
Duct Leakage 

 
Defines the resistance of leakage of air from a Ventilation duct.  The values define the area sum of holes 

per total unit area, specified as mm2 per m2 of duct.  Because this ratio uses the same units, any 
number representation of the ratio x 1 x 106 (million) could be used – for example parts per million 
(ppm). 

Duct Heat Transfer 
 

Defines the heat transfer properties of the material of a Ventilation duct. A thickness and thermal 
conductivity of the duct material are required; the insulation properties are optional and can left as zero.   

Regulators 
 



 

 

Presents a summary of the regulators. The basic characteristics of a regulator can be edited here. The 

critical aspect of a regulator, the shock curve, can only be edited through the Regulator Database edit 
form.  

Gases 
 

Defines a mixture of gases that can be applied to airway gas simulation.  If the total volumetric 
concentration of gases defined is less than 100%, then the remaining volume will be used during 
simulation to allow airway gases to volumetrically balance into the remaining void.  This will retain the 
preset gas mixture of the defined gas value, but allow other undefined gases to change depending on the 

airway gas content at simulation time.  

Explosives 
 

Defines a mixture of explosion products for use in the Explosives Dynamic Simulation.  Typical yield 
products are included, such as Carbon Monoxide, Nirous Oxides and Ammonia. When these explosives 

are used, the explosion contaminant density is calculated from the sum of the yields provided in the 

Explosive preset. 

Filters 
 

Defines a range of standard filters that will have an effect across a range of the Ventsim simulation tools.  
The filtering efficiency can be specified for a range of contaminants, including Dust, Contaminant, DPM, 
Carbon Monoxide, Nirous Oxides.  There are also two optional fields, where the user can choose to filter 
any gas available in Ventsim.  The maximum velocity setting is used to provide a warning for when the 
maximum velocity of the filter is exceeded; adding more than one filter will reduce the velocity of air 
through the filter.  The rated and clear pressure drops are used to calculate the pressure drop across the 
filter, according to how dirty, or clogged, the individual filter is. 



 

 

12  SETTINGS 

 

Settings provide control over a large number of parameters used in VentSim for simulation, graphical 
display and file handling.  Settings are normally saved specifically for the file in which they are modified 
for, but can be shared with other files using the INHERIT function, or the MASTER LINK function. 

12.1. Costing 

Defines the mining and ventilation cost components of a model.  These figures are used in calculating 
optimum airway sizes, and total ventilation cost to run a modelled ventilation system. 
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12 



 

 

The symbol used for the local region currency value. This symbol will be 

applied in text displays and reports.  Ensure all costs defined in this section 
are set in the local region current value. 

The cost of mining a unit volume of rock for horizontal or inclined airways. 

This figure is an approximation used in the global optimisation routines to calculate 
efficient airway sizes.  If a mine has an approximate cost per linear distance (eg per metre) 
for each tunnel size, this can usually be approximated back to a fixed cost per metre and a 
variable cost per m3 which is largely consistent over different airway sizes.  VentSim uses 
both the fixed and variable component in calculating total airway cost. 

The cost per unit volume for mining vertical or inclined ROUND shafts.  As with 
horizontal costs, this can be approximated if the linear cost of vertical airway mining is 
converted to a fixed linear and variable unit volume cost.  VentSim uses both the fixed 

and variable component in calculating total airway cost.  VentSim assumes any airway with a 
slope greater than 45 degrees is defined as a vertical airway. 

The cost per unit volume for mining vertical raises that are NOT ROUND.  The 
cost basis for a raisebored airway (round) and a blasted vertical area (eg a winze or 
Alimak raise) are normally very different, hence this category allows costs of different 

types of vertical development to be differentiated.  VentSim assumes any airway with a 
slope greater than 45 degrees is defined as a vertical airway. 

The purchase cost is an approximation of a fan total cost per unit of power.  
For example a cost estimate of $1000 per kW, would mean a fan of 30kW in size would 
cost $30,000 to purchase.  This figure is used in the optimisations to estimate fan costs 

for different fan power requirements.  This cost should be calculated to include the electrical 
infrastructure and installation costs as well as the fan purchase cost. 

The expected average mine life of airways in the mine.  This figure is used by the 
optimisation to estimate to power costs consumed over the life of an airway. 

The discounted rate of future costs to determine the present value of expenditure 
on power over the life of the mine.  Values higher than zero (0) will decrease the 
significance of (discount) future cost savings, placing more importance on initial capital 

costs such as the airway mining cost and the fan purchase cost. 

The cost of power supplied to the mine.  The power cost is used to calculate 
the ventilation cost of running a mine model, and applied to all fans, fixed 
quantities and fixed pressures.  The power cost is local currency unit 

dependent.  Total power costs for mine model will be displayed as a factor of 
this value.   

HINT : To gain the true operating cost of a ventilation model, users should consider including a maintenance and depreciation 
component in the power cost to cover the future cost impact of maintenance, repair and replacement of ventilation infrastructure. A 
value of 15% – 20% additional cost to the power cost can be typically used. 

  

Currency 

Cost Horizontal fixed 
and variable  

Cost Shaft  

Cost Vertical Other 

Fan Purchase Cost 

Mine Life 

NPV Rate 

Power Cost 



 

 

12.2. General 

 

General factors describe default airway sizes and settings when first building a model, as well as file 
saving and loading behaviour in VentSim. 

Airway Defaults 
Various defaults used by VentSim in establishing airways without defined dimensions. 

Default shape of airway. 

Default fan motor efficiency to apply to calculated fan shaft power to 
estimate the electrical power absorbed by the fan motor.  In most cases it 

will be around 95% for direct drive electrical motors, or as low as 80 – 85% 
for offset or gear drive fans. 

Default efficiency factor to apply to motor shaft power calculations for fixed 
quantities and fans without efficiency or power curves. 

Default friction (K) factor to apply to new airways 

The number of the friction factor type to use on a default airway 

Default view layers to set to new airways. 

Default resistance to apply if resistances are set in airways which have 
reversed airflow AND the ‘restrict’ reverse airflow button is pressure.  This is 

only applied if no reversing resistance already exists for the preset item.  For 
example a resistance for a door may be 10 during normal flow direction, but 

may reduce to 0.5 when the airflow is reversed and the door swings open.  
Once again, this figure is ONLY applied if the ‘restrict reverse airflow’ option is 
chosen in the EDIT box, AND there are no pre-existing reversing resistances set 
in the resistance preset spreadsheet. 

Default layers to apply for new airways.   

Default size of new airways.  Imported DXF and text files without specific 
airway size will also be set to these values 

Airway Shape  

Efficiency Fan Motor:  

Efficiency Fan Fix:  

Friction Factor  

Friction Factor Type  

Primary  Secondary 
Layer   

Reversing Default 
Resistance 

Layers – Primary and 
Secondary 

Size Width, Size Height, 
Size Area 



 

 

Hint : Airway defaults are normally only applied if airways are constructed without connection to other airways.  Where airways are 
connected to existing airways, they will INHERIT the settings of the airways the new airways is connected to.  This behaviour can be 
modified from the EDIT > NEW AIRWAYS menu item. 

File Settings 
 

Forces VentSim to make a backup of the currently worked model every 5 
minutes.  If the program crashes, or is forcibly exited, the backed up model 
will be loaded automatically next time the program is run. 

Warning – if the model has become corrupted for some reason, there is a possibility that the auto-saved model may also be corrupted.  
For this reason, it is recommended that a model be regularly saved to ensure that good working copies are available as backups if 
required. 

Automatically performs an heat simulation when the file is loaded.  This will 
update heat simulation summary parameters and a number of calculated 

heat parameters only available after a simulation 

Automatically performs an heat simulation when the file is loaded.  This will 

update heat simulation summary parameters and a number of calculated 
heat parameters only available after a simulation 

License Settings 
Alters license activation settings which may be required to allow VentSim to access the internet to validate 
licenses.  VentSim normally uses Microsoft Internet Explorer settings to access the internet, however on 
occasions third party programs like VentSim may be denied direct access, requiring the proxy name and 
proxy port address to be entered manually. 

These values can also be adjusted in the License Manager form. 

12.3. Graphics Settings 

Control the various aspects of the screen graphics and presentation. 

 

 

  

Auto Backup 

Maximum Airway 
Numbers 

Maximum Reference 
Elements 



 

 

Background 
 

Sets a preset or custom picture to the background of the visual display.  This 
may provide some visual flair for presentations or may simply suit the users 
preferences.  An option exists to use a preset background (current CLOUDS 

or GROUND), or a custom background picture can be displayed by simply 
dragging a picture file from windows on to the screen. 

Tints the background picture using the Screen Colour Top and Bottom 
settings.  Note that a black screen colour will totally hide the pictures, while 
a white screen colour will fully show the picture in natural colours.  

Colour of upper and lower halves of background.  The colours are smoothly 
blended to provide a gradient effect. Lighter colours may be more 
appropriate for presentations and report. 

 
Dark and stormy background image 

Colours 
 

Controls the relative brightness and intensity of the colour displays on screen. 

Colour of grid lines. 

Colour of semi-transparent edit plane sheet shown during vertical drawing 
operations. 

Colour of the airway data.  Text colours may need to be adjusted to provide 
contrast if the background colours are adjusted. 

Colour of the airway text names and error messages.  Text colours may need 

to be adjusted to provide contrast if the background colours are adjusted. 

Colour of the airway node names.  Text colours may need to be adjusted to 
provide contrast if the background colours are adjusted. 

Instructs the program to make the background white when printing a 
graphics model to a printer or saving the image to a file. 

The colour of selected airways.  The default colour is yellow, however 
sometimes this colour may not be as visible with lighter colour backgrounds. 

Background Picture 

Background Picture 
Tinting 

Background Colour 
Bottom and Top 

Brightness 

Grid Colour  

Grid Sheet  

Colour Text Data 

Colour Text Airway 

Colour Text Node 

Print to White 
Background 

Selection Colour 



 

 

The colour behind text on the screen if transparent text is not used. 

Controls 
 

 

Snap Tolerance 

Adjust the willingness of the VentSim 
cursor to adjust or join to other airways 

while drawing or moving airway items.  
For finer control (less propensity to 
connect to close airways) reduce this 
number (minimum 1, maximum 100) 

Use 3D Mouse 

Turns on an option to use a Connexion™ 

3D mouse.  This type of input allows for 

models to be rotated, panned, and 
zoomed with a single control, leaving the 
regular mouse free to operate menus and 
selection duties.  This option will have no 
effect if a Connexion™ 3D mouse is not 
present. 

Coordinates 
 

Defines the direction of grid north on the screen.  Therefore, if grid north 
direction is defined as UP, then the Northing coordinate numbers will start 
lower from the screen bottom, to higher numbers towards the screen top.  If 

a GRID NORTH system is not chosen, then this setting will show CUSTOM. 

Most mines use a GRID NORTH system.  VentSim’s coordinate convention 
when using grid north coordinates is Easting, Northing and Elevation in that 

order.  If another type of system is used, then an XYZ system can be 
specified, which allows for orientation of coordinates in any direction.  Some 
VentSim CLASSIC models use a custom system and in this will likely be 
automatically set when a VentSim Classic model is imported. 

Defines the centre of the grid system from which the grid lines will be drawn.  
Note that this can only be specified if Automatic Grid Centering is turned OFF 
(otherwise the centre numbers will be automatically adjusted when the 

model is viewed or reloaded).  

The range of elevations to show around a single selected level.  Selected 
levels may be chosen from the RIGHT CLICK mouse popup menu, and limit 
the range of airways data shown on screen. 

This option should only be used for CUSTOM grid orientation.  Grid NORTH 
orientations do not require these settings to be adjusted. 

The spacing between grid lines on the screen. 

 

Text Background 

Grid North Orientation 

Grid System 

Coordinate Centre 

Level Range 

Orientation of Elevation, 
X Axis, Y Axis 

Spacing for Grid 



 

 

Icons 

 

Figure 12-1  Graphics Setting Options 

Controls the display of resistance icons where airways have been assigned a 
custom resistance.  Only airways with a resistance above the threshold will 

have an icon displayed. 

Shows transparent sides for icons over airways. 

Rendering 
 

An advanced graphics option (not supported by all graphics card) which 
smooths the appearance of the edges of solids to give a visually more 
appealing look.  The option may significantly slow some graphics cards or 

cause graphics irregularities.  By default, it is set to FALSE. 

 

 

 

 
Figure 12-2  Graphics Setting Options  

Removes hidden surfaces from the display.  This may make older graphics 
cards more responsive in displaying complex graphics. 

Hides text while model is rotated or zoomed.  Very large models with lots of 
text can slow or make smooth rotation movements unresponsive.  Use this 

option to hide text and make rotation movement much smoother. 

Custom Resistance 
Display Threshold 

Transparent Icons 

Anti-aliasing 

Backface Culling 

Hide Text While Rotating 



 

 

VentSim model rotation results in a short period of continued rotation after 

the mouse is released.  This is purely for visual appeal and is provided to 
give models the illusion of ‘weight’ and solidity.  The speed at which rotation 

is damped can be adjusted or turned off using these settings.  

HINT  To allow the model to rotate freely without stopping, choose a damping level of zero (0), or HOLD THE CTRL key down when 
rotating a model with the mouse. 

Hide or shows arrow, node and text data by default.  This can be used to 
improve display clarity by removing unnecessary graphical details.  Note that 

this function can be overridden from the View menu options or the RIGHT 
click context menu options for text and other graphical items. 

The rate at which to update the screen graphics.  To conserve laptop battery 
power, the minimum frame rate option is available to reduce power when 
VentSim DESIGN™ is not the active program in Windows. 

Size 
 

Scales airways graphically so they appear larger or smaller than the specified 
dimensions.  This does not change the calculated airway size.   A factor of ‘1’ 

is normal scale.  Factors larger than one will enlarge airway graphics while 
factors smaller than ‘1’ will shrink airway graphics.  This function may make 
very large extensive models larger and easier to see, or conversely can make 
very small model (eg lab scale apparatus) also easier to see. 

Size of airway text displayed on model.  Larger text sizes are generally 
clearer to read, however excessive data may clutter display.  

The size of the nodes, icons and arrows.  Note that the size reduces in 

wireframe mode to improve display legibility. 

The size of the nodes, icons and arrows.  Note that the size reduces in 
wireframe mode to improve display legibility.  In Solid mode, Icons and 
Nodes will not be reduced smaller than the airway size. 

Text 

 

Allow selection of the type of FONT to display on the screen. 

Display text on icons with heat sources.  

Shows the thermodynamic setting names on the airways they are attached 
to. 

Hides text beyond a defined distance from the display front.  For large 
models, this can speed up display. 

Display text showing fan name description 

Rotation Inertia / 
Damping 

Show All Arrow/ Node/ 
Text data. 

Maximum / Minimum 
Frame Rate 

Airway Scale 

Size Data Node Airway 
Text 

Size Node, Icons, 
Arrows 

Size Node Icons/Arrows 

Font for Text 

Icon Heat Test 

Show Heat Text with 
Airway Text 

Maximum Distance for 
Text 

Show Fan Description 

Text Transparent 



 

 

The background for text characters is shown as a solid colour, or transparent.  

Turning off text transparency can improve clarity of text graphics, but will 
obscure the airway graphics behind the text. 

[TRUE] Text labels backgrounds are transparent and show graphics under 
the label. 

[FALSE] Text label backgrounds are solid and do not show graphics underneath.   
In some cases, this may improve the legibility of text. 

[TRUE] Reduces the size of text labels relative to distance away from view 
camera.  This make close airways larger and more legible and distant airway 
text smaller. Simulation – Airflow 

12.4. Simulation 

Airflow 
Simulation airflow settings directly influence how the airflow simulation operates. 

 

Figure 12-3  VentSim DESIGN™ Settings  

Defines the level of accuracy VentSim must resolve down to before an 
acceptable solution is displayed.  This should normally be set to less than 0.1 
m3/s error.  If a final analysis is required it may be advisable to set this to 

0.01 m3/s or lower.  The smaller the value, the more accurate the simulation 
process, but the longer it may take. 

Automatically performs an airflow simulation after every modification to a 

model.  This will conveniently display airflow amounts and directions without 
having to simulate the model.  For large models, or models undergoing 

extensive modifications, it may be preferable to turn this function off, as it will 
slow down editing and view functions. 

 

Text Scale Relative 

Allowable error 

Auto simulation 



 

 

Use compressible airflow simulation techniques. 

Compressible airflow has a significant influence when simulating deeper 

mines.  In deeper mines (greater than 500m) or when heat simulation is used, 
it is recommended that compressible airflow be set to True. 

When set to True, VentSim DESIGN™ will assume compressible air, and adjust 
air densities, volumes and fan curves according to airway depth and 
corresponding density.  In the Advanced version, temperature effects on density 
are also taken into account when Heat simulation is run in conjunction with air 
simulation. 

Airflows and fan curve performance after simulation is shown according to the 
density of air at the location of the airway. 

Enables the simulation to adjust the friction factors to the local airway 
density.  As resistance is a factor of friction, this will in turn adjust the airway 

resistance value. This setting is set to YES by default.  

When set to YES, all preset friction factors are assumed to be specified at the 
reference density specified in each factor preset (normally 1.2kg/m3).  If 
compressible airflows are enabled, the factor will be adjusted to the simulated 
local air density.  If incompressible flows are used, the factor is adjusted to the 
standard environment density setting.   

If this setting is not enabled or the airway EDIT form has set the value to 

‘Already Adjusted’, then the actual value entered in the preset will not be 
adjusted. 

Enables the simulation to adjust the preset resistance values to the local 
airway density.  Preset resistance values do not use friction factors, therefore 

any friction factor setting is ignored. 

When set to YES, all preset resistances are assumed to be at their preset 
reference density (normally 1.2kg/m3) and will be adjusted to suit the local 
airway conditions.  If compressible airflows are enabled, the preset value will be 
adjusted to the simulated local air density, otherwise the value is adjusted to 
the standard environment density setting.   

If this setting is not enabled or the airway EDIT form has set the value to 

‘Already Adjusted’, then the actual value entered in the preset will be used. 

HINT : Density adjusted friction and resistance values are a potential source of confusion.  Most text books will quote friction and 
resistance values standardized to a 1.2kg/m3 air density.   If standard values are used, ENSURE that both of the Density Adjust 
options are set to YES, and the reference density set in the Presets is 1.2 kg/m3 or equivalent. 

If resistance or friction values are measured locally however, then the values obtained are only valid for the density at which they 
are measured.  To use measured values in VentSim, you will need to consider one of the following options. 

OPTION 1 : If all preset values are measured at the true mine density and will not be used or duplicated elsewhere in the mine, then 
simply set the “ density adjust” setting for resistance and/or friction values to ‘NO’ 

OPTION 2 : If only some values are measured and other values are standardized to 1.2kg/m3, then you will need to use the EDIT 
form setting to set individual airways to ‘Already Adjusted” (the check box next to the resistance or friction value) 

OPTION 3 : To avoid the potential confusion of Option 2, you may want to simply convert all of your measured values (at the local 
mine density) to a 1.2kg/m3 standard and set both settings to YES.  This also has the benefit of allowing the setting to be used 
elsewhere in the mine at different densities. 

[TRUE] VentSim DESIGN™ will ignore all warnings related to No Entry or No 
Exit errors found during simulation (airways with no other airways joining) 

Compressible Airflows 
[Advanced] 

Density Adjust Friction 
Factors 

Density Adjust 
Resistance Factors 

Ignore Warnings 



 

 

[FALSE] VentSim DESIGN™ will only ignore airways which have been set to 

Allow Closed End in the Edit box.  Any other ‘orphaned’ airways will cause the 
simulation to show warnings. 

Sets the number of attempts VentSim DESIGN™ can take to achieve an 
acceptable error, before the program abandons the simulation process. 

The maximum pressure the simulation will allow between airways before a 
simulation error is reported.  This error may indicate unreasonable fixed 
flows or resistances which interact and cause large pressure changes in the 

model.  

Modifies the VentSim DESIGN™ simulation algorithm to give fans additional 
priority when forming meshes.  Normally this is desirable and should be set 
to on, unless unstable or lengthy model simulation occurs. 

Modifies the VentSim DESIGN™ simulation algorithm to give mesh forming 

priority to surface connected airways. This normally ensure rapid solving of 
model simulations, however for models with extensive surface connected 

airways this may cause simulation balancing issues, and turning off this option 
may give better results. 

Defines the shock loss method to use. VentSim DESIGN™ can be set to 

calculate shock losses using the equivalent length method, or the shock 
factor (X) method.  Shock loss calculations are necessary to estimate 

pressure loss due to air turbulence cause by a change in airway direction, a 
junction or a change in airway size.  Note that changing this value in an existing 
model will result in VentSim DESIGN™ requesting to recalculate the shock 
losses using the alternative system. 

The equivalent length method requires the user to estimate an equivalent extra 

airway length required to approximate pressure loss due to shock.   

The shock factor (X) method uses a calculated factor derived from both 
empirical and calculated changes in airway areas and velocities.  Both methods 
are described in any number of ventilation texts. 

Once the method is set, the Edit Box will require an appropriate shock loss value 
for each airway.  The Edit Box can accept a manually entered number, but also 
has a number of preset values, as well as an AUTO function which will force 

VentSim DESIGN™ to attempt to calculate a shock loss factor or an equivalent 
length. 

Defines the minimum resistance at which VentSim DESIGN™ will completely 
stop all airflow in an airway.   All preset resistances above this value will 
cause airflow in the set airway to completely stop.  Only one Preset 

Resistance value should be greater than the Stop Resistance value.  This 

function artificially restricts airflow and has the potential to cause simulation 
problems if used on too many airways.   The simulation will check and ensure 

that only one (or nil) preset resistances are greater than this value.  

[TRUE] Forces VentSim to calculate natural ventilation pressures derived 
from air heat and density differences in the underground model.  Natural 
ventilation pressures can sometimes produce unstable simulation air flows 

due to dynamic changes in airflow affecting subsequent heat balance 

simulations. This is discussed further in the Heat Simulation section.   If this 
problem impacts heat simulation, providing natural ventilation pressures are not 
critical it is suggested to set to it to False to produce a stable simulation. 

[FALSE] Ignore natural ventilation pressures.  Where heat simulation is not 
required, or natural ventilation pressures are not likely to be significant in a 
mine, it is suggested that this setting be set to FALSE.  

Iterations 

Maximum Simulation 
Pressure 

Mesh Fan Priority 

Mesh Surface Priority 

Shock Loss Type 

Stop Resistance  

Use Natural Ventilation 
Pressures 



 

 

Applies velocity pressure losses to exits to atmosphere.  Auto will detect if the 

user is using Fan Total Pressures or Fan Static Pressure curves in the model, 
and choose whether to apply velocity pressure losses during simulation.  If 

Fan Total Pressure curves are used exclusively, then velocity pressure losses will 
be calculated and applied to the system resistance.  Include will force the 

software to include any lost velocity pressures.  Ignore will force the software to 
ignore and not use velocity pressure in system resistance calculations.  

Limits the maximum velocity pressure applied.  Velocity pressure is 
calculated based on simulated airflow velocity, and is used for system exit 
losses, and barometric pressure calculation within the mine.  To prevent 

unreasonable simulated velocities (from very small airways for example) 
causing errors, this option limits the maximum pressure usable by the 

calculations. 

If set to TRUE,  and an airway is specified in the EDIT form with a FIXED 
DIRECTION, VentSim DESIGN™ compares airway directions before and after 

a simulation and alerts the user which airways have airflow that has changed 
direction during simulation. 

If set to TRUE, VentSim DESIGN™ will perform a check on all up casting 

vertical or semi vertical (>45 degrees) airways.  The water suspension 
phenomena occurs on water droplets where the up casting air velocity 

friction is counteracted by gravitational forces, forming a suspended column of 
water droplets which can greatly increase shaft resistance and pressure.  This 
can only be overcome by reducing airflow velocity allowing water to fall to the 
shaft bottom, or increasing velocity to carry the water out of the top of the 
shaft.  The exact critical velocity depends on shaft size and geometry, as well as 

water droplet size and geometry of entry into the shaft. 

The upper and lower limits at which VentSim DESIGN™ will flag a warning if 
water suspension checking is optioned.  Warnings do not affect simulation, 
but simply alert users to potential problem areas.  

Water suspension is unlikely to be a problem in shorter shafts.  This setting 
allows the simulation to ignore shafts that are less than a defined length. 

The flow at which VentSim DESIGN™ assumes ‘zero’ flow.  This function 

does not directly affect simulation, and is simply used to determine whether 
airways are displayed when the ‘zero flow’ graphical option is used to hide 

airways with no flow. 

Contaminants  
The default contaminant values and factors to use in simulation.  In most cases these values can be 
overridden in the Edit > Contaminant box. 

 

Figure 12-4 Simulation Contaminant Settings 
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An arbitrary unit defining the volume concentration value of the contaminant 
simulation.  VentSim defaults to a unit-less value, which normally represents 

a percentage, however any volumetric portion unit such as ppm or mg/m3 
could be used.  Results of the simulation shown will be representative of the 
original value entered in the contamination value field. 

The default amount of contamination to place in an airway if the contaminant 
tool button is clicked.  For steady state simulation, this would normally be 
the maximum concentration expected through the model unless recirculation 

or upstream contaminant sources are present.   

For dynamic state simulation, this should be considered the average 
concentration of the contaminant volume to be cleared.   

The default diesel emission factor to use, if the preset heat sources do not 
have a specified factor.  It is normally recommended that preset heat 
sources each have their own defined diesel particulate emission value.  See 

DPM Simulation for further information. 

The value at which dynamic contaminant simulation will stop if every airway 

in the mine is below this number.  It is suggested this threshold should be 
set to a number equivalent to safe access for the area.  

Dynamic Simulation 
 

 

Dynamic simulation factors control simulation parameter required during dynamic simulation or when 
using the VentFIRE™ option. 

The increment at which VentSim will advance the dynamic simulation.  
Smaller increments result in more accurate simulation and greater sub cell 
formation, however will take proportionally longer to simulate. 

Warning – because of the way sub-cells work, it is not recommended to use large increments, as this will result in a loss of fidelity and 
accuracy in dynamic modelling.  If airflow travels the length of an airway faster than the time increment, then the movement of cells 
through that airway is capped at the time increment, resulting in a small inaccuracy in time calculated to travel through the airway.  
Extensive occurrences of airways like this will cause simulation inaccuracies, generally resulting in slower dispersion times than actual.   

Howden recommended increments of one second (or less) where possible, and does not recommend increments more than 10 
seconds for most conventional models. 

The frequency per increment at which airflow simulation will occur if 
selected.  For example, a frequency of ‘10’ will perform an airflow simulation 
every 10 dynamic increments.  Airflow simulation is an intensive calculation 

and for larger models it is recommended to increase the frequency factor (which 
will decrease the actual frequency) of airflow simulation to reduce simulation 
time. 

Contamination Unit 

Default Contamination 
Value 

Diesel Particulate 
Emissions 

Dynamic Contaminant 
Threshold 

Dynamic Increment 

Frequency Airflow 
Simulation 



 

 

The frequency per increment at which data from the simulation will be 

collected for airways with a monitor in place.  For example, a frequency of 
‘10’ will collect data once every 10 increments. 

The frequency at which the screen will be updated and graphically show the 
progress of the simulation.  For example, a frequency of ‘10’ will display the 

graphics every 10 increments iterations.  Lower numbers will result in a 
smooth display update, but will slow down simulation, particularly for large 
models. 

The number of data points available for recording monitor location results 
during dynamic simulation.  For length simulations or models with a large 
number of monitors, this may need to be increased.  If a simulation exceeds 

the available number of points, it will ignore the overflow. 

The number of sub cell divisions that airways are divided into during dynamic 
simulation.  Each sub cell moves independently through a model during 

simulation, collecting gases, heat, and contaminants.  Cells movements and 
speed is controlled by the air simulation.    

Note : VentSim will always target the maximum number of sub cells, however the number of cells cannot be more than the time it 
takes to travel one increment of time.  Therefore, for example if an airway passes air from start to end in 10 seconds, and the 
dynamic increment is 5 seconds, then a maximum of only two sub cells could be placed in the airway.  Smaller dynamic increments 
will generally allow more sub cells to be used, resulting in more accurate, but slower simulation. 

For small models, the simulation may progress too fast to visually track 
changes.  A simulation pause (in milliseconds) can be entered to slow 
simulation down.  For larger models, it is suggested to keep this pause to 

zero (0) to prevent unnecessary simulation delays. 

The time period for a simulation to complete (in seconds).  For example, 
7200 is equivalent to running the dynamic simulation for two (2) hours.  At 
the end of the simulation time, VentSim will ask if the user wishes to 

continue the simulation. 

 

Simulation Environment [ADVANCED] 
The environment factors describe values used by physical items within the model.  They are critical to 
identify the base starting points of a ventilation simulation, or providing default air or heat simulation 
parameters to airways that do not have specific values set. 

 

Figure 12-5 Simulation Environment Settings 

Frequency Log Data 

Frequency Screen 
Update 

Maximum Data Logs 

Maximum Subcells 

Simulation Pause (ms) 

Simulation Total Time 



 

 

Defines the air density to use at the surface datum elevation.  Note that this 

value is automatically linked to the surface barometric pressure and surface 
elevation above sea level, and will change both of these values if changed.  

Only one of these values types needs to be changed.  

Compressible flow simulation means that the model air densities will be different 

through the model.  The air density of the airways through the model is based 
on the barometric and fan pressure at each location, and the calculated heat 
temperatures. Therefore this value only defines the air density on the surface at 
this specific elevation.  All other densities in the model are automatically 
calculated during simulation.  Density sensitive items such as fan curves, pre-
set resistances and friction factors are also automatically adjusted for different 
densities. 

Defines the default air density to use in the model if incompressible flows are 
used (this is standard behaviour with VentSim DESIGN™ Standard and 
optional with VentSim DESIGN™ Advanced).  All airways, resistance, friction 

factors and fan curves will be automatically adjusted to this air density.  

The calendar year at which the simulation takes place.   

VentSim DESIGN™ uses this value to calculate the age of an airway 
underground, if the individual airway age is entered as a calendar year (such as 
‘2005’ in the EDIT box).  Where an airway age is entered as a time value (such 
as ‘3.5’ years), the Current Year value is ignored. 

HINT  Where true airway ages have been entered as a calendar year within a model, the Current Year setting is useful for ‘ageing’ a 
mine and determining future cooling requirements.  Heat flow from virgin rock strata decreases exponentially over time as the rock 
is cooled, and future cooling requirements can potentially be lower than current cooling requirements as a result. 

The rate at which rock increases in temperature at depth.  This is assumed to 
be a linear value.  Geothermal gradients show significant differences at 
different points around the earth, and can be as low as 1 degree Celsius per 

100m to more than 10 degrees Celsius per 100m.  This value should always be 
adjusted to suit the conditions at or near your mine. 

HINT  In some cases, the temperature gradient may not be close to linear, particularly in near surface portions of the mine.  The near 
surface rock temperature may be influence heavily by climatic conditions on the surface.  The best approach is to calculate to 
gradient over the unaffected deeper underground portion of the underground mine (which a subject to the majority of heat 
influence), and project this temperature gradient to the surface elevation.  Enter the ‘Surface Rock Temperature’ setting as this 
calculated value, not the true surface rock temperature. 

Orebody Type Degrees C/100m Degrees F/100ft 

 Min Max Min Max 

Copper Ore body   2.5    7.7    1.4    4.2  

Carboniferous   2.0    5.0    1.1    2.7  

Clays   3.3    3.3    1.8    1.8  

Limestone   1.8    1.8    1.0    1.0  

Sandstone   1.7    3.3    0.9    1.8  

Dolerite   3.0    3.0    1.7    1.7  

Quartzite   0.8    1.5    0.5    0.8  

Potash Low Grade   1.3    1.7    0.7    0.9  

Air Density 
Compressible Flow 

Air Density 
Incompressible Flow 

Current Year 

Geothermal Gradient 



 

 

Potash High Grade   0.8    1.3    0.5    0.7  

Halite Low Grade   1.4    4.0    0.8    2.2  

Halite High Grade   1.0    1.4    0.5    0.8  

Table 12-1 Examples of Geothermal Gradients found in areas around the world – these values are regional only and should not be used 
for all mines 

 

The Default Age of an airway opening in years.  Airways without a specified 
age set in the Edit Box, will be assigned this default airway age.  Establishing 
airway age allows VentSim DESIGN™ to more accurately calculate 

geothermal heat flow into an airway.  Geothermal heat flow decreases with 
airway opening age. 

The default fraction of airway rock surface that is wet.  Most rock surfaces 

underground have some degree of moisture.  The wetness fraction defines 

what average portion of rock surfaces are considered wet.  A value of 0.01 
would define a very dry airway, while a value of 1.0 would define a fully wet 
airway.  This value will be assigned to airways without a set wetness fraction 
from the Edit Box, and directly affects the amount of moisture available to 
evaporate into the air passing the rock surface. 

The default density of rock underground.  This value is applied to an airway, 
if it has not already been set in the airway Edit Box.  Rock density is a 

property which describes the mass of rock per unit volume.  Rock density is 
used by VentSim to calculate the thermal diffusivity of rock material.  Rock 
Density is not required if thermal diffusivity has already been set.  If this value is 
changed, the user will be prompted to allow VentSim to auto calculate the rock 
diffusivity. 

The default Specific Heat of rock underground.  This value is applied to an 

airway, if it has not already been set in the Edit Box.  Rock Specific heat 
describes how much heat must be absorbed or emitted to raise or lower the 

rock temperature. 

The default Thermal Diffusivity of rock underground.  This value is applied to 
an airway, if it has not already been set in the Edit Box.  Rock Thermal 
Diffusivity is a property which describes the ability of rock to diffuse or 

transmit contained heat over a unit area per unit of time.  Rock with high 

thermal diffusivity more rapidly adjusts its temperature to that of the 
surroundings, because it conducts heat quickly in comparison to its heat 
capacity or 'thermal bulk'.  Because diffusivity is directly related to density, 
thermal conductivity and specific heat by formula, rock thermal diffusivity is 
required only if rock density has not been set.  If this value is changed, the user 
will be prompted to allow VentSim to auto calculate the rock density. 

The default Rock Thermal Conductivity..  This value is applied to an airway, if 

it has not already been set in the Edit Box.  Rock Thermal Conductivity is a 
property which describes the ability of rock to transmit heat through its 

mass. 

The Default Surface Temperature Conditions of air entering a mine.  All air 
intakes into the mine are assigned the default surface temperatures.  The 
temperatures and Surface Barometric Pressure are used to calculate the 

surface air density. 

HINT: In rare cases, a mine may have multiple intake airways with a range of elevations so great that different temperatures may be 
present at each intake.  As the Surface Barometric pressure is defined for a single Surface Elevation, Barometric Pressures will be 
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correctly recalculated for differing intake elevations; however temperatures may need to be manually corrected.  Temperatures can 
be adjusted by place a heat or cooling source at the inlet of intakes to produce differing temperatures. 

The Barometric Air Pressure at the Surface Elevation.  The surface barometric 
pressure is important as VentSim DESIGN™ calculates mine air densities 
from the surface barometric pressure and wet and dry bulb temperatures.  

Note that this value is linked to the surface air density and height above sea 
level, and will change these values also if adjusted.  If the surface barometric 
pressure is not known, either the density or elevation above sea level can be 

adjusted instead.  Only one of these values needs to be set. 

The elevation (or ‘reduced level’) where a specified point in the mine exits 
the surface. All other surface related settings (such as surface temperatures, 
pressures and rock temperatures) are assumed to be at this elevation. This 

is the grid coordinate Z of the mine.  It is not necessarily elevation above sea 

level as the grid coordinates could be set to a different datum. 

If this value is set to zero (0), VentSim will search and use the highest point in 
the model. 

The estimated elevation of the surface datum above sea level. It is optional 
only, and will be automatically estimated in the surface barometric pressure 
or density is changed.  If changed, it will automatically recalculate and 

estimate the surface barometric pressure and density. 

The temperature of virgin rock at the Surface Elevation.  All virgin rock 
temperatures underground are calculated from this base elevation by using 
the Geothermal Gradient. 

Examples of Rock Properties 
 

Rock Type Thermal 

conductivity 

Specific 

Heat 

Thermal 

Diffusivity 

 W/mC J/kgC m2/s 10-6 

basalt 1.80 840 0.74 

coal 0.33 1300 0.20 

dunite 4.30 820 1.64 

gabbro 2.10 800 0.97 

gneiss 2.90 800 1.29 

granite 3.00 790 1.41 

limestone 1.30 840 0.64 

magnetite 4.41 600 2.10 

marble 2.60 880 1.18 

potash 3.50 690 2.55 

quartzite 5.25 800 2.43 

quartzite 3.00 800 1.39 

rock salt 4.48 880 2.04 

sandstone 1.70 920 0.71 

shale 1.23 850 0.55 

                      Table 12-2  Metric Examples of Airway Rock Physical Parameters 
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 Btu/h/ftF Btu/lbF ft2/h 

basalt 1.04 0.20 0.029 

coal 0.19 0.31 0.008 

dunite 2.48 0.20 0.064 

gabbro 1.21 0.19 0.038 

gneiss 1.68 0.19 0.050 

granite 1.73 0.19 0.055 

limestone 0.75 0.20 0.025 

magnetite 2.55 0.14 0.081 

marble 1.50 0.21 0.046 

quartzite 3.03 0.19 0.094 

potash 2.02 0.18 0.099 

quartzite 1.73 0.19 0.054 

rock salt 2.59 0.21 0.079 

sandstone 0.98 0.22 0.028 

shale 0.71 0.20 0.021 

Table 12-3  Imperial Examples of Airway Rock Physical Parameters 

Warning – These are examples only.  Rock characteristics vary widely for different rock types and locations.  Where possible, 
characteristics should be measured by laboratory analysis. 

Explosive 
The gas density of the contaminant gas of concern from the explosive 
reaction.  For example, if Carbon Monoxide is the main gas of concern, then 

a gas density of 1.16 kg/m3 could be used.  VentSim uses this density figure 
to convert the yield mass into a volume. 

The mass ratio of contaminant (of concern) produced per equivalent mass of 

explosive detonated.  For example, if Carbon Monoxide was the gas of 
concern in an explosive detonation, tests by Orica reveal that approximately 

0.015 kg of carbon monoxide is produced for every 1.0kg of explosive 
detonated.  Therefore the contaminant yield for CO is 0.015. 

Further information regarding contaminant simulation can be found in the Run > 
Contaminant section. 

Fire [PREMIUM] 
 

 
The portion of fuel converted to heat defined under the ‘Heat of Combustion’ 
of the fuel source.   

Contaminant Density 

Contaminant Yield 
Amount 

Combustion Efficiency 



 

 

Note: The combustion efficiency of an underground fuel fire will generally be less than 100%.  Combustion efficiency generally 
depends on the availability of oxygen to all parts of the fire and the heat generated by the fire.  In many cases, the efficiency may be 
a little as 75% or less, although if this is not known, using 100% is considered a more conservative approach. 

The amount to shift the equivalence ratio towards or beyond the fuel rich gas 
generating zone. 

Equivalence ratio is the ratio of available oxygen to the fuel burn rate to produce 
a perfect stoichiometric reaction.  An equivalent ratio of ‘1’ would mean that 

there was exactly enough oxygen provided to perfectly burn a defined mass of 
fuel.  An equivalence ratio of less than one would mean that the amount of 
oxygen exceeds the rate at which the fuel consumes it (oxygen rich fire).  An 
equivalence ratio of greater than one means that insufficient oxygen is available 
to burn the fuel mass, resulting in incomplete combustion gases and pyrolised 
hydrocarbons (fuel rich fire). 

Note; For perfect combustion in an ideal environment, fires produce very little carbon monoxide where equivalent ratios are less 
than 0.5.  The rate of carbon monoxide production increases as the equivalent ratio approaches 1.0, and the yield rate generally 
peaks at a ratio of around 1.3.  VentSim will alter the generation of CO2 and CO gases based on the equivalence ratio, and the 
combustion yield factors used in the preset.   

For an underground fire in a confined place at extreme temperatures, even in the presence of a theoretically excess amount of 
oxygen, a fire can produce significant amounts of incomplete or ‘chemically reduced’ combustion products.  To force VentSim to 
produce higher amounts of carbon monoxide, the equivalence ratio can be moved towards ‘fuel rich’ results by adding a shift factor.  
If in doubt as to the behaviour of the fire, it is suggested to use a shift factor of ‘1’ or more to force the maximum amount of Carbon 
Monoxide to be produced. 

VentSim will modify the defined fuel burn rate based on the oxygen limits to 

produce a more realistic fuel burn profile. 

For example, most open flame sources will diminish significantly below 15% 
oxygen, and continue diminishing as oxygen levels reduce further.  Between the 
upper and lower limit, VentSim will limit the fuel burn to proportionally less than 
the defined amount set in the airway, reducing combustion rates linearly 
between the upper and lower limits.  Combustion of the fuel will cease below the 

lower oxygen limit. 

To disable this behaviour, set both limits to zero (0). 

Controls the maximum flow of moisture to a rock surface available for 
evaporative cooling in millimetres (mm) per second surface coverage.   A 
default of 0.1mm is suggested. 

Wetness fraction settings for rock influences evaporative cooling of airflow 
flowing past a rock surface.  In the event of a fire, the rate of evaporation can 

easily exceed the rate at which water will replenish the rock surface.  Therefore 
it is important to limit the flow of water otherwise the hot air from a fire will be 
artificially cooled at a rate much greater than would be possible in a real life 
scenario. 

Maintains a minimum flow of heat from the fire source, even if insufficient 

oxygen causes combustion rates to fall below this level. 

Heat from a fire does not immediately cease if the combustion is reduced or 

ceased by lack of oxygen.  Significant amounts of heat may be stored within the 
combustible structure mass and may continue to be released even without 
direct combustion.  To ensure the simulation continues to receive at least some 
heat during periods of low oxygen, this value can be set at a portion of the 
normal full combustible heat level. 

The modified radial heat transfer age coefficient VentSim uses for fire 
simulation. 

Equivalence Ratio Shift 

Limit O2 Upper Lower 

Maximum moisture 
release rate 

Residual Heat % 

Rock Absorptivity Age 



 

 

Normal steady state heat simulation requires a rock exposure age (in years) to 

modify the exposed rock mass to a temperature closer to the long term air 
temperature. 

For fire simulation, the rock mass surrounding the immediate airway is assumed 
to have cooled close to a long term air average, and the fire simulation assumes 

a rapid transfer of heat from the hot air back into the cooled rock mass.  To 
facilitate this rapid transfer, the rock must be assumed in the (Gibson’s heat) 
transfer algorithm to be ‘freshly’ exposed again.   

Note: A default value of 60 seconds is suggested, which provides rapid absorption for intense heat changes.   Values lower than this 
can cause over prediction of heat absorption of very hot air.   

For non-fire dynamic simulations, heat calculations can sometimes slightly exceed steady state estimates.  If dynamic simulations 
are required to closely match steady state simulations, it is suggested to increase this value substantially (the second equivalents of 
days, weeks or even months). 

 

The thickness of rock which is directly influenced from short term dynamic 
heat changes. 

This method allows an exposed surface rock layer of ‘skin’ to both store and 
release heat from rapid heat changes.   

While actual rock in this situation will theoretically build up a complex graduated 
heat profile based on changing heat and air velocity, this simplified method 

assumes a single homogenous rock mass skin that absorbs heat evenly, but 
beyond which no significant heat passes.  For short term dynamic simulation, 
this is a reasonable assumption.   

INFO : As this ‘skin layer’ heats and becomes closer to the temperature of the heated airflow, the rate of heat absorption will 
decrease. 

Conversely, if the fire heat reduces and air temperatures fall below the heated rock surface, this rock skin layer can rapidly release 
heat back into the airway airflow during simulation. 

Gas 
 
Use Gas Density for Air Simulation.  Uses the relative density of different gas compositions to apply natural 
ventilation pressures to airflow during simulation.  Gas compositions may be set using the gas options in 
the EDIT box, or from VentFIRE™ simulations. 

Heat [ADVANCED] 
 
Adjusts settings which directly influence how the heat simulation performs. 

Rock Boundary Heat 
Flux Limit 



 

 

 

Figure 12-6  Simulation Heat Settings 

The efficiency at which diesel engine mechanical output is derived from the 
total heat of combustion of the fuel source.  VentSim uses this value to 
convert diesel engine power sources into heat during simulation.  VentSim 

assumes by default all diesel engine output power AND wasted inefficiencies 
enter the airflow as latent and sensible heat.  The heat calculated from a diesel 
engine is  

𝐻𝐸𝐴𝑇 𝑅𝑒𝑙𝑒𝑎𝑠𝑒𝑑 =
𝐷𝑖𝑒𝑠𝑒𝑙 Motor 𝑃𝑜𝑤𝑒𝑟

𝐸𝑓𝑓𝑖𝑐𝑖𝑒𝑛𝑐𝑦
 

Airway segment divisions for heat calculations. 

The heat simulation process in VentSim DESIGN™ progressively calculates heat 
along each airway by dividing it into smaller sections.  Where airflow is very 

slow or an airway is very long, this allows the psychrometric process to 
continually adjust pressures, temperatures and moisture content, resulting in a 
more accurate simulation.  VentSim DESIGN™ automatically adjusts the 
number of divisions according to airflow velocity, airway length and heat inputs.  
The number of divisions used is restricted by the min and max values in the 
settings.   Higher division values will theoretically give more accurate heat 
estimates but will increase the time required for simulation. 

Performs multiple airflow and heat simulations. 

When set to more than one (1) performs multiple heat and airflow simulations, 

adjusting densities and airflows between each simulation. Manually pressing the 
HEAT simulation button has the same effect. 

Heat simulation in VentSim DESIGN™ Advanced is performed as two discrete 
simulations, first as an airflow balance, followed by a heat balance simulation.  
While the mass flow balance from the airflow simulation is kept constant during 
heat simulation, the new temperatures and air densities calculated after heat 
simulation, result in a theoretical mass imbalance of airflows.  This can be 
corrected by a subsequent airflow simulation; however subsequent heat 
simulations will again affect the balance.  This imbalance normally reduces with 

subsequent simulations, as temperatures and airflow changes reach equilibrium. 

Diesel Efficiency 

Heat Divisions Min/Max 

Multi Heat Iterations 



 

 

Multiple pass iterations can be set which will automatically force VentSim 

DESIGN™ to simulate the model a number of times, to account for some of the 
potential imbalance.  This will significantly slow down simulation time.  Iteration 
values larger than one are usually unnecessary if a model has already been heat 
balanced, or if the HEAT simulation button has already been pressed a number 

of times. 

HINT  Performing a multiple pass heat simulation may have value if the model shows some heat instability (changes in temperatures 
between simulations).  Heat instability is often caused by unstable natural ventilation changes driven by conflicting changes in 
airflow, strata heat and evaporation. 

For example a heat source which causes an increase in temperature may cause an increase in airflow due to natural ventilation – in 
subsequent simulations, the higher airflow causes lesser temperature increase from the heat source, which in turn reduces the 
airflow due to natural ventilation. Evaporation from strata moisture may also causing conflicting density changes, with strata heat 
density changes offset by cooling evaporation.  The process may then oscillate between solutions for each heat simulation.  As a 
final pass performing a multiple pass simulation of 10 or 20 (which may take a long time) may help resolve this instability.  

 

Limits the number of internal iterations permitted by VentSim DESIGN™ to 
converge and find an acceptable heat solution.  Where recirculation occurs or 
high numbers of very low airflows are present, a simulation may take a large 
number of iterations to fully balance.  In most cases, the main airflows will 
quickly balance, and even if the simulation fails to complete within the set 
number of iterations, this will usually be in the low flow airways which have little 

effect on the main flow airways.  The status bar at the base of the VentSim 
DESIGN™ window will show the progress of a heat simulation, including the 
number of iterations and the heat balance errors.  Increasing the number of 
iterations may help resolved unbalanced models, but will take longer to 
simulate. 

HINT  A leading cause of heat flow convergence issues is recirculating airways in low flow airways due to natural ventilation 
pressures.  Natural ventilation pressures can create internal ‘eddies’ of air in disused or low flow airways which can affect heat 
simulation convergence.  To prevent this, and speed up heat simulation, either turn off natural ventilation simulation (if natural vent 
pressures are not significant) or block disused airways so they simulate as no flow 

 

For diesel heat sources, this value defines the amount of water emitted to the air 

as latent heat is per unit weight of diesel fuel consumed.  Although the 
theoretical combustion reaction portion of water produced to fuel consumed is 
only around 1.1, the operation of a diesel machine in a mine environment 
results in a greater release of water into the air due to accelerated evaporation 
of water around the machine (from a wet roadway or walls for example), 
compounded by other sources such as handling of moist or wet material, wet 
exhaust scrubbers and cooling systems used by the machine, result in a much 

higher value.  A value of five (5) or more is generally recognised as giving a 
more realistic result for water introduced to the air by mobile machines.  
Stationary machines may be closer to the theoretical value.   

The default water to diesel ratio is used on all diesel sources in the model.  To 
use values other than default, the sensible and latent heat will need to be 
entered separately instead of a single diesel heat source. 

 

Describes the default amount of diesel particles emitted from a diesel engine, 
per unit of diesel engine power.  This value is applied to diesel heat sources 
placed in a model, to assist in diesel particulate matter (DPM) simulation for the 
model.  The value is highly dependent on the type of diesel engines, catalytic 
converters and scrubbers being used on the exhaust, as well as the type of 
diesel fuel used.  In most cases, tests will need to be done on engine exhausts, 
or information gained from diesel engine manufacturers to find the correct value 

Heat Iterations 

Water to Diesel Ratio 

Diesel Particle Emissions 



 

 

to use.  VentSim DESIGN™ will apply this default value to diesel sources which 

have not been assigned a specific emission rate.  Specific rates for diesel 
equipment and airways that will override this default value can be assigned in 
the Presets or in the Edit box. 

 

The temperature limit above which VentSim DESIGN™ will halt simulation and 
display an error if it occurs.  Temperature limits can be exceeded when too 

higher heat input is placed in an airway with not enough airflow. 

Heat simulation uses a number of empirical formulas which are designed to 
work within a specific temperature range.  In general, temperatures above 70 
degrees centigrade will start to result in a reduction of accuracy of heat 
estimation. 

The minimum mass flow that VentSim DESIGN™ will perform a heat 
simulation on.  Below this limit, VentSim will assume the air is stationary, 
and adopt the local virgin rock temperatures as the air temperature.  This 

value must be set above zero, as portions of the program which calculate heat 
and moisture derived from rock surfaces must have some airflow velocity to 

work.  While there is some potential for heat imbalance errors by not taking into 
account low flow airways, it is generally small due to the limited heat energy 
flow able to be carried by these low flow airways. 

The ratio of output refrigeration power (kWR) generated by the refrigeration 
heat exchange process, versus the input electrical power (kW) required to 
produce this heat exchange.  This factor is not used by the simulation, by 

rather by the power and cost calculation of a model in the Summary section.. 

Sets the temperature balance limit VentSim DESIGN™ must achieve for all 
airway mixing at junctions in a model, to consider a simulation as balanced.  
If the balance is not achieved for EVERY airway and junction, iteration is 

performed until the iteration limit is reached or temperatures are resolved. 

HINT  The smaller the temperature accuracy set, the longer a simulation may take to complete.  In most cases, the vast majority of 
airways will fall well under this limit, and any temperature accuracy issues will be limited by very low flowing airways which have 
little impact on the main model. 

Limits the amount of heat that can be put into a single airway.  This is mainly 
included as a check to ensure excessive heat is not placed in an airway (such 

as a point heat source value accidently being entered as a linear heat value) 

Recirculation 
 

The number of recirculated airways beyond which VentSim will first ask 
permission to simulate exact recirculation amounts.  The simulation routine 
to calculate individual airway recirculation is complex and time consuming.  

If there are more than (say) 500 airways, this may take a minute or two to 

simulate.  Therefore the option will be given to abandon the simulation, or 
simply show the airway which recirculate without actual % amounts.  On faster 

computers, it may be desirable to life this limit, to prevent VentSim pausing and 
asking permission. 

The volume of air that is allowed to recirculate before the Check 
Recirculation routine flags a warning and initiates a full recirculation check.   

 

Temperature Limit 

Mass Flow Limit 

Refrigeration COP 

Temperature Accuracy 

Maximum Heat Input 

Recirculated Airway 
Limit [Advanced] 

Recirculation Limit 
Volume [Advanced] 



 

 

12.5. VentSim System Settings 

VentSim Program settings control over-arching settings which influence all parts of the program. 

 

Figure 12-7  VentSim DESIGN™ General Settings 

The type of units to use in VentSim™.  The program operates natively in SI 
Metric, with underlying calculations performed in metric units.  To display 
imperial values and accept imperial input, set the unit type to Imperial.  The 

imperial setting uses a conversion table to calculate the conversion from metric, 
and can be customised to suit mine preferences.  The imperial conversion table 
can even be set to use a combination of Metric values by setting the program to 
IMPERIAL and then using the SETTINGS > UNITS menu to individually specify 
what units will remain ALWAYS METRIC. 

Warning – the conversion table has set limits of decimal accuracy to convert from metric to imperial and back again.  If the decimal 
accuracy is too low, some accuracy may be lost in the conversion process, and the value input as an Imperial number, may be returned 
slightly differently. 

Replaces fixed flow input in airway edit forms, with a fixed mass flow option.  
Some countries utilise mass flows to specify air quantities in mine ventilation.  

 

Unit Type 

Use Mass Flow 



 

 

13 HEAT ASSISTANT 

The heat assistant helps in calculating thermodynamic inputs into the ventilation model.  The calculator 
can quickly establish required cooling, heating or moisture loads, which can then be accepted in the 
model.   

The assistant is also useful for ‘pre-conditioning’ airflow to a required temperature and humidity to more 
closely simulate observed conditions underground. 

Pressing Accept after any calculation will insert the values into the model airway for future simulation.  
This will overwrite any existing heat values within the airway. 

Warning : The assistant calculates estimates only. In some cases, the assistant utilises an iterative technique, with initial values sourced 
from the airway currently being edited.  The initial values can be changed as desired.  Because the simulation process utilises a more 
detailed, multiple pass approach, taking into consideration surrounding airways and rock heat transfer into the airway, the resulting 
estimates from the assistant may not always equal the values ultimately calculated in the simulator. 

The assistant contains thirteen (13) tabs. 

 

Figure 13-1 Ventilation Calculator Assistant 
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Airflow S/L 
Calculates the required heat loads to condition air from one state to another.  The values are returned as 
sensible and latent heat estimates.   

Values returned for sensible heat are generally (+ve) for heating or (-ve) for cooling.  Values returned 
for latent heat are generally (+ve) for humidification or (-ve) for de-humidification or drying of air.  The 
word ‘generally’ has been included as differences in pressure can influence the amount of sensible and 
latent heat available in the process. 

Airflow S/W 
 

Similar to the Airflow S/L calculator, this calculates the required heat loads to condition air from one state 
to another, but instead returns values as sensible and an evaporated moisture flow estimate.  This may 

be useful for calculating moisture being evaporated from underground processes such as decline dust 
suppression sprays, drill machine activity or evaporative cooling chambers. 

Diesel Engine 
Diesel engine heat loads can be more accurately calculated by considering the environment and 
utilisation of the diesel engine within the model.  The diesel engine calculator assists with this.  The 
output of the calculator is return as an averaged diesel engine output.  The corresponding sensible and 
latent heats are also provided as a reference, however are not transferred to the model as VentSim 
DESIGN™ automatically calculates these values in the model from the diesel power value.  

 

Diesel Efficiency 

The percentage of diesel calorific energy converted 
into mechanical energy.  This diesel efficiency is an 
estimated value for a typical diesel engine and 
generally should not be changed unless specifically 
known for a type of engine or particular type of 
fuel. The value dictates the amount of heat placed 

in a model per unit of engine power used. 

 

Figure 13-2  Diesel Heat Estimator 

For example a 200kW rated diesel engine, will consume nearly 600kW in diesel fuel energy, initially rejecting 400kW of waste heat 
through engine friction and exhaust.  In most cases, the remaining 200kW of mechanical power will also be converted to heat 
through further friction losses, except where the mechanical power may be partially passed to other energy absorbing processes 
(such as water or transfer of rock uphill).  If required, this can be accounted for under the potential energy conversion item. 

Diesel engines underground rarely operate at full power 100% of the time.  
It is important to consider the actual weighted percentage of time engines 
are operated at full power to gain the true heat input into the mine model. 

For example, a load haul dump unit (LHD) operates continuously, but uses only full power (100%) while loading buckets and hauling 
up a ramp for 15 minutes per hour, operates at 50% maximum power tramming horizontally or downhill for 30 minutes per hour, 
and idles at 10% maximum power for the remaining 15 minutes per hour 

(15 × 100%+30×50%+15 × 10%)

60
   

=52.5% peak utilisation 

In some processes, diesel mechanical engine power can be converted into 
other useful energies.  For example a truck hauling rock up a decline will 

impart a portion of its mechanical energy into the potential energy difference 
of the change in elevation of the hauled rock.  This can be calculated as a 
percentage of the mechanical output of the diesel engine, and will reduce the 
amount of heat input into the model.  In most cases, this will only be a small 
fraction of the diesel engine power, and in most cases can be ignored. 

Utilization 

Potential Energy 
Converson 



 

 

Diesel Fuel 
The diesel fuel calculator provides an alternative way to calculate engine power within a ventilation 
model, overcoming the need to estimate engine utilisation.  It calculates diesel engine power by using 
the calorific heat value of fuel, and back calculating engine power using the diesel efficiency setting in 
VentSim (by default 35%).  

 

By entering the average fuel usage of a 
diesel engine, VentSim DESIGN™ can 

calculate the equivalent average engine 
output for use in the model.  If this 
value is derived from actual engine 
diesel fuel usage of a particular unit in 
operation (many modern machines 
automatically record average fuel flow), 
this therefore already includes time the 

machine is not operating at full capacity. 

As with the previous tab, a portion of 
the diesel engine power can be included 
as potential energy to another process.  
This reduces the effective diesel heat 
input into the model. 

 

Figure 13-3  Diesel Fuel Consumption Assistant 

Electric 
Similar to the diesel engine calculator, this allows the user to estimate the heat emitting from an electric 

motor, based on its duty cycle and conversion of work into useful energy. 

 

Figure 13-4 Electric motor heat estimation 

  



 

 

Water Flow 
The water flow calculator estimates the amount of heat entered or removed from a model from water 
flow source.  It can be used for both hot water and chilled water calculations. 

 

The Water tab may be useful for estimating: 

• How much cooling power a cooling tower 
or spray chamber is producing from a 

refrigeration water source.. VentSim 
DESIGN™ will calculate how much cooling 
is being generated from the flow and 
temperature change of the water into the 
airflow. 

• How much heat a geothermal water source 
may be putting into a model.  To calculate 
the heat input, simply input the average 

water temperature entering the mine 

(from a rock fissures for example), and 
enter the average water temperature and 
flow exiting the mine (at a pump station 
discharge for example).  VentSim 
DESIGN™ will calculate how much heat is 
being lost from the water most of which 

ultimately enters the airflow. 

 

Figure 13-5  Heat Assistant Screen 

13.1. Cooling Towers 

A tool to assist in calculating the performance of cooling towers.  The calculation tool can be directed in 3 

ways – calculate factor of merit, calculate output air temperature, or calculate required amount of chilled 
water.  Each option will allow different entry variables.  Clicking the CALCULATE button will calculate the 
missing data. 

•  

  



 

 

Effective Temperature 
• A tool to  calculate effective temperature, a popular cooling index used mainly in coal mines (both 

basic scale and normal scale) 

•  

 

Cooling Power 
• A tool to calculate cooling power in two common scales – the Australian TWL calculation, and the Air 

Cooling Power (Metric) ACPM from the USA. 

   

Properties Temperature, Properties Sigma, Properties RH 
• The three tabs beginning with “Properties” give three different tools to do quick psychrometric 

calculations, calculating the density and heat and moisture content per kilogram of air at given 

temperatures, sigma heat, or relative humidity. 

 



 

 

 

Duct Calculator 
• A tool to calculate duct length and fan requirements for auxiliary ducting, based on different 

combinations of input data. The calculator takes account of duct leakage as well 

•  



 

 

14  FANS 

Fans are an important part of the modelling process.  Correct entry of data for fan curves describing the 
pressure and flow performance at different fan duties is essential for accurate simulation. 

14.1. Fan Database 

The fan database is accessible from the TOOLS > FANS menu.  The fan database allows editing, adding 
and deleting of all fans in the model fan database.  Up to one thousand (1000) fans and the associated 
fan curves may be entered into the fan database.  A display for each fan curve and data will be 
presented when a fan is selected from the display list.   

   

The Edit > copy and paste functions can be used to copy data to or from another program (for example 

a spreadsheet). 

Caution should be taken when deleting or modifying a fan, as any model which may use the deleted fan number, will not simulate 
correctly.  

At a minimum, fan curve points for quantity and either fan static or total pressure must be entered for 
each fan.  Other curve information such as efficiency and power can also be entered to assist VentSim 
DESIGN™ in estimating fan power and heat.  

Density is the air density that the fan curve is specified on the manufactures sheet.  IT IS NOT 
necessarily the air density that the fan in the model will be operated at. In VentSim DESIGN™ Advanced, 
fan performance is adjusted for density changes in the mine.  Most manufactures supply fan curves at a 
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standard sea level density (1.2kg/m3), however different densities can be entered for the fan curve if 

required. 

Diameter is an optional parameter describing the exit diameter of a fan.  This 
may be the diameter of the fan casing or an evasé if fitted.  Ensure the fan 
curve entered is for the specific fan configuration (check with your fan 

manufacture for this).  Adding or removing an evasé from a fan for example can 
significantly change the fan performance within VentSim (although the fan total 
pressure curve will remain similar).  Where only a static curve is available, the 
diameter can help estimate velocity pressure from the fan and the associated 
power consumption.   

Where only fan total pressure is entered, the fan diameter can help estimate 
available fan static pressure, a consideration for the performance of surface 

exhaust fans. Finally, the fan diameter can also help estimate new curve points 
for the fan database, if either the fan static or total curve is unavailable.  See 
the fan database section for more information.  

Hint: It is recommended that where fan pressure curves are provided without an evasé (which is normally how fan manufacturers 
provide the curves as mines may mount the fan in different configurations), any evasé effects can be independently modelled by 
using the edit box options to place an diffuser in the airway.  

Fan speed is a manufactures reference to the normal speed of the fan 
operation for the specified fan curve.  The number is not directly used during 

simulation and will not influence simulation outcome.  The percentage fan 
speed can however be adjusted in the EDIT box. 

Reverse P and Reverse Q modifies performance for fans run backwards for 
an emergency situation.  Most manufactures will not supply these figures as 
fans are not generally designed to do this (although some fans can be 

designed to perform better in reverse than others).  These figures ideally need 
to be derived experimentally be measuring actual fan performance with blades 

running in reverse.  VentSim DESIGN™ initially defaults to 0.5 for both (50% of 
maximum pressure and 50% of maximum airflow). 

The method used to estimate curve data between specified fan duty points.  
The cubic spline method estimates a curved data path between fan points.  
If only a few points of data are available, this may produce a better estimate 

of fan duty, however the method may be limited by sudden changes in curve 
data point direction.  Ensure sufficient points are available to produce a smooth 

non-reversing curve. 

The linear method predicts a straight path between points.  This method is 
slightly faster during simulation, and if the maximum number of fan points (10) 
are entered, it should provide sufficient accuracy in most cases. 

HINT: It is important that pressure on the curve is not permitted to bend over in a U shape (or upside down U), otherwise the 
simulation may oscillate between two pressure points.  Stall regions of fans should be omitted for this reason. 

Comment box is included to describe more information about the setup or 
configuration of the fan.  It is not used for simulation. 

Fan Point Table : The table will allow direct entry of fan curve data.  Fan curves 
will be constructed as data is entered.  Points can be submitted non-
sequentially, and will be automatically rearranged when the fan is re-loaded or 

saved. 

As a minimum, VentSim requires at least airflow, and a Fan Static Pressure or 
Fan Total Pressure point.  Other information such as efficiency or power can be 
calculated by VentSim using default settings, however it is recommended to 
enter one of these values if available to enable more accurate power and heat 
calculations. 

Fan speed 

Fan Reversal 

Curve Estimation 

Comments 



 

 

To calculate fan power within a model, VentSim DESIGN™ needs either a fan 

efficiency curve or a fan power curve.  If neither of these curves is available, the 
default fan efficiency will be used from the Settings menu.  If both efficiency and 
power curves are entered, VentSim DESIGN™ will preferentially use the fan 
power curve to calculate absorbed fan power. 

Fan Variations 
Fans can be either added individually or as multiple variations.  Variations are intended to be entered as 

blade angle variations of the same fan design however they can specified into groups or any other 
collection of fan curves.  Variants are simply differentiated by a main name (which is the same for all fan 
variations) and a variant name.  VentSim internally treats all variants as unique fans and keeps these 
names stored together, separated by a ‘ | ‘ character.  This means the user can at any time break a fan 
into a variant by inserting this character (with a space either side) in the main fan name. 

HINT : If fans have already been entered into a previous version of VentSim, then they can be grouped into variant by ensuring they 
all have the same main name, separated by a variant character ‘ | ‘ followed by the variant name.  The variant name will then be 
broken away from the main name and entered in the variant list. 

Fan Losses 
VentSim 4 introduces ‘installed resistance’ options, to introduce additional fan losses (resistance) to be 
included in simulation.  Fans are often installed with resistance that impede fan performance, such as 

discharge bends, silencers, cooling coils or items that cause shock loss.  

Losses can be specified at an example airflow / pressure loss (often described by the fan manufacturer), 
or an estimated shock loss based on discharge diameter size. Once entered, the calculated resistance will 
be automatically applied during simulation. 

 

Entering Data 
To construct a fan database from an existing fan manufactures curve, two methods can be used – direct 
data entry, or Digitizer Entry 

Direct Data Entry 

1. Identify the type of fan pressure curve used, the fan configuration and exit diameter, and the air 
density the fan curve is established at. 

2. Divide the curve into up to ten (10) points.  Do not include the STALL region of the curve in the fan 
database.  Entering the stall region of a fan may result in an unstable model simulation at it 

oscillates between the two pressure and volume flow states. 

3. Note that less than ten (10) points can be entered if desired, however this will increase 
interpolation errors between points resulting in a less accurate simulation.  A minimum of five (5) 
points is recommended. 

4. Enter the curve points and fan information in the Fan Database edit form.  

5. To utilise the fan within the model, ensure the Fan Total Pressure method is selected in the 
Settings, and use the Edit Box to place a fan within an airway.  

Digitizer Entry 



 

 

1. The digitizer is a powerful tool to allow the user to directly copy a fan sheet into VentSim, and then 

digitize (move and click) the mouse directly over the fan curves to enter the fan points.  This saves 
the tedious step of manually estimating and entering fan points by keyboard. 

 

a) To enter the digitizer mode, click the digitizer button on the main fan entry sheet, 

or drag and drop and fan image (PDF file or image file) 

b) Drag and drop an image or PDF file into the digitizer region if not already done. 

c) Select the type of curve, and use the DEFINE REGION option to draw a box 
around the region of the fan sheet with the type of curve. 

d) Enter the maximum graph values for this region in the lower right corner. 

e) Select the ADD POINT button, and click the mouse over the fan curve. 

f) Repeat for the other type of curves. 

g) Variants can be added using the ‘+” button at the top right tab selection. 

h) Press OK when complete.  The fan curve picture will be stored permanently in the 

VentSim file. 

14.2. Fan Pressure Types 

Where both Fan Static and Fan Total pressure curves have been entered for all fans in the database, 
VentSim will automatically use Fan Total Pressures for simulation calculations.  The method selects the 
curve automatically, depending on what curve is available in the fan curve database.  

VentSim will only use Fan Static Pressure for simulation if a fan does not contain a Fan Total Pressure curve. 

Simulation Handling of Exit Velocity Pressure Losses 
Exit Velocity Pressures occur on any airway or fan discharging air to the surface atmosphere.  When 

considering fan pressure requirements, the exit velocity pressure loss is added to the mine resistance 
system pressure losses to calculate fan total pressure requirements.  Fans must therefore provide sufficient 
total pressure to overcome both the mine resistance and the surface velocity pressure losses. 

The decision to apply Velocity Pressure losses to system resistance is controlled automatically by default 

in VentSim.  If only Fan Static Pressure curves or a combination of fan static and fan total pressure curve 
are being used in a simulation, then exit velocity pressure is ignored for all mine exhausts EXCEPT where 

a fan is present using a Fan Total Pressure curve.  If all fans use Fan Total Pressure curves, then exit 
velocity pressure is automatically included.  The automatic application of velocity pressures can be 
overridden in the Settings > Airflow Simulation > Velocity Pressure. 

The use of fan total pressures (fan static and velocity pressure) is considered the technically correct 
method for simulating airflows, as both static and velocity pressures contribute to airflow through an 
underground mine.  VentSim DESIGN™ can help predict a fan total pressure curve from an existing 
static pressure curve using tools in the Fan Database Editor. 

Total Pressure Method 



 

 

The total pressure method assumes the full fan total pressure is available to ‘push or pull’ air through a 

mine.  The method also considers system velocity pressure losses to the atmosphere (for example from 
exhaust shafts) and incorporates these into the simulation.  The fan total pressure method relies on the 
user accurately considering fan exit losses with appropriate diffuser sizes, shock loss factors and 
resistances, as total fan pressure is never fully available to  pressure the underground air flow.  Fan 

outlet configuration, outlet flow direction changes and the inclusion of diffusers (which boost fan static 
performance and reduce exit losses) or other exit devices such as fan shutters need to be fully 
considered if they have not been incorporated into the fan curve, otherwise the model may over predict 
the available pressure and flow for the model. 

To use the Fan Total Pressure Method, ensure all fans contain a Fan Total Pressure Curve.  If any fans have only a Static Pressure 
curve, then the simulation will automatically switch to the Static Pressure Method. 

Static Pressure Method 

A more traditional approach is to use fan static pressure, which assumes that fan velocity pressure is 
wasted and does not contribute to the system ventilation pressure and flow.  While this is not technically 

correct, this assumption removes some of the criticality of defining accurate exit losses, and while exit 

losses should still not be ignored, the resulting simulation will provide a more conservative result to 
simulation estimates of pressure and flow.  The Fan Static Pressure (FSP) method ignores system exit 
velocity pressure losses and for a primary (surface) fan driven model systems, there is negligible 
difference between the FSP and FTP methods (as the FTP methods considers velocity pressure losses as 
part of the system pressure).  However where underground booster fans contribute to a significant 

portion of ventilation flow, the difference between the two methods will increase. 

To use this method, all fan curves used from the database should have a static pressure component.   As with the FTP method, the 
fan database form has tools to assist the user in estimating FSP curves if not available. 

Mixed Pressure Method 

The mixed pressure method maintains compatibility with VentSim Classic 3.9, which allows both 
pressure types (static and total) to be used for fans in models.  The mixed pressure method is similar to 
the static method, in that it does not consider system velocity pressure exit losses.  Fan pressure curve 
types can be specified for each fan location in the model.  This may be of assistance if some static or 
total pressure curves are not available for the fan, and the user does not wish to estimate a curve.  The 

mixed pressure method is considered to be the least consistent method to use, and should be avoided if 
possible.   

VentSim Classic 3.9 models will be automatically imported into VentSim DESIGN™ as a ‘mixed pressure model’.   VentSim 3 will 
automatically select the pressure simulation method based on the type of fan curve pressures available in the fan database for 
simulation.  The type of simulation method used is stated in the RUN > SUMMARY. 

Fans used in Auxiliary Ventilation Duct 

Unless discharge losses are manually considered, only Fan Static Pressure curves should be used for duct 
pressure and airflow calculations, as the velocity pressure exiting the duct is considered wasted. 

For this reason, when a fan is placed in a ventilation duct, VentSim will only use the Fan Static Pressure 
curve.  If only a Fan Total Pressure Curve is available, then VentSim will attempt to calculate the Fan 
Static Pressure Curve, based on the fan diameter or area, or if this is not available, from the size of the 

duct the fan is place in. 

Most fan manufactures supply one or both types of pressure curves.  
VentSim DESIGN™ differs from VentSim Classic 3.9 in it can use fan total 
pressures (FTP), fan static pressures (FSP) or a mixture of both.   

Using FSP curves will ignore the fan velocity pressure (FVP) portion contribution to model pressures, but 
will also ignore any system exit velocity losses to surface throughout the model.   

Using FTP curves will include the FVP portion, but will include system exit velocity pressure losses as part 
of the model system total pressure. 

Should I Use Static or 
Total Pressure? 



 

 

The case for Fan Static Pressure Simulation 

It is technically correct for simulations to use fan total pressure (FTP) curves for fan installations.  Fan 

total pressure however is not always converted into useful ventilation energy due to outlet losses from 
fan installation configurations. 

Traditionally, VentSim Classic 3.9 has encouraged users to utilise fan static pressure (FSP) curves for 
modelling.  Using FSP curves excludes the velocity (dynamic) component of fan pressure curve which is 
therefore assumed not to contribute to the overall system pressures in a model simulation.  To partly 
offset the lack of fan velocity pressure inclusion, the system exit velocity pressures (the velocity pressure 
loss to the model from air exiting from shafts or other exhaust airways) are also not included by VentSim 

Classic 3.9 in calculating overall system pressure.  While these two factors partially cancel each other 
out, using Static curves for underground fans is likely to give a slightly conservative system pressure and 
airflow if fan exit (shock) losses are modelled identically for both an FSP and FTP case.   

When designing a model, this may be advantageous to provide contingency for design simulations.  In 
addition, use of FSP curves is less reliant on accurately modelling fan exit shock losses, and provides a 

greater contingency for design airflow.  In general, they may be more suitable to use for a less 
experienced user. 

The case for Fan Total Pressure (FTP) Simulation 

FTP Simulation will allow VentSim DESIGN™ to utilise the full fan total pressure curve for model system 
pressures.  Provided fan exit shock losses are modelled to consider the fan installation and exit airflow 
orientation, then this method should provide more accurate results.  In addition, as VentSim DESIGN™ 

will consider system exit velocity pressures allowing fan exit diameters, airway surface exhaust sizes or 
evasés sizes are adjusted to simulate the effect of on surface exhaust airways and mine system 
pressure.  

Note: Increasing fan diameters or including diffusers in VentSim DESIGN™ for underground installed fans will have no automatic 
effect on model simulation results, as it will not change the surface velocity pressure exit losses.  It may however decrease shock 
losses at the fan exit, which if modelled in VentSim DESIGN™ by changing airway shock loss will result in improved fan performance. 

Evasé / Diffuser Hint: If the Fan Total Pressure Method is chosen, the effect of diffuser size on surface exhaust shafts can be 
examined.  Simply click on the surface airway, and select ‘diffuser’ and place a size large than the fan or airway.  Alternatively, you 
can construct a short enlarged surface connection airway which will produce a similar effect to including an evasé option in an 
airway. 

In Summary 

In most cases, if fan exit shock losses are modelled are modelled correctly, the Fan Total Pressure (FTP) 
method is the best option to use.   

14.3. Fan Database Menu Items 

 

The tools menu contains a number of functions to assist in estimating fan static or total fan curves as if 
either one is unavailable, as well as fan total shaft efficiency and fan absorbed power if either one is 

unavailable. This may be required if only a Fan Static Pressure (FSP) curve is available, and you wish to 
simulate the model using a Fan Total Pressure (FTP) curve.  

VentSim DESIGN™ will use the outlet diameter of the fan to calculate the velocity exit pressure of the 
fan, and thereby calculate the missing static or total pressure curve.   

To estimate absorbed power, VentSim DESIGN™ will calculate theoretical power using total pressure and 
airflow.  Note that none of these estimation methods take into account shock losses, resistance and 
compression factors which will slightly affect calculated pressure and powers.  It therefore should be 
used as a guide only, and is no substitute for an accurate fan manufactures curve if available. 

Estimate Tools Menu 



 

 

Quickly estimates 10 evenly spaced points of fan curve duty from as few as 

3 entered points.  The estimation method will use the Cubic Spline method 
to add the additional points.  This method should only be used if additional 

fan curve data is not accurately available. 

Estimate Fan Curve 



 

 

15  BUILDING A VENTILATION MODEL 

A ventilation model must have a number of key components to successfully run. 

Some Simple Rules for Constructing a Model are: 

• All airways in a model must be connected at both ends to another airway, unless connected to the 
surface or ‘blanked’ off as a closed end. 

• A model must have a device(s) to produce pressure within the model and induce airflow.  Pressure 
producing methods use in VentSim DESIGN™ includes placing fans or a fixed airflow or pressure 
within an airway.  

• Any fixed flow in an airway must not restrict another fixed flow elsewhere in a model, or be overly 
restricted by an impassable high resistance. 

 

Errors contributing to the above conditions account for around 90% of simulation errors and problems 
noted in VentSim (from Chasm Consulting observations) 

 

15.1. Overview 

There are many different ways to build a computer ventilation model.  VentSim DESIGN™ (as the name 
suggests) utilises a visual approach to creating models, and the fundamental structure (shape) of models 
can be built either by hand with the mouse, or imported from a CAD program.   

While a ventilation model can be built schematically in VentSim, it is highly recommended building a true 
to scale 3D model if possible, to allow VentSim to automatically use parameters such as size, length and 

depth for simulation.  For compressible airflow models, this allows for automatic density adjustment and 
natural ventilation pressure application, resulting in more accurate and realistic results.  In addition, rock 
temperature and autocompression can be automatically calculated for heat simulation. 

 

15.2. Types of Models 

A ventilation model must have a framework of connected airways or branches.  For airflow to 

successfully travel along an airway, each airway must have a connecting airway at the entry and exit.  
Airways with no connection at either end will not carry airflow unless connected to the surface. 

Model Types 
A ventilation model can be developed as either a closed or open model. 

A closed model does not have any airways connecting to the surface.  While 
this would be unusual for a real mine, for diagnostic purposes it is possible to 

build and simulate an entirely closed model, which continually circulates air 
around the modelled airways.  To construct a closed model, simply connect and 
loop all airways so that they form a continuous path and all airway ends are 
connected to at least one other.  Because a closed system is entirely self-
contained, pressures and energies placed within the model to distribute flows 
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are entirely consumed by the airways in the model.  No ventilation energy is lost 

to outside sources. 

 

Figure 15-1  Example of a Closed Model 

 

An open model has at least two airways which connect to the surface, at 
least one of which is an intake airway, and another which is an exhaust 
airway.  Most (if not all) mines will be established as open models. Airflow 

that exits an exhaust airway, in no way influences the pressure (or 
temperature) of the airflow which enters an intake airway.  Airflow velocity 
pressures and energies lost from an exhaust airway are assumed lost to the 

model system.  To link any airway to the surface, simply use the Connect to 
Surface function under the Edit Form. 

 

Figure 15-2  Example of an Open Model 

 

15.3. Initial Model Construction 

Airways can be constructed in a number of ways. 

• Manually draw scaled airways with the mouse using the toolbar functions. 

• Manually draw schematic airways with the mouse using the toolbar functions. 

• Import airway data from a formatted spreadsheet using the TXT import function. 

Open Model 



 

 

Import graphics data from a DXF/DWG/ Datamine / Surpac graphics file into VentSim, and convert 

the data to airways.  Most mine planning and CAD packages will have the ability to export data to 
one of these formats. 

 

Regardless of the method used, in summary the recommended steps for constructing a ventilation model 

are as follows: 

1. Construct the airways either manually using the DRAW function, or via the IMPORT function, 
ensuring all airways join correctly to each other.  Filter tools are available in VentSim to assist 
with ensuring airways are joined together. 

2. Use the EDIT button to edit the airways that connect to the surface, and mark SURFACE option on 
the form. 

3. Again, using the EDIT button, set the correct size and shape for all airways.  Insert any 

ventilation controls or regulators in the model, and specify airway characteristics such as friction 

factors and shock losses. 

4. Place a FAN or FIXED flow in an airway again using the EDIT button, and selecting the FAN tab 
of this form.  This will provide pressure to drive the airflow through the model 

5. Finally, press the SIMULATE button to show the result of the model construction.  If everything 
has been constructed correctly, the airflow data and arrows should show the result of the 

simulation. 

6. If some airways are dead ends, then simulation warnings can be prevented by setting the 
“CLOSED END” option in the airway EDIT form. 

7. If any error or warnings show, then correct the mistakes individually or grouped as required. 

 

Manual Scaled Construction 
To manually construct airways, simply use the construction tools (the draw, move, copy and delete 
buttons) from the toolbar.   

Airways can be drawn freehand on the screen with the mouse, using the coordinates displayed in the 

status bar to guide the airway location.  Additionally, coordinates for airways can be entered manually 
using the coordinate entry function or by simply clicking on an airway end while in the draw mode. 

This method is generally suitable for small models (less than several hundred airway segments).  Most 
airway models are generally fairly tolerant of misaligned or slightly misplaced airways, providing 
approximate airway lengths are close to reality.  In many cases, to assist with clarity, airways can be 
deliberately moved aside, and a fixed length function used to override the automatic length calculation to 
set actual lengths. 

If the model is required to be true to scale, then more accurate construction may be required, and it is 
often better to import actual mine designs from CAD programs into VentSim to use as a template to 

constructing a true to scale model. 

Manual Schematic Construction 
In some cases, a model schematic can be constructed to simulate a model.  A model schematic may look 
nothing like a real mine, but simply represent airways by a series of conveniently located two 
dimensional lines.  Correct airway lengths can be entered by fixing the length under the Edit From. 

Warning: Schematic Models, although convenient in simplifying mine airway models, have major restrictions which can affect their 
functionality in VentSim™.  VentSim DESIGN™ uses true airway locations to calculate changes in air density and heat properties of 
rock and airflow, and as such, schematic models are largely unsuitable for VentSim DESIGN™ Advanced models which simulate deep 
mines with compressibility effects or for heat simulation. 



 

 

Spreadsheet Text Import 
Where a list of airway coordinates and sizes may be available (from a database or another ventilation 
program for example), these can be directly imported into VentSim DESIGN™ using the File Open Text 
Function.  Data to be imported must meet a specific TAB delimited data format.  This format can be 
loaded and saved by most office application software such as Microsoft Excel or Word.  This format can 
be viewed by saving any existing model file as a TXT file format under the save menu. 

DXF Graphics Import 
For large models that need to be built to scale from existing mine workings or designs, the best method 
is to import line string data (AutoCAD Drawing Exchange Format DXF, DWG, Datamine or Surpac), and 

allow VentSim DESIGN™ to construct a model from the imported data lines.  The import function can be 
activated from the File Import menu. 

STEP 1 – Create and Import a DXF file into VentSim™ 

  

This method relies on passing line or string graphics data from a CAD or Mine Planning package to 
VentSim™. The data may simply be the centre lines of surveyed mine floors or mine designs.  To allow 

VentSim DESIGN™ to efficiently use this data without excessive post import editing, the following criteria 
should be considered. 

• Only import the minimum data required.  Excessive detail or headings which do not form part of the 
ventilation model should not be imported if possible.  In many cases, is may be quicker and more 

accurate to construct a skeleton ventilation model consisting of interconnected lines within the Mine 
Planning or CAD package, before import into VentSim™.  The skeleton lines should simply trace over 
existing mine workings or designs. 

• Try to ensure the lines join into each other, so VentSim DESIGN™ knows they are junctions through 
which air can flow.  Lines that simply cross each other without a junction, or which terminate close to 
each other but not join, will not carry airflow, and may result in a no exit/entry error in VentSim 
which will need to be corrected in VentSim. 

When importing data, the lines can be converted to airways during the import process (by selected the 
option “Convert to airways’), or selectively after importing using the DRAW > CONVERT button to click or 

fence which lines are to be converted.  The second option has the advantage of overlaying the updated 
DXF files with new development over the existing VentSim airways, and selectively choosing where to 
update the VentSim model. 

Hint : To efficiently add DXF data to VentSim™, keep a ‘layer’, ‘object’ or ‘file’ within your Mine Planning or CAD package dedicated 
to VentSim DESIGN™ data,  As new airways or designs become available, simply export the additions as separate DXF files, and 
import them into VentSim DESIGN™ to add to the existing model. 

Warning : Three dimensional solids (such as survey mine solids) will import into VentSim™, but cannot directly be converted to airway.  
They can however be used as a guide to manually draw and construct new airways in the model 

Import DXF Graphics 
Line Data 



 

 

 

Figure 15-3 Imported DXF Lines 

      

Figure 15-4  Conversion of DXF lines to airways 

STEP 2 – Modifying and Validating Import Data 

Once imported into VentSim™, the program will assign default airways sizes and shapes to all the 
imported airways.  Ensure you have default sizes and shapes set in the Settings menu that will 
approximate the typical sizes that are imported.  This will prevent having to re-edit of ALL of the airway 
sizes and shapes (although this can still be quickly done using the group edit command) 

 

Unlike line string data, solid or wireframe graphics cannot be directly 
converted to airways.  The data can still however be used to help construct 
airways, by either using the referenced (imported) graphics as guides to 

manually draw airways, or by using a special function in VentSim to group the 
data and construct an airway of best fit through the data. 

OPTION 1 – Turn on Edit > Lock on References menu option and select the DRAW button. 

Import DXF Graphics 
Solid or Wireframe Data 



 

 

Simply use the mouse to DRAW airways over the top of the imported graphics.  The airways will 

‘connect’ to the same position as the reference graphics (providing the Edit > Reference Lock is 
enabled), allowing the ventilation model to be drawn in true 3D coordinates. 

OPTION 2 – Convert ANY (references to airways).  Use the Draw Sub-Option > Convert Any. 

This option converts groups of referenced graphics to an expected airway path, and may be of use to 
attempt to convert large amounts of wireframe or multiple string (for example floor outlines) to an 
expected airway.  It is likely that significant editing may be required after using this function to adjust 
airway locations and correct errors.  For further information on this method see Convert Any option. 

Correcting Errors 
To quickly sort and validate (check) the imported airways, click on airflow simulation.  While the model is 
unlikely to correctly simulate at this stage, this function will check the airways for duplicates and 

unconnected airway ends, which will speed up the process of establishing a working model.   

In most cases, errors will result from airways not exactly joined into other airways, or remaining 

unconnected as dead ends, resulting in no exit or entry errors. If many of these can be corrected before 
starting an airflow simulation, this will improve the ease of creating a working model. 

To help tidy up models and correct initial errors, a number of tools are 
provided in the TOOLS > FILTER menu, to bind disconnected airways, and 
find duplicated airways.   

Alternatively, for airways which are disconnected use the toolbar move function to move the airway end 
onto the other junctions ends.  If this is done correctly, moving the node after joining will then result in 
all airway ends moving simultaneously. 

Under Tools > Utilities > FILTERING TOOLS 

BINDING : Bind Nodes (use a value up to 4-5m or more to bind ends that are close to each other).  Bind 
Junctions (Binds loose nodes that are close to a passing airway which has no corresponding node or 
junction).  Bind Intercepts (find and/or join airways that cross each other, but have no joining nodes) 

SIMPLIFY (removes a lot of the small airways and unnecessary detail).  In many cases, importing a DXF 
files directly from a mine planning will create an overly detailed model file, which will slow down the 
system graphics and simulation, resulting in a more unwieldy model.   

For example, a nice smoothly rounded decline airway which produces many airway segments is simply 

not required for accurate ventilation simulation and in most case can be designed with less segments 
and detail.  The Simplify function in VentSim™, will sort through a model, identifying unnecessary detail, 
which can be removed without adversely affecting simulation. 

  

Figure 15-5  Example show the effect of the Simplify Function to reduce airway data 

Alternatively, airways can be manually simplified by using the toolbar delete function to remove node 
junctions between airways. 

DUPLICATES (find and/or remove any duplicated or overlapping airways) 

Filtering Tools 



 

 

15.4. Creating Pressure for Flow 

To produce pressure within a model to motivate airflow, the following three methods can be used.   

• Fans : Utilise and fan curve to establish accurate working flows and pressures in a ventilation model. 

• Fixed Pressures : Use a consistent pressure to induce an airflow in a ventilation model.  Airflow will 
vary based on resistance encountered by the pressure. 

• Fixed Airflows : Use a consistent airflow to induced flow through a model.  Pressure required will be 
adjusted to whatever is required to produce the airflow. 

Without at least one of the above methods to produce model pressures, airflow will simply remain 

stagnant. 

In VentSim DESIGN™ Advanced, a fourth method uses natural ventilation pressures to also induce flow, although this is entirely 
derived from heat and density air changes throughout the mine.  It is possible to build a ventilation model with airflow driven 
entirely by geothermal heat or evaporative cooling, however the simulation results can sometimes be unreliable due to changing 
airflow and pressures continuously affecting natural ventilation pressures. 

Fans 
A fan can be selected to simulate flow in a model.  Fan curves in VentSim are automatically modified for 
local air density in a model, and therefore may not match the original curve which may be at a different 

density.  Power, efficiency and the fan duty point are calculated and provided in the EDIT box.  See the 
FAN section for further information. 

Fixed Airflow 
Fixed airflows can either be used to simulate the effect of a fan, or for forcing airflow into parts of a 
model to reproduce observed flows. 

In general, unless estimating the requirements for a fan, the use of fixed flows to reproduce observable 
underground airflow is generally discouraged at it may adversely affect other parts of a model and does 
not provide a realistic behaviour for changes in underground model systems.  In many cases it can mask 
real problems with the model construction. 

A fixed flow will force VentSim DESIGN™ to calculate a pressure required to induce flow to the set 
amount.  This pressure can be substantial if the airflow needs to be pushed through a high resistance.  
Conversely, the pressure may actually be negative, if the fixed flow forces the airflow to be lower than 
would otherwise simulate, effectively resulting in the fixed airflow acting as a higher resistance. 

Hint : VentSim DESIGN™ limits fixed airflow pressure build up to around 50,000 Pa.  Pressures beyond this can result in serious 
model imbalances and heat build up, and in most cases are likely to be erroneous in nature anyway (for example, an airflow fix may 
be forcing air through a very high resistance).  VentSim DESIGN™ will raise a simulation error in this case to warn the user of 
unacceptable pressure build up.  This can normally be easily fixed by finding the restricting airway. 

In all cases, the results of a fixed flow can be observed from the Edit Box information function, which 
describes the pressure and power or resistance required to produce the flow.  This can be directly used to 
estimate a fan duty point which would be required to produce the same results.  This fix pressure can be 
equivalent to Fan Static Pressure or Fan Total Pressure, depending on the simulation type and location of 

fan. 

Fixed Flows are often used to help estimate required fan pressures.  The 
Pressure given for fixed flows will be an estimate of the Collar Total Pressure 
– ie the total pressure of the airflow in the airway directy beneath the fan.   

For a fan with an equal diameter to the airway, this equates to the Fan Static 
Pressure requirement, however caution should be used for this interpretation 
because differing fan diameters will alter fan static pressure requirements.  A 

fan manufacturer will normally be able to utilise the collar total pressure value to 
an equivalent fan pressure.  The Fan Total Pressure requirement will be a 
function of the discharge size and velocity of the fan, as well as any resistance 
and shock losses in the fan and structure between inlet and outlet.  Thereofre 
the fan manufacturer will need to take this into account when selecting a 
suitable fan.  Also note that the simulated pressures provided will be influenced 

Estimating Fan Pressure 
Requirements 



 

 

by the simulated Fan or Airway Discharge diameter (evasé) so ensure this is 

noted and specified when quoting the duty point summary. 

It is important to note that fixed flows contribute to model power consumption 
and heat, in much the same way as fans.  The fixed power and heat within a 
model is summarised from the Run Summary menu item. 

When calculating power and heat for a fixed airflow, the default fan/fix efficiency 
from the Settings Menu is used. 

More information on fixed airflow and pressure is available from the Edit Box 
functions. 

Finally, when specifying a fan duty point based on a fixed airflow, it is 
important that the air density the fixed flow was simulated in is noted.  Fan 
performance varies substantially in different densities and a fan 

manufacturers will need to know the required density to the fan curve can be 

adjusted for the local condition accordingly. 

For VentSim DESIGN™ Standard, incompressible air is assumed and the air 
density remains constant and is specified in the Settings menu.  For VentSim 
DESIGN™ Advanced, this value varies throughout the mine, and may be 
significantly different from the surface or standard density value. 

The Air Density is specified in the airway, or in the Fan or Fix summary page in 
the Edit Box. 

Fixed Pressure 
Fixed pressures work in much the same way as fixed airflows, but instead forces VentSim DESIGN™ to 
calculate a resulting airflow to match the input pressures.   As with fixed flows, fixed pressures consume 
power and produce heat, which again is summarised in the Edit Box information summary, or from the 
Model Summary menu item. 

When calculating power and heat for a fixed pressure, the default fan/fix efficiency from the Settings 
Menu is used. 

More information on fixed airflow and pressure is available from the Edit Box functions. 

15.5. Simulating Airflow in a Model 

Ventilation Pathways 
A critical part of developing new models is ensuring air can move through new airways.   

Place a Fan or a Fixed flow in the model to SIMULATE and start air moving through the model.  This does 
not need to be accurate at this stage – it is simply a way to determine the connected paths where 
ventilation can flow, and where there may be errors. 

 

Figure 15-6  Placing a fixed flow in an airway 

Fan Air Density 



 

 

Once a fan or fixed flow is placed, simulating the model will align all connected airways in the direction of 

airflow.  Airways that are not aligned or show no airflow may be dead ends, or may not be connected 
properly to the model.  Airways without flow should be closely examined for corrected airway ends. 

If there are NO ENTRY / EXIT warnings, these will normally be caused by airways with dead ends.  These 
can be selected and EDIT directly from the Warnings Box, and then closed using the “CLOSE END” 

function in the EDIT box. 

If other warnings are present where airways are not connected correctly, run the BINDING tools again 
with a larger search radius, or just manually use the MOVE button to move the airways ends together. 

The above steps should sort out most of the erroneous airways.  Connected airways that show NO 
ENTRY OR EXIT errors may be because all of the airways do not travel in the same direction.  VentSim 
automatically establishes this direction where airflow is present, however this cannot be done for dead 
ends.  The warnings can be fixed by either “CLOSE END” the airways with warning or by manually 

reversing individual airways with the REVERSE button. 

 

Figure 15-7  Example of import error after simulation resulting from misaligned ends or unjoined nodes 

Ventilation Ducting and Blind Headings 
In most mines, a number of blind or ‘dead end’ headings will exist.  By model definition, a blind heading 

cannot carry airflow, as it does not have a continuous path of airways leading to and from each end.  In 
many real cases however, these headings are effectively ventilated by auxiliary ventilation duct, and 
often need to be simulated within a model.  Auxiliary fans blowing into ventilation duct are moving air 
from one part of the mine to another and often much of the heat and moisture for a mine comes from 
auxiliary ventilated areas that need to be simulated as part of the overall mine heat balance. 

To satisfy a model requirement for a continuous air pathway, ventilation duct needs to be included as a 
separate airway.  For clarification, this airway is best placed outside of the mined airway, and sized 

according to true ventilation duct size.  The ventilation duct airway will carry air to the blind heading 

face.  The blind heading airways will carry airflow back to a model junction, and then join any other 
airflow beyond the blind heading. 

The DUCT construction tool (in the drop down option box next to the DRAW button) will automatically 
construct a duct airway parallel to a SELECTED series of airways.  Once constructed, a fan or fixed flow 
just needs to be added to one section of the duct to simulate flows. 

Hint : Specify the air type of ventilation duct to a different type and colour.  Airway types can be displayed independently, and the 
duct visibility can be turned on or off to improve visibility of the model. 



 

 

 

Figure 15-8  Example showing ventilation duct into blind heading.  
Note the two leakage paths included to ‘simulate’ vent duct leakage 

Interconnecting Mine Airways 
In some mines, airways may connect to other parts of a mine which are not simulated or included in the 
model.  The airflow to or from these other parts must be included into the local model.  To include 
airflows to areas not simulated or included in the current model, simply run a single airway off the main 
model, assign a Connect to Surface attribute under the Edit Form and then enter either a fixed flow or 
fixed pressure to simulate airflow to or from the area.  Ensure the direction of the airway is correct. 

 

15.6. Utilizing Layers 

Layers are a way to individually layer or identify and view parts of a model separately from other parts of 
the model.  Some examples may include a stope system, an orepass or ventilation raise system, a 

workshop area, or any other collection of airways.  Note that there is no requirement for the user to 
utilise viewing layers.  They are only present to allow easier manipulation and viewing of a model.  The 
‘Metal Mine’ example in the VentSim > File > Demonstration menu shows an example of layers. 

Layers work by allowing the user to 'overlay' multiple layers of airways or information on a screen.  By 
doing this, unnecessary detail can be 'turned off' so only airways of interest are viewed. 

Layers may be made active or displayed using the Display Manager.  Layers names can be changed from 
the Edit Box by clicking the button adjacent to the layer name.  

Primary Layers 
Primary Layers consist of up to 250 layers.  It is intended that the Primary Layers be used for identifying 
types of airways.  For example, Layer 1 could be Primary Shafts, Layer 2 could be Main Airways, Layer 3 
- Raises, Layer 4 - Stopes, Layer 5 - Minor Airways etc.   

Secondary Layers 
Secondary Layers, also consist of 250 discreet layers.  It is intended that the Secondary Layers be used 
for isolating parts of a model that could be viewed independently from the rest of the model.  As 
mentioned above, this could include working areas, stope, raises, declines or any other feature of 
interest.   

There is no limitation on the number of airways belonging to a layer, however an airway can belong to 
only one secondary and one primary layer.  Primary layers and secondary layers can be set and viewed 
independently of each other. 

See the Metal Mine example (BLUE_SKY.VSM) examples that comes with VentSim™. 



 

 

Hint : To quickly save and recall a ‘layer state’ use the Save View function to save and recall views with the Primary and Secondary 
Layers settings. 

Using Layers 
The easiest way to use Layers may be to create the model first (all airways will default to Layer 1 of both 
Primary and Secondary Layers, and then editing individual or group airways to change the layers to the 

desired number.   

Hint : The Edit Box has a function which will select and group all similar airways (for example all round airways with a diameter of 
3.0m.  This can provide a quick way to group edit and change layers for multiple airways. 

New airways constructed will inherit the layer numbers of the airway they are constructed from.  If no 
airway exists, new airways will use the default layers set in the Display Manager. 

Hint : Because primary and secondary layers can used together, this creates an opportunity to create a filter using both layer 
systems.  If for example, primary layers were assigned as different regions of a mine (North, South, East and West for example), and 
Secondary layers was defined as different functions (Shafts, Ramps, Ore drives for example), then by individually setting the Primary 
and Secondary layers, the following examples could be easily viewed. 

All ramps in the North Mine 

All ore drives in the East and West mine. 

All ramps and shaft in all mines. 

 

15.7. Summary 

The information in this Chapter explains only the basic techniques to establishing working ventilation 

models.  To create a truly representative ventilation model, airway sizes and resistance must be 
accurately established; ventilation controls (such as doors or walls) must be placed in the model with 
correct resistances, and many other important factors such as shock losses considered. 

For further information,  

• See the Tutorial part of this manual 

• Check the www.ventsim.com website for newsletters and forum information. 

• Seek a suitable VentSim DESIGN™ training course to undertake advanced training in the product. 

  

http://www.ventsim.com/


 

 

16  AUXILLIARY VENTILATION AND DUCTS 

The auxiliary ventilation duct building function in VentSim DESIGN™ provides an opportunity to model 
complex auxiliary duct arrangements in a mine model.  Auxiliary duct in mines is essential to ensure 
quality fresh air reaches areas of the mine without flow through ventilation, which in most cases will be 
blind headings. 

While auxiliary duct modelling is not a requirement for all models, the modelling of auxiliary fans and 
duct may be important to ensure adequate ventilation is delivered to key area, that the correct size duct 
and fan is used for a given length of duct, and that the impact of heat, humidity and fumes generated in 
auxiliary ventilated areas is correctly modelled on the remainder of the mine network. 

 

16.1. Introduction 

Simulation of contaminants through underground mines can be difficult to predict, particularly if 
simulations are required to take into account the complex 

The vent duct builder box requires a number of values to be entered 

The diameter of the duct 

The friction factor of the duct.  This can be directly overridden with a custom 
value, or additional friction factors can be added to the drop down list in the 
Preset > Friction Factor section of the program settings 

A leakage factor representing the portion of the duct surface with holes, 
compared to the total duct surface.  By default this measurement is in mm2 / 
m2, which could also be considered as ‘hole parts per million’.  Higher values 

represent higher leakage.  Placing a zero (0) in this box represents no leakage.  
Modelling leakage will increase model size and simulation complexity, therefore 
leakage should only be specified if it is specifically required to be modelled. 
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Diameter 

Friction Factor  

Leakage Porosity  



 

 

VentSim offers a number of default porosity factors in the drop down list, 

however these are subjective and can be altered in the Preset > Leakage 
section of the program settings. 

During simulation, leakage will demonstrate reducing airflow further along the 
duct away from the fan.  Fan pressures and duct diameter, together with 

leakage factors will influence leakage amounts.  Leaked air is returned to the 
airway at the position it is leaked from the duct.  

This field allows the Air Type of the duct to be specified directly from the 
Construct duct Form. 

(Heat Simulation only) Specifies the material of the duct if the user wants to 
enable heat exchange between the air inside and outside of the duct through 
the duct material. Selecting a Preset here will update the duct thickness and 

thermal conductivity fields. 

This specification is an internal instruction to VentSim to build a leakage path 
(an invisible duct) into the airway at frequent intervals to allow air to leak 
back into the main airway.  The resistance of this path is calculated 

automatically and is a function of the leakage factors and the leakage interval.  
In most cases it will not alter the simulation result significantly, however smaller 

leakage intervals will theoretically give more accurate results, but will increase 
the clutter and complexity of the display.   For longer ducts, a minimum of 50m 
is suggested. 

Specifies where the duct will be built in relation to the airway.  It is 
advantageous to build the duct outside of the main airway as it is easier to 
see and manipulate.  For example, if the main airway is 5m high, then a Z 

Offset of 5m will place the duct at 5m above the centreline of the airway. Do not 

use an offset of (0, 0, 0) as this will overlay the duct on the airway centreline 
and will simulate correctly. 

Starts the duct building process.  A duct and leakage paths are place on a 
single group to allow the system to be selected with a single Select click in 
future. 

 

Figure 16-1 Example of duct built 

modifies existing selected ducting with any new factors entered into the duct 

builder.  Note that the leakage intervals cannot be modified.  If this is required, 
the duct should be removed and re-built. 

deletes any existing selected ducting from the model.  If normal airways are 
also selected, then this function will only delete ducting and leakage paths. 

Hint – Things you may want to do next  

Air Type  

Duct Heat Transfer  

Leakage Intervals  

Offset  

Build Duct  

Modify Duct  

Remove Duct  



 

 

Place a suitable fan at the start of the ducting airway 

Consider placing an obstruction in the main airway if the duct is significant in size, and airflows along the main airway are high. 

 

16.2. Applying Ventilation to Ducts 

When duct is created, a pathway will be built into the duct to allow it to draw and deliver airflow to the 
underlying airway. 

To ventilate a duct, simply EDIT the start of the duct airway with the EDIT toolbar button (do not SELECT 
the duct first as the entire duct will be selected) and then use the FAN tab to place a fan or a FIXED flow 
in the duct. 

 

Figure 16-2  Auxiliary ventilation of duct 

     

The direction of the fan controls whether the duct is pressurised or in 
suction.  To change the direction of the installed fan after placement, simply 
use the REVERSE toolbar button to change the direction of the fan section of 

the duct.  The entire duct airflow direction will then reverse after the next 
simulation. 

 
If a duct has multiple fans installed at different positions (a common practise 
for long lengths of rigid duct), then additional fans can simply be installed at 
locations along the duct, by using the previous method to install fans or fixed 

flows.  If the duct is built with leakage, leakage can travel too or from the duct 
either way depending on fan and suction pressures. 

HINT : Using the TOTAL RELATIVE PRESSURE colours, the user can determine if the duct section are under pressure or suction. 

 
Figure 16-3  Colours showing the relative internal pressure of the duct 

Pressurised or Suction 
Duct? 

Inline Fans 



 

 

 

 
If more than one duct is to be built along an airway, then the OFFSET 
function can be used to ensure  the ducts are separated and will simulate 
correctly. 

For example, if two ducts are required, the first duct can be built with a 
HORIZONTAL offset of ‘-2’ and the second duct can then be built with a 
horizontal offset of ‘2’.  This ensures that either duct sits on opposite side of the 
airway and that they can be independently simulated. 

 

Figure 16-4  Multiple Ducts 

 
If ducts require different sizes midway along the duct length, then this can 
be altered by selecting the duct portion that requires a different size, and 
then using the EDIT toolbar button to modify the duct size.  Because duct is 

automatically GROUPED when created, to select only a section of the duct, 
either use the SELECT fence function, or ensure the CTRL key is held down while 
selected to override the GROUP functionality. 

 

Figure 16-5  Partially changing the duct size 

To extend duct or create new tee-sections and junctions it is normally 

recommend to remove then rebuild the entire duct with the new section.  

Alternatively, it is possible to build only the new section of duct with the duct 
builder tool, however the connection section of the duct that join back to the 
airway will need to be manually removed with the DELETE button, to ensure the 
duct does not ‘dump’ the air back into the airway at the new join. 

For example, in the picture below, a new auxiliary duct was created to extend 
into a new airway to the right of the main airway an duct.  The duct builder 
created the duct with a connection back into the main airway.  To ensure this 

duct is correctly joined, the connection must be DELETED and the remaining end 
of the duct MOVED back to the main duct and joined. 

Multiple Ducts 

Multiple Sizes 

Extending Duct 



 

 

                         

 

Figure 16-6  Extending an auxiliary duct 

  



 

 

17  CONTAMINANT SIMULATION (Steady State) 

Steady State Contaminant simulation allows tracking the concentration of contaminants through a 
ventilation model.  VentSim DESIGN™ has a number of different types of contaminant simulations to 
enable users to predict the paths of any sort of gas, dust, smoke, stench gas or even fresh air through a 
mine, and may assist in emergency planning, production design, and to improve blast clearance times. 

 

17.1. Introduction 

Simulation of contaminants through underground mines can be difficult to predict, particularly if 
simulations are required to take into account the complex boundary and mixing behaviours of 
contaminants traveling through a three dimensional airway.  

VentSim DESIGN™ uses a relatively simple algorithm which distributes contaminants in a linear velocity 
fashion, and assumes perfect mixing at intersections.  This method is considered suitable for high level 
studies through broad mine areas, but is not recommended for analysis of contaminant diffusion on a 
small scale level.  In this case a computational fluid dynamic simulation may be better suited. 

A number of different simulation techniques are offered to provide users with a host of tools to analyse 
the tracking of air and contaminants through a mine.  Contaminants can either be specified as an in-line 

concentration of contaminant within the airway, or they can be injected into an airway using a surface 
connected airway to represent an external gas source (see the Gas Simulation section for further 
information on this method) 

17.2. Contaminant Steady State 

Performs a steady state (continuous) contaminant simulation based on the position of contaminant 
source(s) placed in the model.  

Steady state simulation simulates the spread of contaminants until such time as the contaminant 
spreads through all possible pathways, and contaminant levels have stabilised to a ‘steady state’.  Where 
recirculation may be present, the simulation will continue until the recirculated air has reached 
equilibrium concentration.  The simulation will only show result when ‘steady state’ conditions have been 
achieved. 

Upon completion, the view will switch to a contaminant view of the final results with airways coloured 
according to concentration of contaminants.  The contaminant spread time can also be selected as a 

Chapter 

17 



 

 

colour or data text option, however this function will only provide the time that the contaminant first 

reaches an airway location, not the specific concentration of contaminant at that time.  For calculating 
contaminant concentration at a particular time, the Dynamic Simulation function will need to be used. 

Contaminant can be placed in a model by using the Edit  toolbar function and selecting the Contaminant 

Tab, or the Contaminant toolbar button
.  Contaminant strengths are volume unit 

based and can be entered either as a 
proportional unit base, or a volumetric gas 
concentration. 

EXAMPLE  Entering ‘100’ as a concentration value may 
indicate 100% of the original contaminated source 
strength in an airway, and will result in the dilution of the 
value as uncontaminated air is mixed downstream.  In this 
case, a downstream value of ‘25’ downstream would 
indicate 25% of the original contamination strength. 

Another example of entering ‘2000’ may indicate an initial 
value of 2000 ppm of CO gas.  Downstream values would 
show diluted concentrations of this value.  The units name 
does not need to be changed, however if desired can be 
changed in the Settings > Contaminant menu. 

17.3. DPM 

Simulates a steady state flow of diesel particulates calculated from diesel heat sources placed in the 
mine.  For further information on this function, see the DPM simulation section. 

17.4. Gas 

Simulates a steady state flow of multiple gases defined as sources in one or more airways.  This is 

similar to contaminant simulation, but volumetrically simulates many different types of gases 
simultaneously.  For further information on this function, see the GAS simulation section. 

17.5. Reverse Contaminant 

Determines the source of air at a specific location. 

A sourcing simulation is similar to a reversed contamination simulation.  It tracks airflow back from a 
placed contaminant sfource, and indicates the percentage of airflow which contributes to the airflow 
through the contaminant marker.  This function is useful in determining where a location sources its 
fresh air from, or for analysing ways to reduce or increase airflow sources from certain areas (such as 
increasing airflow sourced from a bulk air cooler or decreasing airflow sourced from a hot production 

area.) 

EXAMPLE:  Entering ‘100’ as a concentration value and performing an ‘air sourcing’ simulation will show which airways upstream are 
carrying the relative amounts into the original airway.  Back tracking the concentrations to the surface will show which surface 
airways are providing the airflow and may show values such as (for example) 25% decline adit, 60% main vent shaft, 15% hoisting 
shaft. 

17.6. Find Source 

Assists in finding the location of a contaminant source. 

This simulation function was designed to assist in quickly identifying the possible locations of a fire or 
contaminant source (e.g. dust or production fumes) underground.  As people report the status of air 
from different locations (for example smoky air or clear air), the simulation will colour airways upstream 
and downstream as either smoke (red), blue (clear) or yellow (possible smoke source) 



 

 

Contaminant reports can be placed by selecting the location tool bar button under the contaminant 

button.  A RED pin can be placed to designate a contamination report.  VentSim will assume that all 
airways downstream from this report will also be in smoke (coloured red) and all airways above the 
report will be a possible source of smoke (marked in yellow).  The BLUE pin indicates clear air. VentSim 
will assume that all airways upstream from this point are in fresh air (coloured blue).  Once reports are 

place, select the location simulation function to simulate and colour the airways around the reports. 

As more reports are received, the YELLOW possible smoke source areas will decrease and the location of 
a fire or contaminant source can be narrowed. 

EXAMPLE   Mine Control receives a radio report that smoke has been smelled in a decline location.  Checks reveal that other 
personnel further up the decline cannot smell any smoke. 

The vent officer places a ‘REPORT SMOKE’ tag on the airway where smoke was reported and a ‘REPORT FRESH’ tag on the clear 
airways.  Pressing LOCATION SIM will show the likely paths of the smoke in RED, what areas are likely to be fresh in BLUE, and what 
airways may be the source of the SMOKE in YELLOW. 

After receiving two more reports of smoke in different areas and fresh air in other areas, the simulation suggests the smoke could 
only be coming from a workshop area in the mine.  The vent officer directs emergency personnel to that area, who find a large 
number of smouldering rags in an industrial waste bin. 

 

Figure 17-1  Example of contaminant sourcing narrowing down a smoke source. 

17.7. Fire Simulation? 

For intense or hot fires, it is not recommended to use the contaminant functions for fire simulation.  Hot 
fires produce significant expansion of airflow and natural ventilation pressures which can change flow 
quantities and even directions, thereby rendering conventional contamination simulation models 
inaccurate. 

For small fires, or perhaps the initial phases of a larger fire, contaminant distribution may still be a useful 

way to model smoke concentration and direction through a mine. 

For larger fires, it is recommended to use the VentSim Premium VentFIRE™ function which has specific 
simulation methods for distribution of hot gases, smoke and heat from fires, and can assist in simulating 
the dynamic changes to the ventilation system. 



 

 

18  DYNAMIC SIMULATION (Advanced) 

Dynamic simulation is a specialised simulation method that shows a time based simulation result that 
can be dynamically viewed and changed during the simulation. Dynamic simulation can be applied to 
contaminants, gases, DPM and heat. 

 

The key difference between steady state and dynamic simulation is that changing ventilation conditions 
and contaminants can be tracked through the mine at specific times, and in most cases, the VentSim 

model can be dynamically changed (for example different levels of contaminants can be changed, or the 
model airflows, resistances or fans can be altered) to see the effect on contaminant flow. 

18.1. View Dynamic Simulation Results 

Dynamic simulation employs two methods of observing results.  The simulation will dynamically show the 
on screen results as the simulation progresses.  Ensure the text and colours are showing the required 
simulation data type during the simulation to see the results. 

Alternatively, a ‘monitor’ can be placed in an airway to observe and record the 

simulation changes historically. 

 

To view the results contained in a monitor, simply click the VIEW button on the 
monitor to view a graph of results. 
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Figure 18-1 – Example of Blasting Gases at a monitor location 

18.2. Contaminant Dynamic 

Performs a dynamic contaminant simulation based on the position of contaminant source placed in the 
model.  

The simulation will run a continuous time based simulation showing the track and concentration of 
fumes.  The simulation can be paused at any time and the colour or type of data can be changed during 
the simulation.   

Warning: Dynamic contamination in VentSim uses a simplified homogenous distribution algorithm which ignores the slower turbulent 
boundary effects of airflow along a rough passage and around corners, and the higher centre airflow velocities.  Due to this leading 
and trailing effect, VentSim may slightly underestimate the speed of gas distribution, and also underestimate the speed at which all 
gas is cleared from an airway.  The simulation should only be treated as a guide. 

Dynamic Contaminant can be applied and set in the EDIT – Contaminant box of any airway, or by using 
the SMOKE icon on the toolbar.  There is no limit to the number of contaminant sources that may be 
simulated simultaneously in a model. 

 

Dynamic Contaminant Sources may included 

• Fixed Time Release 

• Linear Decay Release 

• Logarithmic Decay Release 

• Explosive Gas Release 

 

Figure 18-2 : Placing a contaminant in an airway 



 

 

18.3. Fixed / Linear / Logarithmic Release 

Selecting these options releases a contaminant for a limited amount of time into the airstream.  The 
amount of time is set in the EDIT box.  FIXED release emits the same contaminant level throughout the 
release time.  Linear Decay releases a decreasing amount throughout the release time, starting at the 
original set contaminant levels, and reducing to zero at a linear rate by the end of the release time.  
Logarithmic Decay is similar to linear decay, but more rapidly reduces concentration at the start of release 
time according to a logarithmic power scale. 

Time release dynamic contaminants are intended to be used for sudden or limited time release events, 

such as a stench gas release, gas burst or inundation or tracer gas release, or limited emission of smoke 
or other contaminants from a source.  The simulation is useful for not only detecting the spread 
concentration, range and timing of contaminants, but also for establishing how long it will take to clear 
contaminated areas of contaminants. 

18.4. Dynamic Explosive Contamination 

VentSim 2 utilised a throwback blasting volume method to calculate an initial volume of blast 

contaminated air that was fed into the mine atmosphere at a decaying rate.  This method was restrictive 
in that the throwback volume factor and the initial throwback volume contaminant concentration had to 
be estimated for each blast.   

Actual blasting tends to produce more concentrated initial contaminant volumes for large blasts 
compared to small blasts.  As a result, there was potential to underestimate blast gas concentrations, or 
underestimate clearance times. 

VentSim 3.0 and above dynamic explosive contaminant simulation utilises a more automated method 
and works on the theory that any blasting source will initially produce a mass of pure blasting gases 
(based on a ‘yield’ factor for the explosives) that must be ‘bled’ into the surrounding atmosphere.   
Rather than trying to calculate an initial ‘throwback’ volume, the rate at which this pure gas is bled into 

the surrounding atmosphere is based on an adjustable logarithmic decay series which in the experience 
of Chasm Consulting appears more consistent with practical measurements of actual blast gas releases 
underground.  

When explosve gas enters a mine airway, the ventilation system must then remove the contaminated air 
from the region through the rest of the mine to the exhaust.  The rate at which the fresh air ventilation 
can initially remove the contaminant depends on the efficiency of the ventilation flow to access and 
remove all fumes from the blast zone (labeled the ‘dispersion factor’ in VentSim).   

For example, in an open free flowing drive with good airflow, contaminant would be expected to be 
removed quickly as the fresh air forces all pockets of fumes and gas quickly down the drive.  A blind 
heading, ventilated by duct which may be damaged or some way away from the heading end will clear 
slowly as the fresh air cannot efficiently reach all parts of the drive and remove the fume.  

The intial blast gas concentration mixing into the atmosphere is automatically calculated by VentSim and 
is based on the blast size and the dispersion factor.  This value is shown as an estimate in the EDIT box. 

Results for Version3.0 and above in most cases should be similar to VentSim 2.0, however for large 
blasts, initial gas concentrations may be higher than determined by the user, and clearance times may 
be shorter. 

 

VentSim uses logarithmic decay series to determine the portion of injection of 
blast gases into the atmosphere.  The decay series uses a ‘dispersion’ factor of 
between 0 and 10 to control the logarithmic decay rate.   

The dispersion factor is a unitless number that uses a square power series to 
describe the rate of gas removal.  For example, a factor of ‘2’ will initially release 
the explosive gases into the atmosphere at twice the rate of a factor of ‘1’.  A 
factor of ‘4’ will initially release the explosive gases at twice the rate of ‘2’, 
creating an intially more toxic atmosphere, but clearing more rapidly.   

Dispersion Rate 



 

 

These factors are somewhat subjective (VentSim describes ‘1’ as very slow 

dispersion and very fast 
as ‘10’)  and it is 
suggested that mines 
use a gas detection 

meter to gain an 
understanding of their 
dispersion rates for 
different blast and 
ventilation scenarios.  
Once VentSim 
simulations are 

calibrated with the blast 
results, the factors can 
be more accurately 
determined and used 
with more confidence in 
other areas. 

The contaminant and explosive concentration and amount can be placed with 
the SMOKE button and can be changed in the EDIT – Contamination box.  A 
unlimited number of  dynamic sources can be placed throughout the model, 
each with a different blast size and clearance rate (to simulate a number of 
development headings and stopes firing simultaneously for example). The 
simulation is activated from the Run menu or from the Contaminant Simulation 
side button access 

The yield rates of explosive gas release can be 

established in the 
Contamination Simulation 
settings.  The default yield 
rates are based the 
number of kilograms of 

Carbon Monoxide release 
per kilogram of explosive 
blasted as measured by 
Orica.  This yield factor 
can be changed or made 
to represent other types 

of gases.  The 
concentration units 
entered can be changed to 
any concentration based 
unit (eg %, ppm, mg/m3 
etc) in the settings.  The unit name can also be changed in the Settings > 
Contamination menu section. 

 

In VentSim Version 5.2 and above, an Explosive Type can be selected from the 
Explosive Presets. This allows the user to specify particular explosive product 

yields, allowing calculation of a range of products during the same simulation. 
The Explosive Presets allow the specification of set contaminant yields for typical 
explosion products, including Carbon Monoxide, Nitrous Oxides and Ammonia. 
Using this option, the same underlying method for the Explosive Simulation is 
used, but the Contaminant Yield Ratio is calculated from the Explosive Preset 
yields. At the end of the simulation, the concentrations of the explosion products 
throughout the mine are calculated based on the current local contaminant 

concentration and the fractional yields of the various components.  

Explosive Gas Release – Contaminant Only 

Explosive Gas Release – Preset Explosives  



 

 

EXAMPLE :  Blasted development headings have been previously measured to initially have up to 2000 ppm of CO carbon monoxide 
immediately after blasting and a clearance time of 15 minutes.  Therefore a dispersion factor is entered into the EDIT box to obtain a 
similar result (the setting unit can be changed to “CO ppm” if the user selects), and the explosive amount set to 200 kg.  When 
dynamic simulation is chosen, the concentration of fumes (in ppm CO) is shown through the model second by second.  Clearance 
times can be established when concentration falls below a specified limit (for example 25 ppm).  At any time, the colour legend and 
limits can be changed to show the concentration as colours. 

Warning : Dynamic contaminant simulation has many factors which can initially be difficult to predict.  It is highly recommended users 
calibrate their models with actual data if they have the opportunity.  The simulation does not replace real gas measurement or 
observation when entering blasting areas.    

18.5. Dynamic Gas Simulation 

Dynamic gas simulation simulates the time based spread of gases through a mine.  Once again, the 
dynamic monitor functions can be used to record historical gas results from the simulation at different 
locations. 

For further information see the GAS SIMULATION chapter. 

18.6. Dynamic DPM Simulation 

Dynamic DPM simulation uses diesel heat sources to calculate diesel emissions through the mine.  The 
DPM levels are spread through the mine over time, and can be recorded with the dynamic monitors to 
show a history of results. 

The DPM levels can be dynamically adjusted by PAUSING and editing or moving the machines around 
during the simulation, and then RESUMING the simulation. 

For further information see the DPM SIMULATION chapter. 

18.7. Dynamic HEAT Simulation 

Dynamic Heat Simulation is a potentially complex function that can help determine transient or changing 

mine temperature based on changing conditions through the mine. 

For example, surface temperatures, machines, refrigeration or mining activities can be changed during the 
dynamic simulation to determine the effect of the changes over time on the mine atmosphere at different 
locations in the mine. 

 

To calculate the true dynamic effects on the 
mine atmosphere, the mine rock surface 

boundaries must be considered to have 
reached a stable boundary temperature so 
that short term changes in mine atmosphere 
temperatures can be released or absorbed by 
the rock at levels similar to the initial rock 
exposure receptiveness. 

This creates a ‘thermal’ buffer or flywheel 

effect that effectively reduces the 

downstream impact of rapid temperature 
changes on the mine atmosphere.  The 
thermal flywheel effect diminishes with 
exposure time; however for the short term 
dynamic simulation term that this function is 
designed for, the assumption of the rock 

boundary layer achieving a stable 
temperature produces reasonable results.  To 
adjust for longer term exposure during 
dynamic heat simulation, VentSim creates a 
boundary layer of rock at a predetermined 



 

 

thickness that is allowed to store or release 

heat during simulation. 

The settings in the DYNAMIC > VENTFIRE™ section provide some level of control over the way this function 
works on the mine atmosphere. 

For more detail on this function, see the VentFIRE ™ section of the manual.  For complex dynamic heat 

simulation, the VentFIRE™ module is recommended as it allows pre-programmed heat and temperature 
changes to be included in the modelling, rather than manually pausing and changing the simulation. 

For further information on steady state heat or dynamic heat simulation, see the THERMODYNAMIC 
SIMULATION chapter or the VENTFIRE™ section. 

Warning : Due to the nature of short term dynamic heat simulation, it may not predict exactly the same results as steady state heat simulation.   If this 
is required, the SETTING > DYNAMIC > VENTFIRE™ option for Dynamic Rock Age may need to be increased, however this will impact on the Thermal 
Flywheel effect during simulation. 



 

 

19  MULTI GAS SIMULATION (Advanced) 

[VentSim DESIGN™ Advanced] 

Gas Simulation is a subset of contaminant simulation with some specialised properties to allow for 
multiple gases and air density estimation based on gas composition.  This can have application for 
natural ventilation changes for simulation. 

19.1. Introduction 

Gas Simulation is based on the same linear spread algorithm as other contaminant simulations, however 

it allows for the simultaneous release and distribution of up to 15 different gas types, and automatically 
volumetrically balances other gases to ensure a 100% total concentration mixture is maintained.  This 
function may be useful when tracking multiple contaminants of different levels from different sources, or 
when the density effects of different gas types need to be modelled in a simulation. 

Gases can be placed in models using an injection method, an inline gas concentration method, or by 
using a gas emission rate.  The first two methods use the same type of simulation, however the 
construction of the airways in VentSim differs.  The last method ‘emits; gas along predefined airway 

routes. 

Inline Concentration Method 
Specifically sets the concentration of gases in an airway and distributes the gas concentration 
downstream.  All air entering the set airway is reset to the specified gas concentration.  This method 
would normally be used when a known or measured concentration of gas is present in an airway. 

 

Figure 19-1  Inline Concentration (represented by the green icon) 

Injection Method 
This method allows the user to ‘inject’ a gas into an airway and observe the changes downstream.  It 

does not reset the concentration of gas passing the injection point, and will therefore allow accumulation 
of gas concentration though the model. 
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This method involves constructing a separate dummy ‘airway’ to inject the gas into the model.  The 

injection dummy airway should connect to the ‘surface’ to allow the injection to draw a quantity of gas 
separate from the model simulation.  The injected gas should then be set to the actual concentration (eg 
90% methane) and a fixed flow amount set to specify the rate of injection into the model.  If very small 
fixed flow values need to be specified, the unit accuracy for airflow may need to be increased in the 

Conversion Settings. 

The model can then be simulated to show the results downstream.  To show the smaller concentrations 
of gas, the colour legend display may need to be manually adjusted to show the full range of colours 
over a much smaller range. 

 

Figure 19-2  Example of Injected Gas 

 

Linear Emission Method 
This method allows the user to specify a rate that gas may be emitting from an airway surface into the 
mine atmosphere (for example coal seam gas).  The emission is entered in litres per second per metre 
(l/sec/m) along the airway, and gradually replaces the atmosphere in the airway over time.  Note that 
the method used is ‘replacement’ which is not strictly accurate as in reality the gas adds to the 
atmospheric volume causing a change in ventilation flows.  In most cases however, the ventilation flow 
change is minute and can be ignored.  If the emission rate is significant, and is likely to independently 

cause a change in airflows and perhaps push gas into other airways, then the more cumbersome 
‘injection’ method should be considered instead. 

 

 



 

 

19.2. Simulating Gas Sources 

Placing Gas Sources 
 The EDIT form has a facility to fix the concentration of gas 

compositions in any airway (injected or in-line) in the 
ventilation model.  All gas concentrations should be entered 
as a volume based concentration value (not mass based) 
and then ‘FIXED’ to instruct the simulation to use the 
specified amount.  

If gas mixtures are to be commonly used throughout a 
model, it is recommended to establish PRESET gas 

mixtures, which can be defined in the PRESET table and will 
automatically apply the gases to the airway when set. 

Gases which are not fixed will be automatically adjusted to 
ensure the total volume concentration of all combined gases 
remain at 100%.  The adjustment is done proportionally so 

gases which are not fixed (for example Nitrogen at 79%) 
will be adjusted proportionally more than lower 

concentration gases (for example Oxygen as 21%) 

 

Simulating Results 
Pressing the simulation directly from the Edit form or the Contamination Gas Simulation sub-button on 
the toolbar will run a Steady State simulation. Alternatively, gas simulation can be performed 
dynamically, using the Dynamic Simulation > Gas button. 

 

Figure 19-3  Run the gas simulation option 

To display the results, the text or colour display may need to be changed to select the type of gas to be 
reviewed.  The colour legend values may also need to be manually changed to show the full range of 
colours for the desired concentrations. 



 

 

     

Figure 19-4  Change the text and colour to show gas concentrations 

To clear the results of a gas simulation and reset the model back to a standard atmospheric gas 

composition, use the Clear Contaminants options. 

19.3. Density Based Simulation of Gas 

VentSim DESIGN™ Advanced has the ability to simulate the effect of different air densities on airway 

resistance and natural ventilation pressures. 

This ability is extended to include the effect of gas composition on total air density and natural ventilation 
pressures.  To use this option, the following options need to be enabled in the Settings > Simulation > 
Gas 

2. Compressible Airflows (available from Settings > Simulation > Airflow Menu) 

3. Natural Ventilation Pressure (available from Settings > Simulation > Airflow Menu) 

4. Gas Density for Simulation (available from the Settings > Simulation > GAS Menu) 

 

Once enabled, provided Natural Ventilation Pressure (NVP) option is chosen, any gas distribution 
simulated in the model will result in changes to airflow simulation based on the effect of the gas density 
on air buoyancy, and the change in effective airway resistance. 

For example, if 5% methane is simulated through an area of a mine with a Gas Simulation, then providing the Gas Density Simulation 
option is turned on, subsequent airflow simulation will predict the steady state buoyancy effect of methane through that region of 
the mine. 

Another option may be to simulate gas drainage through pipe models, although this process has yet to be validated in VentSim™ 

Warning : After completing simulation work using Gas Density simulation options, remember to restore the settings and turn off the 
option, otherwise future simulation will be permanently affected by gas through a model, until the gas it cleared out and removed 
with the clear contaminant option. 

19.4. Wet Air Gas Balance 

VentSim DESIGN™ Advanced has the ability to include Water Vapour as a component gas in Gas 
Simulations. The Water Vapour content of air is usually low (<3%) and is often ignored in gas analyses 

since its concentration is strongly linked to the heat and psychrometric properties of the air. In some 
contexts (strongly humid conditions, such as the application of Gag gas units for fire fighting) the 
inclusion of the water vapour is important, as high concentrations can significantly affect concentrations 
of other gases, notably Oxygen, which can in turn affect fire propagation. 



 

 

By default, Gas Simulations are run with the option disabled. Before enabling the option, the model 

should have a well-calibrated Heat Simulation, since the Water Vapour concentrations are calculated 
directly from the psychrometric properties of the air in each airway. To enable Water Vapour 
concentration to be calculated and included in the gas balance, disable the default Dry Air option in 
Settings > Dry Air Gas Balance. Doing so will have the following effects: 

• During Gas Simulation (and other simulations utilising Gas, such as VentFire) 
Water Vapour concentration will be calculated. The calculation is based only on 
the current psychrometric condition (heat, moisture, pressure) of the air.  

• After the Water Vapour concentration is calculated, other gas concentrations are 
adjusted to include the Water Vapour. 

• The Water Vapour concentration can be viewed in the model in the same way as 
the other gases; through the Color Data box and the Gas Tab of the Edit Box. 

Note, that unlike the other gases, the Water Vapour is NOT transported from one airway to another with 
the airflow. Instead, a new Water Vapour concentration is calculated in each airway, adjusting for the 
local heat and pressure.  

Furthermore, because of the calculation method, a Fixed Water Vapour concentration can not be set. If 
users wish to set a given Water Vapour concentration in a given airway, they would need to create heat, 
moisture and pressure in the airway to give rise to that Water Vapour concentration.  



 

 

20  THERMODYNAMIC SIMULATION (Advanced) 

[VentSim DESIGN™ Advanced] 

Thermodynamic (or heat and moisture) simulation is a complex field of mine ventilation and 
environmental engineering.  A comprehensive understanding of psychrometry as well as practical 
aspects of heating and refrigeration is recommended before using VentSim DESIGN™ to assist with 
major infrastructure decisions for mine planning and development. 

20.1. Introduction 

Heat in mines is an inevitable part of mining in the earth’s crust at depth.  As mines become deeper, 
excessive heat may play an increasingly more important part in the consideration of a ventilation system 
design.  Conversely, cold conditions, particularly in far northern mines can equally affect a mines 
performance, especially in winter where freezing of shafts and collars and worker discomfort 
underground become a problem. 

The impact of heat on worker physiology is perhaps the key factor in designing a ventilation system for 
underground mining that is impacted by adverse temperatures. The exposure of excessive heat to 

workers impacts both on their work performance and output, and ultimately their health and safety. 

When designing a ventilation system, in addition to providing ventilation to provide fresh air and remove 

noxious gases and dust, we also must design a climate for people to work in.  Even if a mine does not 
have excessive heat concerns, worker performance will always be best where sufficient cool air is 
available to efficiently remove heat generated from human bodies doing work duties.  Different 
ventilation strategies can impact on the underground climate, and this chapter discusses how VentSim 

DESIGN™ deals with different sources of heat and moisture and explains tools in VentSim DESIGN™ to 
analyse and apply design changes to improve underground climates. 

Sources of Heat 
Heat comes from a variety of sources in underground mining.  If we begin with the heat provided initially 
in the fresh air entering the mine from the outside climate, the following sources are important factors in 
what happens while the air travels though the mine. 

• Rock Strata – Dictated by the rock type and geothermal gradient, the temperature and heat flow 
from exposed rock increases at depth. 

• Autocompression – As air travels deeper and is ‘compressed’ under gravity, the temperature 

increases theoretically by nearly 10 degrees C dry bulb per 1000m although this may be less if 
moisture is present in the airways. 

• Diesel Equipment – A major source in modern mines, both heat and moisture are generated by 
diesel equipment. 

• Electrical Equipment – Fans, pumps, winders, substation and electrical distribution system all 
distribute heat into underground workings. 

• Blasting – Perhaps more of a transient heat source, blast can cause short term spikes in heat in a 

mine, and some heat can be retained in broken rock for some time. 
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• Oxidisation – Highly reactive ores can produce heat when exposed to oxygen. 

 

Figure 20-1 Example of Heat in mine calculated by VentSim after simulation 

Source of Moisture 
In addition, moisture can affect the comfort level of air underground.  As moisture levels and humidity 
increase, this reduces the ability of the human cooling system (sweating) to adequately cool the body. 

Strata – moist or wet rock surfaces from ground water results in increased evaporation. 

Ponded Water – collection of water on the ground or underground dams can increase evaporation of 
water. 

Diesel Equipment – generates additional moisture in the air through exhaust and by work activities by as 

much as 1.5 – 5 litres of water per litre of diesel consumed. 

Dust Suppression / Sprays – used to settle the dust often on main travel routes, much of the additional 
water is eventually evaporated into the air. 

It is important to note that the evaporation of water into the air does not directly increase the ‘heat’ of 
the air – in fact the dry bulb temperature is decreased and wet bulb temperature remains initially 
unchanged.  However the decreased ambient air temperature makes the cooler air more receptive to 
collecting heat from downstream rock surfaces, resulting in increasing wet bulb temperatures.  As a 

result, air quality and cooling power will more rapidly decrease and wet bulb temperature increase with 
the addition of moisture to the air. 

 

20.2. Application of Heat 

Model Environmental Settings 
While VentSim DESIGN™ analysis automatically considers heat from strata, autocompression and fans, 

the correct base assumptions or ‘environmental’ factors must be first entered in the VentSim model 
settings to establish the conditions in which the mine is being simulated.  See the Settings > Simulation 
– Environment section for further details. 

User Inputs 
All direct user specified heat into airways is entered via the EDIT box > HEAT.  The most common user 
heat input source will be diesel heat or sensible (dry) heat, however the user can also input latent (water 
vapour) heat, refrigeratiion and oxidisation if applicable.  In addition, the temperature of the air at a 
location can be specifically fixed to match actual data, or to provide simulated feedback from VentSim 

DESIGN™ on what is required to achieve such temperatures. 



 

 

Warning : Perhaps the biggest mistake in attempting to simulate heat underground, is trying to apply a heat source to an airway 
carrying small amounts of airflow.  While this may be possible in real life due to perhaps only a short time of exposure, because 
VentSim DESIGN™ uses a steady state thermal simulation, the heat is assumed to apply continuously and can result in extremely high 
air temperatures.  As the thermodynamic equations are only optimised for a certain heat range (up to around 100 degrees), excessive 
heat will produce a simulation error. 

Sensible Heat 
Sensible heat is the application of heat to the air with no change in moisture content.  The situation 
applies to dry heat sources such as electric motors from fans or pumps, radiating heat from hydraulic or 
working equipment or frictional heat sources from conveyor belts or crushers.   

Note that all ventilation power underground such as fans and fixed flows or pressures are automatically assumed to be sources of 
heat in VentSim.  They do not need to be entered as separate heat sources. 

Diesel Heat 
Diesel engine sources underground are internally converted to a mixture of sensible and latent heat for 
simulation.  Due to thermal inefficiencies, a diesel engine of a rated power will produce nearly three 

times the heat of the rated engine power, assuming no energy is converted to ‘useful’ work.  Ensure 

when entering diesel heat sources, that only the engine power diesel equivalent is entered, not the 
engine heat output.  The efficiency of a diesel engine can be specified in the Heat Simulation settings. 

Diesel combustion results in the production of heated exhaust gases and water vapour, which is 
transferred to the surrounding air.  In addition, additional water vapour source from engine cooling 
systems or the surround environment is added to the air in the form of evaporation.  This ratio of diesel 
fuel to water is set in the Settings Menu, and is assumed the same for all diesel heat sources.  If 
separate ratios need to be considered, the sensible and latent heat will need to be entered instead of a 

single diesel heat figure. 

Latent Heat 
Perhaps the biggest source of confusion in applying underground heat is the application of latent heat.  
In general, latent heat, which is essentially adding heat to the air in the form of water vapour, should 
rarely need to be considered as a separate user input.  While latent heat is internally calculated by 
VentSim DESIGN™ in the application of strata evaporation and diesel equipment, it rarely needs to be 

applied directly by the user.  The only exception may be to ‘condition’ air to a required wet bulb and dry 
bulb temperature, or in the application of heating to a mine with propane or some other moisture 

producing fuel source. 

Oxidisation 
Oxidisation heat is included for completeness, but will rarely be required to be entered into a mine 

model.  For most mines with reasonable ventilation flows, oxidisation will be generally insignificant in 
overall heat gain.  The exception may be in highly reactive ores or where there is very low airflow. While 
there are formulas to estimate the reactive heat of certain types of ores, it is generally unreasonable to 
try to calculate this value theoretically due to the variability of oxidising ores.  In most cases, oxidisation 
heat can be estimated from empirical measurements from actual underground areas. 

Fan and Fixed Flow Heat 
All electrical fans generate heat which is dissipated into the surround airflow.  The heat generated is 
equivalent to the input electrical power, and is dissipated into the airflow through a combination of 

electrical motor inefficiencies, blade inefficiencies and air compression.  VentSim DESIGN™ automatically 

includes heat from fans (and fixed flow) in a model heat simulation, therefore there is no need to include 
fans as a separate heat source 

20.3. Injection of Moisture 

While VentSim DESIGN™ automatically considers moisture derived from wet or damp strata surfaces, 
direct user moisture injection to air from underground sources is unlikely to be commonly used in most 
models.   

It is important to note that moisture application to air does not directly alter the heat content of the 
airflow (providing the moisture added is the same temperature as the airflow).  Instead, through the 
process of evaporative cooling, the dry bulb air temperature is decreased, while air moisture content in 



 

 

the form of water vapour increases (as latent head), resulting in net zero energy change.  Once 

evaporation occurs however, the cooler ambient air temperature may be more receptive to heat transfer 
from rock surfaces resulting in increasing wet bulb and dry bulb temperatures downstream from the 
transfer point. 

Examples of water addition to airflow may be: 

• Dust suppression sprays 

• Evaporative Cooling 

• Conditioning of air for simulation 

• Water can be injected into airflow using the Point or Linear moisture source function in the Heat 
input sheet on the Edit form. 

Dust Suppression 
Dust suppression sprays are often used on dusty roadways, at stope draw points or on conveyor belts or 
crushers.  Water sprays directly increase the water content of air through increased evaporation from 
fine water particles, as well as wet surfaces around the sprays.  In many cases however the uses of 

sprays is often sporadic and does not represent a steady state flow model.  For sporadic sprays, a better 
solution to applying moisture to the airflow in a dust suppression area may be to increase the wall 
wetness fraction to closer to one (1).  This will assume the area remains wet and also proportionately 
alter moisture addition depending on the airflow quantities in the area. 

Caution: The amount of water capable of being applied to airflow will be limited by the amount of airflow in the airway.  If too much 
water is attempted to be applied, the excess will appear as condensate in the simulation. 

Evaporative Cooling 
Another application for adding moisture is evaporative cooling, however these are not commonly used in 
mines unless very dry warm air is present.  To simulate evaporative cooling, ideally a water balance 
should be undertaken to identify water being added to the air from an actual installation.  Alternatively, a 
temperature difference before and after the evaporative cooling chamber will allow VentSim DESIGN™ to 

estimate the water balance in the Edit Box Heat Assistant. 

Wet Material / Dam / Flooded airways 
Water may be picked up via evaporation via any wet material or ponded water. Once again, the problem 

of directly applying a water flow volume to the air is that evaporation will change depending on the 
volume flow and velocity of the air.  A better alternative to applying water over wet or flooded areas is to 
increase the wetness fraction of the airways. 

20.4. Application of Refrigeration 

The application of refrigeration for deeper or hot underground mines has become a routine requirement 
for many mines as they push deeper and environmental considerations become more pressing. 

There are several different types of refrigeration processes used in mines.  Refrigeration uses a heat 
exchange process where an amount of input energy (normally electrical or sometimes diesel) is used to 
create a heat exchange process where heat is removed from one medium (usually water or air) and 

exchanged as heat to another medium in a different location.  If the refrigeration system is surface 

based and the heat from the refrigeration electrical input and exchange is rejected to atmosphere, then 
only the direct refrigeration component needs to be considered for underground and can be placed 
where it occurs (e.g. at a surface shaft collar for a bulk air cooler, or in an underground airway for a 
chilled water spray chamber or cooling tower). 

If the entire refrigeration plant is placed underground however, then the heat rejected by the 
refrigeration plant needs to be placed separately as a (usually) SENSIBLE heat source.  This heat source 
needs to include an amount of equal value to the refrigeration value used, PLUS the input electrical or 

diesel power to the plant.  The ventilation design implications are of course that the heat should not re-
enter the cooled airflow, and sufficient airflow should be available to remove the heat. 



 

 

Refrigeration plant design for underground simulation can be summarised with 3 different methods. 

5.  BAC – Bulk Air Cooling, where all or part of the air entering the mine is cooled on or near the 
surface.  The plant is based on the surface, and only the refrigerative portion needs to be entered 
into the simulation.  BAC plants have the advantage of surface design and heat rejection, but the 
disadvantage of cooling air before it reaches the require location, thereby losing some cooling 

effectiveness along the travel route. 

6. Underground Spot Cooler Plant.  A refrigeration plant or machine placed underground normally 
only provides spot cooling for part of a mine.  The simulation requires both a refrigerative and heat 
source to be separately placed in the model, representing the cooling produced and the heat 
rejected.  The heat rejected must also include the input power to the plant.  Spot coolers have the 
advantage of only cooling the air required, but the disadvantage of requiring a separate exhaust 
airway to remove the heat rejection.  In addition, spot cooler tend to be smaller due to 

underground size restrictions and are more difficult to run and maintain.  

7. Underground Chilled Water.  The refrigeration plant is based on the surface, but the chilled water 

refrigeration exchange is location underground.  In this case, only a refrigeration source needs to 
be simulation.  Chilled water systems have the advantage of providing cooling only where needed, 
but the disadvantage of requiring potentially large volumes of water to be pumped and distributed 
through a mine. 

Finally, the ratio of the refrigeration power (heat exchange) generated versus the electrical (or 
mechanical) input power is called the refrigeration coefficient of performance (COP) and is specified in 
the SETTING > HEAT.  Although this factor is not directly involved in the simulation process (the final 
Refrigeration Exchange cooling kW is set by the user, not the input power), this setting helps VentSim 
calculate the total electrical power a model consumes.  COP normally varies from 2.5 to 5.0 (refrigeration 
power vs input power) and is dependent on the plant design and the input and output temperature 
parameters to the plant.  Direct simulation of these parameters is beyond the scope of VentSim 

simulation. 

Placement of Refrigeration Sources 
VentSim DESIGN™ assumes any item placed in an airway is simulated at the icon location.  For this 

reason, placing a bulk air cooler in the middle of a shaft, would assume the bulk air cooler is located half 
way down a shaft, which in most cases would clearly not be the case.  This assumption would result in 
slightly differing air densities and air temperature than would be the case if placed on surface. 

It is recommended that for fans and thermodynamic items, the icon be placed where the simulation is 
required to be performed, or alternatively a short airway segment (vertical or horizontal) is placed at the 
top of a shaft airway for the cooling infrastructure.  This will force the program to use surface conditions 

for the device. 

What portion of the air is cooled? 
VentSim DESIGN™ assumes all airflow within an airway is equally cooled by a refrigeration or heating 
device.  If only part of the airflow is actually cooled (and the other part mixes downstream), because of 
condensation of the split portion the mixed airflow results may have substantially different psychrometric 
properties than air that was universally cooled. 

While the two airflow cases will report similar heat reduction (consisting of sigma heat and enthalpy 

flow), the partially chilled airflow case may have the refrigerated portion chilled to much lower 
temperatures, resulting in an increase in condensation and subsequent removal of additional moisture.  

The resulting mixed stream will then be generally warmer, but dryer with a lower relative humidity, 
compared to the stream which is evenly chilled. 

Whether the installation is on surface or underground, if a cooling device only chills part of the airflow, 
ensure a separate airway is included to represent this chilled portion.  The example below shows the 
substantial difference in downstream temperatures between the two cases. 



 

 

 

Figure 20-2  Example of an inline cooler chilling ALL airflow 

Discussion: It is important to note that in both cases, 3500kW of heat has been removed from the air.  Downstream from the 
refrigeration unit, the difference in psychrometric properties of the mixed versus the whole chilled airflows will actually diminish.  
The dryer warmer air resulting from the mixed case, will actually enhance evaporative cooling from damp or wet airways, resulting 
in potentially cooler moister air, while the case with the cooler moister flow will enhance geothermal heat transfer from rock 
surfaces and reduce evaporative cooling. 

The resulting air temperatures some distance from the refrigeration source may be very similar.  

The type of refrigeration plant will have subtle differences on the effect on air 
temperatures and humidity.  A closed plate cooling tower versus a spray 
chamber for example may result in a different relative humidity due to the 

air to moisture contact mechanism, particularly if the dew point temperature of 
the air is not reached or the air is very dry.  Additionally, the presence and 
location of electrical pumps and equipment required to run the installation may 
introduce heat back into the airflow for an underground installation, but not a 

surface installation. 

As VentSim DESIGN™ only considers the refrigeration output of a plant, the 
plant performance in achieving this output is largely irrelevant to the 
simulation (although plants will perform differently depending on ambient 

temperatures to be cooled).  The plant design to achieve this refrigerative 
output for the ambient working temperatures is an extra design criteria outside 

of the scope of VentSim simulation.  For detailed engineering studies it is 
important to consider plant design to establish overall economics and 
effectiveness for the proposed ventilation circuit.  In addition, fouling and 
subsequent degradation of refrigeration plants should also be considered when 
allowing for contingency in sizing a refrigeration plant. 

 

20.5. Thermodynamic Flywheel Modelling (Beta feature) 

Heat inputs into a mine are not steady state.  Constant air temperature 
changes during a working shift, a day/night cycle, or an annual seasonal 
cycle continuously changes the rate at which heat is drawn from or into rock 

strata.  The cycling of heat loads in and out of rock due to changes in air 
temperature is commonly known as the ‘Thermal Flywheel Effect” which implies 
a cyclic storage and release of heat, although in fact more commonly it is simply 
a fluctuating change in the amount of heat released or stored from the rock over 
a period of time. 

Steady state simulation assumes a constant air to rock temperature heat 
transfer, and therefore can over or under predict the average transfer of 

heat over time, as daytime hot temperature are normally used as a basis for 

What type of 
refrigeration plant is it? 

Refrigeration Plant 
Performance 

Introduction 

Effect of Cyclic Heat 
Input 



 

 

simulation.  This can in turn lead to errors in the estimation of long term heat 

release from the rock mass, and subsequently lead to errors in air temperature 
prediction.  In most cases, while steady state simulation may over predict 
temperatures, this variance will be relatively small, however in mines which a 
great variance in rock to air temperature, the difference will be more significant. 

Another effect of the thermal flywheel process is to ‘buffer’ out temperature 
differences between day and night, or  between summer and winter.  This effect 
increases the further into an underground mine the air travels.  Temperature 
variances between day and night will be substantial near surface intakes, but 
deep in the mine the variance may be minimal.  The rock strata stores 
differences in intake air temperature and releases the differences during 
opposite air temperature cycles, thereby reducing the variance of air 

temperature the longer the air is exposed to rock. 

VentSim offers this simulation option to show the likely maximum and 
minimum temperatures due to the day/night effect in all parts of the mine.  

This will assist in assessing temperature conditions during a 24 hour period 
and may provide guidance on cooling strategies or likely times and periods of 
temperature exceedance.  The option does not consider variance in temperature 

during the shift (due to working machines for example) or longer term cycles 
where heat or cool may be carried into the future due to seasonal changes. 

 

The minimum and 
maximum surface wet and 
dry bulb temperatures will 
need to be set in the 

Thermal Flywheel settings.  
The maximum 
temperatures are shared 
with the Environment 

Surface Temperatures.  
The minimum 
temperatures can be specified, or a variance established to reduce maximum 

temperatures by a set amount.  The diurnal cycle time setting option is a 
calibration setting and should normally not be adjusted from 24 hours.  The 
cycle time creates a more aggressive thermal flywheel effect, and greater time 
reduces the effect. 

To run the simulation, simply select 
the Daily Thermal Flywheel 

Simulation option under the HEAT 
toolbar option.  The data categories 
will show colours and data presented 
for the maximum and minimum 
temperatures, as well as the variance 
between day and night temperatures.  
In most cases you will notice the 

variance will decrease the further into 
the mine the air flows. 

  

20.6. Annual Thermodynamic Flywheel Modelling (Beta feature) 
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The Annual Thermal Flywheel tool runs similarly to the Daily Flywheel tool, except it calculates temperature 

variations over a 12 month period, rather than a single day. The Annual Flywheel runs a heat simulation 
for each month of the year, providing the annual variation of temperature for every airway.  

The settings for the summer and winter temperatures 
for the Annual Thermal Flywheel are located along with 

the settings for the Daily Flywheel. In addition, the 
Annual Flywheel requires a Warmest Month to be set. 
(the default Warmest Month is August). The 
atmospheric temperatures throughout the year are 
approximated with a sinusoidal variation between the 
maximum and minimum temperatues, peaking during 
the Warmest Month. 

The Annual Flywheel model runs a heat simulation for each month of the year, as well as running an 
initial calibration run, so it will take longer than the Daily Flywheel. A progress bar will appear as the 
Annual Flywheel runs. Once the Annual Flywheel has completed, the results can be accessed in two 

ways. When Annual Flywheel data are available, an option will be enabled underneath the Heat 
Simulation dropdown menu, called Annual Flywheel Results. This will launch a graph cursor. Clicking on 
an airway will open a results window for that airway. 

 

This graph plots in dotted lines the annual variation of the atmospheric dry bulb and wet bulb 
temperatures and in solid lines, the annual variation of the selected airway dry bulb and wet bulb 
temperature is plotted. Users can enter different airway indices, unique numbers or names to show the 
results for other airways; multiple graphs can also be shown. Note, that results from new Flywheel 
simulations will not automatically update any existing graphs; to do this, press the Refresh button on the 
on the graph. This allows the user compare results between different runs. Users can make image copies 
of the graphs, as well as copy data to the clipboard. 

In the example shown, the damping of the temperature variation in the airway, in contrast to the 
atmospheric temperature, can be seen. Also, there is a lag in the peak temperature of the airway with 
respect to the peak of the atmospheric temperature. This phase lag in temperatures results from the 

thermal capacitance of the mine network and will increase the further from the air mine entry point the 
airway is. 

The results of the Annual Flywheel can also be accessed throurh the Color Data box, under Thermal 
Flywheel. The dry bulb and wet bulb temperatures of the mine can be shown for each month of the year. 

In addition, the variation throughout the mine of the heat phase lag can also be examined.  



 

 

21 DIESEL EMISSIONS SIMULATION 

[VentSim DESIGN™ Advanced] 

Diesel emissions include many gases however the main products of interest in terms of harm to health 
are Carbon Monoxide (CO), Nitrous Oxides (NOx / NO2) and Diesel Particulates (DPM). 

Diesel Particulate Matter (DPM) concentrations are a relatively new concern for underground mining 
operations.  While prolonged exposure to high levels of diesel particulates has long been suspected as 
having potential to cause health problems, only recently have mining regulators started imposing strict 
atmospheric exposure limits for underground mines.   

VentSim DESIGN™ Advanced provides tools to assist in predicting the distribution and concentration of 
diesel emissions through an underground mine. 

21.1. Application of Diesel Emission Simulation 

VentSim DESIGN™ Advanced uses simplified homogenous mixing methods (similar to contaminant 
simulation) to simulate emissions from diesel equipment exhaust entering the airflow and being 
distributed downstream.  While real diesel output will always be variable, because regulatory limits are 

normally based on an 8 hour time weight average (TWA) exposure for a person throughout a shift, most 
of these variations can be averaged. 

Every diesel engine emits a certain amount of pollutants which include 
noxious gases and solid particulates.  Regulators in many countries have 
introduced steadily decreasing emission limits on new engines, (known in 

North America as the Tier standard, or in Europe as the Euro rating).  Generally 

speaking, the higher the rating the ‘cleaner’ the engine emissions should be.  
The recently introduced Tier 4 standard is being implemented over the period 
2008 – 2015 and demands emissions be reduced by up to 90% lower than 
previous Tier standards.  Engine emission results are tested and approved by 
the EPA in North America, and many of these test results are available online 
from the internet. 

Diesel exhaust gas and particulate matter emissions are normally quoted by 

regulatory agencies in terms of grams produced per kW engine output per 
hour (g/kWh).  Engine emission standards have been improved over time.  

For example, a Tier 3 Diesel engine may have an Oxides of Nitrogen (NOx) 

output of 9.2 g/kWh and CO 3.5 and PM 0.12, while a Tier 4 Diesel engine has a 
considerably reduced NOx requirement of only 0.4 g/kWh NOx.  A useful source 
of information on engine output is available from the EPA United States 
Webpage. 

A complicating part of measuring and modelling NOx gases is that this is a 
composite of 7 different forms of nitrogen / oxygen molecules.  The main health 
concern is the NO2 component which has a limit for exposure of around 2-
3ppm, however the presence of NO2 is highly dependent of the presence of 
Ozone (O3) which is responsible for much of the formation of NO2 gas from 
NOx.  Typically in urban environments, the ratio of NO2/NOx may be between 
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10% and 30%, however in underground mining, away from the atmosphere 

and sunlight, the ratio may drop to only 2%. 

To provide an indicative NO2 value for modelling and design improvement 
purpose, VentSim assumes a ratio of 5%, however this is highly subjective and 
should not be used for designing critical airflows or diesel equipment calculations 

without calibration with measured results.  The ratio can be adjusted in the 
VentSim settings – simulation > Diesel. 

http://www.atmos-chem-phys-discuss.net/5/12723/2005/acpd-5-12723-
2005.pdf 

 

Figure 21-1  Examples of Euro Rated Diesel Output Limits 

The makeup of quoted diesel engine particulate matter (PM) can vary 
depending on engine type and fuel used, however a widely accepted ratio 
range is around 50-60% elemental carbon, 20-30% organic carbons and 15-

20% other matter.  The two most commonly used standards are the elemental 

carbon value (EC) and the total carbon value (TC) which is the sum of the 
elemental and organic carbon components. Current North American guidelines 
suggest an elemental to total carbon ratio factor of around 1.3X.  Unfortunately, 
most EPA test results are for total particulate emission (including non-carbon 
particulates) and do not state the different particulate composition.   

Rather than introduce emission standards, mining regulators focus on 

atmospheric exposure levels in mining environments.  The atmospheric 
concentration of a diesel engine emission is a function of the rate and 

concentration of the exhaust emission, and the amount of diluting airflow 
around the equipment.  By placing an engine size and emission concentration in 
VentSim™, the program can use simulated airflows to calculate the resulting 
atmospheric concentration. 

Regulators have specified either an ‘elemental’ carbon limit or a ‘total’ carbon 

limit for allowable TWA atmospheric levels of diesel particulates.  In North 
America (2008) a standard of 160ug/m3 Total Carbon (elemental + organic 
carbon) has been initially imposed, while Australia looks likely to adopt a 
100ug/m3 Elemental Carbon limit. 

Diesel Equipment emissions are usually specified as a particular matter (PM) 
level, normally factored to engine output (for example 0.15 grams per kilowatt 
hour of engine power).  This level includes elemental carbon, organic carbon 

and other particulate matter such as sulphates. As the atmospheric limits relate 
only to carbon emission, care must be taken to either factor the emission rate to 
carbon levels accordingly, or factor the final atmospheric concentration limit so 
that only the desired carbon levels are used (elemental or total). 

Composition of Diesel 
Particulate Matter (PM) 

Atmospheric Standards 

http://www.atmos-chem-phys-discuss.net/5/12723/2005/acpd-5-12723-2005.pdf
http://www.atmos-chem-phys-discuss.net/5/12723/2005/acpd-5-12723-2005.pdf


 

 

In the event the emission components are not known, it is suggested a factor of 

50% can be applied to convert total particulates to an Elemental Carbon (EC) 
level, or 80% to convert to a Total Carbon (TC) level. 

Finally, the diesel engine emission outputs may in some cases be further 
reduced by the equipment manufacturer or mine utilising catalytic / 

regenerative converters and particulate filters.  This can further lower the 
emission rate further (by 50% or more) and if present, should be considered in 
the final DP emission value.  Conversely, worn or damaged equipment may 
produce significantly higher than expected emissions. Where possible, mine 
sites should measure actual equipment exhaust to obtain actual values, 
however if this is not possible, then equipment manufacturer advice should be 
gained, or a conservative approach from EPA data taken. 

Simulated atmospheric concentrations of particulates are only the first step 
in what must be a multi-pronged approach to controlling exposure levels.  
Operators of machines may be directly exposed to higher concentrations 

than predicted due to their proximity to exhaust emissions.  Conversely, 
operators protected by filtered cabins may be exposed to lower concentrations 
that predicted.  Also keep in mind that mine concentrations of DPM which are 

higher than the allowed standards still may be permissible if other control 
methods such as reduced exposure time or personnel protective equipment are 
used to control exposure. 

Where control of exposure measures cannot be guaranteed to protect workers, 
the mine will need to consider implementing engineering strategies such as 
increased ventilation flow, or improved engine or emission control.  Where 
increase ventilation flows are used, ensure that this has a cost benefit against 

improve exhaust emission or exposure control.  The financial functions in 
VentSim DESIGN™ provide useful feedback on the additional cost of ventilation 
– cost which may be better invested in exhaust emission reduction. 

21.2. How to perform Diesel Emission Simulation in VentSim 

VentSim DESIGN™ uses the diesel equipment placed for heat simulation to also simulate diesel emission 
concentrations.  Emission rates can be entered either in the Heat Presets, or directly as a manual entry 
in the EDIT form.  Once again, note that the atmospheric concentration will be given in the same 
composition units as the diesel emission assumption (emissions rates are entered as elemental, total 
carbon, or total particulate matter, therefore atmospheric concentrations will be of the same type) 

Example 
A diesel engine is listed as having a PM (particulate matter) value of (for example) 0.16 g/kW-hr.  The 
mine is regulated under an Elemental Carbon limit of 100 ug/m3, and the user has assumed that 

Elemental Carbon is 50% of Particulate Matter (PM).  Therefore the user must either convert the diesel 
emission rate to elemental carbon (50% = 0.08g/kw-hr) or keep in mind that their actual simulated 
atmospheric limit is in total PM (200ug/m3) instead of Elemental Carbon EC (assumed 50% = 100 
ug/m3) 

The VentSim user decides to convert the PM value to an Elemental Carbon value of 0.08g/kW-hr, and 
enters this value in the Heat Presets. 

Next, the user must decide the average diesel power output of the engine during the shift.  DO NOT 
ENTER THE MAXIMUM diesel engine power, as no typical diesel equipment will run at full engine power 

for the entire shift, and using this value will over predict DPM concentrations.  The best method is to 
measure actual fuel consumption for the shift, and use the Heat Assistant in VentSim to calculate 
average engine power output.  In most cases, trucks and loaders will not exceed 50% of their rated 
power, and auxiliary equipment and light vehicles will be much less. 

What is the actual 
released DP value? 

Application in a Mining 
Environment 



 

 

 

Figure 21-2 Diesel Equipment with DPM emissions in Preset Values 

The user has five loaders with rated diesel engine power of 250kW each.  After observing fuel usage for 
the shift, the user specifies the machine put out an average of 125kW of diesel power and enters this 
value in the Heat Presets.   

The five (5) loaders are then placed in typical airways around the mine and the DPM SIMULATION 
function is activated. 

 

Figure 21-3 Diesel heat and DPM source placed in airway 

The DPM levels can be actively viewed around the mine, and the colour ranges adjusted in the Display 
Manager to view areas of potential concern.  Further changes or increases to air flows will require a re-
simulation of the diesel particulates to recalculate new values. 



 

 

 

Figure 21-4 Example showing DPM simulation colouring through mine 

  



 

 

22  STAGING – (All Versions) 

22.1. What is Staging? 

Staging is a term representing the ability of VentSim to create multiple versions of similar models in a 
single simulation file.  Examples of this may include creating ventilation models representing different 

phases or timelines of the mine design, or alternatively it could be used for representing different options 
and variations for a ventilation design.   

Up to 24 different stages can be developed in a single model.  Each stage can ‘share’ common airways 

with other stages, or can have unique airways that are only valid for a particular stage or stages. 

Staging is a great alternatively to creating multiple different VentSim files that can quickly become out of 
date.  Because staging shares common airways, then changes to shared airways on one stage will flow 
automatically to other stages. 

   

  

Figure 22-1 - Example above showing a single model divided into four (4) different stages. 

Example 1 – Multiple Stage Time Line 
A user may want to build a model showing the initial decline development phase of the mine (complete 
with ventilation ducts and auxiliary ventilation from the surface).  Next an intermediate phase is 

required, show decline development complete and primary shafts in place (with the surface auxiliary duct 
now removed), but no production activities shown.  Finally a model is required representing all 
production activities. 

For this example, the user can create three stages.  Every airway in the model can belong to one or 
more of the stages.  For example, the surface ventilation auxiliary duct system would belong only to 
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Stage 1 (initial development), however the initial main decline would belong to all three stages because 

it does not change. 

The second stage would include the main shafts (which belong to both Stages 2 and 3, but not Stage 1).  
Finally the production development and activities would belong to only Stage 3.  

Different stages can be selected and displayed from the stage menu in VentSim 

 

Example 2 – Multiple Options 
A consultant wishes to show a client three (3) different ventilation options for a mine design.  Option 1 

has a large shaft design with a single high pressure fan.  Option 2 has two smaller shafts located in 
different areas, with two smaller fans.  Option 3 has the two smaller shafts, and also the large shaft 

design but with a lower pressure fan.  The ventilation design connecting the shafts in all three options is 
similar. 

For this example, three (3) stages can be used to represent the three different options. 

Because the horizontal mine design connecting the shafts is similar in all cases, then the airways for the 
horizontal mine design can be shared and set to belong to all three stages.   

The Option 1 large shaft is also used in Option 3, however in this case a different fan is intended to be 

used for this shaft airway.  Therefore the large shaft IS NOT common between Stage 1 and 3, and can 
only be set to belong to Stage 1.  

 Stage 3 will require an identical duplicate of this large shaft airway, but with a different fan (low 
pressure) that is only set to belong to Stage 3. 

The two smaller shafts are utilised by Stage 2 and 3, and therefore must be set to belong to each of 
these stages (providing the same fans are used for these shafts in both cases) 

Example 3 – Totally different models 
A user wishes to design two totally different ventilation models with very few (if any) shared airways 
between stages. 

For this example, each stage can be a totally new set of airways.  When changing to different stages, 
new airways will (by default) only belong to the stage they are constructed on (unless extended from 
other multi stage airways). 

The user is welcome to construct new independent (non-shared) ventilation models on each stage.  If a 
common ‘skeleton’ of airways will be used and modified between each stage, then the airways can be 
‘copied’ from one stage then ‘pasted’ in the same position on a different stage.  Using this method, any 
airway can be modified without fear of changing airways on other stages. 

22.2. Using Stages 

HINT : Please ensure you understand staging before create multiple stages with shared airways.  There is a danger that a user may 
make changes to shared airways, forgetting that it may unintentionally affect other stages (unless the modification is done to a 
unique airway only belonging to that stage) 

 

Staging names can be directly typed into the combo box on the main screen by pressing the RIGHT MOUSE 
button on the list.   



 

 

To enter more detailed Stage names and descriptions, the TOOLS > STAGES menu in VentSim can be 

used instead to change names.  This tool also allows detailed descriptions to be entered in the lower Stage 
window. 

 

In addition, the order of stages can be moved up or down in relation to other stages by selecting the ROW 
and using the keyboard arrow key.  Click on the Sim Air and/or Sim Heat to simulate the models when 
switching between Stages.  By default, simulated airflows are not updated when changing Stages.  
Therefore, airways that are shared with other stages may contain data belonging to simulations from other 
stages, unless a new simulation is performed for the current stage. 

 

Selecting Stages 
Stages can be selected from the main stage combo menu.  Once a stage is selected, ONLY airways that 

are assigned to that stage are shown on the screen.  All other airways not belonging to the selected stage 
will be hidden, and will not form part of the error checking, simulation or summary.   

 

You cannot view ALL airways on ALL stages simultaneously, and at this time to prevent confusion, all 
Windows opened in VentSim will display only the selected stage. 

 Manually Assigning airways to different stages. 
Airways can be assigned to different stages from the EDIT box function.  Simply use the SELECT button to 
select the airways, then use the EDIT button to change one or more airways to a new stage selection. 

 

A horizontal series of boxes representing each available stage is shown in the EDIT box.  Three different 
colours represent the current state of the selected airways.  If the mouse is hovered over any of the boxes, 
a tool tip will show the name of the stage. 

• Clear White shows that the edited airways do not currently belong to that stage. 



 

 

22.3. Creating a Unique Version of an Airway for a Stage 

Whenever a variation is required of an existing airway for a particular stage (for example an extra or 
different fan added, a different airway size, a different resistance or preset value, a different heat source 
or event, etc) then a ‘copy’ or ‘duplicate’ of the airway must be made for use on that stage only.  There 
are a number of ways to do this.  For novices, the easiest way is described in OPTION 4 – Automatic Stage 
Control. 

Ensure the airways you wish to create a unique version of (duplicate) are set 
to show on the stage where the change is required.  Select and change to the 

required stage from the pull down menu on the main screen (the airways 
should still show), the SELECT and EDIT the airways with the EDIT box. 

Use the stage Duplicate button to create a unique version of these airways.  This button will REMOVE the 
selected airways from the current stage, and then create a duplicate of the airway that are set to only the 
current stage.  The edited airways can now be modified without affecting the same airways on another 
stage. 

While still on the old stage, select the airways you wish to appear on the new 
stage.  If the selected airways are already shared with the new stage, EDIT 
the airways and deselect the new stage box so these airways will not show 

when switching to the new stage. 

While the airways are still selected, choose EDIT > COPY AIRWAYS menu, switch to the new stage (the 
airways should not be displayed if they have been correctly switched off for this stage), then choose the 
EDIT > PASTE AIRWAYS TRUE (same position) menu.  A copy of the airways should now appear in the 

new stage, which can be independently modified without affecting the same airways on other stage.  

 

Simply drawing a new airway with the ADD button, or converting a DXF 
centreline will add an airway unique to the currently selected stage (unless an 
airway is drawn from an existing airway, in which case it adopts the existing 

airway stage settings).  These airways can remain on this particular stage only, or can be later selected 

and set to appear on other stages. 

VentSim 4 introduces a new method to create and maintain shared and unique 
staged models.  Instead of managing individual airways, VentSim can be made 
to manage stage airway changes automatically.  Stages now have a lock 

command that can be used to ensure any changes to the model are only retained on the new stage instead 
of flowing through all other shared stages.   

• Click the ADD SHARED COPY by right clicking on the current stage selection list.  A shared copy of 

the current model will be created.   

• Click the LOCK STAGE (green) button next to the STAGE selector.   

• Make any required changes to the model.   

• When complete, UNLOCK the stage.   

• Only changed airways will be modified on the new STAGE.  All unchanged airways will remain shared 
with the original other stages. 

Option 1 - Edit Box Auto 
Create Button 

Option 2 – Create a copy 
of the airways 

Option 3 – Construct a 
new airway 

Option 4 - Automatic 
Stage Control 



 

 

Version 4 Additional Features 
Version 4 or greater of VentSim introduces additional tools to assist in creating and managing 
stages.  The features are available by RIGHT clicking the stage drop down list. 

 

Rename the stage to another name. 

Remove the stage AND remove any unique airways belonging ONLY to that 
stage.  Airways which are shared by other stages will not be deleted.  A 
warning will be shown before a stage is deleted. 

A powerful tool that will remove airways on the current stage if identical 
airways are found on other stages.  The other stage airways will then be 
shared with the current stage to replace them.   

This tool may be useful if a detached (not shared) copy of an airway (or entire 
model) has been made on a new stage, and you wish to recombine that stage 
so that identical airways will be removed and other stage airways will be shared 
to take their place. Even models from other files can be copy and pasted, then 

merged into the current VentSim file, providing the PRESET settings (resistance, 
fans, friction factors etc) in both files closely match.    

Only airways which are different and unique to that stage will remain, and the 
size of the VentSim file will be reduced.  Simulations should remain unchanged. 

Similar to Merge Current, however ALL stages will be tested for opportunities 
to combine and share airways with each other stages. 

Adds a new stage name with no shared airways assigned to it.  

Creates a new stage, with all airways on the former stage, shared with the 
new stage.  Note that unless the new stage is locked first, any changes 
made will occur on both the new and former stages simultaneously, because 

all airways are shared. 

Creates a new stage, and copies all airways from the former stage to the new 

stage as independent airways.  Any changes made to the new stage airways 

will not affect the former stage. 

Moves the stage name higher in the list. 

Moves the stage name lower in the list. 

Open the STAGE SETTIGNS configuration box for addition details and 
descriptions of the stages. 

Rename 

Delete 

Merge Current 

Merge All 

Add Blank 

Add Shared Copy 

Add Detached Copy 

Move Order Up 

Move Order Down 

Settings 



 

 

22.4. Suggested Tips for Developing Staged Models 

There are many ways to utilise staging, and users are encouraged to use methods that suit their design 
techniques. 

Independent Models 
While not recommended, it is possible to simply copy an entire model onto a new blank stage using the 
previous method.  Because all airways are copied, then any modifications can be done in either stage 
without affecting the other stage.   

While this method is probably safest for beginners, it has the disadvantage of creating duplicates of every 
airway for every stage (which can reduce available program memory – particularly for large models).  In 
addition, if a common fundamental change on one model is made (for example the decline size is changed), 

then as none of the stages share airways, then the same change would have to be manually made for all 
the decline airways on all the stages. 

An independent ‘detached’ model can be created by RIGHT clicking the stage selector and selecting ‘Add 

Detached Copy’ 

Shared Models 
A smarter way is to ensure common airways are shared.  This creates a smaller model file, requires less 
memory, and ensures changes to common airways are reflected in all stages automatically. 

• The FILE > LOAD DEMONSTRATION > METAL MINE example shows a progressive stage design (with 
four (4) different stages).   

• A useful technique in creating such a model is to start with a full final ventilation design with ALL 
airways belonging to ALL stages.   

• Then work backward towards the initial stages of a ventilation design and progressively remove the 
airways that do not belong to particular stages.   

For example, assuming that by STAGE 4, all airways have been established, 

progressively remove other airways to create earlier stages. 

Once the final design is working, RIGHT CLICK the stage selector and click ‘ADD 
SHARED COPY’  

VentSim will automatically switch the display to the new stage.  Click the LOCK 
STAGE button.  Delete any airways that do not belong to this stage, and make 
any required modifications. 

When complete, click the LOCK STAGE button again to unlock the stage. 

The early model design will now have the changes and additions only on this 

stage. The original stage will be unchanged. 

•  

Alternatively, start with the initial model design (on Stage 1 for example).  
Once this design is working, RIGHT CLICK the stage selector and click ‘ADD 
SHARED COPY’   

VentSim will automatically switch the display to the new stage.  Click the LOCK 
STAGE button. Add or change the required airways 

When complete, click the LOCK STAGE button again to unlock the stage. 

All changes and additions will only appear on this stage. 

To add more stages, ADD SHARED COPY again and repeat the steps. 

Work Backwards 
Technique 

Work Forwards 
Technique 



 

 

•  

Using Staging for Options 
Staging is an ideal tool to create a number of different scenarios or options. In most cases, the models will 
be mostly the same, containing only a limited number of variations between stages.  It is preferable in 
most cases to SHARE the majority of the design between all the different options, and only change specific 
airways between stages.  Once again click ‘ADD SHARE COPY’ for each stage variation or option. 

• VentSim will automatically switch the display to the new stage.  Click the LOCK STAGE button. Add 

or change the required airways 

• When complete, click the LOCK STAGE button again to unlock the stage. 

• All changes and additions will only appear on this stage. 

• To add more stage options, ADD SHARED COPY again and repeat the steps. 

 

Other Uses for Staging 
Even if the model design remains largely the same, staging can be used to run different heat, gas or 
contaminant scenarios.   

In this case, each stage will have mostly shared airways, with the exception of airways containing the 

changed heat, gas or contaminant parameters.  In this case, these airways are made into a unique copy 
for the required stage (using the EDIT box AUTO COPY button), and the parameters are changes 
accordingly.   

The stage names can be changed to descriptively describe the changed parameters, and the stage 
description (available from the TOOLS > STAGES menu) can contain more information if required. 

 



 

 

23 VENTFIRE™ –Scenario Simulation (Premium) 

 

23.1. What is VentFIRE? 

VentFIRE™ is a module that uses dynamic simulation techniques (time based) to simultaneously model 
heat, gas and airflow changes on a mine ventilation environment over a period of time.  Sometimes 
known as ‘transient’ simulations, the method is useful to determine the performance of a ventilation 
circuit over differing conditions and inputs. 

Despite the name, VentFIRE™ is also designed to work on other heat or cooling sources such as (for 

example) diesel machines and refrigeration plants.  In addition, VentFIRE™ allows a ventilation model to 
be dynamically modified during simulation (for example doors may be opened or closed, or fans may be 
turned on or off at certain times).  The result is that a complete scenario may be modelled over a period 
of time, and the atmospheric changes observed at different points in the mine. 

Example 1 
It is necessary to model the results of a large truck fire in the main decline, in particular the spread of 
gases and change of ventilation. The mine would also like to test of scenario to see what effect closing 
some doors and turning off fans will have on the fire and smoke spread at a pre-determined time into 
the fire.   

A VentFIRE™ simulation can be easily established to  

• Calculate the gases, temperatures and change of airflows (and whether they reverse) produced by 
the truck fire 

• Show the atmospheric gas levels at various points through the mine including areas such as crib 
rooms or refuge bay where people may congregate. 

• What will happen if fire doors are closed 15 minutes after the fire starts, and some fans are turned 

off, and whether this will limit smoke spread or gas concentration through the mine. 

Example 2 
A mine would like to model the effects of reducing mine refrigeration output during cooler night time 

hours to reduce power consumption. 

Even though this has nothing to do with fire, a VentFIRE™ simulation can be established to  

• Dynamically vary the day and night time air temperatures flowing into the mine. 

• Dynamically vary the refrigeration output at different times during the day and night. 
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• Monitor the effects of these changes on air temperature and humidity deep in the mine at different 

locations. 

Example 3 
A mine would like to model the heat and diesel fumes from intense diesel engine activity that occurs 
during various mining cycles to see what range of temperatures will be experienced in different parts of 
the mine, and for how long those temperatures may exceed a certain threshold. 

Once again, VentFIRE™ can be used to 

• Dynamically vary the location and output of diesel equipment during the day. 

• Dynamically modify what auxiliary or booster fans may be turned on or off. 

• Monitor the effects of these changes on air temperature and diesel particulates at different working 
locations around and downstream from the activities. 

23.2. Preamble on Fire Simulation 

No underground hazard has greater potential for large loss of life than a mine fire or explosion.  The 
smoke and gases produced by such an event in a confined space quickly creates a lethal atmosphere for 
any underground workers exposed to the event. 

For this reason, there is great interest in being able to predict the effects of underground fires and utilise 
the results to establish emergency response procedures and systems to ensure the safety of people 

working underground. 

Unfortunately, the prediction of fires before the event is extremely difficult; not only the location (which 
to some degree may be predicted using risk assessment techniques on possible combustible sources), 
but also to the nature, size and behaviour of the fire.  

For example, a ‘truck’ fire could be caused by engine / turbo failure, hydraulic line failure onto hot 
exhaust, electrical short circuits or a ‘hot’ tyre.  In each case the fire may be contained within the 

immediate portion of the truck, or it could spread to the entire unit.  Numerous fuel types are present 
including diesel fuel, rubber tyres, hydraulic oils and cabin plastics, an each could burn at a different time 
and rate.  The rate of combustion depends on available airflow and oxygen, confinement of the fire, 
exposure of the fire source and numerous other environmental considerations.  Poisonous gas emissions 
from the fire are highly dependent on surrounding airflow, temperature of the fire and types of fuel 
burning. 

It is obvious that trying to accurately predict all of these factors would be extremely difficult – the range 

of possibilities is endless.  Therefore, it is important to consider that ‘Fire Simulation’ in software should 
not necessarily be about trying to accurately simulate the fire or combustion gasses, but rather to help 
determine the range of effects that different sized fires may have on the mine environment.  By 
considering a range of possibilities and the resultant potential effects on the mine environment, an idea 
of the impact of a fire can be assessed and emergency response plans and mine ventilation design 
changes can be put in place.  

23.3. How it works 

VentFIRE™ uses a discrete cell transport and node mixing method to simulate moving parcels of heat 
and gas around a mine. 

To dynamically model mine ventilation and accurately take into account continual changes in 

atmospheric concentrations of gases and heat including recirculation, VentFIRE™ breaks the model into 
small independent ‘cells’ which move freely around a model, mixing with other cells at junctions.  Each 
airway may be broken into dozens of cells (creating potentially hundreds of thousands of cells for a large 
model), and each cell independently contains information on gases, heat, moisture and density at that 
location within the airway.  The cells are moved around at directions and speeds calculated by the global 
airflow simulation (a Hardy Cross simulation based on compressible flows and density driven natural 

ventilation).   



 

 

Because simulations for VentFIRE™ are assumed short term (normally less than 24 hours) heat transfer 

to and from each cell from rock strata is calculated by the radial heat transfer method, but with strata 
heat transfer modified by the assumption of exposed rock boundary temperatures at a long term aged 
average, coupled with a very short time Gibson’s algorithm constant to accelerate heat transfer to and 
from the immediate rock boundaries during the fire simulation.  A ‘shell’ of exposed rock at a 

customisable defined thickness is allowed to heat or cool during the fire event from the airflow however 
heat transfer beyond this exposed shell volume of rock into the greater surrounding rock mass is ignored 
during the short-term simulation. 

As each cell of air passes over a fire, oxygen from the cell is consumed (based on defined fuel properties) 
at a defined combustible fuel burning rate.  Heat from combustion (also defined in the fuel source 
properties) is added to the cell.  If oxygen is reduced below a predetermined concentration the fire is 
throttled if excess fuel is available, and heat and gas output is limited.  Other gases are added to cells 

based on the yield (y) rates specified in the combustible fuel properties.  For critical gases, such as 
carbon monoxide, an upper and lower limit can be specified to simulate the carbon monoxide emission 
effects of an oxygen or fuel rich fire; however this can be overridden (by selected a ratio ‘shift’ of up to 
1) to produce maximum carbon monoxide if a cautionary (‘worst case’) scenario is desired. 

Airflow simulation is done periodically (the frequency set by the user) to recalculate the flow velocities 
and flow direction in the model.  The airway natural ventilation pressures are modified each time by 

collecting the aggregate air density of the cells within the airways.  In some cases, this may change the 
direction and velocity of flow of air within the model. 

Information is entered into a VentFIRE™ simulation using ‘Events’ where an event describes a change in 
input parameters such as a fire size, or a change in diesel machines (moving around), fans (stopping or 
starting) or resistances (such as a door opening or closing).  An unlimited number of events can be 
entered into a simulation at different locations and times.  An airway with multiple events can be 
sequenced to show changing conditions over time.  For example, a fire may initially grow rapidly in size, 

plateau at a maximum defined combustion rate, and then die slowly to nothing.  For heat and 
combustion sources, the event scale can be made to linearly interpolate between a starting and ending 
value. 

23.4. Use the Vent FIRE™ Function. 

Adding Events 
 

The VentFIRE™ simulation requires ‘Events’ to drive the inputs into the simulation.  Events may be 

entered into any airway by EDITing the airway, and selecting the DYNAMIC  fire tab option.   

 
To create a new script, click on the  button.  After entering a name for the script, it is time to add one 
or more events, using the Add New Events button (green plus sign).  Try to provide a descriptive name, 
and enter a time frame (in seconds) for the event.  During this time frame a number of changes can be 
made to the airway. 

• Up to three combustion source types can be added for a fire 



 

 

• A preset heat source or defined range of preset temperatures can be used.   

• In addition, a preset resistance (such as a ‘DOOR’) can be added (for this time frame only – it will 
revert to the original resistance outside of this time frame) 

• An existing fan can be turned ON or OFF or the speed changed – providing it is present in the 
original airway. 

• A gas source (such as a GAG or inertisation unit) can be added during simulation. 

Where a ‘starting’ and ‘ending’ value can be entered in the dynamic event, the simulation will range the 
values between the starting and ending time during the simulation. 

 

Figure 23-1  Dynamic Event Entry Form 

The rate and behaviour of the range between the starting and ending time can be varied by the 

‘Transition Curve’ factor.  This is an exponential factor that modifies the rate of change between the two 
time.  For example to linearly change the inputs between the two time (a straight line), a factor on one 
‘1’ would be chosen.  For fire simulation, a t-squared profile is often quotes in text as the most likely 
behaviour of an escalating fire in a confined compartment, therefore a factor of two ‘2’ could be selected. 



 

 

 

Figure 23-2  Linear '1' transition factor vs a t-squared '2' transition factor 

Multiple events can be added to the same airway, by subsequently clicking the ‘+’ button, or by right - 
clicking on an existing event to duplicate and modify it.  Events can be added in any order or out of 
sequence, as long at the time ranges specified for each event are correct. 

  

Fire Event Wizard 
Configuring a fire usually requires determination of the amount of 
fuel to be burnt, the growth, sustain and decay times of the fire, 
as well as the total time. To help with setting this up and to 
avoid doing the calculations by hand, VentSim includes a Fire 

Event Wizard, available using the button with Fire icon on the 
VentFire Events Manager Form.  

To use the Fire Event Wizard, determine the types of fuel to 

burnt and their mass. Up to 3 types of fuel can be included. After 
specifying the Total Fire Time, enter in a Growth and a Decay 
Period. A graph will appear giving the variation of the Burn Rate 
in kg/hour, which will burn the specified fuel during the time 

specified. Transition curve factors are included for the Growth and 
Decay Periods.  

After clicking Create Fire Events, the 3 fire events for this fire will 
be automatically created. To save the fire, the user can click OK, 
without having to open the Dynamic Event Form. Nonetheless, the 3 
events created can also be edited, if needed, through the 
Dynamic Event Form.  



 

 

Gag Event Wizard 
VentFire can be used to simulate the use of Gag gas in combating 
mine fires. A gag gas unit can be used to direct a stream of air high in 
concentration of inert gases. This starves the fire of oxgen and 
hopefully puts it out, or stops it propagating.  

Of critical importance to the effectiveness of a gag unit is how close to 
the fire the gag can be applied, how long the gas takes to reach the 

fire and how diluted the gag gas is once arriving at the fire. 
VentFire can be used to simulate this.  

Programming a Gag gas unit through the Dynamic Event form 
involves specifying a fixed flow, a fixed temperature and a fixed gas 
type. To help with this, a Gag Event Wizard is available through the 
VentFire Events Manager, via the button labelled GAG. After 
opening the wizard, the first step is to specify the gas mixture of the 

gag gas. The Gas Presets can be accessed using the Gas Mixture link, 

where a gas mixture can be specified. Once a gas has been entered in 
the Presets, it will be available in the dropdwon menu. The gas 
components of the gas mixture are presented. The Gag Gas Unit will have a specified outlet flow rate, 
and outlet temperature which can be entered on the Wizard as well. Finally, the duration of the gas and 
the starting time can be specified. After clicking on Create Gas Gas Events, the event is added and can 

be saved without having to open the Dynamic Event Form; however, the event can still be edited, if 
needed, through the Dynamic Event Form.  

Note, that if simulating a gag unit using VentFire, you probably want to uncheck Settings > Dry Gas Air Balance.  Doing so will allow 
VentSim to calculate the concentration of water vapour in the mine.  The air from a gag unit can be at very high temperature and 
humidity, meaning the concentration of water vapour can be high. This can have an effect on the oxygen concentration, which in 
turn will affect any fires in the mine. 

Adding Monitors 
A ‘monitor’ is like a sensor that records a range of data during the dynamic simulation such as airflows, 
temperature and gases. 

Due to the huge amounts of data generated by a dynamic simulation, only information at specific preset 
monitor locations is recorded.  While instantaneous simulation results for the entire mine can be viewed 
during the simulation, only locations installed with a ‘Monitor’ can show the complete historical range of 
data collected during the entire simulation. 

  A monitor is automatically placed on airways that have predefined dynamic events, however to 
place monitors elsewhere in the model, use the toolbar button (shown above left).  Once selected, simply 
click on an airway to add or remove a monitor.  Monitors can also be removed using the DELETE button.  
Be aware that the amount of recorded data is limited, and more monitors will consume greater amounts 

of recorded data space.  For lengthy simulation with many monitors, the amount of monitor recording 
memory can be increased in the Settings. 

Once placed on an airway, a monitor will appear as follows. 

 



 

 

23.5. Establishing Simulation Parameters 

Dynamic Simulation Settings 
A wide range of settings can be adjusted for dynamic simulation, including the time steps, air simulation 

update frequency, and screen graphics update frequency.  In addition, variation parameters for changing 
the performance and behaviour of the fire can be changed.  Please ensure you are aware of the effects of 
these changes before experimenting.  A list of definitions and explanations is available in the Settings 
section. 

Resistance 
Resistances can be added or changed during the simulation.  Any resistance set before a simulation 
starts and not defined by an Event will remain in place. 

For example, a resistance called a ‘Mine Fire Door’ could be applied 20 minutes into a Ventfire simulation, to simulate a scripted 
mine emergency response procedure and test the effect on the airflow and atmosphere during a fire. 

 

Contaminants 
Contaminants can be added or changed during the simulation.  A contaminant could be a generic 
contaminant (for example stench gas), dust or an explosive source which will generate a contaminant at 
a preset yield rate.   

For example, a series of mine blasts with explosives can be time to fire at specific intervals, and the resulting fume distribution can 
be analysed with monitors at different locations to determine to soonest time when re-entry could occur. 

 

Gases 
Gas addition during dynamic simulation is designed for adding or changing gas compositions 
independent of the fire source.  Gas mixtures can be defined in the PRESETS which can be directly 
accessed by pressing the MIXTURE button.  Gases can be added to a VentFIRE before the simulation (in 
which case this function is not necessary), or dynamically during the simulation. 

The function can be used in two ways;  

(1) If the Linear Emission IS NOT checked, then the gas mixture will be applied to all air passing 
through this airway.  The air will be changed to the specified FIXED gas mixtures and all unfixed 
concentration will volumetrically balance to the remaining volume. 

(2) If the Linear Emission option IS checked, then the atmosphere in the airway will gradually be 
replaced at the rate defined in the linear emission boxes (litres / metre / second). 

The first option is designed to allow users to either change the gas composition of the air at a point in a 

mine (perhaps because the user may have some sensor data they can apply), or to specify the gas 
content of air that may be injected into a mine (for example a GAG unit, or NITROGEN inertisation 
system).   

For example, if gas is injected into a mine during a fire, then the VentFIRE simulation will show a decrease in the output of any fires 
that are flooded with inertisation gases (provided the oxygen levels drop low enough), regardless of the original user specified fuel 
burn rate of the fire. 

The second option is designed to simulate the buildup of gases, particularly in areas of low ventilation 
flow.   

For example, if fans are slowed or stopped during a coal mine emergency, then the release rate of methane could be specified, and 
the dynamic simulation would show how long it would take for gas to build to explosive levels. 

Note this option mimics gas buildup by a volumetric replacement method, where a portion of the atmosphere is periodically 
replaced by the emission gas.  This is suitable for relatively slow emission rates, however for very high emission rates which may 
create a significant flow and push gases into areas without emissions, a ‘gas injection’ method using fixed flows of defined gases is 
recommended instead. 

Fuels 



 

 

Up to three burning fuel types can be added to the event and the estimated rate of burn for the total fuel 

amount can be specified at the start and end of the time period for the event.  The different fuels can be 
proportionally varied by a percentage % of the total amount specified. The rate of fuel burn and heat 
output may be limited to less than specified if there is insufficient oxygen passing over the fire source.  
The fire behaviour at low oxygen level can be defined in the VentFIRE settings page, in the main 

Simulation Settings form. 

For example, if a truck fire is to be simulated, then the total mass of combustible material on the truck can be estimated (eg tyres, 
fuel, oil etc) and assumptions can be made as to the rate of burning (for example a previous incident may suggest a truck will 
completely burn within 2-3 hours).  The combustible material could be combined into a single fuel type (in the Preset) which 
combines by weighted average the heat and gas output of all the materials, or alternatively, the fuel mixture could be converted to 
an equivalent amount of an existing fuel type (such as diesel), to give total similar heat and gas output. 

For a very large fire, such as a coal fire, the total amount of fuel burn rate may not be that critical if insufficient oxygen is present.  
VentFIRE will only burn the amount of fuel relative to the amount of oxygen present.  Therefore, overestimating the fuel burn 
amount will make no difference to the simulation if insufficient oxygen is present. 

Preset Combustible Fuels 
Up to 250 different types of combustible fuels can be added to the VentSim preset database (from the 

SETTINGS > PRESETS menu).  Each type of fuel can have defined Heat of Combustion outputs, oxygen 
consumption rates, and emission yield rates of various gases per kg fuel burned.  VentSim comes with a 
standard series of simple fuels with laboratory estimated heat and gas yields.  The user is welcome to 

make ‘combination’ fuel types where the heat outputs and gas yields from different products are mixed 
proportionally to create an equivalent mixed fuel. 

Note that because of the complex chemistry of fire reactions, these values may significantly change in a 
real mine fire, particularly if intense temperatures (>1000C) result in further chemical reactions to 
combustible products and pyrolised fuel (solid or liquid fuel converted by heat into hydrocarbon 
vapours).   

For example fire tests in some experiments have demonstrated significantly greater portions (2 – 3 X 

yield of laboratory experiments) of carbon monoxide that can be generated during intense fuel or tyre 
fires due to the chemical reduction of CO2 to CO gas over hot surfaces.  The user is welcome to change 
the typical laboratory value used by VentSim to other values if they have information which may provide 
improved accuracy for their conditions.   

As discussed in the introduction however, due to the wide range of assumptions used, the simulated gas 
values must not be used as an absolute determination of likely gas levels in a mine, but more as a guide 

to the extent of gas contaminants, and the likely variation between different parts of a mine. 

Heat Sources 
Heat sources are defined by existing heat presets.  They could represent diesel machines, conveyors, 
electrical equipment, refrigeration plants or any other heating or cooling source.  In addition, the Heat 
Source option allows the temperature of air to be specified passing through the airway.  This could be 
used for setting the temperature to known measurements, or to specify days and night temperatures 
entering a mine through the total period of dynamic simulation. 

23.6. Simulating Events 

Establish Settings 
•  

• Make sure all events and monitors have been set and placed.    If they require modification, then the 
simulation must the halted and restarted after the changes have been made. 

• Ensure the simulation dynamic settings and combustible presets have been established. 

• For FIRE simulation, ensure that both COMPRESSIBLE FLOW and NATURAL VENTILATON simulation 

options have been selected. 

• If simulation of GAS elemental density is required (for example you want to simulate the relative 
buoyancy of methane or the heaviness of CO2), then ensure that the setting SIMULATION > GAS > 
Use Gas Density for Air Simulation is set to YES.  For most fire simulation this is not necessary. 



 

 

• Ensure the simulation settings for Dynamic and VentFIRE simulation are set correctly.  The number 

of sub-cells or the dynamic simulation increment should be set according to the accuracy of the 
required simulation output.  In the event that the base program settings are lost, Chasm Consulting 
recommend the following parameters be used as a base. 

o Dynamic Increment : 1 second 

o Maximum SubCells : 8 (or more) 

o Time Delay : 0 (unless the model is very small) 

o Display Update Frequency : 10 

o Air Simulation Frequency : 10 (if required) 

Before Each Simulation 
 

Ensure your model is properly balanced and simulating correctly (both steady state air and heat simulation) 
before fire simulation. 

Optionally, the model can be ‘stripped’ of previous simulated results by selecting RESET EVENTS.  Note 

that VentSim will automatically remove previous gas and contamination results before a new simulation 
anyway. 

Running a VentFIRE FireSim Simulation 

 

Once all events and monitors have been placed, a simulation can be 
performed by pressing the button for VentFIRE™ simulation, or 

selecting the RUN > VentFIRE > FIRE SIM option from the main 
menu.   

A ‘Fire-Sim’ simulation will perform simultaneous dynamic simulation on 
airflow, heat and gas.  Other combinations of simulation can be 
selected from the Multi-Sim option.  The simulation type performed will 
default to the previously selected simulation type, so ensure the sub 
option has selected ‘Fire Sim’ simulation if this is the type of 

simulation required. 

A dynamic simulation will provide a time based simulation result, with 
screen updates showing the simulation result at a displayed time. 

 

The screen graphics will show the current results on the simulation with colours and text showing 
simulation progress.  During a dynamic simulation, the graphics view can be changed to show different 
location, and colours and text can be changed to show different types of data. 

At any time the simulation can be paused to allow the user to examine areas of interest, or to check the 
results currently stored in the Monitors. 

To significantly increase simulation speed, turn off the ‘Update Graphics’ option to prevent the screen 
from updating after every simulation step.  The update number can also be increased to reduce the 

number of screen updates. 



 

 

Multi-Sim Simulation 
VentFIRE also has an option called Multi-Sim where the user can select a number of different types of 
simultaneous simulations from the Multi-Sim options.  Unlike the Fire Sim option, Multi-Sim allows a 
defined series of simulation types to be selected.   

For example, a dynamic heat and DPM simulation may be required to analyse heat and diesel fume build-up in parts of a mine 
during mining activities.  In this case, the Multi-Sim Options of HEAT and DPM would be selected, and the Multi Sim simulation 
option selected to perform the simulation. 

 

Explosive Pressure Simulation 
 

This is an experimental function to briefly inject large pressures into a mining region (defined in the 

airway > contaminant edit tab) to analyse pressures on regulators caused by a gas, explosive or dust 
explosion.   

Likely pressure distributions relatively to the original 
overpressure estimation are shown through different 
parts of the model as colour or text, and any preset 
resistances (such as door or regulators) are tested 
for strength capacity and whether they will fail under 

the overpressure calculated.  If the preset resistance 
is calculated to fail, the pressure distribution will be 
recalculated assuming the resistance is no longer in 
place.   

Please note that this function is experimental only and not currently supported by Chasm Consulting. 

Program limitations during simulation 
A number of rules MUST be observed during dynamic simulation 

• Airways must not be deleted or added during simulation. 

• The normal steady-state simulation buttons must not be used. 

• Events cannot be changed, added to or removed during simulation. 

• Airways CAN be modified with changed resistances or fans provided the simulation is paused and none of the above 
conditions are violated. 

Failure to follow the above rules may produce unpredictable results or program errors. 

23.7. Viewing Results 

Instantaneous Results 
 

The dynamic simulation will show the results (every update time interval) on the screen, so gas, 

temperatures and airflows can be tracked through the mine during simulation. 



 

 

 

Historical Results from Monitors 
Any monitor can be viewed during or after a simulation by pressing the EDIT or VIEW toolbar button, 
and left mouse clicking on the monitor icon. 

A graph will show allowing the user to view a wide range of ventilation conditions at that location in the 
model.   

 

Storing a static graph image of results 
Simply press the ‘camera’ button on the graph form to make a static copy of the currently displayed 
airway monitor results at that location.  This will not change for subsequent simulation and can be used 
(for example) to compare the graph results between two different simulations.  

Exporting simulation data 
To export this data to a spreadsheet or other document, use the CLIPBOARD icon on the graph for to 

copy the data to the Windows Clipboard.  Then (for example) open an Excel Spreadsheet, and PASTE the 
data into the spreadsheet.  All available data for that location will be copied into the Excel spreadsheet 
cells. 



 

 

Smoothing Data 
Data results can be filtered to smooth and average rapid changes.  If the Log Frequency of data is 
greater than ‘1’ then VentSim will automatically smooth the data during simulation by averaging the data 
collected during every dynamic increment period. 

Data results can also be smooth after simulation by selecting the ‘Smooth Data’ option in the VentFIRE 
menu.  The smoothing factor entered collates and averages the defined number of data events around 
each data point.  This function can also occur automatically after simulation if require, by setting the 

option in the Simulation > Dynamic settings. 

Video Recording 
VentFIRE simulation can take a long time, particularly for large models.  The Video Recording option will 
record a video of the VentFIRE simulation progress over time to play back at a future date.  The speed of 
video recording will play back at 25 frames per second.  The number of frames recorded depending on 
the Dynamic Screen Update frequency in the Simulation – Dynamic settings. 

For example, if a dynamic screen update frequency of ‘10’ was chosen, and a dynamic increment of ‘1’ second was used, then the 
video would be recorded at 1 frame per 10 seconds, and would play back at 25 x 10 = 250X real time speeds. 

23.8. Interpreting Results 

Overview 
Simulations can generate large amounts of data.  While in many cases, temperature and gas may build 
up as expected and the simulation will show the extent and concentration of heat and gases through the 
mine as different times, sometimes a large fire can generate significant disturbance to primary airflow, 
particularly on sloping airways such as declines and shafts. 

Rates of airflow can also impact on temperature and gas build-up within air passing the fire.  A fire will 

expand the volume of air due to heat addition and the expanded gas and resultant increased 
downstream airflow can cause additional frictional pressure loss downstream from the fire.  This can slow 
the airflow past the fire, causing a ‘choking’ effect, which can then compound the heat and gas build up 
further reducing airflow.   

 

Figure 23-3  - Chart showing a complex buildup of Carbon Monoxide complicated by reversing and recirculating airflows 

Airflow reversal 
In addition if the fire occurs on a sloped airway, the buoyance of the low density air can provide natural 
ventilation pressures that act against the normal airflow direction, eventually slowing or even reversing 

the airflow.   Airflow reversal is shown on a graph as a ‘negative’ airflow, and the time at which it 
reverses can be determined by examining the point at which it crosses the zero airflow axis. 



 

 

 

Choked and Alternating Airflows 
It is interesting to note however that if the fire consumes all available oxygen before airflow is reversed, 

then the fire effectively becomes constrained by the lack of oxygen, and heat output decreases, which 
reduces the potential for natural ventilation buoyancy to reverse ventilation.  Even if airflow is 
temporarily reversed, the reversed airflow which is already low in oxygen may not provide for enough 
fire heat output to continue reversed airflow, and the airflow may switch backwards and forward 
between normal and reversed airflow.   

In many cases, equilibrium may be reached where the fire receives sufficient airflow oxygen to choke 
most airflow, but not enough to provide the additional heat required to reverse the airflow.  Additional 

heat is absorbed by the surrounding rock mass of the airway very quickly, and this can contribute further 
to a choked balance condition. 

In the case of a choked airflow, this is a complex and potentially unstable scenario which in reality may 
or may not reverse in a mine.  It can be dependent on complex three dimensional fire behaviour that can 
only be analysed using computational fluid dynamics (CFD) type analysis.  For example, a fire that 

produces zero net airflow in VentSim will be quickly assumed by VentFIRE™ to be ‘throttled’ with 

insufficient oxygen.  In reality a bidirectional flow pattern may be established where fuel rich / oxygen 
deficient hot air travels in one direction away from the fire near the roof, while oxygen rich fresher air 
continues to travel to the fire at floor level in the other direction.   

Such behaviour is beyond current VentFIRE™ capabilities, however to test this scenario in VentFIRE™ 
the user is welcome to change the ‘oxygen dependent’ setting in the EVENT sheet, that will prevent the 
fire from being throttled in the event of insignificant oxygen.  Another less extreme option is to adjust 
the ‘residual heat’ setting in the SETTINGS > DYNAMIC simulation to provide a continued source of heat 

(eg 50% of maximum combustible rates) in the event the fire is throttled below this point.   

Finally. A further option is to decrease the frequency of air simulation during a fire simulation (again from 
the SETTINGS > DYNAMIC) to allow the air to travel a certain distance (airflow momentum) before a 
change of airflow is established. 

Rollback Simulation in VentSim 
By default, VentSim does not consider roll back.  Rollback is where natural pressure buoyancy causes 
heat and fumes to travel along the roof in the opposite direction to the airflow for some distance back 
from the fire.  Rollback distances are highly variable and depend on fire intensity, the slope of the 
airway, and the velocity of the opposing airflow. 

VentSim 4 introduces a rollback pathway creation tool.  This tool can be used to modify airways to allow 
heat driven rollback to occur for a limited distance from the fire. It is only recommend where rollback 
must be specifically simulated as it can slow fire simulation speed significantly.  Rollback may be 
important if the roll back gases can move against the primary airflow and reach a junction that carries 
the gases into part of the mine upstream from the fire. 



 

 

To create rollback paths, the user will need to initially SELECT the airways along which rollback may 

occur.  Typically this should be no more than 50m each side of the fire location.  

       

Once selected, choose the ROLL BACK creation tool.  This tool splits the selected airways into upper and 
lower pathways with vertical connection to allow passage of heated smoke and gases.    The underlying 
airway parameters are modified automatically to maintain similar overall resistance, and heat transfer 

paths are modified to ensure only surfaces contacting rock can transfer heat. 

 

Figure 23-4 Rollback construction applied to airway above and below fire 

Run the VentFIRE Fire Simulation.  If rollback may occur, distribution of heat and gas will be observed 
along the roof in the opposite direction of airflow. 

 

Figure 23-5  Rollback Simulation clearly shows movement of gases along the roof upstream of the fire 



 

 

Because of the short pathways created by rollback construction, best simulation results occur when the 

dynamic interval time is reduced from the default setting of one (1) second to a shorter interval (eg 0.25 
seconds).   This will however create longer simulation times. 

Clearing rollback constructions.   
After completion of the rollback simulation, it is recommended the rollback construction be cleared from 
the model and the former airways restored.  The CLEAR ROLLBACK option in the main menu beneath the 
rollback construction option will perform this function. 

23.9. VentFIRE™ Limitations 

A number of limitations need to be recognised when using VentFIRE. 

Fire effect simulation, not fire chemistry simulation 
Fire chemistry is not simulated (apart from oxygen deficiency).  Simulated results are only as good as 
assumptions entered into the program.  Gas levels are highly dependent on assumed yield rates of 

combustible materials and should not be generally used to indicated ‘safe’ gas level and ‘dangerous’ gas 

levels.  ANY abnormal gas level simulated by VentFIRE™ should be considered potentially hazardous. 

Rollback 
Rollback simulation is an approximation of rollback behaviour only.  While it has been calibrated and 
verified with CFD simulation and empirical estimations, it is not a detailed simulation of the rollback zone, 
and only ‘mimics’ the behaviour of rollback to more realistically distribute smoke and fumes.  Simulation 
of rollback zones tends to appear chaotic, with frequent airflow direction changes and movements.  This 
is considered normal given the simulation method used, however should not be considered entirely 
representative of actual behaviour. 

Choking Limitations 
The initial expansion phase of the fire will produce a ‘non’ mass balanced model where the mass flow of 

cold air exiting an airway may be greater than the mass flow (of hotter air) entering the same airway.  In 
other words, for a limited time the lower mass-flow of hotter air pushes out a higher mass-flow of cold 
air.  Because airflow simulation in VentFIRE™ is based on a mass balanced Hardy Cross algorithm, even 
though this takes into account the greater pressure losses and choking effects of airways produced from 

higher volume flows of hot air, it does not take into account the short term periods were greater masses 
of cold air are being pushed out.  The ‘net’ effect is that VentFIRE™ may temporarily underestimate the 
choking effect of the fire. 

  



 

 

24 VENTSIM LIVEVIEW™ (Premium) 

LiveView™ is an extension of VentSim DESIGN™ software, and will operate in conjunction with the main 
VentSim DESIGN™ license.   

LiveView™ provides a number of additional functions to enable the software to connect externally to data 
sources and display the data within the VentSim model.  Examples of this may include airflows, 
temperatures, gases or pressures, or even machinery such as diesel or electrical equipment. 

LiveView™ also provides an interface to simulate ventilation models using captured sensor data, offering 
an ability to display downstream simulated results from actual data. 

 

24.1. OVERVIEW OF LIVEVIEW™ 

LiveView can connect to multiple different data sources, and extract data from those sources to display 
(and optionally use) the data in the 3D VentSim model.  

Because of the large number of different types of sensors and communications systems, VentSim LiveView 
does not attempt to connect directly with sensor hardware.  Most sensor communication system will have 

hardware and software interfaces that record and store sensor data within an industry standard SQL 

database or similar.  VentSim LiveView is designed to access the data from the databases or data files, not 
directly from the sensors.   

For example, sensors located in an underground mine will send data through a network to a data collection 
computer which will store the sensor data in a database.  VentSim LiveView can then query the database 
and extract the data values as soon as they are stored in the database, or even extract historical data if 

available. 

In cases where companies may not like third party programs (such as VentSim) accessing databases 
directly, the database can also be set up with read only SQL ‘Views”, or alternatively could periodically 
dump a data file into a TEXT or EXCEL format file for VentSim LiveView to access. 

Once the data is extracted into LiveView, the sensor data can be ‘mapped’ and displayed onto individual 
airways.  The sensor data can be assigned to hold specific types of data (for example airflow, gases or 
temperatures).  If the data assigned a ‘type’, then it is also possible for that data to be automatically used 

in a simulation. 

For example, a sensor gas value can be used to simulate the likely downstream gas concentrations from 
the sensor location.  With enough sensor values, an entire mine gas distribution could potential be 
simulated and displayed in realtime. 

VentSim LiveView allows multiple different data sources to be used simultaneously.  For example two (2) 
different SQL databases, and a Text file could all be used together to import and show data in a VentSim 
model. 

How Does VentSim LiveView use the data? 
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24.2. Creating LiveView Data Connections 

Step 1.  Connect to a Data source. 
 A LiveView™ data source connection is a database or a file which contains external sensor information to 
import into VentSim.  The data from sensors may be sent to VentSim in a number of different ways 

including Microsoft SQL servers, MYSQL servers, Microsoft Access, Microsoft Excel, CSV and TXT text file. 

Please note that Microsoft Access and Excel are proprietary Microsoft licenses formats, and require drivers 
to be installed in Windows to access the file types.  If you have Microsoft Office 2010 or later installed, 
your computer may have these drivers already.  If not, you can install the drivers from the free Microsoft 
download “Microsoft Access Database Engine 2010 Redistributable” from 

http://www.microsoft.com/en-au/download/details.aspx?id=13255 

Please ensure the correct 32 or 64 bit version of the drivers are installed (if running VentSim 32 bit, install 

the 32 bit version, if running VentSim 64 bit, install the 64 bit version). 

Warning : If Microsoft Office has already been installed, the version of the Microsoft connectivity drivers will correspond with the 
Office version installed (32 or 64 bit).  It is currently common for end users to install 32 bit versions of Microsoft Office on 64 bit 
Windows computers.  In this case, only the 32 bit installation of VentSim will work with these drivers.  This issue only relates to Excel 
and Access type files. 

To access LiveView, click on the CONNECT > LIVEVIEW > SETTINGS in VentSim. 

•  The data representing all the available different sensor values is imported into VentSim 

• The user selects what sensor data records are to be made available for display and use in the 
VentSim model. 

• If the imported data does not contain information describing the type of data (for example 
airflow, velocity, gas, temperature etc), then this information must be set for each individual 
sensor data item (The selected data records and sensor information are stored in the VentSim 
model for future reference so this does not need to be done again) 

• If the data source does not contain the airway location, then the airways must be individually 
edited and the sensors assigned to the correct airways. 

• Finally, the data can be displayed, and if required simulated in the VentSim model. 

http://www.microsoft.com/en-au/download/details.aspx?id=13255


 

 

 

Data Sources can be added to the LiveView connection list from the icons located on the RIGHT side of the 
list box. 

Many sensor systems use an SQL database system to collect and store 
sensor data.  VentSim DESIGN™ LiveView™ can directly connect and obtain 
sensor data from such systems. 

Enter an optional generic name describing your 
connection.  If no name is entered, the 
connection server name will be displayed in the 

connection list instead. 

Enter the Server web or IP address location, 
the name of the database, and the name of the 
Table, View or Query which contains the sensor 

data.   

If Windows authentication is not enabled on 
the database, a valid user name and password 

will be required. 

An optional data format field is available to 
assist in the import translation of data, 
however if the data is typed correctly in the 
database, this should not be necessary. 

The data connection can be turned on or off at any time with the STATUS 
button. 

In some businesses, companies may not want LiveView™ to connect directly 
to the sensor database for security or performance reasons.   

Instead a 3rd party macro can be written in many systems for the data collection 
system to periodically dump the sensor data into a file which VentSim can read. 

SQL Database 
Connection.   

Access, Excel or Text 
files. 



 

 

Enter a generic name describing your 

connection.  If no name is entered, the file 
name will be displayed in the connection list 
instead. 

To connect Liveview™ to the file, simply 

click on the file type Tab (Access, Excel, or 
Text CSV or TXT) and enter the file name.    
The input forms will differ slightly depending 
on the data type. 

The MS Access option will require a table 
name (and password if required), and Excel 
options will require a worksheet name.  

The data connection can be turned on or off 
at any time with the STATUS button. 

Testing the Data Source 
 

To test the raw data connection, click the SOURCE 
button on the Settings sheet to ensure a valid 
connection has been made.  VentSim DESIGN™ 
LiveView™ should display a table spread sheet listing 

all available data.  If no information is shown, or an 
error is displayed, check the input parameters and try 
again. 

 

To find out more about what settings and values VentSim DESIGN™ LiveView™  will accept, use the menu 
FILE > EXPORT > SENSOR DEFINITIONS and SENSOR UNIT SCHEMA in the Setting Form, to view a copy 

of different codes that can be used when importing sensor data.  Including additional sensor codes (for 

example Sensor Type numbers) in your data source can reduce the amount of editing required after 
importing the sensors. 

For example, the UNIT SCHEMA export option, shows what code numbers can be used in the UNIT TYPE column in the sensor data. 
This column is used to specify the type of data the sensor is providing to LiveView™ and will automatically be shown correctly when 
imported.  If the information is not present, the user will need to specify the type of sensor data manually after importing. 

  

Step 4. Mapping the Sensors 
 It is unlikely that the sensor file or database will have column 
names that correspond to names that LiveView™ expects.  
LiveView™ needs to know the column formats and names 
(Schemas) so it can correctly import the right kind of data into 

the correct fields. 

For example, LiveView™ needs to know which column contains the date/time 
and which column contain the sensor  data . To assist LiveView™ , the user must 
link or ‘MAP’ the LiveView™  names with the external data source names. 

At a minimum the Sensor ID NAME and Sensor VALUE (true 
value) needs to be mapped to LiveView™.  Sensor values should 
be numbers only, and must not include text such as unit names. 

Other items such as sensor time, location, data type, and sensor 
type can also been mapped if present in the data source, however 

these items can be defined later if they are not defined in the data 
source.  If LiveView™ has not found an equivalent column name in the source data, the item will be left 
blank.   This item can be mapped by clicking the combo box and selecting which column name in the 



 

 

imported data file is matched with the LiveView type.  If there is no equivalent column this item can be 

ignored for now. 

Single Sensor value per row. 

If the data contains a single sensor data value per row (in addition to other 
sensor attributes such as time, sensor type etc), then choose the “Single Sensor 

Value per Row” option.  This will allow other attributes in the row to define 
different characteristics of the sensor. 

Multiple Sensor values per row. 

In this case, each record entry in the data source may have multiple sensor 
values per row.  Select the “Multiple Sensor Values per Row” option.  For 
example a single recording sensor station may list multiple gas sensor values 
(eg O2, CO2, CO, H2S etc) on the same row.  The columns containing the data 

values will then be split by LiveView on the sensor import and individual sensor 

types can then be defined after importing the values in the same way as single 
row data.  Note that in this case, other sensor attributes (such as sensor types) 
cannot be defined in the data source tables, and must be manually assigned 
after importing the data. 

Sensor Types and Unit Types 
Sensor Types is expected to be a special number defining 
the type of sensor imported into VentSim (for example air 

velocity, CO gas etc).  If this is not defined, either through 
the sensor mapping, or later through the sensor editing, 
then VentSim will only be able to display the sensor value, 
but not make use of it for simulation if required. 

If the data from the sensor does not contain the correct 
VentSim code number for the sensor, you will need to MAP 
your own names or definitions to these codes.  Click the 

 button to view the Sensor Definition table.  Each type 
of Sensor Type can now be mapped to the value or text 
string shown in your sensor data (not the column name, 
but the actual data for each sensor). 

Unit Types are defined automatically if the sensor type is defined.  However if the unit type is different 
than the expected VentSim type, is can be remapped and defined the same way as shown with sensors. 

Testing the Sensor Data Import 
To TEST the mapped connection to see what sensor information will be imported, click the SENSORS 
button.  

  



 

 

24.3. Managing Connections 

Once the LiveView connections have been established, they will be displayed in the connection list in the 
main LiveView form.  You can edit, delete and make duplicates of the connections using the appropriate 
button at the base of the list.  You can also edit the connection by double clicking the name in the list. 

The connections can be simultaneously tested by clicking the VALIDATE CONNECTIONS button.  Any 
issues will be reported in the results box, and the combined data imported with be shown in a datasheet.  
If a connection has failed, edit the connection data, and test the mapping and sensor data for more 
specific error reporting. 

  

24.4. LiveView Settings 

Set Sensor Simulation Options 
LiveView™ can be set to periodically read and display sensor data in the model.  The sensor data can also 
be used to simulate conditions in the model, and a number of simulation options are provided on the 
settings page.  It is recommended the sensor information first be observed for valid data, as incorrect or 

unreasonable data may cause the simulation to fail or show unpredictable results. 

• Date From / To: The date fields can be checked to 

import only data from a specific time and date.  This 
assumes that multiple identical sensor readings are 
available in the data file from different dates.  If this 
remains unchecked, then only the most recent sensor data 

will be shown. 

• Manual / Auto Update.  The sensor data can be set to 
import into the model only once, or periodically at set time 
intervals.  If Auto Update is selected, then the user may 
note that VentSim will pause momentarily whenever the 
data is imported.  

Simulation Options.  The data can be used to simulate 

conditions within the VentSim model.  Use these settings with 
caution as incorrect sensor settings can seriously affect 
simulation results and invalidate the VentSim model with 

incorrect data.  The sensors must be set to allow simulation 
individually, otherwise these settings will be ignored. 

Simulation Update Frequency.  If simulation of sensors is required, this can be done with steady state 
simulation, or dynamically over time.  Steady state simulation can be done either manually (by running a 

simulation from the normal toolbar), automatically after every sensor update, or at set time intervals.  
Dynamic simulation is performed continuously and uses the most previous sensor values as base values 
for each location.  Dynamic simulation is computationally intensive and may slow computer response, 
however it provides a more realistic spread of sensor data through a model. 

IMPORT and MODIFY SENSORS 



 

 

LiveView data cannot be directly used in a VentSim model, until the individual sensors within the data 

source are identified and modified if required.   This is because some of the imported data may be invalid 
or unnecessary.  In addition, some of the imported data may be missing basic attributes. 

VentSim LiveView keeps a copy of these modified sensors settings within the model, so that future data 
imports are automatically correctly modified. 

To define the sensors in the imported data, click the “Import and Modify Sensors” button, and then select 
the sensor you want to be able to access within the VentSim model and transfer them into the “Included 
Sensors” list. 

 

The included list will contain GREEN values if the 
data source connections still contain these sensor 
names.  If the data source no longer contains 
these sensors names, or is temporarily offline or 

unavailable, then the included sensor names will 
be shown in RED.  If sensor names in RED are 

included in a VentSim airway, the LiveView display 
will not update the values. 

Once the sensors are included in the list, they are 
available to assign to individual airways.  However 

if they are missing important information such as 
the type of value, or alarm levels, they may be of 
limited use.  Therefore it is important to assign 
attributes to the sensors to help VentSim 
understand more about the sensor. 

Assigning Attributes to Sensors 

To EDIT a sensor and assign attributes, select the sensor or sensors from the list, and click EDIT.  Normally 
a sensor must at least be defined with a type (eg velocity, methane gas etc).  If these items are not defined 
in the Imported Data, then they must be manually set using the Sensor Editor. 

Other attributes such as alarm levels, metric/imperial units and whether the sensor should be activated or 
simulated in the model can also be set. 



 

 

 

Specifying the Sensor Location 

If the imported data contains either the Airway 
unique number or columns for the X, Y, Z coordinates 
of the sensor then LiveView™ will automatically place 

the sensor information against the airway when 
imported.   

If the sensor location is not defined in the imported 
data, then the user must specify which airway the 
sensor belongs to. 

 

• The EDIT SENSORS OPTION under the LiveView™ menu also allows the user to specify the airway 
the sensor belongs to, by entering the Airway Name or Number. 

• An alternative option to placing a sensor on an airway is to use the EDIT selection box, to click on an 
airway where the sensor(s) is located, and select the sensor name directly.  The Sensor option is 
currently a sub-option of the GAS tab in the edit box.   

 

 

• An option is provided in either 
the Sensor Editor form, or the 

Airway Edit form to specify 

whether to sensor will help 
simulate the model data, or 
whether it should be only 
passively displayed. 

 

24.5. DISPLAYING THE SENSOR DATA 

Once the sensor information is imported and the sensors assign to airways, the data can be displayed by 
clicking the Connect > LiveView > Update Once or Update Continuous menu.  Clicking “Update Continuous” 
will continually update the model with sensor data at intervals defined in the LiveView Settings page.  If 
the automatic simulation option is chosen, the downstream result of the sensor will be displayed on other 

airways.  For example, if the sensor is an AIR VELOCITY sensor, then the airflow in the sensor airway will 
be restricted to the sensor velocity, and all airway leading to an from this airway will be adjusted 
accordingly. 

WARNING: Using Sensors to simulate model airflows may not necessarily correctly predict ventilation conditions in other airways.  For 
example, if a change in airflow is transmitted by the sensor, then this may be because a fan has been turned off, or a door has been 
opened or closed.   



 

 

If these other ventilation items are not also input into VentSim (although VentSim LiveView™  can accept regulator and fan operational 
sensor data as well), then the simulated airflow activity may not be correct.  

Airways with sensors will display a sensor icon, and a show a box describing the sensor data. 

   

The sensor data boxes can be shown or hidden by selecting the Text Display Icon and hiding the Ventlog 
/ LiveView text display option. 

24.6. COPYING LIVEVIEW CONNECTIONS TO ANOTHER MODEL FILE  

To copy your LiveView connections and settings to another file, load the other file in VentSim, the use 
the FILE > INHERIT function.   Select the VentSim model file that contains the LiveView settings, choose 

the LIVEVIEW option in the Inherit setting box, then click OK.  The LiveView connections and settings will 
now be available in the new file. 
  



 

 

25  VENTSIM CONNECT™ 

VentSim CONNECT™ is an optional add-on of VentSim for connnecting directly with devices on a site for 
monitoring or control purposes. 

Note: VentSim CONNECT is designed to simplify manually controlled access to a number of sensor or control devices on-site. If you 
are looking for an Enterprise system to enable full automated control of all devices on-site and take advantage of VOD 
(Ventilation on demand) options  refer to VentSim CONTROL™ from Howden Simsmart. 

 

 

Figure 25-1 Access VentSim™ CONNECT 

25.1. Connection Information 

 

Each connection has the following parameters: 

The name of the device. 

 
The airway the device is located in. 
 
Fan, Regulator, Sensor, Custom Device  
 
1. Modbus TCP IP - Modbus is a serial communications protocol 

2. Ethernet IP - Ethernet/IP is an industrial network protocol 
3. MCS – Monitoring and Control Station (plug and play unit from 

Howden) 
 

The IP address of the device. 
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Name 

Airway 

Device Type 

Connect Type 

Address 



 

 

1. MS units are Monitoring Stations for determining air flow and air 

quality. 
2. MSg units are Monitoring Stations to which specific gas sensors, chosen 

to reflect local conditions, can be added. 
3. MCS units provide both Monitoring and Control capabilities. 

4. MCSg units offer Monitoring and Control and incorporate gas sensors. 
 

The device can be disabled (the device will not try to connect unless it is 
enabled). 

25.2. Transfer 

Each connection must have a list of one of more transfers.  

A transfer is simply a transfer of data to or from the device. 

  

Used only when connecting to MCS devices. 

 

Used only when connecting to MCS devices. 
Defines the data you want to access on the device. 

 

The address of the data you want sent or retrieved from the connected 
device. 
 
The physical data type that will be sent to the connected device. 
 

MCS Class 
(MCS connection types 
only) 

Disabled 

MCS Section 

MSC Address 

Address 

Data Type 



 

 

  

The transfer is incoming (read) or outgoing (write). 
 
Custom, Fan Speed, Status 
 
The name of the transfer (shown in the monitor display) 

 
Unit of the data Type 

 

Unit of the data Type at the source. 

 

25.3. Linking to a Device 

Select the airway where the device is located and open the edit properties dialog, select the  

connect tab and click “Link to Devices”, Select device you want and click ok. 

 

 

Direction 

Transfer Type 

Name 

Unit Type 

Source Unit 



 

 

25.4. Monitoring Device  

 

In the above example the Fan Speed is displayed in the data box above the fan location. By clicking “Open 
Device” from the Edit Properties dialog, you can open a monitoring dialog that will display information from 
the connected device and allow you to send instructions to the device. The Monitoring dialog also displays 

recent history of the data received from the device (this is limited to showing the last 24 hours of 
information received; use the track bar at the bottom of the form to modify the timescale shown). It also 
has information on the Fan pressue, efficiency and power located in the curve tab. 

   

  



 

 

26  RADON SIMULATION (Premium) 

Radon simulation is a separate type of simulation that differs from normal gas simulation in that the 
hazardous nature of the gas is not directly the concentration of radon in the airways, but radiation 
exposure from the radioactive decay of the gas into the various radon daughter elements. 

26.1. Introduction 

Radon gas can emitted from many types of rock.  While usually associated in higher concentrations with 
the mining of uranium ore, radon gas can also be present in lower concentrations in any type of mine. 

Radon is released from rock surfaces along mined tunnels, and from broken rock or ore during the mining 
process.  The amount of radon released is usually in proportion to the presence of uranium ore (U3O8) in 
the rock, however this can vary between mining operations and orebodies. 

Hazardous exposure to radon gas results when the Radon element decays into lower order elements (called 
Radon daughters) during which radiation in the form of alpha and beta particles, and gamma radiation is 
released.  The formation of these Radon progeny potentially exposes mine workers to harmful levels of 
radiation that can increase the risk of radiation related diseases such as lung cancers.  Most countries have 

strict guidelines on the amount of radiation that workers can safely receive over a period of time. 

Radon Concentration 
Because of the small volumetric portion of Radon in mine, emanation into the atmosphere is instead 
normally specified in Becquerels (Bq) or Picocuries (pCi), which represents the potential decaying 
radioactive capacity of the Radon gas presence.  Once into the atmosphere, the concentration is normally 
specified in Bq/litre or pCi/litre of air.  The release of the radon gas in VentSim can be introduced in two 
ways; either by the average emanation of radon per second over a m2 of exposed rock surface, and/or 
alternatively by an emanation rate of radon (Bq or pCi) per second (from ore piles for example) that can 

usually be derived using a factor based on the volume of broken source ore material. 

Radon Progeny 
The formation of Radon progeny (Radon daughters) causes the harmful exposure of radiation to workers.  

The Radon progeny calculation in VentSim utilises a number of factors, including the exposed rock surface 
area, existing and newly emitted radon gas, and existing Radon progeny activity in the atmosphere.  The 
result shows the potential radiation exposure in the atmosphere at different locations in the mine.   

Because the decay of Radon gas into its various daughters can take some time after the gas enters the 

atmosphere (Radon gas has a half-life of 3.82 days), the radiation emanation of Radon progeny is highly 
dependent on the time that Radon and its daughter particles are present in the atmosphere, hence the 

higher progeny exposures can be some distance from where the Radon enters the atmosphere, or where 
air is stagnant or slow moving.  For this reason, it is highly desirable to limit the time that Radon loaded 
atmosphere spends in the mine. 

Radon progeny levels are normally specified in uJ/m3 or air, or more commonly in North America as a 
Working Level (WL) (which was originally devised as a representation of an acceptable working level 
concentration of 100 pCi/litre, although this level has been substantially reduced since it was devised). 

Threshold Exposure Limits 
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The harmful effects of Radon progeny are generated by exposure over time.  The current method of 

assessing mine worker dosage is based on time weighted cumulative exposure to Radon progeny.  For 
example, an exposure to one (1) Working Level (WL) for one (1) working month (consisting of 170 hours) 
equals 1 WLM cumulative exposure.  A typical recommended limit for a standard year of 2040 hours 
exposure is 4WLM, which would be equivalent to continuous at work exposure of 0.33WL. 

An alternative SI exposure level unit is mSv which can be calculated by the uJh/m3 progeny level where 
1-hour exposure at 1uJ/m3 equals 0.00141 mSv.  Therefore, an annual exposure of 2040 hours at 
10uJ/m3 would be a dosage of 28.8 mSv.  A typical recommended limit is 20mSv for a standard 2040hr 
year, which is equivalent to continuous at work exposure of 6.9 uJ/m3.  Standards may also exist for 
higher short-term exposures. 

VentSim also provides an annual exposure dosage calculation, however it must be remembered that actual 
exposure and dosage will be the weighted average of all regions of the mine accessed by a mine worker, 

and this calculation is based on 2040 work exposure hours per year, which may need to be adjusted for 
different rosters or time spent in the mine to give actual individual dosage estimates. 

 

26.2. Using the Radon Simulation Feature 

 

Four (4) different inputs can be specified for Radon and progeny concentration in an airway.   

Radon Emanation 
Typically, the Radon emanation will be specified based on the exposed area of the surface of the airway.   

In addition, if broken ore or rock is present, the user may elect to calculate an extra Radon addition into 
the airway.  This is normally calculated by estimating the emanation of radon from the exposed ore surface 
(based on the area exposed m2) and also from within the ore pile (based on the m3 present).   The 

additional Radon calculated can be added to the airway in the second field (Radon Addition). 

Radon and Progeny Fixed Settings 
Alternatively, the levels of Radon concentration and progeny levels can be specifically set in the airway 
using the FIX options in the 3rd and 4th setting.  These factors will override any calculations derived from 
the emanation settings and will ensure any airflow exiting the airway contains these values.  These settings 
should only be used where there is a known concentration as they will override any prior estimates of 
radon activity travelling through these airways.  The emanation settings should not be used simultaneously 
with the fixed settings in the same airway. 

Activating Radon 
The Activate Radon checkbox will ensure the radon settings of the airway will be included in the Radon 
simulation.  Deselect this box if the settings are not required to be used in the simulation. 

 



 

 

 

Simulating Radon 
Radon simulation can be performed as a Steady State simulation by 
simulating directly from the EDIT form, or from the Contaminant 
Simulation sub option. 

Radon can also be simulated using the Dynamic simulation options, although 

because of the simulation technique, results may slightly vary. 

Radon simulation results will show Radon and progeny levels distributed through 
the mine as colours and data.  As will most other VentSim units, the different 
Radon results can be specified in the colour and data menus under the separate Radon data category. 

Radon units and decimal accuracy can be altered in the TOOLS > UNITS main menu.  In addition, the 

standard year work hours for calculating dosage can be adjusted in the RADON section of the TOOLS > 
SETTINGS > SIMULATION menu. 

 



 

 

27  FINANCIAL OPTIMISATION (Advanced) 

VentSim DESIGN™ provides many useful tools to analyse and develop strategies to save money.  While 
the total ventilation cost for most mines is significant, in many cases much of the cost of ventilation may 
remain largely hidden or ignored. 

The total cost of ventilation in mines should be considered as a combination of costs; 

• A direct operating cost (such as power consumed or maintenance and upkeep of ventilation system), 
and 

• A direct capital infrastructure cost (which includes the development and infrastructure mined and 
fans purchased); and 

• An indirect cost which factors productivity gains and losses due to good or adverse ventilation 
conditions.  

When ventilation costs are viewed as an integral part of all production activities, the cost of poor 
ventilation becomes even more substantial and can be used to justify additional investment in the 
ventilation system.  VentSim DESIGN™ includes a number of tools to quickly analyse and help reduce 
ventilation costs. 

27.1. Financial simulation 

[Advanced Versions] 

This function is designed to quickly estimate optimum ventilation infrastructure size, by considering 
mining costs as well as life of mine ventilation operating costs.   

Financial simulation can help optimise airway sizes and save substantial money over the life of a mine.  

Keep in mind however, when using estimated mine life to optimise an airway size, that in many cases 
mine life extends far beyond initial estimations as further ore resources are found.   

Many mines are stuck with an inadequate ventilation systems that are stretched far beyond the useful 
life, because the possibility of mine extensions or expansions was not considered in the early stages of 
ventilation design. 

VentSim has three (3) different options for financial optimisation. 

Option 1 – Quick Select 
This function can help optimise the size of vertical or horizontal airways by considering a variable cost of 
mining based on airways size, and then optimising airflow power costs through potential different sizes. 

This method is based on variable airways size costs based on fixed and variable parameters and 
formulas.  While this method considers an infinite number of different sizes, the formula assumptions 
used must be estimated from actual mining costs and therefore will vary between different sizes.  The 
parameters for fixed and variable mining costs must be entered each for round vertical shafts, horizontal 
tunnels and vertical square openings.  The fixed and variable costs must be representative of all 
considered sizes. 
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To correctly estimate the fixed and variable costs, a MINING COST 

CALCULATOR is included in VentSim, accessible from the TOOLS > 
Calculator menu, or directly from the Cost Settings pages.  Users are invited 

to enter between two and four example costs for each airway type.  The costs 
will be averaged and the best overall fixed and variable costs will be chosen 

when the CALCULATE button is clicked.  To give the user confidence in the 
results, the same fixed and variable costs are then tested against each size.  If 
the check is close to the original cost $/m then the user can be confident the 
predicted cost parameters are reasonable.  If the costs appear reasonable, click 
the COPY TO SETTINGS button to transfer the fixed and variable costs 
permanently into the model settings. 

 

This method is based on defined airway costs and parameters for a number 
of discrete sizes, and will construct graphs showing different size options. 

This method is based on the Quick Select method, but considers every single 
airway in the mine model for optimisation.  Optimisation is only considered 
for larger than original size airways, as recommending smaller sizes often 

ignores the reality that mining sizes are designed for minimum sized passage of 

men or equipment.  A list of potential airways that can be optimised will be 
provided at the end of the simulation. 

Option 2 : Selected Airway Graph Optimisation 
Option 2 - The selected airways method - allows for the definition of size and costs of up to ten different 
airways sizes and shapes.  These are defined in a table, which is then used to calculate various 
ventilation costs for each size.  After calculation of each size, a graph is drawn showing the three major 
ventilation costs (mining, power and fan purchase).  The lowest combined cost is normally the optimised 

point in sizing. 

Quick Select Cost 
Calculator 

Option 2 – Selected 
Airways 

Option 3 Global 
Optimisation 



 

 

 

Figure 27-1 : Financial Simulator Output showing life of mine airway costs 

Increasing airway size is the easiest way to reduce frictional pressure losses and decrease ventilation 
costs in a mine.  Increasing airway size however creates additional mining costs, and this is further 
exacerbated by the ‘time value of money’ which dictates that a dollar saved in mining costs now is worth 
more than a dollar saved in ventilation costs in the future.  Another factor to consider is how long the 

airway is required to carry air, which affects how much ventilation cost can be saved in the future. 

The financial simulator takes all this into account, and simulates up to 10 different airways sizes for an 
airway or group of airways, reporting the effect on mining cost and ventilation costs as an NPV (net 
present value cost) adjusted overall cost.  

 

Figure 27-2 Example of a Financial Simulation Table 

The system relies on the use of accurate mining costs to estimate the costs of different airway sizes and 
shapes.  The correct power cost must also be placed in the Settings. 

Performs a financial simulation and maintains identical flow through each 
size to ensure the airway size is optimised for the required flow.  Note that 

once a size is selected in the final model, then unless a fixed flow has been 
chosen, adjustment to fans or flow elsewhere in the model may be required to 
achieve the desired flow through the new shaft size.  This is the method that 
should be generally chosen when optimising shaft sizes for new or extended 
mines. 

Performs a financial simulation and allows the simulation to adjust the flow 
through the airway (unless using fixed airflow) based on the resistance of 

each size.  This option should only be used if it is understood that by allowing 
the airflow to adjust, the basic economics of the shaft also adjusts, and may 
place additional costs elsewhere in the ventilation model.   

Maintain Flows 
Simulation  

Adjust Flows Simulation 



 

 

The function is useful to establish shaft or airway size performance where 

existing fans or infrastructure is in place, but should not be used when designing 
a new mine or shaft and fan system where an optimised size is required for a 
specific airflow.  

Using FAN  curves on selected airways, will result in decreasing flow for smaller 

airways, which in turn, despite increasing fan pressures, may actually result in a 
decrease in ventilation costs.  There is no point in establishing an economic 
airway size if it does not deliver the required airflow. 

Airway shapes:  Round or Square.  A set of 10 airway parameters is stored 
for each shape type. More complex shapes or fixed areas are not supported 
at this time. 

Life: The life in years required for the airway to be in operation.  This directly affects the ventilation 

operating costs of the airway, and the effect of time value of money. 

Discount % : The time value discount of money per annum.  The value of money will diminish over the 
life of project, meaning costs saved up front (in most case mining and fan purchase costs) are worth 
more than costs saved in the future (in most cases ventilation costs).  Other similar names associated 
with factor include the discount rate, project hurdle rate, rate of return or NPV (net present value) 
discount rate.  To use a value of money not diminished by time or to estimate undiscounted future 

savings, use a zero (0) rate.  To evaluate projects however, most mining companies will use factors 
ranging from 5% to 15%, depending on the cost of money and the competing project values to be 
gained elsewhere with that money. 

Fan Cost : The capital (purchase) cost of fans required to provide ventilation power for the mine 
simulation.  Note that this uses an approximation of $/unit power cost approach which is only an 
estimate of actual fan costs, and may vary substantially when compared to real fans of different sizes. 
Nonetheless,  it provides an important adjustment to different airway sizes that in most cases will be 

accurate enough for selecting suitable sizes. 

Sim : Check this box to include the airway size in the simulation.  Airway sizes that are not reasonable or 

which do not deliver sufficient airflows should not be included for use as they can distort the graphs to 
excessive ranges. 

Fixed Cost : Many airways, such a shafts have an initial setup cost to establish the mining method.  This 
option is included to allow this to be factored in to the overall airway mining costs.  It is applied only once 
for the airway, or group of airways selected, not applied to each individual airway.  In most cases, 

horizontal development will not have a fixed cost applied against it. 

Variable Cost :The cost per unit length of development or mining.  Using this value, VentSim DESIGN™ 
calculates total mining costs based on the length of the airways selected. 

Mining Cost  : Total cost of mining the airways 

Fan Cost : Cost of the capital cost portion of fan infrastructure required to 
produce the ventilation flow.  Note only the portion of fan cost related to 

providing ventilation for the selected airway will be used. 

Selected Annual Vent Cost; Cost of ventilating selected airways for one year. Note this is only the 
frictional cost of the airway, not the power cost of distributing air through the model. 

Selected Lifetime Cost : Total cost of mining and ventilating selected airways for the life of the airways. 

Model Annual Vent Cost:  Cost of ventilating the whole of model for one year 

Model Fan Cost :  Combined cost of all fan purchase costs based on the required ventilation power for the 
entire model. 

Input variables required 

Financial Simulator 
Outputs 



 

 

Model Lifetime Cost :  Combined cost of mining selected airway plus cost of ventilating whole of model for 

life of the airways. 

Sel Airflow (avg) : Average airflow through each selected airway 

Net Airflow (total) :  Airflow through entire mine model. 

In most cases, only the Selected Airway costs and graphs will be relevant to the simulation results, 

however at times it is important to consider the effect of changing airway sizes on the rest of a mine.   

For example, creating a large shaft to deliver more airflow to a mine, may simply increase the cost of the 
airflow through other parts of the mine, offsetting some of the expected ventilation savings.  For this 
reason, Total Model ventilation costs are included as a separate column and graph, and should be 
considered if the project is an addition to a mature mine.  

OPTION 3 Global Financial Simulation [ADVANCED] 
Checks and reports on all airways within a mine model on their size suitability to carry the simulated air. 

This is a broad function which utilises the default cost settings to determine to cost of airflow through 
each airway for the life of the mine.  The cost component costs are a relative mining cost, and fan capital 
cost component and a lifetime discounted power cost to provide the ventilation. 

The simulation will only report airways which are over-restricted and potential cost savings exist by 
making the airway larger.  While smaller airways could also be more economical, VentSim ignores this 
option as this type of airway is usually sized for a certain means (eg truck access), and it would be 
distracting to report all possible size reductions.  To check individual airways for size reduction options, it 
is suggested the Quick Select, or Graph Select Financial optimiser be used, or the Suggest (?) button in 
the Edit airway form. 

 
Figure 27-3  Global Optimisation 

27.2. Cost Data Function 

The program contains a number of data types which show ventilation costs per annum for airways.  
These are located under the colour and text ENERGY category and include fan/fix power costs, friction 

losses per airway and friction losses per unit length. 

Perhaps the most useful way to consider ventilation costs is not to look at the cost of running fans, but 

rather look at the cost of pushing ventilation through individual airways located throughout a mine. 

Of all the cost data function, perhaps one of the most useful is the friction cost per unit length.  This 
describes the friction pressure loss along an airway length, and is directly proportional to the ventilation 
cost per unit length of development. 

For example, if a particular airway reports a ventilation operating cost due to friction loss of $800/yr per metre, then over a mine life 
of 10 years, the total cost of pushing ventilation through the heading is $8000 per metre.  It is not hard to see that increasing the 
mined airway size slightly for (say) an additional mining cost of $500 per metre will quickly pay dividend in reduced ventilation costs. 



 

 

By using the VentSim DESIGN™ Display Manager, and colouring data to the ventilation cost per annum 

per unit length, high cost airways will be highlighted, and can be quickly identified and analysed for 
potential different sizes. 

Example 
In the ‘Blue-Sky’ example presented below, the data colour display is set to Head Cost/L (friction 
pressure cost per metre).  The colour sliders are adjusted to show airways costing greater than $2 per 
metre per year.  Airways below this are made transparent to clarify the display. 

The data clearly shows in particular two air shafts with extremely high costs per metre, one in particular 
at over $600 per metre per year, as well as a horizontal connecting airway costing nearly $300 per 
metre.  If the mine life was substantial, it would not be hard to justify enlarging or installing a second 
shaft system to reduce overall ventilation costs. 

In this case, increasing shaft size from 3.0m to 3.5m reduced per metre annual ventilation costs from 
$600 per metre to $250 per metre.  Over 10 years, this would result in a saving of $400,000 for this 
relatively short airway. 

 
Figure 27-4  High Cost Airways coloured to show clearly 

27.3. Ventilation on Demand. 

An increasingly popular method of reducing ventilation costs is applying ventilation only when and where 

it is needed.  While simple in principle, this fundamental approach provides significant challenges when 
applied to complex models.  Changes or reductions in ventilation flows can significantly impact other 
areas of the mine, resulting in recirculation and heat and gas build up. 

Using VentSim™, different scenarios can be easily examined by simulating potential changes, such as 
reducing or turning off fan flows or reducing refrigeration. 

The model summary will predict savings made in ventilation costs and power for the change. 

The recirculation checker in Visual Advanced will quickly check for any recirculation resulting from the 
change.   



 

 

The contamination and diesel particulate tools (in the Advanced version) will estimate any change to 

exhaust and potential fume.   

The thermodynamic simulator will identify any unacceptable changes to temperature 

 Doors, fans and stopping can be quickly placed to control model airflow to acceptable levels and provide 
useful information as to what automatic controls may be required to achieve the ventilation changes. 

27.4. Fan Optimisation 

Correctly sized fans can significantly reduce operating costs. 

Ensure airflows are not significantly overdesigned, and fan 

curves and duty points are closely matched to run efficiently.  
Many fan curves rapidly lose efficiency away from the central 
duty points, resulting in poor performance and excessive 
power consumption. 

The fan efficiency and power consumption can be examined 
under the Edit Box fan menu.  Ideally, the fan efficiency 

should have the operating duty point close to the maximum 
fan efficiency. 

A further way to boost fan flow and efficiency is to ensure an 
evasé is fitted to surface exhaust fans.  Fan evasés reduce 
surface velocity pressure losses, increasing available fan static 
pressure to overcome mine resistance.  The overall effect is 
improved airflow at a similar cost. 

Finally, overall model efficiency is largely influenced by the 
configuration of fans throughout a model.  The use of ‘in-
series’ booster fans underground for a single primary 
ventilation circuit should generally be avoided if possible, as 

fan efficiencies are compounded as the same airflow travels through each fan (booster fans may 
however be useful in directing airflow into parts of a mine which would otherwise require inefficient 
regulators on the primary vent flow to do so).  The result compared to a single pass fan system is higher 

power for similar airflow.  The overall model efficiency is available from the model summary function. 



 

 

28  TEXTURED GRAPHICS (All Versions) 

VentSim DESIGN™ allows photographs and pictures to be ‘draped’ over reference graphics solids to 
provide a full 3D picture.  This is typically used for placing satellite or aerial imagery over topographic 3D 
shapes.  In addition, textured graphics can also be used to apply scanned or PDF’s mine plans 
graphically in VentSim.  Once correctly scaled and rotated, they can then be used as a guide for drawing 
VentSim airways in the correct location. 

 

 

Figure 28-1 An example of a textured aerial photograph over a 3D topographic solid surface 

28.1. Applying Textures to Reference Graphics. 

To apply a texture to a reference graphics, simply drag and drop a picture file (jpg, gif, bmp, tiff, png 
formats) directly only to an existing reference graphic surface.  PDF files can also be used. The picture 
will automatically fill the extents of all graphics elements on that layer. 

Once displayed, the user will want to rotate and scale the picture correctly over the 3D shape.  The 

MOVE button on the top tool bar contains options to do this quickly.  See the ACTION TOOLBAR section 
for details on how to use the MOVE REFERENCES and MOVE / ROTATE and SCALE TEXTURES to correct 
positions. 

To remove a texture, use the REFERENCE MANAGER to show a list of references, click the desired 
reference to clear, and RIGHT CLICK selecting REMOVE TEXTURE. 
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28.2. Applying Texture to a New Surface 

To create a new surface for a texture, drag and drop a picture into empty space within the VentSim 
model.  A new surface is typically required to display a mine plan, or legend image within the 3D space 
of a model.  Once placed, it will rotate and display in true position with all other airway and elements in 
the model.  

 

Figure 28-2   An example of a PDF file dropped into VentSim as a new textured surface 

When dropped onto the screen, an option to either REPLACE BACKGROUND PICTURE or CREATE 
TEXTURED SURFACE will be requested.  Choose the CREATE TEXTURED SURFACE option.  If the dropped 
file is a PDF file, an option to correctly scale the PDF image will also be requested. 

Once the image appears on screen within a 3D reference surface, the surface can then be moved, 

rotated and scaled correctly into place with the MOVE button as described previously.  It is 
recommended the 3D reference surface be mostly manipulated to do this as the texture will be partly 
lost from the side of the reference surface if used alone. 

 



 

 

29  SHORTEST PATH ANALYSIS 

VentSim DESIGN™ has a tool to SELECT a path through a model automatically that contains special 
characteristics such as lowest resistance or shortest distance.  The selection can then be analysed or 
graphed to show how the ventilation conditions change along the selected path, a useful tool (for 
example) to show temperature, pressure and airflow variations. 

 

Figure 29-1 An example of a path through a model showing variations in temperature and pressure. 

29.1. Uses of Shortest Path 

Shortest path selection offers a number of uses in ventilation modelling.  The selected pathways can be 
analysed for good ventilation design or to examine variations in ventilation conditions along the path.  

The paths can also be used to identify potential bottlenecks or blockages in a ventilation circuit causing 
high pressure and power loss.  The selected path tool has a graphing function to graph a wide range of 
ventilation conditions between two points or to export the data to a spreadsheet. 

Shortest paths can also be simply used as a tool to select and EDIT pathways – for example, to select an 
entire decline or ramp system to change the airway parameters (such as friction factors), the “shortest 
horizontal distance” path option can be chosen and the top and bottom of the ramp clicked to selected 
the entire ramp in between.  The EDIT option can then be used to change the selected airways. 
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Figure 29-2  An example showing a decline selected using the short horizontal distance option 

29.2. Type of Paths 

Chooses a path between two selected 
point which is the shortest aggregate 
distance of the pathways between the 

points. 

Chooses a path between two selected 
points along only horizontal or inclined 

(less than 45 degrees) airways.  This tool 
is more suitable to choose (for example) a 
vehicular access path.  Both the shortest 
distance methods may have uses in finding 

escape pathways for emergency analysis. 

Chooses a path with the least aggregate resistance between two points.  The 

tool is useful to analyse ventilation circuits to ensure suitably resistanced 
pathways exist between two points in a ventilation circuits.  It may assist the 

uses in highlighting areas that are constricted or unintentionally pass between 
through high resisting (and therefore power wasting) pathways.  Typically, a 
path between an intake and exhaust airway may be selected with the path 
showing the path of least resistance for the airway to follow. 

Free Split is a variation of the least resistance option and finds the path of 

maximum pressure loss between two points ignoring pressure losses over 
preset resistances (such as door or regulators) and fans.  The purpose of this 

function is to find unintended placement of high resistance items they may be 
unnecessarily restricting model flows and causing poor energy efficiency and 
higher pressures.   

In many cases the results may be similar to the least resistance method, 
however the pathway for free split will be uni-directional (ie – it will never travel 

in an upstream direction) and unlike the least resistance method, it will try to 
avoid preset resistance paths (which in most cases will be intentionally placed 
by the user to control airflow).  Good ventilation design that achieves the lowest 
resistance and power consumption will typically have at least one path between 
exhaust and intake that is ‘free’ from added resistances and unnecessary 
pressure losses.  The theory is that all other ‘controlled’ paths can then be 

adjusted to the lowest resistance settings ensuring greater energy efficiency. 

The graph menu option constructs a graph of ventilation conditions along a 
selected path.  The graph is sequenced from the starting point to the ending 

Shortest Distance 

Shortest Horizontal 
Distance 

Least Resistance 

Free Split 

Graph 



 

 

point with the X-Axis representing the length travelled, and the Y-Axis 

representing a user selectable ventilation data type such as airflow, temperature 
or pressure.   

  



 

 

30  HEAT AND RESISTANCE SENSITIVITY ANALYSIS 

 

30.1. Resistance Sensitivity Analysis  

The Resistance Sensitivity Analsyis allows the user to analyze the sensitivity of the simulated airflows to 
potential errors in airway resistance.  

The airflow quantity and direction in some airways will be stable to changes elsewhere in the network, 

while some airways (such as cross-cuts between high-flow rate airways) may be very sensitive. The 

Resistance Sensitivity Tool, found under the Air Simulation Button, can help identify such airways. The tool 

runs 100 (or more) simulations of the mine airflow, with each simulation adding a random perturbation to 

each airway resistance. A statistical analysis is then run, which gives the user a derived confidence level 

on the simulated airflow and airflow direction in each airway, as well as providing the statistical quantities, 

such as mean and standard deviation.  

 

Figure 29-30-1 Results after completion of the resistance sensitivity analysis, showing the Confidence Quantity (%).  Low confidence in 
the airflow quantity is often found in cross-cut airways, 

After the tool is run, the results can be found in the Color Data box under Resistance Sensitivity. 
Confidence quantity (%) gives an estimate of the confidence in the true simulated airflow, based on the 
variation of the airflow in response to the changes in resistance. Deviation From Mean Quantity gives the 
difference between the true simulated airflow and the mean or average of the airflow in the randomised 

trials; this can also be viewed as a percentage. Direction confidence gives the percentage of trials in 
which the airflow had the same direction as the true simulated airflow. Stats: Mean Quantity, Stats: 
Mean Standard Error Quantity and Stats: Standard Deviation Quantity give the raw statistical data. 

When running the resistance sensitivity analysis a progress bar appears. From here, more simulations 
can be run or the analysis can be finished early. The number of trials per run and the size of the 
resistance perturbation can be adjusted in the Settings. The statistical analysis the tool uses will increase 

in accuracy the more trials run. The progress bar gives some information on the convergence. The 
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relative standard error of the most variable airway is output on the progress bar, as well as the airway 

index. The average relative standard error gives the average error over the model and will generally be 
much smaller than the maximum. 

  

30.2. Heat Sensitivity Analysis  

The Heat Sensitivity Analsyis allows the user to identify airways in which airflows will depend strongly on 
heat and natural ventilation.  

In some mine network models, Heat simulation results can be seen to vary from one run to the next. In 
such a model, an initial Air simulation is run before the Heat Simulation; the Heat Simulation then runs 

based on the results of the Air Simulation; another Air simulation is run using the results of the Heat 
Simulation, giving different Air Simulation results, and so on. This is indicative of a mine model that does 
not have a steady solution to airflow and heat. Such behaviour can be seen in the Ventsim Fire 
Demonstration Model by repeatedly running the Heat Simulation. This behaviour seen in a well-
configured computational model of a mine is most likely indicative of a real variability and 
unpredictability in the mine heat and air flow. The Heat Sensitivity Tool has been developed to give 

information on this variability. The tool is found under the Heat simulation button. 

    

             

Similar to the Resistance Sensivity Tool, the Heat Sensitivity Tool runs a number of trials, but it does not 
change any design inputs from one run to the next, relying on the natural variability in the mine heat 
and flow. The tool has a progress bar, from which the tool can be finished early or continued for further 

trials. The relative standard error on the most variable airway is given, as well as the average error 

across the whole network. Running more simulation trials will increase the accuracy of the results.  

The results can be found in the Color Data box under Heat Sensitivity. Quantities beginning in “Stats:” 
give the raw statistical data for both quantity and dry bulb temperature. Confidence Quantity (%) gives 
an estimate of the reliability of the simulated airflow, while Deviation From Mean Q and Deviation from 
Mean Temperature give the deviation of the current simulated airflow and temperature from the mean 
airflow and temperature calculated by the heat sensitivity tool. Direction Confidence % gives the 

confidence in the direction of the airflow, based on the count of airflow reversals during the trials.  



 

 

31  GOAL SEEKING 

The Goal Seeking tool is useful for quickly adjusting a new parameter (say, a fan speed) to achieve a 
given output (such as airflow)  

31.1. The Goal Seeking tool 

 

Figure 30-31-1 The Goal Seek Tool  

The Goal Seeking tool is useful for quickly adjusting a new parameter (say, fan speed) to achieve a given 

output (such as airflow) in another part of the model. Where a user could use trial and error, the Goal 

Seeking tool will run the simulation multiple times, calculating the required parameter setting using an 

efficient numerical algorithm. The Adjustable Parameters are:  

• Resistance 

• Fan Speed 

• Sensible Heat 

• Latent Heat 

• Refrigeration 

• Regulator Opening 

• Orifice Area 

• Fix Flow Quantity 

• Fix Pressure 

• Rock Wetness Fraction. 
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While the Target Options are:  

• Flow Quantity 

• Flow Velocity 

• Total Relative Pressure 

• Dry Bulb Temperature 

• Wet Bulb Temperature 

• Gases: O2, CO2, CO, NO, NO2, NOx, CH4, DPM 

To use the Goal Seeking Tool, first select one or more adjustment airways. Then open the Goal Seeking 

Tool, found under the Tools menu.  

 
The property to be adjusted. The adjust menu default is Resistance. It can 

also be set to Heat, Refrigeration or Rock Wetness Fraction, as well as Fan 

Speed, Fix Flow, Fix Pressure, Regulator Opening or Orifice Area, provided the 

adjustment airway contains the chosen object. The top line of the Goal Seeking Tool shows the property 

to be adjusted, the current value and the index of the airway being adjusted.  

The property to be targeted. The target menu can be set to Quantity, Velocity, 

Pressure, Dry Bulb or Wet Bulb Temperature and a range of gases.  

The index of the airway being targeted. Clicking on an airway will set the 

target airway and update the target airway index.  
 
The value of the property being targeted on the target airway. It is updated 
with the current value whenever a new target airway of target menu option 
is chosen. 

Launches the Goal Seek. A series of simulations will be run, changing the 
adjustment values and converging the target value towards the target. The 

graph of the convergence of the target value (in red) towards the target (in 

blue) is updated each iteration. When finished, the final adjusted value is shown 
in the results box, along with the achieved target and the number of simulation 
iterations done. 

Closes the Goal Seeking tool. If a successful Goal Seek has been run, an 
option is presented to save the changes to the model, if desired.  

 

On small mines and only adjusting air quantities, the Goal Seeking Tool will finish quickly. On large models, 

or on Goal Seeking tasks that require Heat Simulation or Gas Simulation, more time will be required. The 

types of simulation that the Goal Seek will run will depend on the type of adjustment and target parameters 

chosen. 

In some situations, for a variety of reasons, the Goal Seeking Tool will fail. This can happen when: 

• The adjustment airway(s) and target airway are not functionally-related. This occurs where the 

targeted property of the target airway simply doesn’t respond to changes in the adjustment 

property of the adjustment airway.  

• The target can not be achieved, despite a functional relationship. This can occur when, for 

example, adjusting resistance to achieve a greater flow. A resistance can not be reduced beyond 

zero, so there is a limit to how great a flow can be achieved by reducing resistance.  

• The mine network has a natural variability in heat, that makes convergence to a particular value 

difficult. In these cases, the Goal Seeking Tool calculates an adjustment value oscillating around 

a certain value and then stops after a maximum number of iterations (usually 30). The mean 

value of the oscillation may give an indication of a useful adjustment value.  

Adjust Menu 

Target Menu 

Airway Index 

Target Data 

Goal Seek! 

Close 



 

 

32  ESCAPE ROUTES  (PREMIUM VERSION) 

The Escape route tool calculates the quickest escape routes to a safe location from any point in the 
ventilation model.  A safe location is defined as the surface or a defined refuge bay.  The feature takes 
into account vertical and horizontal speed of access, as well as the presence of smoke or gas. 

 

Refuge bays can now be placed in the ventilation network and a new measure tool called “Escape 

Routes” can be used to calculate a route from any location in the ventilation network to the closest 
refuge bays or to the closest surface exits. 

 

To place a refuge bay in an airway simply use the draw tool select “construct refuge bay” and click on 
the airway and a refuge bay will be displayed in that airway.  All airways are initially assumed to be 

available to travel, however many pathway may in fact be impossible to traverse (such as a shaft 
without a ladderway).  To mark an airway as impassable go the airway and edit its properties, by clicking 
on the “no thoroughfare” option in the VentFIRE tab and the airway will then be excluded from escape 
route options.  

Using the measure tool “Escape Routes” you can select any airway and VentSim DESIGN will calculate 
multiple routes to both the surface exits and the closest refuge bays. Clicking on the bar chart will display 
each route in the model, and by using the model transparency setting you can easily make the path 
more visible.   
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 The escape path includes some statistics about time required to walk and climb, it also includes time 

spent in travelling in smoke or contaminant areas, STEL limits and other settings can be changed in the 
model settings.   

  

 

  



 

 

33  ACTIVITY TRACKS 

Activity tracks define pathways along which a combination of heat and diesel fume producing machinery 
will work.  The feature aggregates the combined heat and moisture from the machines in the path, and 
distributes it along the defined pathway in either a linear fashion, or by proportioning it to the available 
airflow. 

33.1. Activity Tracks 

Activity tracks are a convenient way to represent a selection of equipment used in the mine.  Instead of 

placing heat producing equipment in individual locations (spot sources) or spreading a heat load across a 

number of airways (linear sources), an activity track allows the user to build a list of equipment and then 

select the collection of airways the list of machines will be travelling or used along.  Equipment defined in 

Activity Paths is automatically included in Heat Simulations and Diesel Simulations.  

To define an activity track, select 

the Activity Track option in the 

main TOOLS menu, enter a new 

track name, then select the 

airways in the model that will 

define the track. The track airways 

will show how many airways are 

currently in the track. To commit 

any newly selected airways to the 

track, click on the Add Selection 

button.  The track airways 

numbers should then be identical. 

The Clear Track Button will clear all 

airways from the track, while the 

Clear Selection Button will only 

clear the current airways.  

Activity paths are shown 

graphically in Ventsim as a 

vertical ‘ribbon’ that sits above 

the airway.  Multiple activity 

tracks can be defined through the same airway.  Activity paths can be directly EDITED by clicking the EDIT 

toolbar button on the path ribbon. 
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Figure 33-1  The Activity Track Editor 



 

 

 

Figure 33-2 An example of a graphical activity path 

33.2. The Activity 

The activity on the Activity Track is defined by selecting the Heat and Vehicle Types on the track. The 

selection of Heat types is taken from the Heat, Moisture, Diesel presets. The Vehicle presets include 

information on vehicle velocity, as well as some aerodynamic characteristics. A vehicle preset is not 

required for modelling heat, but will be required for some of the advanced features of Activity Tracks, 

such as piston effect, dynamic track modelling and placing delays on activity. 

In the units column, the user can add additional heat sources of the same type. The heat from these 

units will be evenly distributed along the track. 

 

Figure 33-3 An example of a graphical activity path 

33.3. Flow Weighted or Not? 

Users can choose if the list of machinery is distributed in an even linear fashion (per unit length along the 

path), or by using a flow weighted method where higher flow airways along the path receive proportionally 

more of the equipment heat.  The check box in the equipment list determines what method is used for 

each machine.  Any either case, the same total amount of heat and moisture is applied to the model, just 

in different areas. 

In theory, if machinery is constantly and evenly moving in a model, then the non-flow weighted method 

may more accurately portray potential hot spots in the mine ventilation network.  However, if there are 

short sections with no or low flow, the simulation may report these areas get too hot as there is insufficient 

airflow to dilute the heat.  In a real mine, providing the areas are short (such as a truck bay with no flow), 

the heat build-up may not be that significant due to local ventilation eddies and dispersion of heat. 

Therefore, the Flow Weighted option will prevent low flow areas from receiving too much heat, and instead 

distribute the heat from low flow areas into higher flowing areas, preventing a simulation error from 

occurring.  The downside is that low flow areas (particularly if they are extensive or long) may artificially 

receive low amount of equipment activity and therefore fail to highlight an insufficient flow / temperature 

too hot ventilation problem in the heat simulation. 



 

 

33.4. Stages 

Activity paths can be defined to belong to specific stages.  In this case, the activity track will only be 

simulated on the stages that are selected.  If NO stages are selected, the activity path will be applied to 

ALL stages. 

 

33.5. Options 

Several other options exist for the Activity Tracks. Many of them will only have an effect if a vehicle type 

is selected, as their effect is calculated based on the speed of the vehicle and the length of the track.  

Checking this option will hide the entire model from the viewer, except for the 

airways include in current Activity Track. This can be useful to easily check 

what airways are included in the track.  

This allows a number of vehicles to be entered per unit length of airways, 
rather than as individual units. This can be useful in some applications where 
traffic is specified as vehicles per length.  

 
The time entered here will be the amount of time between a vehicle leaving 

the end of a track and returning to the beginning. This can be used to model 
a vehicle intermittingly using a track, or perhaps pausing for a period of time 

at some point of the track.  

Checking this option will make vehicles start from the beginning of the track 
and then return in the opposite direction, rather than automatically returning 
to the beginning. It will effectively double the residence time of a vehicle on 

the track. 

Checking this option will make the Track Editor select a different airway end 

for the start point for the vehicles on the track.  

With this option, Ventsim will simulate a piston effect, an effect where a 
moving vehicle or object in an airway produces its own ventilating pressure, 
thereby affecting the airflow. The piston effect pressure calculation is based 

on the aerodynamic characteristics of the vehicle, the size of the airway and the 
relative velocity between the vehicle and the airflow. 

33.6. Dynamic Activity Tracks 

For the Dynamic Simulation, there are two options for how to model vehicle units on the track. The default 

option is to model them as a distributed effect. With this option, the effect of the vehicle (heat, diesel 

emission, piston effect) is divided and distributed evenly along the track and each airway’s portion applied 

at every time step of the Dynamic Simulations. This effectively mimics the treatment of the track in the 

steady-state Heat, Diesel and Air Simulations. 

The other option is to model the vehicle units discretely. This option will model the vehicle heat, diesel 

emission and piston effect entirely on one airway at each time step of the Dynamic Simulation, updating 

the position of the vehicle each time step, according to the vehicle velocity and defined track. In this way, 

the user can see the variation in heat and diesel emission in time, as the source moves. Note, that to 

obtain well-resolved variations in time of data affected by the dynamic activity track, a lower setting of 

time step (Settings | Dynamic | Dynamic Increment) and a higher setting for airway division (Settings | 

Dynamic | Maximum Subcells) will usually be required. This will improve the temporal resolution of the 

data, but slow down the speed of the Dynamic Simulation.  
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34  VENTLOG INTEGRATION 

34.1.   Connect to Ventlog 

Use the Connect - VentLog menu in VentSim Design to map your Ventlog database with your VentSim 
Design model. 

Allows you to connect to a Ventlog file (*.VLG) or an SQL Server that has 
been configured with a Ventlog format database.  Once connected, the 
database link will be saved with your VentSim Design file. 

Loads the Ventlog station data into the VentSim model.  The Ventlog data 
will be overlayed over the corresponding airways in the model.  The date of 
the data import can be specified in the connect option. 

34.2. Add New Stations 

To create a new Ventlog station directly from VentSim Design, use the Add Station button on the Ventlog 

tab of the Edit menu.   

  

Figure 34-1  The add new Ventlog Station form. 

34.3. Add New Records 

On airways that have been mapped to a Ventlog station, the Add Records button will be enabled. This 

brings up the Ventlog entry form where you can add multiple records at a time and quickly add all your 

saved “Favourite” record types.  Editing the list of Favourites is done within the Ventlog software. 

  

Figure 34-2  Shows the Ventlog menu for an airway that has been mapped to a Station. 
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34.4. View Existing Records 

All historical records for every Ventlog station can now be viewed in either a chart or a table view. 

To do this, go to an airway that has been mapped to a Ventlog Station and use the Chart or Table buttons 

found beside the Add Records button. 

  

Figure 34-3  An example showing a Ventlog data in chart format. 

 

Figure 34-4  An example showing a Ventlog data in table format.  



 

 

34.5. Data Comparison 

Mapped Ventlog data can now be selected as a display option for both colour and text: 

 

Figure 34-5  An example of Ventlog data being displayed as the airway colour. 

There is also a new comparison tool available from the Connect – Ventlog – Compare Data menu. 

 

Figure 34-6  An example of Ventlog Comparison results. 

The Find button will jump to the corresponding Airway in the model. 

34.6. Hide a Station 

If you have Ventlog Stations that are no longer in use and you don’t want to see them in the VentSim 

Design model anymore, use the new Hide Station feature to remove them from future imports. 



 

 

34.7. Moving a Station 

You can also use the Link Existing Station feature to map a station that already exists but could not be 

matched to any airways due to missing or incorrect co-ordinates. 

  

Figure 34-7  The move form.  Select the Station row that you wish to move and choose Link Station. 

You can also use the Link Existing Station to move an already mapped station to a new location.  When 

moving an existing station, you can either leave the previous records assigned to the old airway (this is 

for when you are using a temporary recording station and you don’t want the historical data to be mapped 

to the new location) or you can move all existing records to the new location (if you are fixing a mistake). 

 



 

 

35  DUCT HEAT EXCHANGE 

VentSim DESIGN™ heat simulations now features heat exchange between airways and ventilation ducts. 
Ventilation ducting is often lightweight and thin. In particular mine conditions, where a large temperature 
difference exists between the temperatures of the air inside and outside of the duct, significant heat loss 
can occur through the ducting material  

 

Figure 35-1 An airway-to-duct heat transfer. In this example a heat source in a blind heading is ventilated by an auxiliary ventilation 
duct. Because the duct passes through the heated downstream airflow from the heat source, the temperature of the air in the duct 
increases.   

VentSim DESIGN™ heat simulations now features heat exchange between airways and ventilation ducts. 
Ventilation ducting is often lightweight and thin. In particular mine conditions, where a large temperature 
difference exists between the temperatures of the air inside and outside of the duct, significant heat loss 
can occur through the ducting material. This effect can be observed with a heat source placed in a blind 
heading, ventilated by an auxiliary duct, as in Figure 34.1. In this instance, the behaviour of the ventilation 
duct as a heat exchanger leads to higher temperatures at the blind heading than for the idealized case 

with no heat exchange.  

When creating a new duct, a duct material can be chosen from the Duct Heat Transfer Presets. Choosing 
a Duct Heat Transfer Preset will update the thickness and thermal conductivity of the duct. The heat 
exchange relies on the same connections made for Duct Leakage. Therefore, to enable duct-to-airway heat 
exchange, a duct leakage porosity must be set. To edit or add to the Preset duct materials for duct heat 
transfer, click on the Duct Heat Transfer button. 
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Each duct heat transfer material has four parameters: 

The thickness of the duct material. Increasing the thickness will increase the 

insulating effect of the ventilation duct and reduce the amount of heat 
transfer. 

 
Different materials will conduct heat to different degrees for a given wall 
thickness. This effect is accounted for by the thermal conductivity. Metal will 
generally conduct heat more than plastic. Increasing the thermal 

conductivity of the material will increase the amount of heat transfer. 

 
The insulation thickness is simply an option to add an additional insulating 
layer to an already defined duct material. The default duct heat transfer 
materials are set to zero insulation. Adding an insulation thickness will 

decrease the amount of heat transfer. 

 

A different thermal conductivity can be defined for the insulation layer. The 
default duct heat transfer materials are set to zero insulation thermal 
conductivity. Given a non-zero insulation thickness, increasing the insulation 

thermal conductivity will increase the amount of heat transfer. 

 
On Ventsim models with pre-existing ducts, duct-to-airway heat transfer will 
occur by default on ducts that have a duct leakage defined. However, such 

ducts will have a default thickness of 0.05 m and a default thermal conductivity 
of 0.2 W/mC applied. These values can be changed by modifying the duct 
material through the vent duct builder box. 

The user can also turn off duct-to-airway heat transfer entirely, across the 
whole mine, by selecting “No” to Duct-Airway Heat Transfer, under the Heat 
Settings.  

 

Wall Thickness 

Thermal Conductivity 

Insulation Thickness 

Insulation Thermal 
Conductivity 



 

 

36  WATERWAY HEAT EXCHANGE 

VentSim DESIGN™ heat simulations will also include heat and moisture transfer from exposed 
waterways. In a similar way to how ducts are currently added to mine networks in VentSim DESIGN™, 
users will be able to add running waterways to airways, setting parameters such as water speed, volume 
flow and temperature. 

Fissure water or exposed open channel flows in an underground mine can contribute to the heat and 
moisture in a mine’s ventilating airstream. Fissure water in particular is often emitted at a temperature 
near to the virgin rock temperature, leading to a large difference in air and water temperatures and 
significant heat and moisture entering the airstream.  

 

Figure 36-1 An example of a Ventsim model with an added waterway, with water at ~70 degrees Celsius (in purple). Downstream 
airways to the right show increased temperatures.  

VentSim DESIGN™ heat simulations includes the functionality to add heat and moisture transfer from 

exposed waterways. In the example of figure 35.1, a waterway of water temperature of approximately 70 
degrees Celsius, leads to increased temperature and humidity in the downstream airways.  

The heat and moisture transfer from a waterway to the air will depend on a number of factors: 

• The temperature difference between the water and the air, 
• The surface area of the waterway, 
• The airflow and profile of the airway, 

• The “roughness” of the water surface. A high velocity water flow creates a more rippled water 

surface, which will increase heat transfer. A calm water surface results in less heat transfer. The 
velocity of the water is a function of the volume flow rate and the depth and width of the waterway, 

• The water flow volume will also affect the drop in temperature of the water, as a result of the heat 
lost to the air.  

To add an exposed waterway, select one or more airways and then open the Waterway builder box.  

Building a waterway requires several inputs:  
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The water temperature method determines how the temperature of the water 

is defined. There are three options: 

• Constant Temperature: For this method, a single constant inlet temperature is chosen and applied 
to the entirety of the built waterway. 
 

• Set Start and End Temperature: This method requires an inlet and an outlet temperature. The 
inlet of the waterway will take the supplied inlet temperature. The end of the waterway is found 
and the outlet temperature applied there. In any position between, the temperature is set to an 
interpolated value between the inlet and outlet temperatures, based on the distance from the 
inlet. The variation of temperature between the inlet and outlet is logarithmic.  
 

• Calculated Temperature: Only an inlet temperature is needed for this method. The temperature 

of the water is adjusted for the amount of heat lost to the airway. The temperature drop will 
depend on the heat transfer, as well as the volume flow of water in the waterway. The temperature 
of the water is solved for alongside the temperatures of the airways.  

 

The volume flow of the waterway. This will have two effects on the heat 
transfer. Firstly, it will determine, along with the width and depth, the 
velocity of the water flow, which will be used to estimate the equivalent 

roughness of the water surface. High flow volumes will lead to greater heat and 
moisture transfer. The second effect is on the magnitude of the water 
temperature drop when the Calculated Temperature Method is chosen.  

 
Checking this box will fix all flow volumes of the waterway constructed to the 
value entered. Leaving it unchecked, the waterway builder will attempt to 

change the water flow volume to account for any branching in the waterway. 

 
The width of the waterway. Increasing the width will increase the surface 
area of the waterway and therefore the amount of heat and moisture 

transfer. However, increasing the width, for a given flow volume and depth, 
will also reduce the velocity of the water and lead to a calmer water surface, 
which will inhibit heat transfer. The width will also have an effect on the 
graphical representation of the waterway.  

 

Water Temperature 
Method 

Water Flow Volume 

Fix flow rates 

Average Width 



 

 

The depth of the waterway. Increasing the depth, for a given flow volume 

and width, will reduce the velocity of the water and lead to a calmer water 
surface, which will inhibit heat transfer. The depth will also have an effect on 

the graphical representation of the waterway. 

 

The horizontal offset of the graphical representation of the waterway.  
 
The vertical offset of the graphical representation of the waterway.  
 
The waterway builder will select a water source where it will apply the inlet 
water temperature. It will determine this source using the flow directions of 
the air in the airways that the waterway is built from. If a different water 

source is preferred, for example, in a waterway running in a direction opposite 
to the airflow, then the Reverse Waterway Direction box can be checked.  

Starts the waterway build. The waterway will be placed in a single group to 

allow the system to be selected with a single Select click.  

Modifies existing selected waterways. Note that if you want to construct a 
waterway with multiple branching, but with a single source, it is better to 

build the entire the waterway at once.  
 

Deletes the selected waterways.  
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37  REGULATORS 

Ventsim DESIGN™ allows the definition of regulators with specific shock functions. The Orifice resistance 
option in Ventsim DESIGN™ effectively uses a generalized shock-to-opening relation; with the Regulator 
option, the user can define the shock curve either according to manufacturing specification or to in-situ 
measurements of the regulator performance. 

 

Figure 36-37-1 An example of an airway with a regulator added. The Regulator resistance option has been chosen, with an opening of 
80%. The regulator icon is also visible on the airway  

The Regulator option can be used to represent a regulator or an open door, or any airway blockage scenario 

with an adjustable open area. The data required is the shock loss as a function of regulator opening. There 
is also the option of entering the Atkinson’s resistance instead of the shock loss. 

The Regulator Database can be opened by clicking on the Regulator Link on the airway Edit form. Using 
the database, a regulator can be added or deleted, or an existing regulator edited.  
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Figure 36-37-2 The Regulator Database  

The name of the regulator. Other regulators in the list can be selected here. 
 
The dimensions of the regulator can be entered for either a square regulator, 

with a height and a width, or as a round regulator, with a diameter. 
 
There are various ways to enter the regulator dimensions, but the most 
important geometric aspect for the simulation is the regulator area. The area 
can be entered directly or it can be calculated from the other inputs. 

 

The height of a square regulator, it can be used to calculate the area. 
 
The width of a square regulator, it can be used to calculate the area. 
 
The diameter of a round regulator, it can be used to calculate the area. 
 
The perimeter is provided for information and has no effect on the Ventsim 

Design simulations. 
 
A shock loss that will be applied regardless of the opening setting. This can 
be used to represent the shock loss from any permanent regulator fitting, or 
from other obstructions associated with the regulator. Alternatively, the 

default shock loss can be left at zero, and any additional shock losses 
incorporated into the shock curve. 

Checking this box will change the regulator curve inputs to Atkinson’s 

resistance, rather than shock loss. This can be useful where measurements 
of a regulator’s performance are reported as resistances rather than shock 

losses.  

The reference density of the regulator specifications. Only applicable where 
the data is being entered as a resistance. 

The Regulator curve requires two variables: the regulator opening and the shock loss. If the option is 
selected to enter the data as resistance instead, then the regulator opening and resistance are shown. 
 
There are two inputs affecting the behaviour of the regulator during Ventsim Dynamic Simulations, the 
Opening time and the Closing time. 

Regulator Name 

Square / Round  

Area 

Height   

Width  

Diameter  

Perimeter  

Fitting shock factor 

Enter data as resistance 

Reference density 



 

 

The time taken for the regulator to adjust from a setting of 0% to 100%. 

 
The time taken for the regulator to adjust from a setting of 100% to 0%. 
 

During a Dynamic Simulation, if the opening of a regulator is changed, then the Opening and Closing 

times are used to calculate the time over which the setting changes. This models the actual mechanical 
operation of the regulator, as well as mimicking the time taken for changes in airflow momentum 
resulting from the regulator opening change to take full effect.  

Opening time 

Closing time 



 

 

38 RECOMMEND FAN  

VentSim DESIGN™ 5.2 introduces a new tool “Recommend Fan”. This will allow users to quickly 
download and utilise Fan curves from Fan Manufacturers websites. Currently VentSim 5.2 is working with 
the Howden Fan Selection website, and we hope other manfacturers will also provide similar capability in 
the near future. 

 

Figure 36-38-1 Access Recommend Fan Tool  

  

Figure 36-2 Recommend Fan Tool Dialog  

Enter the required Flow, Pressure and Density, click Submit Web Request. VentSim will then request the 
details of the top ten fans that match the requirements and sort the results by efficiency. After VentSim 

receives a response from the Manufactures website, the user can view more details about the Fan by 
clicking View Manufacturer Info. Or, the fan can be added to the VentSim fan database by clicking Add 
Fan. 
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Figure 36-3 Viewing recommended Fan specification (Manufacturers website)  

 



 

 

39  VENTSIM LICENSE MANAGER 

VentSim DESIGN™ has a flexible licensing scheme that ensures users can use VentSim licenses with the 
maximum flexibility and minimum inconvenience. 

The license scheme and options are defined as part of the license purchase and are typically broken into 

three (3) options.  Please note that all licenses are specifically created bu Chasm Consulting and cannot 
work on different schemes.  For example, a Type 2 license cannot be used by a Type 3 license server – in 
most cases the license if activated will report it “Cannot be found” on the server. 

This option remains locked to a single computer and cannot be moved or 
transferred.  Typically, this option is only used for short term rentals, trials 
and educational or research work. 

This is the most common license and represent a typical VentSim license.  

The license is typically activated by an internet connection or a USB key. The 
license may be transferred between computers and user an unlimited 

amount of times, providing the computers and users and within the company 
and site defined by the license registration name.  By default, licenses are 
manually activated and release by the user to ensure other users cannot take a 
used license and the user and computer can use the license away from the 

internet. 

This type of license can be purchased with multiple user and computer 
options attached to a single license.  For example, a single license could 
allow ten (10) simultaneous computers and users from a single network 

license.  Licenses are automatically activated and released when VentSim is 
started or closed, negating the need for manually activating and releasing 
licenses.  The licenses can be used away from the network or internet by a 

‘borrow’ function that allows a user to transfer a license to his computer for up 
to one (1) month at a time.  Multi License options can be activated from either 
the internet VentSim License Server, or from a Client Network Computer with 
installed Chasm License Server software. 

 

39.1. Internet License Server 

Chasm Consulting provides an internet accessible license server for software license activation.  This 
option is available under the INTERNET SERVER tab in the license manager.  Type 1, 2 and 3 licenses 
can use this option if specified in the license parameters by Chasm Consulting. 

To use an internet activated license, ALL details in the form must be entered, including Company, Site, 

License Code, License Number and a contact email.  The contact email can be any email address 
providing it is a valid format, and is only used for contacting the user in the event of a license issue or 
product information. 

 

 

Chapter 

39 

Single Computer options.   

Multi Computer / Multi 
User option.   

Multi License Server 
Options.   



 

 

 

Figure 39-1  Internet Server License Activation and Release 

 

If the VentSim DESIGN™ license is defined by Chasm Consulting as a ‘single’ 
or ‘floating’ license, it can only be used on one computer at a time.  They can 
be activated for use on one computer and then if required released and used 

on another computer (within the terms of the license agreement).  License 
certificates are stored on the VentSim server and prevent simultaneous 
installation of the same license on more than one computer.   

If the license is defined as a ‘multi’ license, the license will allow a defined 

number of simultaneous activations and will attempt to automatically activate 
and release the license when VentSim is loaded and closed.  If the license is 
required to used away from the internet, the ‘BORROW’ button can be clicked to 
loan the license for a specified period of time before it is returned to the 
network. 

As part of the digital licensing agreement, the license manager collects the 

computer name and user name of the computer that VentSim DESIGN™ is 
currently activated on.  This system protects against unauthorised use of the 
VentSim DESIGN™ license and informs other users from licensed company who 
currently has the activated software license. 

 

Once a license is activated on a computer, it cannot be moved to another 
computer unless it is first released from the activated computer.  If another 

computer tries to activate the same license simultaneously, this will be 
prevented and a warning will display the currently licensed computer and the 
login user name of the person who has installed it.  

An internet connection is required to activate and release license certificates 
from a computer.  If an internet connection is not available or an internet 
connection is not authorised by your firewall or company administrator, try to 
arrange a link to the http:\\ventsim.com website.   

If a license cannot be released (for example another user has activated it, and 
the user or computer is no longer available), an emergency manual license 
transfer can be performed via the REQUEST LICENSE link located under the file 
menu, provided the license has current maintenance. This should only be done 

Activating Internet 
Licenses 

Releasing a License 

Registration information must 
be entered EXACTLY as shown 
on license details 

The site license issued number.  
Each license number has a 
unique license code 

License details found on the 
computer.  If no details are 
present, then the license is not 

activated and will run in 
VIEWER mode 

Status display panel for sites 
with multiple licenses.  Licenses 
can be automatically selected 

(double clicked) and activated 

from this list. 

http://ventsim.com/


 

 

as a last resort as only a limited number of these transfer may be available, and 

the transferred license will forcibly disable VentSim on the other computer.   If 
this does not work, please contact Chasm Consulting at ventsim@howden.com 

In the event a license needs to be erased from a computer permanently, the 
FILE > RESET license menu option can be used.  Some types of licenses (for 

example Educational licenses) cannot be released.  In this case the RESET 
option will be required to clear the license before another can be entered. 

In the event the license manager fails to activate or release the license, note 
the error message and take the following action.  In some cases, company 
internet policy or firewalls will prevent VentSim from contacting the license 

server. 

If the error message reports an internet connection problem, then click the 

“TEST www.ventsim.com web connection” link on the License Manager form.  
Ensure that Microsoft Internet Explorer can link to the VentSim webpage.  If this 

does not work, then the Windows connectivity problem needs to be resolved 
before further action can be taken in VentSim.  Ensure an internet connection is 
available, and the firewall or proxy server is not blocking the VentSim website. 

Some companies have PROXY settings that inhibit third party programs using 

the internet.  In most cases, VentSim DESIGN™ will automatically adopt the 
same proxy settings as Microsoft Internet Explorer.  If these settings are not 
available from the local computer, they can be entered into VentSim using the 
Proxy Settings section. To activate the PROXY settings, simply enter a PROXY 
name or IP address, and a PORT number in the EDIT menu of the License 
Manager.  Alternatively, the company may enter VentSim as a proxy exception 
for internet connection, or allow a direct connection to the VentSim license 

website www.ventsim.com  

If license connections continue to be a problem, and company internet or 
firewalls cannot be adjusted, then a USB license or a Local Network License may 

be an option. 

If the license is a DEMO or a STUDENT / EDUCATION license, and needs to be 
removed from the computer, click on the FILE > RESET LICENSE menu option in 
the license manager. 

39.2. Local Server License Activation 

Chasm Consulting offers the option for a company to use their own license server to allow VentSim to be 

activated and release across their internal network.  This option requires special Chasm License Server 
software to be installed on one of the network servers or computers, which then acts as a license host 
for all connected users.  Network License Servers are typically used where internet access is restricted or 
unreliably for VentSim Client computers or where fast and automatic access to multiple license is 
required across a computer networked site.  

Please contact Chasm Consulting at admin@chasm.com.au if you require the software and instructions 
for this option. 

 

Clearing a License 

Licensing Problems 

mailto:ventsim@howden.com
http://www.ventsim.com/
http://www.ventsim.com/
mailto:admin@chasm.com.au


 

 

  

Figure 39-2  Multi License Server Option to Local Network Server (10 License Server) 

A local network server is installed on a computer or server on the site 
network and is activated by an internet license.  This computer will 
automatically issue a specified number available licenses to computers 

connected to the network.  Client computers do not need an internet 

connection, only a local connection to this server.  Locally server software and 
licenses must be specially installed.  A local server cannot connect to a normal 
internet license – if an attempt is made, an error will report “License Not 

Found”.  Contact Chasm Consulting for more details on local server licenses.  

To connect to a Local Server, typically only the Server name or IP address and 
PORT number (default 1314) are required.  If a site has multiple different types 
of Chasm Consulting licenses (for example a VENTSIM and PUMPSIM license), 

the Site License Number may also be required. 

 

Local Server Instruction 
(Client Instructions 
Only) 



 

 

40 TUTORIAL - MODEL EXAMPLES 

Several model examples are included with the VentSim program.  The first example below describes the 
method used in creating the model file EXAMPLE1.VSM 

40.1. Example 1 

An underground mine is to be designed from near the base of an open pit that is 100m deep.  A decline 
will extend down some 140m below the pit floor, travelling adjacent to a sub vertical orebody.  Three 
drilling / production sub levels will branch off the main decline every 40 vertical metres, starting at 60m 

below the pit floor.   Main production will be from the bottom two levels.  A ventilation shaft some 400m 
away (outside the pit boundary) extends from the mine base to the surface, connecting all sub levels.  
An exhaust fan on the shaft will need to pull 150m3/s to supply the mines production needs.  Fresh air is 
supplied to the mine via the main decline. 

1. Conceptually design a mine ventilation model incorporating the three simple sub levels.  Ensure air is 
supplied equally to each level. 

2. Due to power restrictions, main exhaust fan power must not exceed 300kW.  What diameter shaft 

should be mined? 

3. Emergency plans require stench gas to be delivered from the decline portal to all parts of the mine.  

What is the maximum time for the stench gas to be delivered to all areas of the mine? 

 

Suggested Steps 

4. Select the toolbar ADD function , and set the view to Plan. 

5. Establish an initial working elevation by using the Set Edit Centre function under the View menu. 

 

Figure 40-1  Set the starting edit location 
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Figure 40-2  Enter the starting elevation of the drawing (edit) plane 

6. Draw a decline loop, using the Construct Ramp function in VentSim 

7.  

 

Figure 40-3  Construct an initial ramp decline 



 

 

8. From the ramp base, use the ADD button (looks like a pencil) to draw horizontal airways across to a 

‘shaft’ location.  Add some additional detail  if you like. 

 

Figure 40-4 : Draw horizontal airways from the ramp base 

9. To create a shaft, the easiest way is to CLICK the end of the airway while in the drawing ADD mode.   

This will allow the coordinate or offset of the shaft to be entered.  For example, to create a 200m high 
shaft, simply enter ‘200’ as the Z offset.  

 

Figure 40-5  Construct a shaft to the surface 

10. To create additional sublevels, simply draw new airways across from the ramp to the shaft. 



 

 

 

Figure 40-6  Draw multiple levels for the mine 

11. Edit the shaft airways and set them to a required size.  Label the airway, and set the airflow as a fixed 

airflow to the desired amount of 150m3/s.  Ensure the airway has the ‘Surface Connection’ checked.  
Click on the top decline ramp airway, and also ensure the ‘Surface Connection’ is checked.  Click on 
Air Simulation to ensure everything works correctly. 

      

Figure 40-7  Edit the airway to set the airway size and add a fixed flow 



 

 

12. Click on the sublevel entries to the exhaust shaft.  Use the RESTRICT ONLY function to set the 1st and 

2nd sublevel airflows to 50m3/s.  The lower sublevel will automatically simulate to 50m3/s to balance 
the 150m3/s total airflow into the shaft.  Clicking on the Edit Box info will show the required resistance 
to produce this airflow. 

13. If you need to estimate a regulator size from the fixed flow restriction, click the ‘?’ next to the RESTRICT 

ONLY function to recommend a size.  Accepting this size will replace the fixed flow with an orifice 
regulator.  This is normally not recommend until the design process is finished as flow will continue to 
change. 

 

Figure 40-8  Converting a Fixed Flow to an Orifice 

14. Adjust the shaft diameter until the required power 
constraints are met.  Ensure you simulate the 
model between each adjustment.  In this case, a 
shaft size of 2.5m was found to produce the 
desired result.  The required duty point is 921Pa 

Collar Total Fan pressure, 150m3/s with a fan 
motor size of 273kW and an electrical power 
consumption of 287kW. 

 

Figure 40-9  Use the Edit – Info to view airway flow, pressure and 
power 

 

 

 

 



 

 

15. To perform a stench gas simulation, place a contaminant in the upper decline with the Edit Box.  Set 

the contaminant to a strength of 100, and run the contaminant simulation.  The colour display will 
initially show a strength of 100 is spread all through the mine, which is to be expected as the decline 
is the only source of fresh air.  Change the Display Manager to show ‘Spread Time’.  The lower corner 
will show spread times of up to 600 seconds or around 10 minutes. 

  

Figure 40-10  Colouring showing contamination spread time in seconds 

If you got this far, congratulations!   

The complete example is available from the VentSim DESIGN™ installation folder under Examples. 



 

 

40.2. Example 2 

A skeleton model has been created in a mine planning package by tracing over the existing and planned 
development and exporting the file as a DXF format file.  Import this file into VentSim and adjust it to 
create a workable model.  Note that the decline is 5.5m x 5.5m, the sub level drives are 4.0m x 5.0m 
and the ventilation shafts are 2.4m diameter. 

1. Create an RL (reduced level) elevation database that separates the mine into each sub-level.  Create 
a RL that also displays the entire mine. 

2. Create three PRIMARY Layers, and set the DECLINE, SUB-LEVEL and SHAFT airways to these Layers. 

3. Divide the mine into fresh & exhaust air with the DECLINE carrying fresh air, and the SHAFT and the 
upper sub level carrying exhaust. 

4. Create some saved views showing the; 

• whole mine with exhaust and fresh air showing. 
• decline by itself. 
• two upper sub-levels and corresponding shafts. 

Suggested Steps 
 

5. Initially set the default airway sizes (in the Settings>General>Airway Defaults menu) to 4.0 x 5.0m.  

This will set all imported DXF airways to these defaults sizes, and therefore the majority of airways will 
not need to be adjusted after importing. 

6. File > IMPORT the DXF file into VentSim, converting the dxf centrelines directly to airways (import 
option).  Another method is to import the lines as a reference only, and then selectively choose or 
fence which lines to convert using the Airway > Convert Centreline toolbar button option (next to the 
ADD button) 

 

Figure 40-11  Initial imported DXF strings in VentSim™ 

7. Create an RL database with the RL MIN & MAX covering each sub-level range. Use the TOOLS > 

LEVELS menu option for this. 



 

 

 

Figure 40-12  The Level Elevation database 

8. Create the new Primary layer names by utilising the Preset Value forms (under the Settings Menu) OR 
by directly using the Display Manager and right clicking the layer.   

      

Figure 40-13  Set airway layer names 

9. Use the group edit function to select the decline airways 

10. Use the select toolbar button to select all decline airways 

11. Use the edit toolbar button to edit all selected airways. 

12. Change the primary layer name to Main Decline 

13. Change the air type to Fresh 

14. Change the airway dimensions to 5.5m x 5.5m 

15. Apply the changes to the selected airways 



 

 

 

Figure 40-14  Initial selection of all decline airways 

 

Figure 40-15  Select and edit the decline airways 

16. Repeat the above actions to set the other airways parameters for shafts and sub-levels. 

17. Finally, add fans, ventilation controls and stoppings to direct airflow through the model. 



 

 

 

Figure 40-16  Fresh and Exhaust Air Type colouring 

18. To limit the view to the decline or shafts only using the layer control in the display selection to control 
which layers are displayed. 

 



 

 

 

Figure 40-17  The final DXF import result showing the  
decline and the exhaust shafts displayed independently with layers. 

40.3. Example 3 – Import a Complex Mine Design 

A centreline model of an entire existing mine has been 
created in a mine planning package and exported to VentSim.  
Import this file into VentSim and adjust it to create a workable 
model. 

Import the DXF model into VentSim.  Do not convert the 
centrelines to airways at this stage.  The imported model will 
show as a collection of line strings. 

Select the Tool button DRAW > CONVERT 
CENTRELINES.  Draw a fence around the centreline strings (in 
this case all the strings) to convert to standard size airways. 

 

 



 

 

                    

Figure 40-18  Resulting conversion with colour levels reset 

Many airways will have complex curves or may not connect properly.  To tidy up the import we need to 
“Simplify and Bind” the new airways.  Use the TOOLS > FILTER function to activate this option. 

Click on SIMPLIFY.  This will remove 

unnecessary detail, allowing for a simplified and easier 
to work model. 

Click on BIND, increasing the bind search distance 
to 8m to ensure broken airways are joined together.  

Press the BIND button several times to ensure all 
optimisation have been found. 

 

 

 

 

 

Establish the surface connections.  VentSim needs to know which airways connect to the surface; 
otherwise the program will consider them as dead ends where no air can flow. 

 



 

 

 

Establish airflow by placing a FIXED FLOW on one of the major surface connections.  At this stage we are 

not trying to simulate an actual fan installation, but just trying to establish that air can travel through all 
airways in the model. 

 

Press SIMULATE.  Many warnings will show indicating airway dead 
ends which are not closed off or connected to other airways.  Ensure 

that airflows are travelling through parts of the mine where is should 

travel.  Use the flow animation and/or airflow colouring to indicate 
good and bad flow areas.  If areas are not flowing air and that should 
be flowing air, check for any breaks in airways through the region and 
SIMULATE again after any changes. 

 

Once airflow is correctly established (at this stage we are not 

interested 
in 
establishing accurate airflows, just making sure air has an 
open connected pathway to follow), then  SELECT all of the 
airways which are still showing NO EXIT / ENTRY warnings, 
EDIT the airways and select CLOSE ENDS in the Edit Box.  

 

SIMULATE again.  No errors or warnings should show.  If they do, repeat the search for airway error and 
simulate again. 

 

The model is now ready to be correctly sized, with all fans and ventilation controls established.  Select 
and change the airways and set them to the correct size.  Insert fans and control in proper positions.  If 
desired, use LAYERS and text names to help improve accessibility to your model. 

 

Figure 40-19  Airways coloured by airflow 



 

 

 

 

 

 

 

 

 

41 APPENDIX A – GLOSSARY OF TERMS 

41.1. A glossary of commonly used terms 

Airway 
An section of underground tunnel defined by two end points. 

Branch 
An airway; a tunnel or shaft that carries airflow. 

TXT  
TAB Separated Value file - a text file format used by VentSim when saving uncompressed files.  This 
format can also be read into Spreadsheets, Word Processors and databases. 

DXF  
Drawing Exchange Format - An AutoCAD graphics file format that can be imported and exported by most 
CAD and Mining Software packages.  VentSim can also import or export data in this format. 

Endpoint / Start point  
The start or end of an airway, defined by an x, y and z coordinate, which gives its position in space in 

three dimensions. 

Friction cost  
Similar to friction power, with the kilowatt value converted to a dollar cost per annum, based on the 
default power cost. 

Friction factor or k factor  
Atkinson’s friction factor, describing the roughness or unevenness of a wall.  It directly affects the 
resistance of an airway. Friction factors are measured to a specific air density, normally normalised to 
1.2.kg/m3 

Friction loss  
A component of pressure drop along an airway caused by the airway resistance. 

Friction power  
Derived from the friction loss, this estimates (in kilowatts), the amount of energy lost due to the 
resistance of an airway on the airflow. 

Hardy- Cross Sequential Solver 
The simulation method used by VentSim DESIGN™ to perform the calculation of airflows in a model.  It 
uses an iterative estimation method that adjusts the airflows through a model until the estimation errors 
lie within acceptable limits. VentSim DESIGN™ Advanced uses a modified method which takes into 
account density changes and mass flow balances. 

Matrix Solver 
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A new solver option is available for VentSim DESIGN™, the Matrix Solver. It works as the default 

alternative to the existing Hardy-Cross Sequential solver. The Matrix Solver is based on a hybrid node-
loop approach to the flow continuity and pressure equations, often referred to as the “Gradient Method”. 
It has several advantages over the Hardy-Cross Sequential method, the most important of which are 
greater numerical robustness and faster-solving times, in particular for very large models and when 

solving the model without initialization from a previous solution. 

Junction  
A point defining where two or more airway ends share the same position.  Airflow at this point can split 
or join, depending on airflow direction. 

Load (Pressure)  
Estimation of how much load or weight an airway pressure loss would develop across a resistance.  It is 
often used for determining load on a vent door or bulkhead and is calculated by the pressure loss times 
by the drive or resistance area. 

Network 
An interconnect series of airways that together form the model of an airflow design. 

Node  
A point defining the end or junction of an airway(s) 

Pan  
The action of sliding the model graphics to a new screen position by using the right mouse button. 

Pressure loss 
The loss of air pressure along a length of airway due to friction loss, fans, fixed pressures or fixed 
quantities etc. 

Resistance  
A value describing the difficulty air will have moving down an airway.  It is derived from a combination of 
airway size, friction factor, length, shock losses and air density. 

Shock loss  
A factor that estimates the effect a change in drive direction or size has on airflow.  Any such change will 
increase turbulence in an airflow, and hence develop energy losses that can be equated to an increase in 
airway resistance.  VentSim DESIGN™ uses shock loss as an extra length added on to the original drive 

length (i.e. the higher the shock loss, the greater the equivalent length), which in turn increases the 
overall airway resistance. 

Thermal Diffusivity 
Thermal diffusivity is the ratio of thermal conductivity to volumetric heat capacity.  Substances with high 
thermal diffusivity rapidly adjust their temperature to that of their surroundings, because they conduct 
heat quickly in comparison to their volumetric heat capacity or 'thermal bulk' 

Thermal Conductivity 
Thermal conductivity, k, is the property of a material that indicates its ability to conduct heat. It appears 
primarily in Fourier's Law for heat conduction. 

Wetness Fraction 
The ratio of area of wet airway surface to dry airway surface.  A fully wet surface is defined as ‘1.0’ while 
a fully dry surface is defined as ‘0.0’ 

Relative Humidity 
Relative humidity describes the amount of water vapour that exists in a gaseous mixture of air and 
water.  It is defined as the ratio of the partial pressure of water vapour in the mixture to the saturated 

vapour pressure of water at a prescribed temperature. Relative humidity is normally expressed as a 
percentage 

Density 



 

 

The density of a material is defined as its mass per unit volume. The density of air influence many 

psychrometric properties.  Te density of rock influences heat transfer and thermal capacity behaviour. 

 

  



 

 

 

 

 

 

 

 

42 APPENDIX B – SUMMARY OF DATA TYPES 

42.1. Summary of the major data types  

Available from the data selection menus in the menu bar.  Note that additional data and data subsets 
are available in the spreadsheet view. 

Air types 
 

The type of category of air in the model.  Originally designed for specifying 

fresh, exhaust and undetermined air within a model, VentSim DESIGN™ 
allows custom catagories for air types, set from within the Edit menu.  When 

specified in the Display Manager, airtype will show different colours for different 
air types. 

Airflow 
 

The volume flow rate of air through an airway 

The average speed of airflow through an airway across the cross sectional 
area 

The average (wet) air density along an airway.  For vertical shafts, this is the 
air density mid way along the shaft. 

The (dry) mass flow of air through an airway.  This is a function of volume 
flow and air density.  Note that this will not necessarily be equal to the 
quantity x wet density value, because the mass flow does not consider the 

moisture component that is included in the density value. 

 

Pressure 
 

The increase in pressure provide to a model system by an external source, 
such as a fan or fixed flow. 

The fan static pressure equivalent of the pressure boost. 

The pressure or force against an airway resistance converted to an 
equivalent ‘weight’ 

Airtype 

Quantity 

 Velocity 

Density  

Mass Flow 

Pressure Boost 

Pressure BoostStatic 

Pressure Regulator 
Load 

Pressure TotalLoss  
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The total pressure loss along and airway between entry and exit.  Pressure loss may consist of airway 

friction pressure losses, due to wall friction factors and additional resistances placed in the airway 

The relative pressure differential between underground airway and the 
surface, standardised to the surface elevation.  A relative pressure 
differential of zero, would result in no flow from a connecting airway to the 

surface.  A negative relative pressure would see air flow from the surface to the 
underground airway if a path was present.  A positve relative pressure would 
see air flow from underground to the surface if a path was present. 

The pressure reported in atmospheric units of an underground airway, 
corrected to surface elevation.  The correction removes the effect of 
elevation on pressure, and permits a relative assessment between airways at 

different elevations. 

The true pressure reported in total atmospheric units including the elevation 
effects on total pressure.  Barometric pressure increases with depth, where 

no other pressure influences are present. 

The loss of pressure along an airway due to wall friction.  This ignores any 
other resistances in the airway such as doors or stoppings. 

Compares density differences of a column of mine air with an equivalent 

column of atmospheric air and applies a pressure differential.  Every airway 
with a different entry and exit elevation has potential to have some natural 

ventilation.  VentSim DESIGN™ uses a +(ve) number convention to describe 
upwards (buoyant) natural ventilation and –(ve) to show downward (sinking) 
natural ventilation.   

Note that by default, atmospheric density is adjusted for temperature gradient (lapse) rate, in much the same way as auto 
compression can drive changes in underground temperature at different elevations.  Inlet airways at different elevations will have 
different temperatures which are derived from the standard elevation and default surface temperature.  This function can be turned 
off (surface temperature adjust) in the settings if desired. 

Airway Attributes 
 

Total airway resistance along an airway.  The resistance is standardised to 
the surface density, and includes any additional resistance added by the user 
such as doors and stoppings. 

Resistance due to airway wall friction along an airway.  It does not include 

any additional resistances added. 

The shock value reported as either a shock factor (X) or an equivalent airway 
length.  Both factor types add additional resistance to an airway, and 
increase pressure loss due to air turbulence caused by a bend, change of 

size or other obstruction.  The shock length type can be set in the setting menu. 

Atkinsons friction factor describing the uneveness of an airway wall, resulting 

in near surface turnulence and increase airway resistance.  Friction factors 

are standardised to the surface density. 

The size of an airway width and height as the centre section. 

The perimeter of an airway, calculated from the centre height and width, 
taking into account the airway shape profile.  The perimeter can also be set 
directly from the edit menu. 

The area of an airway, calculated from the centre height and width, taking 

into account the airway shape profile.  The area can also be set directly from 
the edit menu. 

Pressure Relative 

Pressure Absolute 

Pressure Barometric 

Pressure FrictionLoss 

Natural Ventilation 

Resistance  

Resistance Wall  

Shock 

 Friction Factor kfactor 

Dimensions  

Perimeter 

Area 



 

 

The true length of an airway, used to calculate airway resistance and heat 

transfer.  It does not include additional shock lengths if specified. 

Report the coordinates of an airway in eastings, northing and elevation. 

 

Energy, Power Cost 
 

 

The friction loss along an airway converted to an equivalent theoretical work 
load.  This value does not include power efficiencies which would result if the 
pressure loss was to be overcome electrically. 

The friction loss along an airway converted to an equivalent theoritical work 

load per unit length.  Because the loss is standardised to a unit length, this 
value is independent of the actual length of the airway. 

The electrical input power into a model to generate pressure and airflow.  

The power input includes efficiency losses due to fan blade efficiency but 
does not include motor efficiency losses. 

The theoretical cost of the power loss due to friction converted to an annual 
electrical cost, based on the power cost set in the Settings. 

The theoretical cost of the power loss per unit length due to friction 
converted to an annual electrical cost, based on the power cost set in the 

Settings.  Because the loss is standardised to a unit length, this value is 
independent of the actual length of the airway. 

The electrical input power by a fan or theorectical fix flow into a model to 

generate pressure and airflow.  The electical input includes both fan or fix 
efficiency factors and an electrical motor efficiency factors specified in the 

Settings. 

Thermo -dynamics 
 

 

Psycrometric properties of air decribing the temperature a volume of air 
would have if cooled adiabatically to saturation at constant pressure by 
evaporation of water into it. 

Psycrometric property of air describing the temperature of air measured by a 
thermometer freely exposed to the air but shielded from radiation and 
moisture. 

An older index of heat stress still commonly used.  VentSim DESIGN™ uses 

Basic Effective Temperature.  Wet or Dry bulb temperatures below 20 
degrees celcius or above 36 degrees celcius should be treated with caution 

as the Effective Temperatures are not normally calculated beyond these limits, 
and VentSim only provides a correlated estimate.  The Effective Temperature is 
defined as the temperature of still saturated aur which would give the same 
thermal feel as the actual environment being consdered.  The Air Cooling Power 
methods described below are generally considered to provide a better index of 

cooling. 

Length 

Coordinates  

Power Loss 

Power Loss/L 

Power Input 

Head Cost 

Head Cost/L 

Fan/Fix Cost 

Wet bulb 

Dry bulb 

Effective Temperature 



 

 

The dew point is the temperature to which a given parcel of air must be 

cooled, at constant barometric pressure, for water vapour to condense into 
water. 

cooling power of mine air determines the capacity of the ambient 
atmosphere to dissipate the metabolic heat generated by humans. The 

cooling power is measured in W/m2 (amount of heat removes from the 
human body per second per unit surface area) to keep skin temperature (ACPM 
method) or body core temperature (TWL method) below safe limits.  It is 
dependent mainly on the wet bulb temperature and the air velocity. 

TWL Method.  Developed in Australia and based on body core temperature limits, the Thermal Work 
Limit method has been developed from a physiological basis and ratified by the Australian Institute of 
Occupational Hygienists (AIOH).  It has been adopted by many Australian mines, and uses standard 

clothing and sweat factors.  The method ideally requires globe temperatures for accurate resutls.  As 
these are not available from a simulation, the TWL may be underestimated for workers around radient 
heat sources such as machinery or hot rock. 

ACPM Method.  Developed in the USA, the Ar Cooling Power (M scale) method is based around limiting 
skin temperature factors as an indicator to body core temperature.  The method is in use in most North 
American mines.  Results are highly dependent on clothing and work output factors.  VentSim DESIGN™ 

defaults to standard light clothing.  Again the method ideally requires globe temperatures for accurate 
resutls.  As these are not available from a simulation, the ACPM may be underestimated for workers 
around radient heat sources such as machinery or hot rock. 

Kata Method.  Developed in South Africa, the Kata cooling method uses the wet bulb and air velocity to 
develop a heat stress index representing cooling ability of the air. 

The sum of sensible heat and latent heat in a substance above a base 
temperature, typically zero (0) degree Celcius or 32 degrees Fahrenheit.  

Sigma Heat is independent of dry bulb temperature, relying only on wet bulb 
temperature and pressure to derive it value. 

Similar to Sigma heat, it is the sum of the total heat content of a unit weight 
of air (including the water vapour) at typically zero (0) degree Celcius or 32 
degrees Fahrenheit.  Unlike Sigma Heat, it does not however take into 

account the adiabatic saturation process, and is therefore not as useful 
pscrometrically. 

The sum product of air ‘mass’ flow and Sigma Heat along an airway.  The 
value is useful to determine the amount of heat an airflow has gathered or 
lost along an airway. 

Relative humidity describes the amount of water vapour that exists in a 
gaseous mixture of air and water.  It is defined as the ratio of the partial 
pressure of water vapour in the mixture to the saturated vapour pressure of 

water at a prescribed temperature. Relative humidity is normally expressed as a 
percentage 

The unit mass of moisture per unit mass of dry air 

The volume flow rate of moisture condensed from an airflow (normally due 
to refrigeration or pressure drop up a shaft) 

Sensible plus Latent heat from all airway heat sources per unit length 

Sensible heat from all airway heat sources per unit length 

Latent heat from all airway heat sources per unit length 

Dew point 

Cooling Power 

Sigma Heat 

Enthalpy 

Energy Flow 

Relative Humidity 

Moisture Content 

Condensate 

Heat Added/L 

Sensible Heat/L 

Latent Heat/L 



 

 

Sensible heat from all airway heat sources 

Latent heat from all airway heat sources 

Heat added or removed by the user, excluding strata heat input. 

 

Descriptors 

 

The internal array number of an airway, reference by VentSim™.  VentSim 
DESIGN™ will report this number during error description.  The airway 
number may change as airways are added or removed from the model. 

The name of an airway branch.  The name can be entered in the airway EDIT 
box.  The name does not affect simulation but may assist the user in 
identifying or finding airways. 

The name of an airway junction.  The name can be entered in the airway 

EDIT box 

A unique number assigned to every airway, that does not change when 
airways are added or removed.  As a result, the numbers may not be 
sequential and may have large gaps in the sequence. 

The descriptive name of the shock loss on the airway 

The descriptive name of the airway type set in the EDIT box. 

The descriptive name of the profile if set. 

The descriptive name of the friction factor. 

The layer nane and number of an airway primary layer 

The layer nane and number of an airway secondary layer 

 

Contaminants 
 

Contaminant simulated concentrations through a model.  The value is unit 
independent and is normally relative in concentration to the original set 
values. 

The time in seconds that contaminant takes to appear in airways 
downstream from the source.  The time is calculate by an average cross-
sectional speed along all airways.  It does not take into account the changing 

velocity profile, or incomplete mixing at junctions.  As a result, it is likely in most 
cases, that a smaller portion of the contaminant will arrive at an airway location 
ahead of the predicted time. 

Sensible Heat 

Latent Heat 

External Heat 

Airway Number 

Airway Name 

Node Name 

Unique ID Number 

Shock Name 

Airway Type 

Profile 

Friction Factor 

Primary Name 

Secondary Name 

Spread Mix 

Spread Time 



 

 

The portion of a contamination that has tranvelled along upstream airways 

to the location of the set contaminant.  The value is a ratio of the airflow that 
contributes to the total volume of air flowing through the contaminant source 

airway. 

The category of air simulated in the sourcing tools simulator.  The sourcing 

tool simulates fresh air, contaminated air, and potential source of 
contaminated air. 

Weight per unit volume of diesel particulate matter in a volume of air. 

The portion of air that has recirculated through the airway 

The maximum portion of air that has recirculated through any single airway 
upstream from the airway.  This may assist in determining the quality of air 
travelling through an airway if it has undergone recirculation at some point 

upstream from the airway. 

 

Rock Properties 
 

Thermal conductivity of rock in the airway. 

Density of rock in the airway. 

The specific heat of rock in the airway 

The fraction of wet to dry surface of the rock in the airway. A fraction of one 

(1) represent fully wet, while zero is dry. 

The age of the rock since exposed by mining in either decimal years (eg 

2005.5 = end June 2005) or by a fixed relative age (eg 4.5 = 4.5 years or 4 
years and 6 months) 

The thermal diffusivity of rock within an airway. 

The virgin rock temperature; the rock temperature before the airway 
excavation and airflow may have cooled the surrounding rock mass. 

 

Measured 
Unused at this time in VentSim DESIGN™ version 3.0 

 

Gas 
The gas contamination levels of a wide range if gases.  During simulation, VentSim volumetrically 
balances non-fixed gases to ensure 100% total volumetric concentration. 

Note that RADON gas at this time is NOT simulated for radon daughter decay. 

 

  

Source Mix 

Sourcing Tool 

Diesel Particulate Matter 

Recirculation 

Recirculation Stream 

Conductivity 

Density 

Specifc Heat 

Wetness Fraction 

Age 

Thermal Diffusivity 

VRT 



 

 

 

 

 

 

 

 

43 APPENDIX C – ICON PICTURE GUIDE 

43.1. Airway Icons 

A number of icons are used in VentSim DESIGN™ to represent various airway attributes.  The icons are 
displayed on top of the airway solid or wireframe, and indicate the presence of a specific item.  Multiple 

attributes in an airway represented by icons are shown side by side.   

Icons can be turned off or on from the Display Manager or from the right mouse button context menu. 

Icons can be MOVED along airways by selecting the MOVE function from the toolbar and dragging the 
icons along the airway with the left mouse button. 

Icons can be COPIED to other airways by selecting the COPY button function from the toolbar and 
dragging the icon to a new airway. 

43.2. Customized Icons. 

Fan, resistance and heat icons can be customized in VentSim.  Providing the icon is established with a 
PRESET name (for example a resistance could be labeled in the preset list as a ‘steel door’), a picture file 

can be dragged on to the icon externally from a Windows file windows or manager.  The picture file can 

be formatted as a jpg, png or gif file.  In addition, the GIF format also supports animated pictures which 
will be displayed as an animated icon in VentSim 

 

Figure 43-1 Customised Truck Picture 
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Fans   

 

Fan icons are used to represent the presence of a fan.  Fans can be shown in four different colours. 

Green – normal operating fan 
Blue – fan turned off and not operating 

Yellow – fan operating in reverse 
Red – fan stalled and air being forced backwards through fan 

Blocked Airway   

 

Blocked icons indicate an airway blockage or very high resistance has been placed and air cannot travel 

freely through the airway.  Blocked resistance values are set in the preset menu.  If blocked resistance 
values are above the maximum resistance specified in the Settings, then absolutely no airflow will be 
permitted along the airway. 

Airway Resistance 

 

Indicates the presence of an airway resistance, above the normal airway resistance calculated from the 
size, shape and wall friction factors.  An airway resistance normally represents an inputted resistance 
feature from the Edit Form, which may be a door, stopping or some other airway restriction. 

Yellow – normal operating resistance setting with a preset value 
Green – a custom resistance value entered specifically for that airway 
Red – a preset resistance operating on a reversal resistance value, which has been activated by a 
reversing airflow and a ‘restrict reversal’ option specified for the airway in the EDIT form.  

Fixed Airway  

Animated 

Fixed airflow placed in airway. 

Green – once simulated, green indicates the fixed airflow is acting as a positive pressure, i.e. it is 
contributing towards overall pressure in the mine model 

Red – once simulated, red indicates the fixed airflow is retarding normal airflow, and reducing pressure – 
i.e. it is acting as a resistance and contributing to overall pressure loss in the model.  



 

 

Fixed Pressure  

Animated 

Fixed pressure source placed in the airway. 

Green –green indicates the fixed pressure is acting as a positive pressure, i.e. it is contributing towards 
overall pressure and flow in the mine model 

Red – red indicates the fixed pressure is negative and retarding normal airflow – i.e. it is acting as a 
resistance and contributing to overall pressure loss in the model. 

Contaminant Report  

 

Indicates a contaminant report has been placed within the airway.  A Contaminant Find simulation will 
use this report to indicate pathways of contaminants and potential sources of the contaminant. 

Fresh Air Report  

 

Indicates a fresh air report has been placed within the airway.  A Contaminant Find simulation will use 
this report to indicate pathways of fresh air through the mine. 

Contaminant  

 Animated 

Indicates the presence of a contaminant in the airway.  A contaminant simulation will predict the path 
and concentration of the contaminant downstream.  A sourcing simulation will predict the paths and 
relative amounts of sourced air travelling to the airway. 

Gas 

 Animated 

Indicates the presence of a gas mixture in the airway.  A gas simulation will predict the path and 
concentration of the gases downstream. 

Thermo- dynamic Heat or Moisture Source   

 

 



 

 

 

Indicates the presence of a positive heat or moisture source in the airway.  A Thermodynamic simulation 
will mix the quantities and distribute the changes downstream.  A grey colour indicates the preset heat or 
moisture has been turned off in the Edit box. 

Thermo- dynamic Cooling or Drying Source  

 

Indicates the presence of a negative heat source (cooling or refrigeration) or a moisture removing source 

in the airway.  A Thermodynamic simulation will mix the quantities and distribute the changes downstream. 
A grey colour indicates the preset heat or moisture has been turned off in the Edit box. 

Airway Notes  

 

Indicates text notes have been made for the airway.  Text notes can be viewed by clicked the airway with 
the Edit Form, and selecting the Notes Tab. 

Surface Connected Airway 

 

Indicates an airway is connected to the surface.  Surface airways can draw or discharge mine airflow to or 
from the atmosphere. 

Unknown Airway End 

 

Defines the end of an airway in construction that has neither been flagged as a surface connection or a 

closed (dead) end.  Headings with these symbols may raise a warning during simulation, and will be 
assumed to be a dead end. 

Orifice 

 

 

 



 

 

Indicates an orifice restriction is present in the airway.  Orifices indicate smaller opening in a wall such as 

a regulator and may be used to apply additional resistance to an airway. 

Backfill 

 

Indicates the presence of backfill in an airway.  Backfill will obstruct the airflow by narrowing the airway 
passage.  In addition, backfill will insulate a portion of heat transfer into the airflow from the surround rock 
strata during heat simulation. 

Obstruction 

 

Indicates an obstruction is present in the airway.  Obstructions reduce the area of the airway for the length 
of the airway.  They can be used to simulate pipes, compartments or structures that limit the airflow cross 

sectional area available. 

Sensor 

 

Indicates the presence of one or more sensors in an airway.  A sensor can feed an external data source 
into a VentSim model.  It is used by the LIVEVIEW™ module to show external live data in a model.  

Shock Loss 

 

Indicates the presence of shock loss in the airway.  The shock symbol (representing swirling air) is generally 

shown at the beginning where air enter the airway. 

 

Radon Source 

 

Indicates the presence of a radon source in the airway.  The radon source could be a fixed source of radon 
emission or a radon activity measurement in the airway 

 

VentFire Fire Script 



 

 

 

Indicates a VentFIRE script has been entered into the airway.  The VentFIRE script may be greyed out if it 
is not active. 

 

Dynamic Monitor 

 

Indicates a dynamic monitor has been placed in the airway.  Dynamic monitor are used to record and 
graph changing ventilation conditions during a dynamic or fire simulation.  Click the ZOOM button on to 
the monitor during or after simulation to see recorded results. 

 

PQ Survey 

 

Shows the presence of a PQ survey within the airway to determine the exact airways resistance.  If PQL is 
shown this indicates the presence of a linear PQ survey. 

 

 

 

 

  



 

 

 

 

 

 

44 APPENDIX D – DISPLAY PROBLEMS 

Occasionally the user may find that the graphics displayed on the computer screen are not as intended.  
The following section will step through some common problems and resolutions 

44.1. Hardware Problems 

A large variety of graphics cards exists on the market today.  While each type of card should perform in 
the same way (although some faster than others), there are many different manufacturers and software 
drivers that may cause differences in expected performance. 

Chasm Consulting tests a wide variety of different cards to ensure optimum performance where possible. 

If an issue exists, often updating the software driver from the card manufacture can help resolve issues.  
Due to the low price of 3D graphics cards, if the computer or graphics card is very old (greater than 5 
years), it may be better to upgrade the computer or replace the graphics cards with a newer type. 

Screen fails to display after coming out of ‘sleep / hybernation’ 
The screen remains blank, or shows corrupted data when resuming from screen savers or hybernation.  
This is caused by the graphics card failing to send the correct message to VentSim to enabled VentSim to 
reset the card and restore the graphics. 

 

In most cases the screen can be recovered by using the VIEW > REFRESH 
menu items.  In extreme cases the software may need to be shutdown and 
restarted. 

Updating the graphics cards software drivers can often help in this case.  Alternatively, disable the screen 
saver / hybernation, and allow the computer to simply turn off the monitor instead. 

Anti-aliasing does not work / is very slow 
Only newer graphics cards fully support this image smoothing feature.  Older graphics cards, particular 
INTEL motherboard types, do not support it.  Low power graphics solutions from ATI or NVIDIA may 

support it, but graphics performance will slow. 

No solution.  Install a newer video card which supports full screen anti-
aliasing or turn off anti-aliasing in the settings. 

 

Custom Icons cannot be used 
Only newer graphics cards fully support custom icons.  Older graphics cards (particularly pre-2008 
INTEL) may not have sufficient memory pointers to support the placement of potentially tens of 
thousands of icon images on the screen, therefore support for these cards has been disabled. 

No solution.  Install a newer video card. 

Resolution 

Resolution 

Resolution 

Chapter 

44 
 



 

 

44.2. Software Problems 

Occasionally, the screen will not display graphics as expected.  This can stem from a wide range of settings 
in VentSim which may not be set correctly to display the desired graphics. 

 

No Graphics Shown on Screen 
The airways may be hidden or invisible, or located off the screen. 

 

Use the VIEW > FIT ALL command to make sure the grpahics are relocated 
to the screen.  If no graphics show, use the VIEW > SHOW ALL, to turn on 
all hidden layers and levels.  If still no graphics show, ensure that airways 

are still present in the model, by running the RUN > SUMMARY menu option and 
ensuring a number of airways are present. 

Finally, make sure that options such as VIEW > HIDE ZERO FLOWS, and VIEW 
> HIDE EXCLUDED AIRWAYS are not turned on. 

  

I can see airways, but no text / arrows / nodes 
The screen may only display the raw airways, but no other information. 

 

The option to display text or arrows may be turned off (press ‘T’ or ‘A’ 

respectively to turn back on), or use the sidebar toolbar menu.  If this does 
not work, the LIMIT command may be turned on.  This command hides text 

/ nodes / arrows if the airways is not specifically set on the EDIT form to show 
DATA.  Turn the LIMIT option off using the ‘L’ button. 

 

  

Resolution 

Resolution 



 

 

 

 

 

 

45 APPENDIX E – SIMULATION ERRORS 

The following messages may be shown if errors are present during 
model simulation.  To select and view an airway with an error, 

simply click the error value in the Error List Box at the lower right 
corner of the screen.  The select multiple airways for editing in 
VentSim, click on the items (hold CTRL to select multiple items) and 
click SELECT. 

 

45.1. Warnings 

Warnings can generally be ignored, as the simulation will complete 
despite the warnings.  They may however be a sign of a more 
serious problem, and should still be investigated. 

no entry airway or surface connection 
There is no airway entering the airway, therefore no airflow can occur.  The airway is not connected to 
the surface or marked as a ‘closed end’.  The program can be set to ignore these warnings in the 

Settings – Airflow Simulation menu. 

Simply connect an airway to the entry, connect the airway to the surface, or 
marked as a closed end in the Edit Box. 

no exit airway or surface connection 
As with no entry warning. 

 

no entry or exit 
As with no entry warning description. 

 

airway stopping redundant 
An airway stopping has been placed in series with another airway stopping.  Only one stopping is 
required. 

None required, although a stopping can be removed if desired. 

 

fan interfering with another fan 
A fan has been placed directly in series with another fan.  The pressure imbalance between the fan 
curves may cause difficulty in resolve the model, partiulcarly if one fan is operating outside of its 
specified fan curve. 

Recommmend removing a fan, or ensuring an alternative airway path is 
available to help ‘bleed’ pressure between fans.  

Fix requires pressure 

Resolution 

Resolution 

Resolution.   
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A ‘limit flow’ option has been place in an airway to slow down airflows, however the unrestricted airflow  

has been placed directly in series with another fan.  The pressure imbalance between the fan curves may 
cause difficulty in resolve the model, partiulcarly if one fan is operating outside of its specified fan curve. 

Recommmend removing a fan, or ensuring an alternative airway path is 
available to help ‘bleed’ pressure between fans. 

 

temperature balancing issue 
Thermodynamic simulation is having difficulty resolving temperature balance between two airways.  This 
may happen at extremes of temperature or pressure. 

Investigate what is causing high / low temperatures (eg high heat or 
refirgeration loads, coupled with low airflows).  Resolve problem if possible.  
The Settings menu can be set to ignore this program, but this is generally 

not recommended. 

stalled fan 
The fan is operating at too higher pressure / low volume, beyond the limits of the fan curve. 

None required, however fans should not be made to run outside the curve.  

VentSim DESIGN™ must ‘guess’ a result, which could lead to errors.  

low pressure fan 
The fan is operating at too low pressure / high volume, beyond the limits of the fan curve. 

None required, however fans should not be made to run outside the curve.  
VentSim DESIGN™ must ‘guess’ a result, which could lead to errors or air 
balancing issues.  To remove the warning, increase the resistance the fan 

operates at, or extend the fan curve down to zero pressure. 

negated fan 
The fan offering no additional pressure to the model, and may actually be retarding airflow. 

None required, however fans should not run as negated.   VentSim 
DESIGN™ must ‘guess’ a result, which could lead to errors or air balancing 

issues.  In most cases, fan negation occurs as a result of other fans drawing 
air through the fan at a flow above the maximum fan curve quantity.  To 
remove this warning, consider removing or switching off the fan. 

 

Water suspension velocity 
The airflow in an upcasting shaft fall between the critical velocities that may cause the water to be 
suspending in the shaft. 

None required.  This warning shows when the Settings > Airflow Simulation 
> Water Suspension checking is set.  From a design point of view, this 

situation may not be desirable and the airflow may need to be increased or 
decreased to ensure velocities fall outside of the critical range. 

45.2. Errors 

Errors will generally halt a simulation process, and must be corrected before a valid simulation can occur. 

airway attempted to reverse 
An airway set as ‘restricted reverse’ in the Edit box was attempted to be reversed by the simulation.  As 
a result, the simulation is halted. 

Resolution.   

Resolution.   

Resolution 

Resolution.   

Resolution.   

Resolution.   



 

 

This function is designed to warn the user about airways which should not 

have reversed airflow.  To remove this error, simply unclick the option in the 
Edit Box for the airway.  

 

Anomalous pressures 
An design in a netwok has resulting in a huge buildup of pressure, beyond allowable levels.  This causes 
the simuliation calculation to corrupt and breakdown.  Because VentSim uses somes of the results of 

previous simulations for current calculations (for example fan pressures are used to help calculate air 
density), this may corrupt future simulations as well 

Allow VentSim DESIGN™ to automatically reset the model.  The model can 
also be manually reset from the Tools Menu.  The cause of the pressure 
buildup should be investigated.  It usually stems from overuse or restriction 

of fixed airflow, or too many high resistance (bulkheads) blocking off a working 
part of the model and restricting flow balanacing.  Occasionally it may be due to 

airways not being connecting properly, restricting movement of air, which can 
be resolved with the Tools > Filter > Bind command. 

Duplicate airway  
An airway with te same entry and exit location as another airway has been created. 

Allow VentSim DESIGN™ to delete the duplicate airway. 

 

Fixed flow cannot be achieved 
An airway has a fixed flow placed in line with another fixed flow, resulting in a conflict between the two 
flows, or a fix flow is placed in a locaton where it cannot draw air. 

Remove one of the fixed flows, or ensure a path between the flows exists to 
balanced the flow difference.  Ensure there are no breaks in any airways 

leading to or from the fixed flow, through which airflow cannot travel. 

Fix being over-restricted 
A fix flow encounters too much resistance to flow the required air quantity causing a massive buildup in 
pressure. 

Check to ensure pathways before and after the fix are connected to the 
model or surface, and can freely flow air, and no blocked resistances are 
present in the pathways before or after the fix.  Airways that are not exactly 

connected cannot carry airflow.  While a no entry/exit warning will normally 
highlight these airways, if ‘allow closed end’ has been selected, then no warning 

will show, and the problem may be difficult to find.  Try the wireframe mode 
with nodes displayed if this is a problem.  

 

operating fan blocked 
A fan has been placed in an airway through which no air can flow. 

As with ‘fix stopped’, check to ensure restricting blocked resistances are not 
present, and the airways before and after the fan can carry air. 

convergence problem 
The model cannot find a resolution in the model airflow balance. 

 

Resolution  

Resolution 

Resolution 

Resolution 

Resolution 

Resolution 



 

 

Ensure fans are not running stalled or negated, and no unusual pressures or 

flows exist within the model. 

temperature outside allowable range 
Temperature is increasing or being reduced beyond the allowable range. 

Investigate what is causing high / low temperatures (eg high heat or 
refirgeration loads, coupled with low airflows).  Ensure airflow is adequate for 
heat addition or removal amounts.  Reduce heat input if possible, or increase 

airflow. 

heat estimation error encountered 
A general error in estimating thermal properties occurred.  This normally occurs where air temperatures 
or pressures are welll outside of the expected range. 

 

Investigate what is causing high / low temperatures (eg high heat or 
refirgeration loads, coupled with low airflows).  Ensure airflow is adequate for 
heat addition or removal amounts.  Reduce heat input if possible, or increase 

airflow. 

temp estimation near rock surface 
An error estimate transfer of heat flux from rock strata surface to airflow.  This may happen where an 

extremely low airflow exists, or temperature or moisture values in the air are unusually high or low.  
Where airflow is less than the error correction value in the air simulaton settings, VentSim will not 
attempt to solve heat balance, and will simply assume the air temperature becomes the same as the 
virgin rock temperature. 

Increase airflow through airway, or increase tolerance of massflow setting in 
the Settings menu, to ignore airways with low flow. 

 

overpressure across resistance 
Pressure building up unacceptably over a high resistance airway, or a fan or fixed flow running into a 

high resistance airway.  This error may occasionally show up when simulating VentSim Classic 3.9 
models with VentSim™. 

Investigate and remove the source of the high pressure (fan or fix) or 
remove the high resistance causing the buildup in pressure.  Unlike VentSim 
Classic 3, which ignore this error, this situation is unacceptable to VentSim™, 

as it adversely affects air densities and heat buildup, and in nearly all cases is a 
result of user input error.  Pressure above 15000 Pa are generaly used as a 

trigger for this error. 

operating fan restricted by resistance 
A resistance has been placed in the same airway as a fan, and the fan is being unreasonably restricted.  
This is a common practise in VentSim Classic 3.9 models to stop airflow through a fan.  In VentSim™, it 

can cause overpressure and heat buildup, and is therefore no longer permitted. 

Turn the fan OFF instead from the EDIT form, of remove the fan.  If the fan 
is turned OFF, click on SELF CLOSING if you want to ensure air does not leak 
back through the fan. 

fix being over restricted 
Similar to overpressure across resistance, but the error code will target the airway with the fan or fix, not 
the resistance. 

Changing the fan or fix, or alternatively removing the high resistance will 
correct the problem. 

Resolution 

Resolution 

Resolution 

Resolution 

Resolution 

Resolution 

Resolution. 



 

 

unresolved pressure or flow 
VentSim DESIGN™ cannot resolve of pressure or airflow volume during simulation 

Ensure no unusually airways, fan pressure or pathways exist within the 
model model. 

fan static P curve invalid, check fan 
No fan static pressure curve is available for the fan, but a static curve has been selected in the Edit Box 
or the Settings Menu. 

Enter a fan static pressure curve for the fan, or ; 

change the Edit Box setting to a Fan Total Curve (FTP), or ; 

change the Global Fan Pressure method in the Settings menu to Total Pressure 
Method. 

fan total P curve invalid, check fan 
No fan total pressure curve (FTP) is available for the fan, but a total curve has been selected in the Edit 
Box or the Settings Menu. 

 

Enter a fan total pressure curve for the fan or; 

Change the Edit Box setting to a Fan Static Curve (FSP), or; 

Change the Global Fan Pressure method in the Settings menu to Static Pressure 

Method. 

 

Meshing error 
VentSim DESIGN™ cannot create a workable mesh of airway loops (meshes) required for airflow and 
pressure balancing using the Hardy Cross method. 

Ensure that there are not too many airways connected to the SURFACE.  In 
addition ensure that airways are physically connected – use the TOOLS > 
FILTER option if necessary to allow VentSim to ensure a connection. 

 

 

  

Resolution 

Resolution 

Resolution 

Resolution 



 

 

 

 

 

46 APPENDIX F – Shortcut Keys 

A number of keyboard strokes exist to assist in rapid selection of commonly used functions.  Most menu 
items have the shortcut key next to the menu item.  Below is a general summary of common key strokes 

CTRL N   New File 
CTRL O   Open File 
CTRL M   Merge File 
CTRL I   Inherit File Attributes 
CTRL S  Save File 
CTRL F   File Note 
CTRL C   Clone Attributes 
CTRL V   Apply Attributes 
CTRL L   Lock On Target (Toggle) 
CTRL T   Lock On Transparency (Toggle) 
CTRL Q   Quick View 
LEFT Arrow   Move to previous Quick View 
RIGHT Arrow   Move to next Quick View 
  
HOME   Fit All 
INSERT   Insert Node 
PAGE UP   Select / Move Up one elevation level (if defined) 
PAGE DOWN   Select / Move Down one elevation level (if defined) 
END   Show ALL elevation levels 
DEL   Enter delete mode (select / fence airways to delete) 
CTRL Z   UNDO 
CTRL R  REDO 

 
CTRL N   New File 
F1   HELP 
F2   Plan / Section Views (Toggle to cycle through views) 
F3   FIND ( Toggle to repeat last find command) 
F4   FIND and HIGHLIGHT found airways 
F5   Simulation Airflow 
F6   Simulation Thermodynamic 
F7   Hide / Show Zero Flow airways 
F8   Hide / Show Excluded airways 
F9   Transparencies on/off 
F12   Save As 
  
T   Show / Hide text data 
L   Show / Hide limited data 
Z   Zoom Mode 
D   Draw or Add airway mode 
E   Edit Mode 
S   Select Mode 
M   Move Mode 
C   Copy Mode 
B   Block Mode (for blocking / unblocking airways) 
R   Reverse Mode (for reversing airways) 
Z  Zoom Out 
P   Perspective / Orthogonal Mode Toggle 
W   Toggle between Wireframe and Solids 
G   Display / Hide Grid 
N   Display / Hide Nodes 
A   Display / Hide Arrows 
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47 APPENDIX G – Command Line Options 

VentSim has limited functionality from command line execution, which bypasses the GUI and results in 
directly running simulation input files from command line parameters instead of user actions.  Command 
line execution is typically used by 3rd party programs which require VentSim to process and return data. 

Command line options generally take the form of the VentSim executable file (including the path location 
of the executable if it is not in the current folder) and a series of parameters defining the functionality 
required from the software. 

vventsim.exe  “filename.vsm” /p1 /p2 /p3 

Currently, there are two functions available through using command line options in VentSim. 

47.1. LiveView Sensor Command Line Options 

Running LIVEVIEW and outputting the initial results of sensor inputs into a steady state simulation results 
file.  Note that LIVEVIEW must be fully pre-configured and the model saved in the GUI before this command 
is used 

/o Output File (Full VentSim File) 

/t Mini Text File Output (airway data only text file) 

/u Update and Read in new Sensor Values if available 

/s1 Enable Air Simulation 

/s2 Enable Heat Simulation 

/s3 Enable Gas Simulation 

 

47.2. Static Script Command Line Options 

Running STATIC Scripting, which runs scripting spreadsheets to modify a VentSim model and output the 
steady state results 

/staticin the path and name of the static script file to be imported to VentSim 

/staticout the path and name of the static script file to be outputted from VentSim 

/stage  (OPTIONAL) switch the VentSim input file STAGE number.  If not selected the input file 
will use the last saved STAGE state of the VentSim file. 

/date  (OPTIONAL) specify a simulation run date, after which any airways with ages greater 
than the date will be automatically excluded from the simulation.  The date should be entered in the 
format ‘yyyy-mm-dd’ 
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47.3. Examples of command lines 

Liveview 
 

Example command line to read in a pre-configure VentSim file called  ‘liveview.vsm’, update with the latest 
sensor information, run an airflow and heat simulation, and output the results to a full VentSim file called 
‘outputfile.vsm’ and an airway result only text file called ‘output.txt’.  The input and output files are located 
on the computer h: drive 

C:\Program Files\VentSim DESIGN™ 4\vvenstim.exe  “h:\liveview.vsm" /t "h:\output.txt" /s1 /s2 /u /o 
"h:\outputfile.vsm" 

 

Static Scripting 
 

Example command line to read in a base VentSim file called ‘staticbase.vsm” and modify and run a static 
script file called ‘inputscript.xlsx’ and export the results to a file called ‘outputresults.xlsx’.   Note that the 
base file must have the static script simulation options specified in the GUI before the command line is 
run. 

C:\Program Files\VentSim DESIGN™ 4\vvenstim.exe  “h:\ staticbase.vsm" /staticin " inputscript.xlsx” 
/staticout "outputresults.xlsx” 

C:\Program Files\VentSim DESIGN™ 4\vvenstim.exe  “h:\testsim.vsm” /date 2019-06-01 /scriptin 

h:\Script.xlsx /scriptout h:\fred.xlsx 

 

  



 

 

 

 

 

 

48 APPENDIX H – VentSim Static Scripting 

Static Scripting is a method of running multiple variations of a VentSim design by feeding in a list of 
variations you would like to modify a ‘base’ model with.  The function works by using an EXCEL spreadsheet 
to define what items in the model you wish to change.   Static scripting is an experimental feature and not 
currently fully supported by Chasm Consulting. 

 

48.1. Introduction 

Many variations to the model can be contained in the same EXCEL sheet, and each variation is run as a 
different model.  

Use the CREATE BASE file to see the full format on the required EXCEL spreadsheet. Then remove the 

columns you don't need to modify and you can use this to create a script. 

 

 

The above example shows an input file with several script changes (model variation), each script number 
changes a selection of airway settings for width and height. Airways are each referenced by their UNIQUE 
ID NUMBER.  

The ‘script’ file is the file that contains the portions of airways of the main file you wish to modify.  You can 
create a script file from the GUI menu and delete the columns and rows you don’t need (eg, just keep the 
WIDTH, HEIGHT and UNIQUE NUMBER IDENTIFIER if you want).  Note ; a script file can have many 

variation scripts.  Column 1 contains the script number.  Each script number will be run and output as a 
separate result.  Unfortunately, the scriptin file column format and numbers are strictly assumed to be 
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metric only, and the names may not be clear as they are derived from the VentSim file format and not 

intended as a user interface.   

The scriptout file is where the simulation results are saved.  There is an option now to choose the output 
data selection in a format more convenient than the raw VentSim format. 

You will first need to configure the mainfile using the GUI setup in the CONNECT > STATIC SCRIPT 

menu.  You may want to try some examples here first before you use the command line. 

Note that the scriptin and scriptout files can be Excel, CSV text or TXT (tab) delimited text files. 

 

48.2. The FLAG field 

The FLAG number in VentSim is an important field that controls many of the airway variation functions.  It 
is the sum of Boolean bit numbers.  See the table below for settings.   

For example, if an airway needs to be EXCLUDED from simulation, use the EXCLUDE flag number 
(134217728), which basically removes an airway from the simulation, and blocks any connecting 
airways.  This may be more useful than trying to use different stages.   

To choose multiple different flag settings, simply add the numbers together.   

 

Boolean Mask Bit Number FlagSet 

1 1 SquareBranch 

2 2 RoundBranch 

4 3 FixQAdd 

8 4 SmokeBranch 

16 5 ServiceBranch 

32 6 FanBranch 

64 7 fixLength 

128 8 TagBranch 

256 9 FreshBranch 

512 10 ExhaustBranch 

1024 11 ShowDataBranch 

2048 12 SurfaceBranch 

4096 13 SurfaceExitBranch 

8192 14 FixDirection 

16384 15 SPARE 

32768 16 AreaBranch 



 

 

65536 17 selectionUser 

131072 18 allowOpen 

262144 19 fixPressure 

524288 20 DensityAdjustR 

1048576 21 DensityAdjustK 

2097152 22 enableOrifice 

4194304 23 FixQResist 

8388608 24 FlagSet 

16777216 25 RemoteDisp 

33554432 26 ductLeakage 

67108864 27 duct 

134217728 28 exclude 

268435456 29 noEntry 

536870912 30 noExit 

1073741824 31 ventFireActive 

 

The UNIQUE numbers will not change for individual airways, even if fans or stages have been 
deleted.  Index numbers will change and should not be used for referencing airway changes. 

 


